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1 Foreword
The multi-axis drive system is designed for multi-axis applications and consists of the SI6 drive controller and PS6 supply
module combination. The most striking feature is its extremely compact design! Each SI6 is connected to the central PS6
supply module. Additional fuses and cabling for each individual axis are not required. They thus reduce material and
operating costs. The SI6 drive controller also offers a lot for acceleration: Together with an EZ series synchronous servo
motor, it can go from 0 to 3000 rpm in 10 ms. Matching Quick DC-Link modules handle the energy supply for the drive
controllers in the group. The SI6 drive controller is available in four sizes as a single or double-axis controller with a nominal
output current of up to 50 A. The PS6 supply module is available in three sizes with a nominal output power of 10 kW to
50 kW.

Features

§ Control of rotary synchronous servo motors and asynchronous motors

§ Sensorless position control of Lean motors

§ Control of linear and torque motors

§ One Cable Solution EnDat 3

§ Electronic motor nameplate via EnDat encoder interfaces

§ Integrated EtherCAT or PROFINET communication

§ STO safety technology using terminals or STO and SS1 using FSoE or PROFIsafe: SIL 3, PL e (Cat. 4)

§ Integrated brake control

§ Energy supply over DC link connection

§ Single-ended nominal power consumption on double-axis controllers for operation of motors with different power

§ Variable feed-in power using supply modules that can be connected in parallel
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2 User information
This documentation covers multi-axis drive systems with SI6 and PS6. You will receive support for assembling the individual
modules along with the associated components that you will need for operating the multi-axis drive controllers in the
control cabinet.

You will also find information on wiring the modules correctly and checking their functionality in the group with an initial
test.

Combinations with other 6th generation STOBER drive controllers are possible under certain boundary conditions.

More detailed information on project configuration, diagnostics and service are additional topics covered in this manual.

2.1 Storage and transfer
As this documentation contains important information for handling the product safely and efficiently, it must be stored in
the immediate vicinity of the product until product disposal and be accessible to qualified personnel at all times.

Also pass on this documentation if the product is transferred or sold to a third party.
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2.2 Described product
This documentation is binding for:

PS6 series supply modules and SI6 series drive controllers in conjunction with the 
DriveControlSuite software (DS6) in V 6.5-L or higher and associated firmware in V 6.5-L or higher.

Type ID No.

Drive controller SI6A061 56645

SI6A062 56646

SI6A161 56647

SI6A162 56648

SI6A261 56649

SI6A262 56653

SI6A361 56654

DC link connection DL6B10 56655

DL6B11 56656

DL6B12 56663

Tab. 1: Described product types, SI6 drive controllers and associated Quick DC-Link rear section modules

Type ID No.

Supply module PS6A24 56650

PS6A34 56651

PS6A44 138679

DC link connection DL6B20 56657

DL6B21 56658

DL6B22 5050114

Tab. 2: Described product types, PS6 supply modules and associated Quick DC-Link rear section modules

2.3 Directives and standards
The following European directives and standards are relevant to the drive controllers:

§ Directive 2006/42/EC – Machinery Directive

§ Directive 2014/30/EU – EMC Directive

§ Directive 2011/65/EU – RoHS Directive

§ Directive 2009/125/EC – Ecodesign Directive

§ EN IEC 61800-3:2018

§ EN 61800-5-1:2007 + A1:2017

§ EN 61800-5-2:2017

§ EN IEC 63000:2018

§ EN ISO 13849-1:2015

Subsequent references to the standards do not specify the respective year in order to improve readability.
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2.4 UL file number
cULus-certified devices with corresponding test symbols meet the requirements of the standards UL 61800-5-1 and CSA
C22.2 No. 274.

Under the file number specified in the following table, you can find the product in the online database of Underwriter
Laboratories (UL):
https://iq2.ulprospector.com

Type File number UL Category Control Number Certification

America Canada cULus/cURus

Drive controller SI6A061 E189114 NMMS NMMS7 cULus

SI6A062

SI6A161

SI6A162

SI6A261

SI6A262

SI6A361

Supply modules PS6A24

PS6A34

PS6A44

DC link connection DL6B10

DL6B11

DL6B12

DL6B20

DL6B21

DL6B22

Braking resistors KWADQU E212934 NMTR2 NMTR8 cURus

FZZMQU

FGFKQU

Power chokes TEP4010-2US00 E103902 XQNX2 XQNX8 cURus

Output chokes TEP3720-0ES41 E333628 NMMS2 NMMS8 cURus

TEP3820-0CS41

TEP4020-0RS41

Motors EZ or LM series
synchronous servo
motors

E488992 PRHZ2 PRHZ8 cURus

Asynchronous motors E216143 PRGY2 PRGY8 cURus

Encoder and power
cables

All types E172204
E170315
E356538

AVLV2 AVLV8 cURus

One Cable Solution
Basic

All types E356538 AVLV2 AVLV8 cURus

One Cable Solution
Advanced

All types E170315 AVLV2 AVLV8 cURus

Tab. 3: File number-certified products

https://iq2.ulprospector.com
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2.5 Timeliness
Check whether this document is the latest version of the documentation. We make the latest document versions for our
products available for download on our website:
http://www.stoeber.de/en/downloads/.

2.6 Original language
The original language of this documentation is German; all other language versions are derived from the original language.

2.7 Limitation of liability
This documentation was created taking into account the applicable standards and regulations as well as the current state of
technology.

No warranty or liability claims for damage shall result from failure to comply with the documentation or from use that
deviates from the intended use of the product. This is especially true for damage caused by individual technical
modifications to the product or the project configuration and operation of the product by unqualified personnel.

http://www.stoeber.de/en/downloads/
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2.8 Formatting conventions
Orientation guides in the form of signal words, symbols and special text markups are used to emphasize specific
information so that you are able identify it in this documentation quickly.

2.8.1 Display of warning messages and information
Warning messages are identified with symbols. They indicate special risks when handling the product and are accompanied
by relevant signal words that express the extent of the risk. Furthermore, useful tips and recommendations for efficient,
error-free operation are specially highlighted.

ATTENTION!

Attention

This indicates that damage to property may occur

▪ if the stated precautionary measures are not taken.

CAUTION!

Caution

This word with a warning triangle indicates that minor personal injury may occur

▪ if the stated precautionary measures are not taken.

WARNING!

Warning

This word with a warning triangle means there may be a considerable risk of fatal injury

▪ if the stated precautionary measures are not taken.

DANGER!

Danger

This word with a warning triangle indicates that there is a considerable risk of fatal injury

▪ if the stated precautionary measures are not taken.

Information

Information indicates important information about the product or serves to emphasize a section in the documentation that
deserves special attention from the reader.

WARNINGS!

Warnings

Warnings with the UL symbol mark text passages quoted from the original.
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2.8.2 Markup of text elements
Certain elements of the continuous text are distinguished as follows.

Important information Words or expressions with a special meaning

Interpolated position mode Optional: File or product name or other name

Detailed information Internal cross-reference

http://www.samplelink.com External cross-reference

Software and other displays

The following formatting is used to identify the various information content of elements referenced by the software
interface or a drive controller display, as well as any user entries.

Main menu 
Settings

Window names, dialog box names, page names or buttons, combined
proper nouns, functions referenced by the interface

Select 
Referencing method A

Predefined entry

Save your 
<own IP address>

User-defined entry

EVENT 52: 
COMMUNICATION

Displays (status, messages, warnings, faults)

Keyboard shortcuts and command sequences or paths are represented as follows.

[Ctrl], [Ctrl] + [S] Key, key combination

Table > Insert table Navigation to menus/submenus (path specification)

2.8.3 Mathematics and formulas
The following signs are used to represent mathematical relationships and formulas.

– Subtraction

+ Addition

× Multiplication

÷ Division

| | Absolute value

http://www.stoeber.de
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2.8.4 Conventions for cables
In the cable connection descriptions, core colors are shortened and used as follows.

Cable colors

BK: BLACK PK: PINK

BN: BROWN RD: RED

BU: BLUE VT: VIOLET

GN: GREEN WH: WHITE

GY: GRAY YE: YELLOW

OG: ORANGE

Formatting conventions

Two-colored core: WHYE WHITEYELLOW (white-yellow core)

Single-colored core: BK/BN BLACK/BROWN (black or brown core)

Core pair: BU-BK BLUE-BLACK (blue and black core)

2.9 Marks and test symbols
The following marks and test symbols are mentioned in the technical data.

RoHS lead-free mark 
Marking in accordance with RoHS directive 2011-65-EU.

CE mark 
Manufacturer's self declaration: The product meets the requirements of EU
directives.

UKCA test symbol
Manufacturer's self declaration: The product meets the requirements of UK
directives.

UL test symbol (cULus)
This product is listed by UL for the United States and Canada.
Representative samples of this product have been evaluated by UL and meet the
requirements of applicable standards.

UL test symbol for recognized component mark (cURus)
This component or material is recognized by UL. Representative samples of this
product have been evaluated by UL and meet applicable requirements.
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2.10 Trademarks
The following names used in connection with the device, its optional equipment and its accessories are trademarks or
registered trademarks of other companies:

CANopen®, 
CiA®

CANopen® and CiA® are registered European Union trademarks of CAN in
AUTOMATION e.V., Nuremberg, Germany.

EnDat® EnDat® and the EnDat® logo are registered trademarks of Dr. Johannes Heidenhain
GmbH, Traunreut, Germany.

EPLAN® EPLAN® and the EPLAN® logo are registered trademarks of EPLAN Software & Service
GmbH & Co. KG, Monheim, Germany.

EtherCAT®,
Safety over EtherCAT®,
TwinCAT®

EtherCAT®, Safety over EtherCAT® and TwinCAT® are registered trademarks of
patented technologies licensed by Beckhoff Automation GmbH, Verl, Germany.

HIPERFACE® HIPERFACE® and the HIPERFACE DSL® logo are registered trademarks of SICK
STEGMANN GmbH, Donaueschingen, Germany.

Hyper-V® Hyper-V® is a registered trademark of the Microsoft Corporation in the United States
and/or other countries.

PLCopen® PLCopen® is a registered trademark of the PLCopen Organisation, Gorinchem,
Netherlands.

PROFIBUS®, 
PROFINET®

PROFIBUS® and PROFINET® are registered trademarks of PROFIBUS
Nutzerorganisation e.V., Karlsruhe, Germany.

PROFIdrive®,
PROFIsafe®

PROFIdrive® and PROFIsafe® are registered trademarks of Siemens AG, Munich,
Germany.

speedtec® speedtec® is a registered trademark of TE Connectivity Industrial GmbH,
Niederwinkling, Germany.

TORX® TORX® and the TORX® logo are registered trademarks of Acument Intellectual
Properties in the USA and/or other countries.

VirtualBox® VirtualBox® is a registered trademark of Oracle America, Inc., Redwood Shores, USA.

VMware® VMware® is a registered trademark of VMware, Inc., Palo Alto, USA.

Windows®,
Windows® 7,
Windows® 10,
Windows® 11

Windows®, the Windows® logo, Windows® XP, Windows® 7, Windows® 10, and
Windows® 11 are registered trademarks of Microsoft Corporation in the United
States and/or other countries.

All other trademarks not listed here are the property of their respective owners.

Products that are registered as trademarks are not specially indicated in this documentation. Existing property rights
(patents, trademarks, protection of utility models) are to be observed.
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3 Safety notes
There are risks associated with the product described in this documentation that can be prevented by complying with the
following basic safety notes as well as the included technical rules and regulations.

3.1 Qualified personnel
In order to be able to perform the tasks described in this documentation, the persons instructed to perform them must
have the appropriate professional qualification and be able to assess the risks and residual hazards when handling the
products. For this reason, all work on the products as well as their operation and disposal may be performed only by
professionally qualified personnel.

Qualified personnel are persons who have acquired the authorization to perform these activities either through training to
become a specialist and/or instruction by specialists.

Furthermore, valid regulations, legal requirements, applicable basic rules, this documentation and the safety notes included
in it must be carefully read, understood and observed.

3.2 Intended use
As defined by EN 50178, SI6 drive controllers and PS6 supply modules are electrical devices operating as power electronics
to control the flow of energy in high-voltage systems.

SI6 drive controllers are intended solely for the operation of motors that meet the requirements of EN 60034-1:

§ Lean motors of the LM series

§ Synchronous servo motors (e.g. of the EZ series)

§ Asynchronous motors

§ Torque motors

The PS6 supply module is intended solely for the supply of one or more drive controllers. Only STOBER drive controllers of
the 6th generation may be connected to the PS6 supply module.

The connection of other electronic loads or operation outside applicable technical specifications constitutes improper use.

When installing drive controllers in machines, commissioning (i.e. commencing intended operation) may not be performed
until it has been determined that the machine is in compliance with local laws and directives.

EMC-compliant installation

The SI6 drive controller and accessories must be installed and wired compliant for EMC.

Modification

As the user, you may not make any physical, technical or electrical modifications to the SI6 drive controller and the
accessories.

Maintenance

The SI6 drive controller and accessories are maintenance-free. However, take appropriate measures to detect or prevent
possible errors in the connecting wiring.
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3.3 Transport and storage
Inspect the delivery for any transport damage immediately after you receive it. Notify the transport company of any
damage immediately. Do not put a damaged product into operation.

Store the products in a dry and dust-free room if you do not install them immediately.

Transport and store the products in the original packaging and protect the products from mechanical impacts and
vibrations. Observe the transport and storage conditions recommended in the technical data.

Reform drive controllers in storage annually or before commissioning (see Storage [} 96]).

3.4 Operational environment and operation
The products are subject to sales restrictions in accordance with EN IEC 61800-3.

The products are not designed for use in a public low-voltage network that supplies residential areas. Radio-frequency
interference can be expected if the products are used in this type of network.

The products are intended exclusively for installation in control cabinets with at least protection class IP54.

To ensure the faultless and safe operation of the products, they must be professionally configured, installed, operated and
maintained.

Always operate the products within the limits specified by the technical data.

The following applications are prohibited:

§ Use in potentially explosive atmospheres

§ Use in environments with harmful substances as specified by EN 60721, such as oils, acids, gases, vapors, dust and
radiation

Implementation of the following applications is permitted only after approval from STOBER:

§ Use in non-stationary applications

§ The connection of active and passive components (drive controllers, supply modules, regenerative feedback modules
or discharge units) from third-party manufacturers

All device types are intended exclusively for operation on TN networks or wye sources that supply a maximum differential
short-circuit current in accordance with the following table.

For UL-compliant operation:
All device types supplied with 480 VAC are intended solely for operation with grounded wye sources at 480/277 VAC.
For all device types with a 480 VAC supply, the supply grid must not deliver a differential short-circuit current above the
specification in the following table.

Type of supply module Max. differential short-circuit current

PS6A24, PS6A34 5000 A

PS6A44 10000 A

Tab. 4: Short circuit current rating (SCCR)

The drive controller has a configurable restart. If the drive controller is designed for an automatic restart after energy
shutdown, this must be clearly specified on the system in accordance with EN 61800-5-1.

The drive controller has the option of a Safe Torque Off safety function (STO) in accordance with EN 61800-5-2 for safely
disconnecting the energy supply to the motor. Measures based on this for protection against unexpected startup are
described in EN ISO 12100 and EN ISO 14118, for example.
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3.5 Working on the machine
Before all work on machines and systems, apply the 5 safety rules in accordance with DIN VDE 0105-100 (Operation of
electrical installations – Part 100: General requirements) in the order listed:

§ Disconnect (also ensure that the auxiliary circuits are disconnected).

§ Ensure power cannot be switched on again.

§ Ensure that everything is de-energized.

§ Ground and short-circuit.

§ Cover adjacent live parts.

Information

Note the discharge time of the DC link capacitors in the general technical data for the devices. You can only determine the
absence of voltage after this time period.

3.6 Installation
Installation work is permitted only when no voltage is present. Obey the 5 safety rules (see Working on the machine
[} 22]).

WARNING!

Electrical voltage! Risk of fatal injury due to electric shock!

▪ Always switch off all power supply voltage before working on the devices!

▪ Note the discharge time of the DC link capacitors in the general technical data. You can only determine the absence
of voltage after this time period.

Handle the devices with care:

§ Do not damage any components or change any insulation distances when transporting or handling the devices.

§ Avoid mechanical overloads.

§ Do not touch any electronic components or contacts.

To protect the devices from overheating, obey the operating conditions described in the technical data and comply with the
required minimum clearances for installation.

Protect the devices against falling parts (bits or strands of wire, pieces of metal, etc.) during installation or other work in the
control cabinet. Parts with conductive properties may result in a short-circuit inside the devices and device failure as a
result.
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3.7 Electrical connection
Connection work is permitted only when no voltage is present. Observe the 5 safety rules (see Working on the machine
[} 22]).

WARNING!

Electrical voltage! Risk of fatal injury due to electric shock!

▪ Always switch off all power supply voltage before working on the devices!

▪ Note the discharge time of the DC link capacitors in the general technical data. You can only determine the absence
of voltage after this time period.

When the power supply voltage is turned on, hazardous voltages may be present on the connection terminals and the
cables connected to them.

The device and the cables connected to it are not necessarily de-energized when the supply voltage is switched off and all
displays have gone out!

Opening the housing, plugging in or unplugging connection terminals, connecting or removing a connecting wiring, and
installing or removing accessories are prohibited while the voltage supply is switched on.

The device housing must be closed before you turn on the supply voltage.

Make sure that all Quick DC-Link modules are built over with a PS6 supply module or SI6 drive controller or covered with a
Quick DC-Link cover after installation or after replacing a device.

Protect the devices against falling parts (bits or strands of wire, pieces of metal, etc.) during installation or other work in the
control cabinet. Parts with conductive properties may result in a short-circuit inside the devices and device failure as a
result.

Use only copper conductors. For the corresponding conductor cross-sections, consult the standards DIN VDE 0298-4 or 
EN 60204-1 (Annexes D, G) as well as the relevant terminal specifications in this documentation.

The protection class of the devices is protective grounding (protection class I in accordance with EN 61140). This means that
operation is permitted only if the grounding conductor is connected according to requirements.

All protective ground connections are identified by "PE" or the international grounding symbol (IEC 60417, symbol 5019).

The products are not designed for use in a public low-voltage network that supplies residential areas. Radio-frequency
interference can be expected if the products are used in this type of network.

3.8 Ensuring traceability
The orderer must ensure traceability of the products using the serial number.

3.9 Decommissioning
In safety-oriented applications, note the mission time TM = 20 years in the safety-relevant key performance indicators. A
drive controller with integrated safety module must be taken out of operation 20 years after the production date. The
production date of the drive controller is found on the accompanying nameplate.

For detailed information about using the safety technology, refer to the corresponding manual (see Detailed information
[} 429]).
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3.10 Disposal
Observe the current national and regional regulations when disposing of the packaging and product! Dispose of the
packaging and individual product parts depending on their properties, e.g. as:

§ Cardboard

§ Electronic waste (circuit boards)

§ Plastic

§ Sheet metal

§ Copper

§ Aluminum

§ Battery

3.11 Firefighting

DANGER!

Electrical voltage! Risk of fatal injury due to electric shock!

There is a risk of fatal injury due to electric shock when using conductive firefighting equipment.

▪ Use ABC powder or carbon dioxide (CO2) for firefighting.
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4 Security
Security refers to the protection and safety of your components and systems with regard to confidentiality, integrity and
availability.

While functional safety technology focuses on the avoidance of systematic or random faults, security technology is based
on targeted influences. These influences may be intentional or unintentional with direct or indirect access to equipment.

Security risks

§ Incorrect operation, e.g. connection to an incorrect device

§ Hardware:

• Changing the wiring

• Changing the device configuration, e.g. the FSoE address

• Disassembly of accessories, e.g. the SD card

§ Software:

• Changing the firmware

• Changing the device configuration, e.g. via DriveControlSuite, via the SD card or using script mode

• Changing parameters

§ Network structure

Recognizing and avoiding risks

For example, the following tools are available to help you identify risks and avoid tampering.

§ Make sure that the device identification is unique:

• Reference code

• Communication address(es)

§ After establishing the connection, make sure that communication with the desired device has been established.

§ Test and log the (re)commissioning.

§ Check the security log of the drive controller regularly (see Security log [} 427]).

§ Limit access:

• Physically (close off the control cabinet and electrical operating room)

• Logically (restrict communication, e.g. by means of a firewall)

§ Use sealing tape to detect tampering at the following interfaces:

• Ethernet service interface X9

• Fieldbus interfaces X200 and X201

• SD slot X700

§ Make sure that the controller runs a plausibility check:

• Device status

• Application-specific configuration ID

Planning measures

The requirements from the locally applicable safety and application standards regarding protection against tampering must
be observed. The authorization of personnel and the implementation of the necessary protective measures are the
responsibility of the operator.
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All systems to be protected must be considered individually. Organizational protective measures are supported by technical
measures. Technical measures alone are not sufficient.

In the course of planning, you should name and document the measures to be taken.

Such measures include:

§ Sensible division of user groups

§ Use of appropriate passwords

§ Updated network plans

Network plans can be used to ensure that secure networks are permanently separated from public networks and, if
necessary, that there is only defined access (e.g. via a firewall or a DMZ).

A regular, e.g. annual, review of the security measures is advisable.

Defense in depth concept

Counter risks with layered security solutions.

In accordance with EN IEC 62443-4-1, the defense-in-depth concept is an approach to defend the system against any kind of
attack by applying multiple independent methods.

Features:

§ The approach is based on the fundamental idea that any protective measure can be, and probably will be, overcome.

§ Attackers have to overcome or bypass each layer without being detected.

§ A weakness in one layer can be mitigated by the capabilities of another layer.

§ The system's IT security becomes a set of layers within the overall IT network security.

§ Each layer should stand alone, should not be based on the same functionality as the other layers and should not have
the same failure modes as them.

Operator
- System security

System integrator
- Network security

- System integrity

Security
process

· Drive controllers
· Commissioning software
· Motors
· Gear units

· Physical access protection
· Processes and policies
· Security services

System

Fig. 1: Defense in depth concept
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5 UL-compliant use
This chapter contains relevant information for use under UL conditions (UL – Underwriters Laboratories).

Surrounding air temperature and pollution degree

The maximum surrounding air temperature for UL-compliant operation is 45°C. Use in an environment up to pollution
degree 2 is permitted.

Supply grid

All device types supplied with 480 VAC are intended solely for operation with grounded wye sources at 480/277 VAC.

For all device types with a 480 VAC supply, the supply grid must not deliver a differential short-circuit current above the
specification in the following table.

Type of supply module Max. differential short-circuit current

PS6A24, PS6A34 5000 A

PS6A44 10000 A

Tab. 5: Short circuit current rating (SCCR)

Project configuration

The maximum number of devices in the device group is limited by certain variables. The nominal output current I2N,PU of the
supply module, the charging capacity CN,PU of the supply module and the maximum copper rail length of 1500 mm must not
be exceeded.

Please obey the Example design for UL-compliant operation [} 386].

In the appendix, you can find an order overview of the necessary hardware components [} 391].

Line fuse

Mark each device group and obey the information on UL-compliant line fuses of powered supply modules [} 122].

Branch circuit protection

Integral solid state short-circuit protection does not provide branch circuit protection (line fuse) upstream of the drive
controller. Branch circuit protection must be provided in accordance with the manufacturer instructions, the National
Electrical Code, the Canadian Electrical Code, part I, and any additional local codes.

Protective grounding

The protective grounding of motors connected to the drive controller must not be connected using terminals X20A and
X20B. The grounding conductor connection of the motor must be ensured for the respective application in accordance with
the valid electrical standards.

PS6A24, PS6A34: The grounding at terminal X10 of the PS6 supply module must not be used for the protective grounding of
the PS6 drive system in combination with SI6. The housing for the PS6 supply modules must be connected to the protective
grounding by the M6 ground bolt. Obey a tightening torque of 4.0 Nm (35 Lb.inch).

PS6A44: Connect the grounding conductor to the supply module via terminal X10. Obey a minimum cross-section of
10 mm² for the grounding conductor and a tightening torque of 5.5 Nm (49 Lb.inch).

Connect the drive controller housing to the DL6B modules of the DC link connection by using the two or four M5 fastening
nuts to install the drive controllers properly. The specified tightening torque for these fastening screws at the DL6B modules
is 3.5 Nm (31 Lb.inch).



5 | UL-compliant use STOBER

28

02
/2

02
4 

| 
ID

 4
42

72
8.

12

Original text

WARNINGS!

Safety grounding

The external motors which are connected to the inverter units SI6A shall not be grounded over the modular drive system.
The bonding/grounding of the motor(s) shall occur in the end use application in accordance with the requirements of
applicable electrical codes/standards.

The grounding provisions present on the terminals X20A/X20B of the SI6A units are not intended for safety grounding of the
motors. The grounding provision present on terminal X10 of the inverter unit is not to be used for the grounding of the
drive system.

The PS6A/SI6A units are to be bonded through the M6 grounding studs on the power supply unit PS6A24 or PS6A34 or
through terminal X10 on the power supply unit PS6A44.

The chassis of the SI6A units are to be bonded to the DL6B units by means of two or four M5 mounting screws on top of the
DL6B unit(s). The specified tightening torque for these mounting screws on the DL6B units is: 3.5 Nm (31 Lb.inch).

The connection for the protective grounding on the housing is identified by the grounding symbol in accordance with IEC
60417 (symbol 5019).

For correct installation, obey the instructions for UL-compliant connection of the grounding conductor [} 127].

Functional grounding

In addition to the protective grounding, a functional grounding is required for proper operation of the PS6 drive system in
combination with SI6 and of the motor. The functional grounding of the PS6 drive system in combination with SI6 is
connected via the X10 terminal. The functional grounding of the motor is connected via terminals X20A and X20B. The
connections for the functional grounding to terminals X20A and X20B are marked with PE. For UL-compliant operation: The
connections marked with PE are intended solely for the functional grounding.

Motor overload protection/motor temperature protection

Use motor overload protection/motor temperature protection. The SI6 drive controller features connections for PTC
thermistors (NAT 145 °C, sensor voltage = 3.3 VDC, sensor current = max. 0.6 mA) at X2A/X2B, pins 7 and 8. The devices are
only intended for use with motors with integrated temperature protection. In accordance with UL certification, operation
without motor overload protection/motor temperature protection in or on the motor (X2 jumpers) is not permitted!

For a proper connection, follow the terminal description for X2A/X2B [} 141].

For EnDat 3 or HIPERFACE DSL encoders, the motor temperature is transmitted together with the encoder data over
connector X4A/X4B. Additional cabling at terminal X2A/X2B is not needed.
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Braking resistor

Use braking resistors with thermal monitoring and limit values described below:

Original text

Cat. No. Minimum resistance Maximum voltage Maximum wattage

PS6A24 22 ohm 680 VDC 27.2 kW

PS6A34 22 ohm 680 VDC 27.2 kW

PS6A44 9.5 ohm 680 VDC 27.2 kW

The temperature switch of the braking resistor must be connected to terminal X23 of the PS6 supply module.

If the temperature switch reports a braking resistor overload, the PS6 supply module must be disconnected from the power
supply using the Warning 1 relay at terminal X100.

Obey the wiring example for UL-compliant connection of the supply module [} 384].

Brake

Obey the technical data for the brake [} 74].

Digital inputs

For terminals X101 and X103, obey the technical data for the digital inputs [} 54].

Terminals

Note that the basic device is delivered without terminals. Suitable terminal sets are available separately for each size. An
order overview of the available terminal sets can be found in the appendix.

The terminals are labeled accordingly for correct connection. Observe the connection overviews and terminal descriptions
for the connection.

Power terminals

PS6A24, PS6A34: Use only copper conductors for a surrounding temperature of 60/75 °C.

PS6A44: Use only copper conductors for a surrounding temperature of 75 °C.

24 V supply and fuses

Low-voltage circuits must be supplied by an isolated source with a maximum output voltage that does not exceed 30 VDC.

Fuses for 24 VDC supplies must be approved for DC voltage in accordance with UL 248.

§ Protect the 24 VDC supply of the control unit with a 10 A fuse (time delay). Follow the terminal description for X11
[} 133], pin 1 or 2 (+).

§ Protect the 24 VDC supply for the brake with a 10 A fuse (time delay). Follow the terminal description for X300 [} 161],
pin 1 or 2 (+).

§ The following applies to the STO safety function via terminal X12 (option SR6): Protect the supply voltage of the status
signal with a 3.15 A fuse (time delay). Follow the terminal description for X12 [} 152], pin 8 (U1status).

UL test

Only the risks of electric shock and the risk of fire have been examined during UL acceptance. Functional safety aspects
have not been assessed during the UL approval process. These are assessed for STOBER by bodies such as the TÜV SÜD
certification service.
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6 System design
The multi-axis drive system consists of at least one PS6 supply module and one SI6 drive controller. To supply energy to the
drive controllers in the device group, you need suitable Quick DC-Link modules for the DC link connection for each supply
module and for each drive controller.

For the connection of the drive controllers to a higher-level controller, we recommend the EtherCAT fieldbus and an
application with a CiA 402 interface or, alternatively, the PROFINET fieldbus with the PROFIdrive application. You
commission the drive controllers using the DriveControlSuite software.

The drive controllers offer the STO safety function in accordance with EN 61800-5-2 as an option. For connection to a
higher-level safety circuit, different interfaces are available.

The following graphic explains the principle system design.
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Fig. 2: System overview for the multi-axis drive system with SI6 and PS6
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6.1 Hardware components
Below you will find an overview of the available hardware components.

6.1.1 Supply module
The PS6 supply module is available in three sizes.

6.1.1.1 Nameplate

The nameplate is placed on the side of the supply module.

Fig. 3: PS6A24 nameplate
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Designation Value in example Meaning

Type PS6A24 Production information

ID No. 56650

HW 003 HD

Date 2311 (year/calendar week)

S/N 9001304

Input voltage 3 × 400 VAC

UL: 3 × 480 VAC

Input voltage

Input current 25.0 A

UL: 23.0 A

3-phase

Input current

Number of phases

Output data 10 kW / 560 VDC

UL: 21.4 A / 680 VDC

DC link max. charging
capacity 5 mF

Output voltage and nominal power or nominal current

Maximum charging capacity

Protection class IP20 Protection class

Efficiency IE2 Energy efficiency class

ηN = Nominal efficiency

Tab. 6: Meaning of the specifications on the supply module nameplate

Information

UL and cUL-certified devices with corresponding test symbols meet the requirements of the standards UL 61800-5-1 and
CSA C22.2 No. 274.

6.1.1.2 Type designation

PS 6 A 2 4

Tab. 7: Example code for supply module type designation

Code Designation Design

PS Series

6 Generation Generation 6

A Version

2 – 4 Size

4 Power output stage

Tab. 8: Meaning of the example code
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6.1.1.3 Material variant

On the side of the supply module above the nameplate, there is another sticker with the material variant (MV) and serial
number (SN).

Fig. 4: Sticker with MV and serial number

Designation Value in example Meaning

MV MV0000012345 MV number

SN 6001192064 Serial number

— PS6A24 Device type according to type designation

— 1000914812/001100 Order number/order item

Tab. 9: Meaning of the specifications on the sticker

6.1.1.4 Sizes

Type ID No. Size

PS6A24 56650 Size 2

PS6A34 56651 Size 3

PS6A44 138679 Size 4

Tab. 10: Available PS6 types and sizes

PS6 in sizes 2 to 4

Note that the basic device is delivered without terminals. Suitable terminal sets are available separately for each size.
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Terminal set for supply module

(Fig. similar)

The following designs are available:

ID No. 138660
Terminal set for PS6A24. Contents: 6 terminals.

ID No. 138661
Terminal set for PS6A34. Contents: 6 terminals.

ID No. 5050112
Terminal set for PS6A44. Contents: 3 terminals.

6.1.2 Drive controllers
The SI6 drive controller is available in several sizes as a single or double-axis controller. Various safety options are also
available.

6.1.2.1 Nameplate

The nameplate is placed on the side of the drive controller.

Fig. 5: SI6A061 nameplate
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Designation Value in example Meaning

Type SI6A061 Production information

ID No. 56645

HW 027 HD

Date 2311 (year/calendar week)

S/N 9001302

Input voltage 560 VDC

UL: 680 VDC

Input voltage

Input current UL: 4.2 A Input current

Output data 0 to 460 VAC

0 to 700 Hz

@4 kHz: 5.0 A
@8 kHz: 4.5 A

3-phase

Output voltage

Output frequency

Output current for 4 kHz clock frequency
Output current for 8 kHz clock frequency

Number of phases

Protection class IP20 Protection class

Efficiency IE2 Energy efficiency class

ηN = 97.1% Nominal efficiency

Tab. 11: Meaning of the specifications on the drive controller nameplate

Information

UL and cUL-certified devices with corresponding test symbols meet the requirements of the standards UL 61800-5-1 and
CSA C22.2 No. 274.

6.1.2.2 Type designation

SI 6 A 0 6 1 Z

Tab. 12: Example code for drive controller type designation

Code Designation Design

SI Series

6 Generation Generation 6

A Version

0 – 3 Size

6 Power output stage Power output stage within the size

1
2

Axis controller Single-axis controller
Double-axis controller

Z
R
U
Y

Safety technology SZ6: Without safety technology
SR6: STO using terminals
SU6: STO and SS1 using PROFIsafe
SY6: STO and SS1 using FSoE

Tab. 13: Meaning of the example code
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6.1.2.3 Material variant

On the side of the drive controller above the nameplate, there is another sticker with the material variant (MV) and serial
number (SN).

Fig. 6: Sticker with MV and serial number

Designation Value in example Meaning

MV MV0000012345 MV number

SN 6001192064 Serial number

— SI6A061Z Device type according to type designation

— 1000914812/001100 Order number/order item

Tab. 14: Meaning of the specifications on the sticker

6.1.2.4 Sizes

Type ID No. Size Axis controller

SI6A061 56645 Size 0 Single-axis controller

SI6A062 56646 Size 0 Double-axis controller

SI6A161 56647 Size 1 Single-axis controller

SI6A162 56648 Size 1 Double-axis controller

SI6A261 56649 Size 2 Single-axis controller

SI6A262 56653 Size 2 Double-axis controller

SI6A361 56654 Size 3 Single-axis controller

Tab. 15: Available SI6 types and sizes

SI6 in sizes 0 to 3
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Note that the basic device is delivered without terminals. Suitable terminal sets are available separately for each size.

Terminal set for drive controllers ─ SZ6 option (without safety technology), SU6 option (STO and SS1 using
PROFIsafe) or SY6 option (STO and SS1 using FSoE)

(Fig. similar)

The following designs are available:

ID No. 138655
Terminal set for SI6A061Z/U/Y. Contents: 8 terminals.

ID No. 138656
Terminal set for SI6A062Z/U/Y. Contents: 11 terminals.

ID No. 138657
Terminal set for SI6A161Z/U/Y. Contents: 8 terminals.

ID No. 138658
Terminal set for SI6A162Z/U/Y. Contents: 11 terminals.

ID No. 138659
Terminal set for SI6A261Z/U/Y. Contents: 8 terminals.

ID No. 138662
Terminal set for SI6A262Z/U/Y. Contents: 11 terminals.

ID No. 138663
Terminal set for SI6A361Z/U/Y. Contents: 8 terminals.

Terminal set for drive controllers ─ SR6 option (STO via terminals)

(Fig. similar)

The following designs are available:

ID No. 138683
Terminal set for SI6A061R. Contents: 9 terminals.

ID No. 138684
Terminal set for SI6A062R. Contents: 12 terminals.

ID No. 138685
Terminal set for SI6A161R. Contents: 9 terminals.

ID No. 138686
Terminal set for SI6A162R. Contents: 12 terminals.

ID No. 138687
Terminal set for SI6A261R. Contents: 9 terminals.

ID No. 138688
Terminal set for SI6A262R. Contents: 12 terminals.

ID No. 138689
Terminal set for SI6A361R. Contents: 9 terminals.
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6.1.3 DC link connection
For the energy supply of the existing drive controllers in the group, you need suitable Quick DC-Link modules of type DL6B
for each PS6 supply module and each SI6 drive controller.

For the horizontal connection, you receive DL6B rear section modules in various designs, matched to the size of the drive
controller or supply module.

The quick fastening clamps for attaching the copper rails and an insulation connection piece are contained in the scope of
delivery. The copper rails are not included in the scope of delivery. These must have a cross-section of 5 x 12 mm. Insulation
end sections for the left and right termination of the device group as well as covers for the rear section modules are
available separately. The covers protect rear section modules installed in the control cabinet that are only later built over
with drive controllers or supply modules, for example as part of a retrofit.

Quick DC-Link DL6B – rear section module for drive controller

The following designs are available:

DL6B10 
ID No. 56655
Rear section module for size 0 drive controller:
SI6A061 and SI6A062

DL6B11 
ID No. 56656
Rear section module for size 1 or 2 (single-axis controller) drive controller:
SI6A161, SI6A162 and SI6A261

DL6B12 
ID No. 56663
Rear section module for size 2 (double-axis controller) or 3 drive controller:
SI6A262 and SI6A361

Quick DC-Link DL6B – rear section module for supply module

The following designs are available:

DL6B20 
ID No. 56657
Rear section module for size 2 supply module:
PS6A24

DL6B21 
ID No. 56658
Rear section module for size 3 supply module:
PS6A34

DL6B22 
ID No. 5050114
Rear section module for size 4 supply module:
PS6A44
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Quick DC-Link DL6B – insulation end section

ID No. 56659
Insulation end sections for the left and right termination of the group, 2 pcs.

Quick DC-Link DL6B – cover

The following designs are available:

QDL6C10 
ID No. 5050128
Cover for DL6B10 or DL6B20 rear section module,
Dimensions: 373 × 45 × 1 mm

QDL6C11 
ID No. 5050129
Cover for DL6B11 or DL6B21 rear section module,
Dimensions: 373 × 64 × 1 mm

QDL6C12 
ID No. 5050130
Cover for DL6B12 rear section module,
Dimensions: 373 × 105 × 1 mm
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6.1.4 Operating motors, encoders and brakes
You can use the SI6 drive controller to operate Lean motors of the LM series, synchronous servo motors (such as those of
the EZ series), asynchronous motors, linear motors or torque motors.

Evaluation options for feedback are available on the X4 connection for the following encoders:

§ EnDat 2.1/2.2 digital encoders

§ SSI encoders

§ Differential TTL and differential HTL incremental encoders (HTL via HT6 adapter)

§ Resolver

§ EnDat 3 or HIPERFACE DSL encoder (with One Cable Solution design)

In addition, evaluation options for the following encoders are available on the X101 and X103 connection:

§ Single-ended HTL incremental encoders

§ Single-ended HTL pulse/direction interface

All device types of the SI6 drive controller have connections for PTC thermistors and can control a 24 VDC brake as standard.
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6.1.5 Accessories
You can find information about the available accessories in the following chapters.

6.1.5.1 Safety technology

The safety modules are used to realize the STO safety function. They prevent the generation of a rotating magnetic field in
the power unit of the drive controller. For an external requirement or in the event of error, the safety module switches the
drive controller to the STO state. Different human-machine interfaces and additional safety functions are available
depending on the selected design of the accessories.

For double-axis controllers, the STO safety function has a two-channel structure that acts upon both axes.

Information

The drive controller is delivered in the standard design without safety technology (option SZ6). If you want a drive
controller with integrated safety technology, you must order it together with the drive controller. The safety modules are
an integrated part of the drive controllers and must not be modified.

SZ6 option – Without safety technology

ID No. 56660
Design without safety technology.

SR6 safety module – STO using terminals

ID No. 56661
Optional accessory for the use of the Safe Torque Off safety function (STO) in safety-
relevant applications (PL e, SIL 3) in accordance with EN ISO 13849-1 and 
EN 61800-5-2. Connection to a higher-level safety circuit via terminal X12.

SY6 safety module – STO and SS1 using FSoE

ID No. 56662
Optional accessory for the use of the Safe Torque Off (STO) and Safe Stop 1 (SS1)
safety functions in safety-relevant applications (PL e, SIL 3) in accordance with 
EN ISO 13849-1 and EN 61800-5-2. Connection to the higher-level safety circuit using
Fail Safe over EtherCAT (FSoE).

SU6 safety module – STO and SS1 using PROFIsafe

ID No. 56696
Optional accessory for the use of the Safe Torque Off (STO) and Safe Stop 1 (SS1)
safety functions in safety-relevant applications (PL e, SIL 3) in accordance with 
EN ISO 13849-1 and EN 61800-5-2. Connection to a higher-level safety circuit via
PROFINET (PROFIsafe).

For detailed information about using the safety technology, refer to the corresponding manual (see Detailed information
[} 429]).



6 | System design STOBER

42

02
/2

02
4 

| 
ID

 4
42

72
8.

12

6.1.5.2 Communication

The drive controller has two interfaces for the EtherCAT or PROFINET connection on the top of the device as well as an
Ethernet service interface on the front of the device. Cables for the connection are available separately.

EtherCAT or PROFINET

Please specify the desired fieldbus system when placing your order for the base
device, since the fieldbus communication is defined using the firmware.

EtherCAT cables

Ethernet patch cable, CAT5e, yellow.

The following designs are available:

ID No. 49313: Length approx. 0.25 m. 
ID No. 49314: Length approx. 0.5 m.

PC connecting cable

ID No. 49857
Cable for connecting the X9 service interface to the PC, CAT5e, blue, length: 5 m.

USB 2.0 Ethernet adapter

ID No. 49940
Adapter for connecting Ethernet to a USB port.

For detailed information about the fieldbus connection, refer to the corresponding manual (see Detailed information
[} 429]).

6.1.5.3 Braking resistor

STOBER offers braking resistors in different sizes and performance classes.

For more detailed information on this, refer to the technical data (see Braking resistor [} 75]).

6.1.5.4 Choke

STOBER offers various chokes corresponding to your application.

For more detailed information, refer to the technical data (see Choke [} 82]).
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6.1.5.5 Encoder battery module

Absolute Encoder Support AES

ID No. 55452
Battery module for buffering the supply voltage when using the EnDat 2.2 digital
inductive encoder with battery-buffered multi-turn stage, for example EBI1135 or
EBI135.
A battery is included.

Information

Note that a 15-pin extension cable between the socket and the AES may be necessary for the connection to the drive
controller due to limited space.

▪ A commercially available shielded extension cable with a 15-pin D-sub connector and a length of ≤ 1 m can be used
between the socket and the AES.

AES replacement battery

ID No. 55453
Replacement battery for AES battery module.

6.1.5.6 HTL-to-TTL adapter

HT6 HTL-to-TTL adapter

ID No. 56665
Adapters for SC6 and SI6 series drive controllers for level conversion from HTL
signals to TTL signals.
It is used to connect an HTL differential incremental encoder to terminal X4 of the
drive controller.
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6.1.5.7 Interface adapters

AP6 interface adapters

The following variants are available:

AP6A00
ID No. 56498
Adapter X4 resolver, 9/15-pin.
Adapter for connecting resolver cables with a 9-pin D-sub connector to the X4
encoder interface of the drive controller.

AP6A01
ID No. 56522
Adapter X4 resolver, 9/15-pin with cores of the motor temperature sensor led out at
the side (core length: approx. 11 cm).
Adapter for connecting resolver cables with a 9-pin D-sub connector to the X4
encoder interface of the drive controller.

6.2 Software components
Various software components are available for commissioning your drive system and implementing your application.

6.2.1 Project configuration and parameterization
For project configuration and parameterization, the drive controller can be addressed using the DriveControlSuite
commissioning software (DS6). The program guides you step by step through the complete project configuration and
parameterization process using wizards.

6.2.2 Applications
A controller-based application is recommended for the central motion control of complex machines.

With the controller-based operating modes of the CiA 402 application (csp, csv, cst, ip) or the controller-based application
class of the PROFIdrive application (AC4), you can implement applications with synchronized, cyclic set value specification
by a motion controller. In addition, the drive controllers can also independently handle motion tasks, such as referencing
and jogging during commissioning.

Drive-based Drive Based and Drive Based Synchronous applications, drive-based operating modes of the CiA 402 application
(pp, vl, pv, pt) and drive-based application classes of the PROFIdrive application (AC1, AC3) are also available.

Furthermore, programming based on IEC 61131-3 with CFC can be used to create new applications or expand existing ones.

For detailed information about the available applications, refer to he corresponding manual (see Detailed information
[} 429]).
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7 Technical data
Technical data for the drive controllers, supply modules and accessories can be found in the following chapters.

7.1 General technical data
The following specifications apply equally to the SI6 drive controller and the PS6 supply module.

Device features

Protection class of the device IP20

Protection class of the installation space At least IP54

Protection class Protection class I in accordance with EN 61140

Radio interference suppression Integrated line filter in accordance with EN 61800-3, interference emission
class C3

Overvoltage category III in accordance with EN 61800-5-1

Marks and test symbols CE, cULus, RoHS

Tab. 16: Device features

Transport and storage conditions

Storage/
transport temperature

−20 °C to +70 °C
Maximum change: 20 K/h

Relative humidity Maximum relative humidity 85%, non-condensing

Vibration (transport) in accordance with
EN 60068-2-6

5 Hz ≤ f ≤ 9 Hz: 3.5 mm 
9 Hz ≤ f ≤ 200 Hz: 10 m/s²
200 Hz ≤ f ≤ 500 Hz: 15 m/s²

Fall height for freefall1

Weight < 100 kg
in accordance with EN 61800-2
(or IEC 60721-3-2, class 2M4)

0.25 m

Tab. 17: Transport and storage conditions

Operating conditions

Surrounding temperature during
operation

0 °C to 45 °C with nominal data
45 °C to 55 °C with derating −2.5% / K

Relative humidity Maximum relative humidity 85%, non-condensing

Installation altitude 0 m to 1000 m above sea level without restrictions
1000 m to 2000 m above sea level with −1.5%/100 m derating

Pollution degree Pollution degree 2 in accordance with EN 50178

Ventilation Installed fan

Vibration (operation) in accordance with
EN 60068-2-6

5 Hz ≤ f ≤ 9 Hz: 0.35 mm 
9 Hz ≤ f ≤ 200 Hz: 1 m/s²

Tab. 18: Operating conditions

Discharge times

Self-discharge of DC link 15 min

Fast discharge of DC link Thanks to PS6 supply module in combination with a braking resistor:
< 1 min

Tab. 19: Discharge times of the DC link circuit

1 Only valid for components in original packaging
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7.2 Supply module
The following section contains specifications for the electrical data, dimensions and weight of the PS6 supply module.

7.2.1 Electrical data
The electrical data of the available PS6 sizes as well as the properties of the brake chopper can be found in the following
sections.

Information

For cyclic power-on/power-off operation, the following is to be observed to prevent the charging capacities of the supply
modules from being exceeded:

▪ PS6 without braking resistor: Direct, repeat activation of the supply voltage possible.

▪ PS6 with braking resistor and an interval < 20 s after power-off (fast discharge inactive): Direct, repeat activation of
the supply voltage possible.

▪ PS6 with braking resistor and an interval > 20 s after power-off (fast discharge active): Reactivation of the supply
voltage only possible 2 min after previous activation!

Information

The STO safety function is available for safe stopping as an alternative to continuous, cyclical power-on/power-off
operation.

For an explanation of the formula symbols used, see Symbols in formulas [} 430].

7.2.1.1 Control unit

Electrical data All types

U1CU 24 VDC, +20%/−15%

I1maxCU 1.5 A

Tab. 20: Control unit electrical data

7.2.1.2 Power unit: Size 2

Electrical data PS6A24

U1PU 3 × 400 VAC, +32%/−50%, 50/60 Hz; 
3 × 480 VAC, +10%/−58%, 50/60 Hz

U2PU,ZK √2 × U1PU

P2N,PU 10 kW

I1N,PU 25 A

I1maxPU I1N,PU × 180% for 5 s;
I1N,PU × 150% for 30 s

CN,PU 5000 µF

Tab. 21: PS6 electrical data, size 2



STOBER 7 | Technical data
02

/2
02

4 
| 

ID
 4

42
72

8.
12

47

7.2.1.3 Power unit: Size 3

Electrical data PS6A34

U1PU 3 × 400 VAC, +32%/−50%, 50/60 Hz; 
3 × 480 VAC, +10%/−58%, 50/60 Hz

U2PU,ZK √2 × U1PU

P2N,PU 20 kW

I1N,PU 50 A

I1maxPU I1N,PU × 180% for 5 s;
I1N,PU × 150% for 30 s

CN,PU 10000 µF

Tab. 22: PS6 electrical data, size 3

7.2.1.4 Power unit: Size 4

Electrical data PS6A44

U1PU 3 × 400 VAC, +32%/−50%, 50/60 Hz; 
3 × 480 VAC, +10%/−58%, 50/60 Hz

U2PU,ZK √2 × U1PU

P2N,PU 50 kW

I1N,PU 92 A

I1maxPU I1N,PU × 180% for 5 s;
I1N,PU × 150% for 30 s

CN,PU 20000 µF

Tab. 23: PS6 electrical data, size 4

7.2.1.5 Parallel connection

Only supply modules of either size 2 or 3 may be connected in parallel.

The power and current increase if supply modules are connected in parallel. Take into account that the total is derated by a
factor of 0.8 in doing so.

The charging capacity of the supply modules can be increased by a parallel connection only if the power supply is connected
to all supply modules simultaneously. Increasing the charging capacity also requires derating the total by a factor of 0.8.

The following table shows example combinations for parallel connection.

Electrical data 2 x PS6A24 3 x PS6A24 2 x PS6A34 3 x PS6A34

P2N,PU 16 kW 24 kW 32 kW 48 kW

I1N,PU 40 A 60 A 80 A 120 A

CmaxPU 8000 µF 12000 µF 16000 µF 24000 µF

Tab. 24: Electrical data for parallel connection: Example combinations

For the parallel connection of supply modules, obey the information on the general conditions (see General conditions for
parallel connection [} 87]).
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7.2.1.6 Brake chopper

Electrical data PS6A24 PS6A34

UonCH 780 – 800 VDC

UoffCH 740 – 760 VDC

R2minRB 22 Ω

PmaxRB 29.1 kW

PeffRB 27.2 kW

Tab. 25: Brake chopper electrical data, sizes 2 and 3

Electrical data PS6A44

UonCH 780 – 800 VDC

UoffCH 740 – 760 VDC

R2minRB 9.5 Ω

PmaxRB 67.3 kW

PeffRB 62.9 kW

Tab. 26: Brake chopper electrical data, size 4

Information

Use braking resistors with thermal monitoring (see Braking resistor [} 75]).

7.2.1.7 Fast discharge

Fast discharge is activated when no supply voltage is present for 20 s and the DC link voltage has reduced over this time. For
active fast discharge, the DC link is discharged via the brake chopper and the braking resistor. Fast discharge does not take
place for constant or increasing DC link voltage as this behavior indicates a second supply module in the DC link group. If the
temperature sensor of the braking resistor is active, the fast discharge also remains off.

7.2.1.8 Status output

The relay status output of terminal X100 in conjunction with the 3 diagnostic LEDs on the front of the device provides
information about the status of the supply module.

Electrical data Relay

U2max 30 VDC

I2max 2.0 A

Expected service life Mechanical min. 100000000 switch.;
at 30 VDC/2 A (ohm. load): 100000 switch.

Tab. 27: X100 electrical data – Status output
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7.2.2 Dimensions

W D 

H1H3

H2

A
B

Fig. 7: PS6A24, PS6A34 dimensional drawing

D

H1H3

H2

CG G

W

A
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Fig. 8: PS6A44 dimensional drawing
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Dimension PS6A24 PS6A34 PS6A44

Supply module Width W 45 65 158

Depth D 204 219 156.5

Body height H1 343 378

Fastening clip height H2 15

Height incl.
fastening clips

H3 373 408

Fastening holes (M5) Vertical distance A 360+2 396+2

Vertical distance to the upper edge B 5

Horizontal spacing of the fastening
holes

C — 82

Horizontal distance to the side
edge

G — 38

Tab. 28: PS6 dimensions [mm]

7.2.3 Weight

Type Weight without packaging [g] Weight with packaging [g]

PS6A24 2680 4180

PS6A34 3820 4920

PS6A44 6640 7640

Tab. 29: PS6 weight [g]
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7.3 Drive controllers
The following chapters contain specifications for the electrical data, dimensions and weight of the drive controller.

7.3.1 Electrical data
The electrical data of the available SI6 sizes can be found in the following sections.

For an explanation of the formula symbols used, see Symbols in formulas [} 430].

7.3.1.1 Control unit

Electrical data All types

U1CU 24 VDC, +20%/−15%

I1maxCU 1.5 A

Tab. 30: Control unit electrical data

7.3.1.2 Power unit: Size 0

Electrical data SI6A061 SI6A062

U1PU 280 – 800 VDC

f2PU 0 – 700 Hz

U2PU 0 – max.

CPU 180 µF 270 µF

Tab. 31: SI6 electrical data, size 0

Nominal currents up to +45 °C (in the control cabinet)

Electrical data SI6A061 SI6A062

fPWM,PU 4 kHz

I2N,PU 5 A 2 × 5 A

I2maxPU 210% for 2 s; 150% for 30 s

Tab. 32: SI6 electrical data, size 0, for 4 kHz clock frequency

Electrical data SI6A061 SI6A062

fPWM,PU 8 kHz

I2N,PU 4.5 A 2 × 4.5 A

I2maxPU 250% for 2 s; 200% for 5 s

Tab. 33: SI6 electrical data, size 0, for 8 kHz clock frequency
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7.3.1.3 Power unit: Size 1

Electrical data SI6A161 SI6A162

U1PU 280 – 800 VDC

f2PU 0 – 700 Hz

U2PU 0 – max.

CPU 470 µF 940 µF

Tab. 34: SI6 electrical data, size 1

Nominal currents up to +45 °C (in the control cabinet)

Electrical data SI6A161 SI6A162

fPWM,PU 4 kHz

I2N,PU 12 A 2 × 12 A

I2maxPU 210% for 2 s; 150% for 30 s

Tab. 35: SI6 electrical data, size 1, for 4 kHz clock frequency

Electrical data SI6A161 SI6A162

fPWM,PU 8 kHz

I2N,PU 10 A 2 × 10 A

I2maxPU 250% for 2 s; 200% for 5 s

Tab. 36: SI6 electrical data, size 1, for 8 kHz clock frequency

7.3.1.4 Power unit: Size 2

Electrical data SI6A261 SI6A262

U1PU 280 – 800 VDC

f2PU 0 – 700 Hz

U2PU 0 – max.

CPU 940 µF 2250 µF

Tab. 37: SI6 electrical data, size 2

Nominal currents up to +45 °C (in the control cabinet)

Electrical data SI6A261 SI6A262

fPWM,PU 4 kHz

I2N,PU 22 A 2 × 25 A

I2maxPU 210% for 2 s; 150% for 30 s

Tab. 38: SI6 electrical data, size 2, for 4 kHz clock frequency

Electrical data SI6A261 SI6A262

fPWM,PU 8 kHz

I2N,PU 20 A 2 × 20 A

I2maxPU 250% for 2 s; 200% for 5 s

Tab. 39: SI6 electrical data, size 2, for 8 kHz clock frequency



STOBER 7 | Technical data
02

/2
02

4 
| 

ID
 4

42
72

8.
12

53

7.3.1.5 Power unit: Size 3

Electrical data SI6A361

U1PU 280 – 800 VDC

f2PU 0 – 700 Hz

U2PU 0 – max.

CPU 2250 µF

Tab. 40: SI6 electrical data, size 3

Nominal currents up to +45 °C (in the control cabinet)

Electrical data SI6A361

fPWM,PU 4 kHz

I2N,PU 50 A

I2maxPU 210% for 2 s; 150% for 30 s

Tab. 41: SI6 electrical data, size 3, for 4 kHz clock frequency

Electrical data SI6A361

fPWM,PU 8 kHz

I2N,PU 40 A

I2maxPU 250% for 2 s; 200% for 5 s

Tab. 42: SI6 electrical data, size 3, for 8 kHz clock frequency
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7.3.1.6 Digital inputs

Feature Value

Internal device update rate Cycle time for the application parameterized in A150; tmin = 250 µs; also applicable to
digital inputs DI3 and DI4 as well as DI8 and DI9: with timestamp correction in an
accuracy range of 1 µs

Max. cable length 30 m

Tab. 43: Technical data – Inputs and outputs

X101 – Digital inputs

The inputs are suitable for the connection of PELV voltage in accordance with EN 60204-1.

Electrical data Digital input Value

Low level DI1 – DI4 0 – 8 VDC

High level 12 – 30 VDC

U1max 30 VDC

I1max 16 mA

f1max DI1 – DI2 10 kHz

DI3 – DI4 250 kHz

Tab. 44: X101 electrical data – Digital inputs

X103 – Digital inputs

The inputs are suitable for the connection of PELV voltage in accordance with EN 60204-1.

Electrical data Digital input Value

Low level DI6 – DI9 0 – 8 VDC

High level 12 – 30 VDC

U1max 30 VDC

I1max 16 mA

f1max DI6 – DI7 10 kHz

DI8 – DI9 250 kHz

Tab. 45: X103 electrical data – Digital inputs
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7.3.1.7 Single-ended nominal power consumption on double-axis controllers

Operating two motors on one double-axis controller makes it possible to operate one of the motors with a continuous
current above the nominal current of the drive controller if the continuous current of the second connected motor is lower
than the nominal current of the drive controller. This enables economical combinations of double-axis controllers and
motors.

The nominal output current for axis B can be determined using the following formula if the output current for axis A is
known:

Example 1

( )2PU(B) 2N,PU 2PU(A) 2N,PU
3I I I I
5

= - - ´
where

2PU(A) 2N,PU0 I I£ £

Example 2

( )2PU(B) 2N,PU 2PU(A) 2N,PU
5I I I I
3

= - - ´
where

2N,PU 2PU(A) 2N,PUI I 1,6 I£ £ ´

1

2

I2PU(B)

I2PU(A)

I2N,PU 160 %

I2N,PU

160 %

Fig. 9: Asymmetric load on double-axis controllers

Information

Note that the available maximum currents I2maxPU of the axis controllers are also relative to the nominal output current I2N,PU

for single-ended nominal power consumption.
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7.3.1.8 Power loss data in accordance with EN 61800-9-2

Type Nominal
current

I2N,PU

Apparent
power

Absolute
losses 
PV,CU

2

Operating points3 IE
class4

Comparison5

(0/25) (0/50) (0/100) (50/25) (50/50) (50/100) (90/50) (90/100)

Relative losses

[A] [kVA] [W] [%]

SI6A06x 5 3.5 Max. 10 0.71 0.86 1.33 0.76 0.97 1.61 1.13 2.13 IE2

SI6A16x 12 8.3 Max. 10 0.55 0.71 1.19 0.59 0.80 1.44 0.94 1.87 IE2

SI6A261 22 16.6 Max. 10 0.55 0.71 1.19 0.59 0.80 1.44 0.94 1.87 IE2

SI6A262 25 17.3 Max. 10 0.45 0.62 1.12 0.50 0.74 1.47 0.95 2.12 IE2

SI6A361 50 34.6 Max. 10 0.45 0.62 1.12 0.50 0.74 1.47 0.95 2.12 IE2

Absolute losses PV

[A] [kVA] [W] [W] [%]

SI6A06x 5 3.5 Max. 10 25 30.2 46.5 26.5 33.8 56.5 39.5 74.4 IE2 24.9

SI6A16x 12 8.3 Max. 10 45.7 58.7 98.7 49.1 66.3 119.6 78.1 155.4 IE2 26.7

SI6A261 22 16.6 Max. 10 91.5 117.4 197.3 98.2 132.6 239.2 156.2 310.8 IE2 30.8

SI6A262 25 17.3 Max. 10 77.9 106.5 193.0 87.1 127.9 254.3 163.8 367.6 IE2 36.4

SI6A361 50 34.6 Max. 10 155.8 213.1 386.0 174.3 255.8 508.6 327.6 735.2 IE2 39.5

Tab. 46: Power loss data in accordance with EN 61800-9-2 for one axis of a SI6 drive controller

2 Absolute losses for a power unit that is switched off
3 Operating points for relative motor stator frequency in % and relative torque current in %
4 IE class in accordance with EN 61800-9-2
5 Comparison of the losses for the reference related to IE2 in the nominal point (90, 100)
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General conditions

The specified losses apply to an axis of a drive controller and take into account the proportionate losses of the PS6 supply module for that axis.

For a group with a total of x axes, the values are to be multiplied by the number of axis controllers (x), e.g. x = 4 for 1 × PS6 and 2 × SI6A062.

The loss data applies to drive controllers without any accessories.

The power loss calculation is based on a three-phase supply voltage with 400 VAC/50 Hz.

The calculated data includes a supplement of 10% in accordance with EN 61800-9-2.

The power loss specifications refer to a clock frequency of 4 kHz.

The absolute losses for a power unit that is switched off refer to the 24 VDC power supply of the control electronics.
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7.3.1.9 Power loss data of accessories

If you intend to order the drive controller with accessory parts, losses increase as follows.

Type Absolute losses
PV [W]

SR6 safety module 1

SY6 or SU6 safety module 2

Tab. 47: Absolute losses of the accessories

Information

Note the absolute power loss of the encoder (usually < 3 W) and of the brake when designing as well.

Loss specifications for other optional accessories can be found in the technical data of the respective accessory part.

7.3.2 Cycle times
Possible cycle times can be found in the following table.

Type Cycle times Relevant parameters

Application 250 µs, 500 µs, 1 ms, 2 ms, 4 ms, 8 ms Adjustable in A150

EtherCAT fieldbus, cyclical
communication

250 µs, 500 µs, 1 ms, 2 ms, 4 ms, 8 ms Adjustable in A150

PROFINET RT fieldbus, cyclical
communication

1 ms, 2 ms, 4 ms, 8 ms Adjustable in A150

PROFINET IRT fieldbus, cyclical
communication

1 ms, 2 ms, 4 ms Adjustable in A150

Motion core (movement calculation) 250 µs —

Control cascade 62.5 µs B24 ≥ 8 kHz and B20 = 48, 64, or 70

125 µs B24 = 4 kHz

Tab. 48: Cycle times

Information

For Lean motors (control mode B20 = 32: LM - sensorless vector control), only operation at 4 kHz is permitted.
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7.3.3 Derating
When dimensioning the drive controller, observe the derating of the nominal output current as a function of the clock
frequency, surrounding temperature and installation altitude. There is no restriction for a surrounding temperature from
0 °C to 45 °C and an installation altitude of 0 m to 1000 m. The details given below apply to values outside these ranges.

7.3.3.1 Effect of the clock frequency

Changing the clock frequency fPWM affects the amount of noise produced by the drive, among other things. However,
increasing the clock frequency results in increased losses. During project configuration, define the highest clock frequency
and use it to determine the nominal output current I2N,PU for dimensioning the drive controller.

Type I2N,PU

4 kHz [A]
I2N,PU

8 kHz [A]
I2N,PU

16 kHz [A]

SI6A061 5 4.5 3.5

SI6A062 2 × 5 2 × 4.5 2 × 3.5

SI6A161 12 10 6

SI6A162 2 × 12 2 × 10 2 × 6

SI6A261 22 20 10

SI6A262 2 × 25 2 × 20 2 × 10

SI6A361 50 40 —

Tab. 49: Nominal output current I2N,PU dependent on the clock frequency

Information

Select the defined clock frequency using parameter B24. The clock frequency for double-axis controllers always applies to
both axis controllers.

7.3.3.2 Effect of the surrounding temperature

Derating as a function of the surrounding temperature is determined as follows:

§ 0 °C to 45 °C: No restrictions (DT = 100%)

§ 45 °C to 55 °C: Derating −2.5%/K

Example

The drive controller needs to be operated at 50 °C.

The derating factor DT is calculated as follows
DT= 100% − 5 × 2.5% = 87.5%
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7.3.3.3 Effect of the installation altitude

Derating as a function of the installation altitude is determined as follows:

§ 0 m to 1000 m: No restriction (DIA = 100%)

§ 1000 m to 2000 m: Derating −1.5%/100 m

Example

The drive controller needs to be installed at an altitude of 1500 m above sea level.

The derating factor DIA is calculated as follows:
DIA = 100% − 5 × 1.5% = 92.5%

7.3.3.4 Calculating the derating

Follow these steps for the calculation:

1. Determine the highest clock frequency (fPWM) that will be used during operation and use it to determine the nominal
current I2N,PU.

2. Determine the derating factors for installation altitude and surrounding temperature.

3. Calculate the reduced nominal current I2N,PU(red) in accordance with the following formula:
I2N,PU(red) = I2N,PU × DT × DIA

Example

A drive controller of type SI6A061 needs to be operated at a clock frequency of 8 kHz at an altitude of 1500 m above sea
level and a surrounding temperature of 50 °C.

The nominal current of the SI6A061 at 8 kHz is 4.5 A. The derating factor DT is calculated as follows: 
DT = 100% − 5 × 2.5% = 87.5%

The derating factor DIA is calculated as follows: 
DIA = 100% − 5 × 1.5% = 92.5%

The output current of importance for the project configuration is: 
I2N,PU(red) = 4.5 A × 0.875 × 0.925 = 3.64 A
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7.3.4 Dimensions

CG G
B

W

W

B

H4 H3 H1A

H2
 

A
D

Fig. 10: SI6 dimensional drawing

Dimension SI6A061
SI6A062

SI6A161
SI6A162

SI6A261 SI6A262 SI6A361

Drive controllers Width W 45 65 105

Depth D 265 286

Body height H1 343

Fastening clip height H2 15

Height incl.
fastening clips

H3 373

Total height incl.
shield connection

H4 423

Fastening holes (M5) Vertical distance A 360+2

Vertical distance to the
upper edge

B 5

Horizontal spacing of the
fastening holes

C — 45

Horizontal distance to
the side edge

G — 30

Tab. 50: SI6 dimensions [mm]
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7.3.5 Weight

Type Weight without packaging [g] Weight with packaging [g]

SI6A061 2980 4600

SI6A062 3460 5060

SI6A161 3880 5260

SI6A162 4820 6240

SI6A261 4760 6200

SI6A262 6240 7420

SI6A361 6180 7360

Tab. 51: SI6 weight [g]
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7.4 DC link connection
The following chapters contain the technical data of the DL6B Quick DC-Link modules.

7.4.1 General technical data
The following information applies to all Quick DC-Link modules and corresponds to the general technical data for the base
device.

Device features

Protection class of the device IP20 (if built over with drive controller or supply module)

Protection class Protection class I in accordance with EN 61140 (if built over with drive
controller or supply module)

Protection class of the installation space At least IP54

Tab. 52: Device features

Transport and storage conditions

Storage/
transport temperature

−20 °C to +70 °C
Maximum change: 20 K/h

Relative humidity Maximum relative humidity 85%, non-condensing

Vibration (transport) in accordance with
EN 60068-2-6

5 Hz ≤ f ≤ 9 Hz: 3.5 mm 
9 Hz ≤ f ≤ 200 Hz: 10 m/s²
200 Hz ≤ f ≤ 500 Hz: 15 m/s²

Fall height for freefall6

Weight < 100 kg
in accordance with EN 61800-2
(or IEC 60721-3-2, class 2M4)

0.25 m

Tab. 53: Transport and storage conditions

Operating conditions

Surrounding temperature during
operation

0 °C to 45 °C with nominal data
45 °C to 55 °C with derating −2.5% / K

Relative humidity Maximum relative humidity 85%, non-condensing

Installation altitude 0 m to 1000 m above sea level without restrictions
1000 m to 2000 m above sea level with −1.5%/100 m derating

Pollution degree Pollution degree 2 in accordance with EN 50178

Vibration (operation) in accordance with
EN 60068-2-6

5 Hz ≤ f ≤ 9 Hz: 0.35 mm 
9 Hz ≤ f ≤ 200 Hz: 1 m/s²

Tab. 54: Operating conditions

6 Only valid for components in original packaging
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7.4.2 assignment to DL6B – SI6 and PS6
DL6B is available in the following designs suitable for the individual drive controller types and supply module types:

Type DL6B10 DL6B11 DL6B12 DL6B20 DL6B21 DL6B22

ID No. 56655 56656 56663 56657 56658 5050114

SI6A061 X — — — — —

SI6A062 X — — — — —

SI6A161 — X — — — —

SI6A162 — X — — — —

SI6A261 — X — — — —

SI6A262 — — X — — —

SI6A361 — — X — — —

PS6A24 — — — X — —

PS6A34 — — — — X —

PS6A44 — — — — — X

Tab. 55: DL6B assignment to SI6 and PS6

7.4.3 Dimensions

G C GW

D2

B2 B1 D1

H2
H1H3A1A2A1A2

B2 B1

W

Fig. 11: Dimensional drawing of DL6B10 to DL6B21
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G C G

D2

B2 B1 D1

H2
H1H3A1A2

W

Fig. 12: DL6B22 dimensional drawing

Dimension DL6B10
DL6B20

DL6B11
DL6B21

DL6B12 DL6B22

Quick DC-Link Width W 45 65 105 158

Depth D1 35

Depth incl.
attachment bolts

D2 49

Height H1 375 410.5

Fastening clip height H2 15

Height incl.
fastening clips

H3 405 440.5

Fastening holes Vertical distance
(wall mounting)

A1 393+2 429+2

Vertical distance
(module mounting)

A2 360 396

Vertical distance to the upper edge B1 4.5

Vertical distance to the upper edge B2 22

Horizontal spacing of the fastening holes C — 45 82

Horizontal distance to the side edge G — 30 38

Tab. 56: DL6B dimensions [mm]
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7.4.4 Weight

Type Weight without packaging [g] Weight with packaging [g]

DL6B10 440 480

DL6B11 560 600

DL6B12 880 920

DL6B20 480 520

DL6B21 740 780

DL6B22 1400 1440

Tab. 57: DL6B weight [g]

7.4.5 Copper rails
For the DC link connection of the Quick DC-Link modules of type DL6B, you need three copper rails with a cross-section of 5
× 12 mm in the correct length. The copper rails must comply with the requirements in accordance with either EN 12167 or
EN 13601. The required length depends on the total width of the device group (see Length of copper rails [} 110]).

7.5 SR6 safety module
The SR6 option adds the STO safety function to the SI6 drive controller via terminal X12.

For double-axis controllers, the STO safety function has a two-channel structure that acts upon both axes.

Information

If you would like to use the STO safety function via terminals, be sure to read the manual for the SR6 safety module.

Digital input Electrical data

STOa U1max = 30 VDC (PELV)
High level = 15 – 30 VDC

Low level = 0 – 8 VDC

I1max = 100 mA
I1N = 10 – 15 mA per channel
C1max = 10 nF

STOb

STOstatus U2 = U1 − (1.5 Ω * I1)

STOstatus supply U1 = +24 VDC, +20%/25% 
I1max = 100 mA

GND —

Tab. 58: X12 electrical data – Digital inputs
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7.6 Operating motors
The drive controller supports rotational motors with a number of motor poles from 2 to 120 poles (1 through 60 pole pairs),
as well as linear motors with pole pitches from 1 to 500 mm.

When selecting the motor, consider the technical data of the drive controller (output voltage range and clock frequency).

You can operate the following motors with the specified control modes.

Motor type B20 Control mode Encoders Other settings Characteristics

Lean motor 32: LM - sensorless
vector control

No encoder required — Dynamics, high speed accuracy,
constant speed, overcurrent
protection

Synchronous
servo motor,
torque motor

64: SSM - vector
control

Absolute encoder
required: EnDat
2.1/2.2 digital, SSI,
resolver, EnDat 3 or
HIPERFACE DSL
encoders

Without field weakening
(B91 Field weakening = 
0: Inactive)

High dynamics, high speed
accuracy, very constant speed,
high overcurrent protection

With field weakening (B91
Field weakening = 
1: Active)

High dynamics, high speed
accuracy, very constant speed,
high overcurrent protection,
greater speed range, but also
higher current requirement

48: SSM-vector
control incremental
encoder

Incremental encoder
required

Without field weakening
(B91 Field weakening = 
0: Inactive)

High dynamics, high speed
accuracy, very constant speed,
high overcurrent protection

With field weakening (B91
Field weakening = 
1: Active)

High dynamics, high speed
accuracy, very constant speed,
high overcurrent protection,
greater speed range, but also
higher current requirement

Synchronous
linear motor

70: SLM - vector
control

Linear encoder and
commutation
information required

— High dynamics, high
overcurrent protection

Asynchronous
motor

2: ASM - vector
control

Encoder required — High dynamics, high speed
accuracy, very constant speed,
high overcurrent protection

3: ASM - sensorless
vector control

No encoder required — Dynamics, speed accuracy,
constant speed, overcurrent
protection

1: ASM - V/f-slip
compensated

Linear characteristic curve
(B21 V/f-characteristic = 
0: Linear)

Very constant speed

Quadratic characteristic
curve (B21 V/f-
characteristic = 1: Square)

Very constant speed, especially
suitable for fan applications

0: ASM - V/f-control Linear characteristic curve
(B21 V/f-characteristic = 
0: Linear)

Very constant speed

Quadratic characteristic
curve (B21 V/f-
characteristic = 1: Square)

Very constant speed, especially
suitable for fan applications

Tab. 59: Motor types and control modes

Unsuitable drive controller/motor combinations

Lean motors of size 5 and 7 cannot be operated on drive controllers of size 0 (type SI6A061 or SI6A062). The LM706 Lean
motor also cannot be operated on drive controllers of size 1 (type SI6A161 or SI6A162).
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7.7 Evaluable encoders
The technical data of the evaluable encoder can be found in the following chapters.

7.7.1 Overview
The following table explains which connections are available for the various encoders.

ATTENTION!

Risk of encoder destruction!

The drive controller provides 12 VDC for the encoder supply. Take this into account when selecting the encoder. Only
connect an encoder that is made for operation with a supply voltage of 12 VDC.

Encoder Connection Note

EnDat 2.1 digital X4 Not suitable for linear encoders

EnDat 2.2 digital X4 The drive controller evaluates the information reported by
the encoder and automatically detects whether the
encoder of a rotational or linear motor is connected

SSI X4 —

Incremental TTL X4 TTL signals, differential

Incremental HTL X4 With HT6 adapter for level conversion: HTL signals,
differential

X101 HTL signals, single-ended

X103 HTL signals, single-ended

HTL pulse and direction X101 HTL signals, single-ended

X103 HTL signals, single-ended

Resolver X4 —

EnDat 3 X4 In One Cable Solution (OCS) design

HIPERFACE DSL X4 In One Cable Solution (OCS) design

Tab. 60: Encoder connections
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7.7.2 Signal transmission
You can find the signal levels valid for the signal transmission in the following chapters.

7.7.2.1 Encoder inputs

The following signal levels apply to the encoder inputs for single-ended signal transmission:

Signal level HTL, single-ended

Low level 0 to 8 VDC

High level 15 to 30 VDC

Tab. 61: Signal level encoder inputs, single-ended

The following signal levels apply to the encoder inputs for differential signal transmission:

Signal level HTL, differential7 TTL, differential
(ANSI TIA/EIA-422)

Low level −30 to −4.2 VDC −6 to −0.2 VDC

High level 4.2 to 30 VDC 0.2 to 6 VDC

Tab. 62: Signal levels of encoder inputs, differential

7.7.3 X4: Encoder

ATTENTION!

Risk of encoder destruction!

The drive controller provides 12 VDC for the encoder supply. Take this into account when selecting the encoder. Only
connect an encoder that is made for operation with a supply voltage of 12 VDC.

X4 – EnDat 2.1 digital encoders

Technical data EnDat 2.1 digital signals

U2 12 VDC +/−5%

I2max 250 mA

I2min —

Encoder type Single-turn and multi-turn; not suitable for linear encoders

Clock frequency 2 MHz

Max. cable length 100 m, shielded

Tab. 63: X4 technical data – EnDat 2.1 digital signals

7 Encoder-side level at HTL to TTL adapter HT6
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X4 – EnDat 2.2 digital encoders

Technical data EnDat 2.2 digital signals

U2 12 VDC +/−5%

I2max 250 mA

Encoder type Single-turn and multi-turn

Clock frequency 4 MHz

Max. cable length 100 m, shielded

Tab. 64: X4 technical data – EnDat 2.2 digital signals

X4 – SSI encoders with free setting

Obey the instructions on the free setting of SSI encoders (see SSI: Evaluation at X4 with free setting (H00 = 78) [} 393]).

Technical data SSI signals

U2 12 VDC +/−5%

I2max 250 mA

Encoder type Single-turn and multi-turn

Data length Various resolutions possible

Clock frequency 150 – 1000 kHz

Sampling rate 250 µs

Monoflop time 10 – 100 µs

Code Binary or gray

Transfer Double or single

Max. cable length 100 m, shielded

Tab. 65: X4 technical data – SSI signals with free setting

X4 – SSI encoders with fixed setting

Obey the instructions on the fixed setting of SSI encoders (see SSI: Evaluation at X4 with fixed setting (H00 = 65) [} 394]).

Technical data SSI signals

U2 12 VDC +/−5%

I2max 250 mA

Encoder type Single-turn and multi-turn

Data length 13, 24 or 25 bits

Clock frequency 250 or 600 kHz

Sampling rate 250 µs

Monoflop time 30 µs

Code Binary or gray

Transfer Double or single

Max. cable length 100 m, shielded

Tab. 66: X4 technical data – SSI signals with fixed setting
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X4 – Incremental encoders

Technical data Incremental signals

U2 12 VDC +/−5%

I2max 250 mA

fmax 1 MHz

Signal level TTL, differential

Max. cable length 100 m, shielded

Tab. 67: X4 technical data – TTL differential incremental signals

Information

Calculation example – Maximum frequency fmax

for an encoder with 2,048 pulses per revolution: 3,000 revolutions per minute (equivalent to 50 revolutions per second) *
2,048 pulses per revolution = 102,400 pulses per second = 102.4 kHz << 1 MHz

Information

Using an HT6 adapter for level conversion from HTL signals to TTL signals, it is also possible to connect a differential HTL
incremental encoder to terminal X4. Note that, with an external power supply, the maximum level of 20 VDC for the HTL
signals may not be exceeded.

X4 – Resolvers

Technical data Resolver signals

Measuring range ± 2.5 V

Resolution 12 bits

U2 ± 10 V

I2max 80 mA

f2 7 – 9 kHz

Pmax 0.8 W

Transfer ratio 0.5 ± 5%

Number of poles 2, 4, 6 and 8

Signal shape Sine

Max. cable length 100 m, shielded

Tab. 68: X4 technical data – Resolver signals

X4 – EnDat 3 encoders (One Cable Solution)

Technical data EnDat 3 signals

U2 12 VDC +/−5%

I2max 250 mA

Encoder type Single-turn and multi-turn

Max. cable length 100 m, shielded

Tab. 69: X4 technical data – EnDat 3 signals
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X4 – HIPERFACE DSL encoders (One Cable Solution)

Technical data HIPERFACE DSL signals

U2 12 VDC +/−5%

I2max 250 mA

Encoder type Single-turn and multi-turn

Max. cable length 100 m, shielded

Tab. 70: X4 technical data – HIPERFACE DSL signals

Unsuitable encoder models

The following encoder models must not be connected due to their supply voltage:

Encoder model Code according to type designation

ECI 1118 C0

EQI 1130 Q0

ECI 1319 CR

EQI 1329 QP

EQI 1331 QR

Tab. 71: Encoder models with unsuitable supply voltage range

7.7.4 X101: Encoder

Feature All sizes

Max. core/cable length 30 m

Tab. 72: Maximum core/cable length [m]

Electrical data Digital input Incremental signals, pulse/direction signals

Low level DI1 – DI4 0 – 8 VDC

High level 15 – 30 VDC

U1max 30 VDC

I1max 16 mA

f1max DI1 – DI2 10 kHz

DI3 – DI4 250 kHz

Tab. 73: X101 electrical data – Single-ended HTL incremental signals and single-ended HTL pulse/direction signals

Information

Calculation example – Maximum frequency fmax

for an encoder with 2,048 pulses per revolution: 3,000 revolutions per minute (equivalent to 50 revolutions per second) *
2,048 pulses per revolution = 102,400 pulses per second = 102.4 kHz < 250 kHz
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7.7.5 X103: Encoder

Feature All sizes

Max. core/cable length 30 m

Tab. 74: Maximum core/cable length [m]

Electrical data Digital input Incremental signals, pulse/direction signals

Low level DI6 – DI9 0 – 8 VDC

High level 15 – 30 VDC

U1max 30 VDC

I1max 16 mA

f1max DI6 – DI7 10 kHz

DI8 – DI9 250 kHz

Tab. 75: X103 electrical data – Single-ended HTL incremental signals and single-ended HTL pulse/direction signals

Information

Calculation example – Maximum frequency fmax

for an encoder with 2,048 pulses per revolution: 3,000 revolutions per minute (equivalent to 50 revolutions per second) *
2,048 pulses per revolution = 102,400 pulses per second = 102.4 kHz < 250 kHz
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7.8 Controllable brakes
The brake of axis A is connected to X2A. Connect the brake of axis B to X2B for double-axis controllers.

You can control the following brakes:

§ Directly connected 24 VDC brakes

§ Brakes connected indirectly over contactor

The brake is supplied over X300.

Electrical data Brake connection

U2 24 VDC, +20%

I2max 2.5 A

f2max 1 Hz at IN ≤ 2.1 A;
0.25 Hz at IN > 2.1 A

E2max 1.83 J

Tab. 76: X2 electrical data – Brake connection

Information

In the case of a nominal brake current > 2.1 A, the controller must ensure compliance with the maximum switching
frequency of 0.25 Hz.

Information

Control modes 48: SSM-vector control incremental encoder and 70: SLM - vector control with commutation finding using
Wake and Shake may only be used in combination with a brake for axes without gravity load.

For more information, see B20 = 32, 48, 64, or 70 [} 236].

7.9 Evaluable motor temperature sensors
You can connect a PTC triplet at terminal X2 or a Pt1000 motor temperature sensor using the One Cable Solution to the SI6
drive controller.

Information

Evaluation of the temperature sensors is always active. If operation without a temperature sensor is permitted, the
connections must be bridged to X2. Otherwise a fault is triggered when the device is switched on.

Type Triggering limit

PTC thermistor 4000 Ω

Pt1000 temperature sensor Can be parameterized in °C in parameter B39

Tab. 77: Triggering limit of temperature sensor
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7.10 Braking resistor
In addition to the supply modules, STOBER offers braking resistors in the various sizes and performance classes described
below. For the selection, note the minimum permitted braking resistors specified in the technical data of the supply
modules. In the event of a fault, such as a defective brake chopper, the supply module must be disconnected from the
power supply.

7.10.1 Assignment of braking resistor – PS6

Type KWADQU
420×91 with

MWS306L

KWADQU
420×91 with

MWS310L

FZZMQU
400×65

FGFKQU
31005

FGFKQU
31009

FGFKQU
31114

ID No. 138675 138676 56635 56636 5050115 5050116

PS6A24 (X) X X X — —

PS6A34 (X) X X X — —

PS6A44 (—) (—) (—) (X) X X

Tab. 78: Braking resistor assignment to PS6 supply module

X Recommended

(X) Possible

(—) Useful under certain conditions

— Not possible

7.10.2 KWADQU flat resistor
The braking resistor is available with two different mounting bracket sets (MWS).

Properties

Technical data KWADQU 420×91 with MWS306L KWADQU 420×91 with MWS310L

ID No. 138675 138676

Type Flat resistor with temperature switch
(incl. mounting bracket)

Resistance [Ω] 100 ±10%

Thermal drift ±10%

Power [W] 600

Thermal time constant τth [s] 60

Pulse power for < 1 s [kW] 13

Umax [V] 848

Cable design FEP

Cable length [mm] 500

Conductor cross-section [AWG] 14/19
(1.9 mm²)

Weight without packaging [g] 2620 2770

Protection class IP54

Marks and test symbols cURus, CE, UKCA

Tab. 79: KWADQU technical data
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Technical data Temperature switch

Switching capacity 2 A / 24 VDC (DC11)

Nominal response temperature ϑNAT 180 °C ± 5 K

Type NC

Cable design FEP

Cable length [mm] 500

Conductor cross-section [AWG] 22

Tab. 80: Temperature switch technical data

Dimensions

Braking resistor with MWS306L

A

7126,2

20

A+
18

60

 TS 

A+
30

91

Fig. 13: KWADQU dimensional drawing with MWS306L
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Braking resistor with MWS310L

The mounting brackets are freely positionable in the vertical direction over the entire length of the braking resistor.

91

106 90

110

20

A

 TS 

47
8,

25

26
,5 41

,5

12
15

26,2

R5,75

6,5

50

Fig. 14: KWADQU dimensional drawing with MWS310L

Dimension KWADQU 420×91

A 420

Tab. 81: KWADQU dimensions [mm]
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7.10.3 FZZMQU tubular fixed resistor

Properties

Technical data FZZMQU 400×65

ID No. 56635

Type Tubular fixed resistor with temperature switch

Resistance [Ω] 47 ±10%

Thermal drift ±10%

Power [W] 1200

Thermal time constant τth [s] 40

Pulse power for < 1 s [kW] 36

Umax [V] 848

Weight without packaging [g] 4200

Protection class IP20

Marks and test symbols cURus, CE, UKCA

Tab. 82: FZZMQU technical data

Technical data Temperature switch

Switching capacity 2 A / 24 VDC (DC11)

Nominal response temperature ϑNAT 180 °C ± 5 K

Type NC

Cable design FEP

Cable length [mm] 500

Conductor cross-section [AWG] 22

Tab. 83: Temperature switch technical data
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Dimensions

R

H

U

K

L

40

øD

10

O

Fig. 15: FZZMQU dimensional drawing

Dimension FZZMQU 400×65

L × D 400 × 65

H 120

K 6.5 × 12

O 485

R 185

U 150

Tab. 84: FZZMQU dimensions [mm]
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7.10.4 FGFKQU steel-grid fixed resistor

Properties

Technical data FGFKQU 31005 FGFKQU 31009 FGFKQU 31114

ID No. 56636 5050115 5050116

Type Steel-grid fixed resistor with temperature switch

Resistance [Ω] 22 ±10% 14.4 ±10% 9.5 ±10%

Thermal drift ±10% ±10% ±10%

Power [W] 2500 4500 7000

Thermal time constant τth [s] 30 30 20

Pulse power for < 1 s [kW] 50 90 140

Umax [V] 848

Weight without packaging [g] 7500 9500 13000

Protection class IP20

Marks and test symbols cURus, CE, UKCA

Tab. 85: FGFKQU technical data

Technical data Temperature switch

Switching capacity 2 A / 24 VDC (DC11)

Nominal response temperature ϑNAT 100 °C ± 5 K

Type NC

Cable design FEP

Cable length [mm] 500

Conductor cross-section [AWG] 22

Tab. 86: Temperature switch technical data
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Dimensions

C490 

26
0

380

 ø10,5

B

A

Fig. 16: FGFKQU dimensional drawing

Dimension FGFKQU 31005 FGFKQU 31009 FGFKQU 31114

A 270 370

B 295 395

C 355 455

Tab. 87: FGFKQU dimensions [mm]
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7.11 Choke
Technical specifications for suitable chokes can be found in the following chapters.

7.11.1 TEP power choke
Power chokes are used to dampen voltage and current peaks and reduce the load of the power feed-in of the supply
modules.

Properties

Technical data TEP4010-2US00

ID No. 56528

Phases 3

Thermally allowed continuous current 100 A

Nominal current IN,MF 90 A

Absolute loss PV 103 W

Inductance 0.14 mH

Voltage range 3 × 400 VAC,
+32%/−50%
3 × 480 VAC,
+10%/−58%

Voltage drop Uk 2%

Frequency range 50/60 Hz

Protection class IP00

Max. surrounding temperature ϑamb,max 40 °C

Insulation class B

Connection Screw terminal

Connection type Flexible with and without end sleeve

Max. conductor cross-section 6 – 35 mm²

Tightening torque 2.5 Nm

Insulation stripping length 17 mm

Installation Screws

Directive EN 61558-2-20

UL Recognized Component (CAN; USA) Yes

Marks and test symbols cURus, CE

Tab. 88: TEP technical data
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Dimensions
m

ax
. 2

37

118

13
6

20
1

75

88

219

7

12

A

A

PE

Fig. 17: Power choke dimensional drawing

Dimensions TEP4010-2US00

Height [mm] Max. 237

Width [mm] 219

Depth [mm] 118

Vertical distance 1 –
Fastening holes [mm]

201

Vertical distance 2 –
Fastening holes [mm]

136

Horizontal distance 1 –
Fastening holes [mm]

88

Horizontal distance 2 –
Fastening holes [mm]

75

Drill holes – Depth [mm] 7

Drill holes – Width [mm] 12

Screw connection – M M6

Weight without packaging [g] 9900

Tab. 89: TEP dimensions and weight
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7.11.2 TEP output choke
Output chokes are required for connecting size 0 to 2 drive controllers to synchronous servo motors or asynchronous
motors from a cable length > 50 m in order to reduce interference pulses and protect the drive system. If Lean motors are
connected, output chokes must not be used.

Information

The following technical data only applies to a rotating magnetic field frequency of 200 Hz. For example, this rotating
magnetic field frequency is achieved with a motor with 4 pole pairs and a nominal speed of 3000 rpm. Always observe the
specified derating for higher rotating magnetic field frequencies. Also observe the relationship with the clock frequency.

Properties

Technical data TEP3720-0ES41 TEP3820-0CS41 TEP4020-0RS41

ID No. 53188 53189 53190

Voltage range 3 × 0 to 480 VAC

Frequency range 0 – 200 Hz

Nominal current IN,MF at 4 kHz 4 A 17.5 A 38 A

Nominal current IN,MF at 8 kHz 3.3 A 15.2 A 30.4 A

Max. permitted motor
cable length with
output choke

100 m

Max. surrounding
temperature ϑamb,max

40 °C

Protection class IP00

Winding losses 11 W 29 W 61 W

Iron losses 25 W 16 W 33 W

Connection Screw terminal

Max. conductor cross-section 10 mm²

UL Recognized
Component (CAN; USA)

Yes

Marks and test symbols cURus, CE

Tab. 90: TEP technical data
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Dimensions

E

F

H

B1

B2

A
M1:2

A

W D

A2A1

Fig. 18: TEP dimensional drawing

Dimension TEP3720-0ES41 TEP3820-0CS41 TEP4020-0RS41

Height H [mm] Max. 153 Max. 153 Max. 180

Width W [mm] 178 178 219

Depth D [mm] 73 88 119

Vertical distance – 
Fastening holes A1 [mm]

166 166 201

Vertical distance – 
Fastening holes A2 [mm]

113 113 136

Horizontal distance – 
Fastening holes B1 [mm]

53 68 89

Horizontal distance – 
Fastening holes B2 [mm]

49 64 76

Drill holes – Depth E [mm] 5.8 5.8 7

Drill holes – Width F [mm] 11 11 13

Screw connection – M M5 M5 M6

Weight without packaging [g] 2900 5900 8800

Tab. 91: TEP dimensions and weight
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8 Project configuration
Relevant information on the project configuration and design of your drive system can be found in the following chapters.

EPLAN macros for all 6th generation drive controllers and their accessories are available in the EPLAN Data Portal for
efficient planning and support of your project configuration.

8.1 Supply module
For project configuration of supply modules, note the framework conditions described below.

8.1.1 Information on design and operation

Information

For the design of the supply module, note that the summed self-capacitance of all SI6 drive controllers may not exceed the
charging capacity of the supply module.

Minimum time between two energizing processes

The supply modules have temperature-dependent resistors in the charging circuit that prevent devices from being damaged
when being connected to the grid after a fault, such as a short-circuited DC link, incorrect wiring, etc. These resistors are
heated when charging the DC link.

The supply module features a fast discharge function for the DC link, which is active 20 s after switching off the supply
voltage.

Information

For cyclic power-on/power-off operation, the following is to be observed to prevent the charging capacities of the supply
modules from being exceeded:

▪ PS6 without braking resistor: Direct, repeat activation of the supply voltage possible.

▪ PS6 with braking resistor and an interval < 20 s after power-off (fast discharge inactive): Direct, repeat activation of
the supply voltage possible.

▪ PS6 with braking resistor and an interval > 20 s after power-off (fast discharge active): Reactivation of the supply
voltage only possible 2 min after previous activation!

Information

The STO safety function is available for safe stopping as an alternative to continuous, cyclical power-on/power-off
operation.



STOBER 8 | Project configuration
02

/2
02

4 
| 

ID
 4

42
72

8.
12

87

8.1.2 General conditions for parallel connection
The following general conditions apply to the parallel connection of several PS6 supply modules:

§ Only supply modules of size 2 or 3 may be connected in parallel.

§ Only the same sizes may be connected in parallel.

§ You can connect a maximum of 3 PS6A34 in parallel.

§ For UL-compliant operation:
A single PS6A24 or PS6A34 supply module converts the 3-phase AC input voltage into a common DC bus output
voltage, which can be used to feed one or more SI6 drive controllers.

§ You can connect one braking resistor for each supply module. The braking power for each braking resistor has to be
overdimensioned:

• By 15% for parallel connection of 2 supply modules

• By 30% for parallel connection of 3 supply modules

§ Observe a derating factor of 0.8 each for the sum in parallel connection for nominal power, current and charging
capacity.

§ The resistance values of the braking resistors must be the same. Make sure that the power output to all braking
resistors is in equal parts.

§ Take into account the specifications for the fuse design for each supply module within the device group (see Line fuse
[} 121]).

§ All supply modules must be connected to the same 3-phase supply grid.

§ The grid must be switched on at all supply modules simultaneously (see Grid connection [} 123]).

§ Each supply module must additionally be grounded at the ground bolt (see Protective grounding [} 125]).

§ There are no restrictions for the position of a supply module within the group.

§ Mixed feed-in operation in which additional components (e.g. drive controllers) contribute to the DC link supply in
addition to the supply modules is not permitted.

Example combinations for parallel connection

The following table shows example combinations for parallel connection. A derating factor of 0.8 is taken into account for
the values.

Electrical data 2 x PS6A24 3 x PS6A24 2 x PS6A34 3 x PS6A34

P2N,PU 16 kW 24 kW 32 kW 48 kW

I1N,PU 40 A 60 A 80 A 120 A

CmaxPU 8000 µF 12000 µF 16000 µF 24000 µF

Tab. 92: Electrical data for parallel connection: Example combinations

Dimensioning the braking resistors

Proceed as follows to dimension the braking resistors:

1. Determine the required braking power PeffRB

2. Divide this by the number of braking resistors

3. Multiply the result by the factor for overdimensioning

4. Take the resulting value into account for selecting the right braking resistor:
PN,RB must be greater than the determined value
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Sample calculation

The required braking power PeffRB is 800 W. Two supply modules of type PS6A34 are connected in parallel.

A braking resistor is connected to every supply module. The required braking power for each braking resistor is calculated
as follows:
800 W ÷ 2 = 400 W

For 2 supply modules connected in parallel, increase the required braking power of the braking resistors by 15%:
400 W × 1.15 = 460 W

A braking resistor of type KWADQU with a nominal power of 600 W should be connected to each supply module:
460 W < 600 W

The nominal power of the braking resistor is then sufficient.

Wiring example

The examples in the appendix (see Wiring examples [} 381]) illustrate the basic connection based on a DC link connection
with Quick DC-Link DL6B.
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8.2 DC link connection
Braked motors work like generators: Operating with an active drive controller, they convert kinetic energy from movement
into electrical energy. This electrical energy is stored in the DC link capacitors of the drive controller. It is supplied to
powered motors with connected DC links and thus used efficiently.

The DC link voltage increases when a motor decelerates. However, capacitors in the DC link can only accept a limited
amount of energy. If the DC link voltage rises above a defined limit, a chopper circuit is activated that converts the excess
energy into heat by means of a connected braking resistor. If the permitted maximum voltage is reached, any possible
damage must be prevented. The drive controller switches to the fault state and shuts down. In a DC link connection, the DC
link capacitors of the drive controllers involved are connected in parallel. As a result, the maximum acceptable amount of
energy increases in the DC link.

8.2.1 Information on design and operation
In order to connect the capacitors of multiple drive controllers, you need a separate DL6B type Quick DC-Link module for
each drive controller and each supply module in the group.

Information

Note that Quick DC-Link can be subject to system or country-specific standards.

Electrical data of the drive controllers

For the design and operation of the Quick DC-Link, the electrical data of the individual drive controller and supply module
types must be observed, particularly the following:

§ Self-capacitance CPU of the drive controllers

§ Charging capacity CN,PU of the supply modules

§ Nominal input current I1N,PU of the supply modules

§ Derating of the nominal input current

The values can be taken from the technical data of the drive controllers and supply modules.

Maximum voltage and maximum current

The maximum DC link voltage is 750 VDC and the maximum permitted overall current is 200 A.
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8.3 Motor
During the project configuration for motors, note the framework conditions described below.

Rotational motors (Lean motors, synchronous servo motors, asynchronous motors, torque motors)

The maximum possible motor speed is limited to 36000 rpm.

The following relationship applies: 
Rotating magnetic field frequency = Motor speed × Number of pole pairs ÷ 60

Since the output frequency f2PU can be a maximum of 700 Hz, the motor speed can only be reached if the calculated rotating
magnetic field frequency is less than f2PU.

The specified torque/speed curve or the nominal points can only be reached in vector control if field weakening operation
is not in effect. Theoretical field weakening operation begins when a voltage is required for the speed (speed × KE constant)
that is greater than the available DC link voltage. In practice, however, field weakening must begin before reaching this
voltage limit (control reserve).

You define the voltage limit in B92. The default value is 80%.

Information

Field weakening is always active for Lean motors (B91 Field weakening = 1: Active). The voltage limit preset in B92 is 95%
for Lean motors.

Translational motors (linear motors)

The maximum possible motor velocity is limited to 20,000 m/min.

The following relationship applies: 
Field frequency = Velocity in m/min × 1000 ÷ (60 ÷ pole distance in mm)

Since the output frequency f2PU can be a maximum of 700 Hz, the motor velocity can only be reached if the calculated field
frequency is less than f2PU.

The specified force/velocity curve or the nominal points can only be reached in vector control if field weakening operation
is not in effect. Theoretical field weakening operation begins when for the velocity a voltage is required (velocity × KE
constant) that is greater than the available DC link voltage. In practice, however, field weakening must begin before
reaching this voltage limit (control reserve).

You define the voltage limit in B92. The default value is 80%.
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8.4 Choke
For project configuration of the chokes, note the general conditions described below.

8.4.1 TEP power choke

Derating – Effect of surrounding temperature
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Fig. 19: Derating the nominal current based on surrounding temperature

Derating – Effect of the installation elevation
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Fig. 20: Derating the nominal current depending on installation elevation
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Fig. 21: Derating the voltage depending on installation elevation
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8.4.2 TEP output choke
Select the output chokes in accordance with the nominal currents of the output chokes, motor and drive controller. In
particular, observe the derating of the output choke for rotating magnetic field frequencies higher than 200 Hz. You can
calculate the rotating magnetic field frequency for your drive with the following formula:

N N
pf n
60

´=

Derating – Effect of the clock frequency
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2
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IN [A]
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Fig. 22: Derating the nominal current depending on the clock frequency, TEP3720-0ES41

1 4 kHz clock frequency

2 8 kHz clock frequency
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Fig. 23: Derating the nominal current depending on the clock frequency, TEP3820-0CS41

1 4 kHz clock frequency

2 8 kHz clock frequency
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Fig. 24: Derating the nominal current depending on the clock frequency, TEP4020-0RS41

1 4 kHz clock frequency

2 8 kHz clock frequency

Derating – Effect of surrounding temperature
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Fig. 25: Derating the nominal current based on surrounding temperature

Derating – Effect of the installation elevation
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Fig. 26: Derating the nominal current depending on installation elevation
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Fig. 27: Derating the voltage depending on installation elevation
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8.5 Mixed operation
You can combine the PS6 supply module and the SI6 drive controller with other 6th generation STOBER drive controllers.

For a DC link connection in mixed operation, however, exclusively supply modules of same type (e.g. PS6A34) may be
supplied with power.

For example, two PS6A34 supply modules with three SI6A262 drive controllers and one SD6A06 drive controller are to be
combined. In this case, both PS6A34 supply modules are connected to the supply grid. The three SI6A262 drive controllers
are connected to the DC link of the supply modules. The SD6A06 drive controller also may only be connected to the DC link
of the PS6A34 supply modules in this case, not to the supply grid.

The graphic below shows an example of the grounding concept in mixed operation with feed-in by a PS6 supply module.
The grounding conductor connection between the supply module or drive controller and the associated Quick DC-Link rear
section module (type DL6B or DL6A) is made using the metallic connection of the housings. The grounding conductor
connection between DL6B type rear section modules is made using a copper rail (PE rail). Obey the requirements for
connecting a 2nd grounding conductor to the supply module (see Connection of the grounding conductor [} 126]). The
same requirements also apply to drive controllers with DL6A rear section modules.

1. PE
2. PE

1. PE
2. PE

X10X10

DC+

Lorem ipsum

DC-

PE

SI6PS6 SC6 SD6

DL6B DL6B DL6B DL6A

Fig. 28: Grounding concept in mixed operation with powered PS6 supply module
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9 Storage
Store the products in a dry and dust-free room if you do not install them immediately.

Observe the Transport and storage conditions [} 45] specified in the technical data.

9.1 Supply module
No reforming is required for the PS6 supply module, even after long storage times.

9.2 Drive controllers
The DC link capacitors can lose their electrical strength due to long storage times and must be reformed before
commissioning.

This property does not apply to size 3 DC link capacitors. Therefore, size 3 drive controllers do not require reforming even
after prolonged storage periods.

ATTENTION!

Material damage due to reduced electrical strength!

Reduced electrical strength can cause considerable material damage when switching on the drive controller.

▪ Reform drive controllers in storage annually or before commissioning.
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9.2.1 Annual reforming
To prevent damage to stored drive controllers, STOBER recommends connecting stored devices to the supply voltage once
per year for one hour.

The following graphic shows the predominant supply connection.

T1

X10

L1 PEL3L2

D-
X22

D+

T2

D-
X22

D+

PEL1 L3L2

F1

PS6 SI6

Fig. 29: Annual reforming

L1 – L3 Lines 1 to 3

N Neutral conductor

PE Grounding conductor

F1 Fuse

T1 Supply module

T2 Drive controller

Information

For UL-compliant operation: The connections marked with PE are intended solely for the functional grounding.
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9.2.2 Reforming before commissioning
If annual reforming is not possible, implement reforming on stored devices before commissioning. Note that the voltage
levels depend on the storage time.

The following graphic shows the predominant supply connection.

T1

F1

PEL1 L3L2

T3T2 

X10

L1 PEL3L2

D-
X22

D+ D-
X22

D+

PS6 SI6

Fig. 30: Reforming before commissioning

L1 – L3 Lines 1 to 3

N Neutral conductor

PE Grounding conductor

F1 Fuse

T1 Variable transformer

T2 Supply module

T3 Drive controller

Information

For UL-compliant operation: The connections marked with PE are intended solely for the functional grounding.
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Fig. 31: Voltage levels dependent on storage time

1 Storage time of 1 – 2 years: Apply voltage for 1 hour before switching on.

2 Storage time of 2 – 3 years: Implement reforming according to the graph before switching on.

3 Storage time ≥ 3 years: Implement reforming according to the graph before switching on.

Storage time < 1 year: No actions required.
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10 Installation
The following chapters describe the installation of the Quick DC-Link rear section modules for the DC link connection as well
as the subsequent installation of the drive controllers and supply modules.

For information on replacing a drive controller or supply module, see Replacement [} 361].

10.1 Basic assembly instructions
Note the points described below for installation.

10.1.1 Drive controllers and supply modules
Note the following points for installation:

§ Prevent condensation, e.g. with anti-condensation heating elements.

§ For reasons related to EMC, use installation plates with a conductive surface (unpainted, etc.).

§ Avoid installation above or in the immediate vicinity of heat-generating devices, e.g. output chokes or braking resistors.

§ To ensure there is sufficient air circulation in the control cabinet, observe the minimum clearances.

§ Install the devices vertically.

Reference code

Attach a sticker to the provided field on the front of the device with the unique reference code of the respective device to
prevent mix-ups during installation or replacement.

T1 T2 T3 T4

Fig. 32: Fields on the front of the device for identification
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10.1.2 Braking resistor
Note the permitted mounting positions for the braking resistor.

KWADQU flat resistor

Permitted installation:

§ On vertical surfaces with cables downwards

§ On horizontal surfaces

§ Installation outside of the control cabinet possible for mechanical protection of
the conductors

Impermissible installation:

§ On vertical surfaces with cables upwards

FZZMQU tubular fixed resistor

Permitted installation:

§ On vertical surfaces with terminals downwards

§ On horizontal surfaces

§ In control cabinets

Impermissible installation:

§ On vertical surfaces with terminals upwards, left or right

§ Outside of control cabinets

FGFKQU steel-grid fixed resistor

Permitted installation:

§ On vertical surfaces with terminals downwards

§ Top and bottom perforated sheets

§ On horizontal surfaces

§ Installation on, next to or in the control cabinet possible

Impermissible installation:

§ On vertical surfaces with terminals upwards, left or right
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10.1.3 Choke
In relation to the flow of cooling air, the following mounting positions are permitted for the TEP output choke:

CA B

10.2 Minimum clearances
Note the minimum clearances for installation below.

Drive controllers and supply modules

D35

E

C C

H

F

B
A

G

Fig. 33: Minimum clearances for drive controllers in combination with a PS6A24 or PS6A34 supply module
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D35
E

C

H
F

C

B
A

G

Fig. 34: Minimum clearances for drive controllers in combination with a PS6A44 supply module

The specified dimensions refer to the outside edges of the drive controller or supply module including the Quick DC-Link
rear section module.

Minimum clearance A (above) B (below) C (on the side) D (in front)

All sizes 100 200 5 508

Tab. 93: Minimum clearances [mm]

Dimension E F G H

PS6A24 73.5 393+2 approx. 174.5 27.5

PS6A34 73.5 393+2 approx. 174.5 37.5

PS6A44 73.5 429+2 approx. 138.5 43

Tab. 94: Dimensions [mm]

Chokes and filters

Avoid installation below drive controllers or supply modules. For installation in a control cabinet, a distance of
approximately 100 mm to other neighboring components is recommended. This distance ensures proper heat dissipation
for chokes and filters.

Braking resistors

Avoid installation below drive controllers or supply modules. In order for heated air to flow out unimpeded, a minimum
clearance of approximately 200 mm must be maintained in relation to neighboring components or walls and approximately
300 mm must be maintained to components above or ceilings.

8 Minimum clearance to be taken into account for permanent connection of the X9 service interface
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10.3 Drilling diagrams and dimensions
You can find drilling diagrams and dimensions for a multi-axis drive system with SI6 and PS6 and for accessories in the
following chapters.

10.3.1 Multi-axis drive system

F

A/2

G

C D E

BA/2 B

Fig. 35: Drilling diagram of DL6B10 to DL6B21
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F

B BA/2

G
C D E

A/2

Fig. 36: DL6B22 drilling diagram

Dimension DL6B10
DL6B20

DL6B11
DL6B21

DL6B12 DL6B22

Horizontal fastening holes
∅ 4.2 (M5)

A 45 65 — —

B — — 30 38

E — — 45±0.2 82±0.2

C DL6B10
DL6B20

46±1 56±1 — —

C DL6B11
DL6B21

56±1 66±1 — —

D DL6B10
DL6B20

— — 53.5±1 61.5±1

D DL6B11
DL6B21

— — 63.5±1 71.5±1

D DL6B12 — — 61±1 69±1

Vertical fastening holes
∅ 4.2 (M5)

F 393+2 429+2

Vertical distance for drive controllers and
supply modules

G 360 396

Tab. 95: Drilling dimensions for the multi-axis drive system [mm]
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10.3.2 Braking resistor

10.3.2.1 KWADQU flat resistor

Braking resistor with MWS306L

60

A+
18

M4

Fig. 37: KWADQU drilling diagram

Braking resistor with MWS310L

The mounting brackets are freely positionable in the vertical direction over the entire length of the braking resistor.

A+18

90

M5

42

A

Fig. 38: KWADQU drilling diagram with MWS 310L

Dimension KWADQU 420×91

A 420

Tab. 96: KWADQU dimensions [mm]
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10.3.2.2 FZZMQU tubular fixed resistor

U

M

K

Fig. 39: FZZMQU drilling diagram

Dimension FZZMQU 400×65

K 6.5 × 12

M 426

U 150

Tab. 97: FZZMQU dimensions [mm]

10.3.2.3 FGFKQU steel-grid fixed resistor

380

A

10,5

Fig. 40: FGFKQU drilling diagram

Dimension FGFKQU 31005 FGFKQU 31009 FGFKQU 31114

A 270 370

Tab. 98: FGFKQU dimensions [mm]
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10.3.3 Choke

10.3.3.1 TEP power choke

13
6±

0,
5

20
1±

0,
5

88±0,5

75±0,5

M6

Fig. 41: Power choke drilling diagram

10.3.3.2 TEP output choke

A1A2

B1

B2

M

Fig. 42: TEP drilling diagram
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Dimension TEP3720-0ES41 TEP3820-0CS41 TEP4020-0RS41

Vertical distance – 
Fastening holes A1 [mm]

166 166 201

Vertical distance – 
Fastening holes A2 [mm]

113 113 136

Horizontal distance – 
Fastening holes B1 [mm]

53 68 89

Horizontal distance – 
Fastening holes B2 [mm]

49 64 76

Drill holes – Depth E [mm] 5.8 5.8 7

Drill holes – Width F [mm] 11 11 13

Screw connection – M M5 M5 M6

Tab. 99: TEP dimensions
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10.4 Length of copper rails
For the installation of the Quick DC-Link modules, you require three prepared copper rails with a cross-section of 
5 × 12 mm.

The length of the copper rails is 5 mm shorter than the total width of the group, i.e. the total width of all DL6B Quick DC-
Link modules present in the group:
B = A − 5 mm

Note that the correct length of the copper rails can be determined only after installation of all modules:

A

B

Fig. 43: Determination of the correct length of the copper rails

A Total width of the group after installation

B Length of the copper rails = A − 5 mm
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10.5 DC link connection
Observe the installation notes when installing the DC link connection and associated hardware components.

10.5.1 Components for the DC link connection

Information

The drive controller is delivered in the standard design without safety technology (option SZ6). If you want a drive
controller with integrated safety technology, you must order it together with the drive controller. The safety modules are
an integrated part of the drive controllers and must not be modified.

Device Safety
technology

Terminal set Quick DC-Link

Type ID No. ID No. ID No. Type ID No. Width [mm]

PS6A24 56650 — 138660 DL6B20 56657 45

PS6A34 56651 — 138661 DL6B21 56658 65

PS6A44 138679 — 5050112 DL6B22 5050114 158

SI6A061 56645 56660a) 138655 DL6B10 56655 45

56696b)

56662c)

56661d) 138683

SI6A062 56646 56660a) 138656 DL6B10 56655 45

56696b)

56662c)

56661d) 138684

SI6A161 56647 56660a) 138657 DL6B11 56656 65

56696b)

56662c)

56661d) 138685

SI6A162 56648 56660a) 138658 DL6B11 56656 65

56696b)

56662c)

56661d) 138686

SI6A261 56649 56660a) 138659 DL6B11 56656 65

56696b)

56662c)

56661d) 138687

SI6A262 56653 56660a) 138662 DL6B12 56663 105

56696b)

56662c)

56661d) 138688
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Device Safety
technology

Terminal set Quick DC-Link

Type ID No. ID No. ID No. Type ID No. Width [mm]

SI6A361 56654 56660a) 138663 DL6B12 56663 105

56696b)

56662c)

56661d) 138689

Tab. 100: Overview of hardware components with ID No.

a) SZ6 option: Without safety technology

b) SU6 safety module: STO and SS1 using PROFIsafe

c) SY6 safety module: STO and SS1 using FSoE

d) SR6 safety module: STO using terminals

10.5.2 Installing the DC link connection
You must first mount the Quick DC-Link modules of type DL6B and then build the appropriate supply modules and drive
controllers over them.

WARNING!

Electrical voltage! Risk of fatal injury due to electric shock!

▪ Always switch off all power supply voltage before working on the devices!

▪ Note the discharge time of the DC link capacitors in the general technical data. You can only determine the absence
of voltage after this time period.

Tools and material

You will need:

§ 3 copper rails with sufficient length and a cross-section of 5 x 12 mm (see Length of copper rails [} 110])

§ The nut and washer assemblies (M5), insulation connection pieces and quick fastening clamps included with the Quick
DC-Link modules

§ The insulation end sections for the left and right termination of the group that are available separately

§ Fastening screws and tool for tightening the fastening screws

Requirements and installation

Observe the basic installation instructions (see Drive controllers and supply modules [} 100]).

Perform the following steps in the specified order.

ü You have tapped holes for fastening screws on the mounting plate at the installation location in accordance with the
drilling diagram and taking into consideration the different device dimensions.

ü The mounting plate has been cleaned (free of oil, grease and swarf).

ü The copper rails must be straight, smooth, free of burrs and cleaned (free of oil and grease).
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1. Fasten the Quick DC-Link modules onto the mounting plate with the fastening screws.

2. Insert the insulation connection pieces between the modules and insulation end section each at the left edge of the
first module and at the right edge of the last module. Ensure correct alignment of the end section using the marking
on the outside and the insertion aids for the copper rails on the inside.

3. Shorten the copper rails to the correct length.

4. Clean the copper rails, especially at the contact points.
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5. Insert the three copper rails one after the other.

6. Fasten the copper rails with quick fastening clamps (DL6B10 to DL6B21 with two, DL6B22 with three quick fastening
clamps per rail). Make certain the contact points of the copper rails do not become contaminated.

ð You have installed the Quick DC-Link. In the next step, build over the Quick DC-Link modules with suitable drive
controllers and supply modules.
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10.6 Installing the drive controller and supply module

WARNING!

Electrical voltage! Risk of fatal injury due to electric shock!

▪ Always switch off all power supply voltage before working on the devices!

▪ Note the discharge time of the DC link capacitors in the general technical data. You can only determine the absence
of voltage after this time period.

Information

Note that drive controllers in storage require reforming each year or before commissioning at the latest.

Sizes 0 to 3: Tools and material

You will need:

§ A suitable terminal set for each drive controller and for each supply module

§ An 8 mm hexagonal socket wrench to tighten the nut and washer assemblies on the threaded bolts

Sizes 0 to 3: Requirements and installation

Perform the following steps for each drive controller and for each supply module up to and including size 3 within the
group.

ü A circuit diagram of the system is available containing a description of connecting the drive controllers and supply
modules.

ü Suitable Quick DC-Link rear section modules (DL6B10 to DL6B21) for the DC link connection are already installed at the
installation position for each drive controller and each supply module.
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1. Remove terminal X22 from the appropriate terminal set. Connect the brown cable D+ on the bottom of the Quick DC-
Link module to D+ of terminal X22, and the black cable D− of the Quick DC-Link module to D− of terminal X22. Make
sure that the conductors of the Quick DC-Link module are twisted pairs.

D+

D-

2. Place the drive controller or supply module on the bottom threaded bolt(s) of the Quick DC-Link module and properly
align the device vertically with the bottom and top threaded bolts.
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3. Fasten the drive controller or the supply module with the nut and washer assemblies (M5, 3.5 Nm) to the threaded
bolts of the Quick DC-Link module. The nut and washer assemblies are included with the Quick DC-Link module.

4. Connect the grounding conductor to the ground bolt of the supply module. As an alternative to the grounding
conductor connection over the 3rd copper rail (PE rail) in the rear section modules, the drive controllers can be
connected individually to the grounding conductor system by their ground bolts. Obey the instructions and
requirements for Protective grounding [} 125].

5. Attach the X22 terminal of the Quick DC-Link module.

ð The installation up to and including size 3 is completed.
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Supply module size 4: Tools and material

You will need:

§ An 8 mm hexagonal socket wrench to tighten the nut and washer assemblies on the threaded bolts

§ A 3 mm hexagon socket wrench insert to tighten and unscrew the screws on X22 (cover)

§ A TX30 TORX screwdriver to tighten and unscrew the screw and washer assemblies on X22 (terminal)

Supply module size 4: Requirements and installation

Perform the following steps for the PS6A44 supply module within the group.

ü There is a system circuit diagram describing the connection of the supply module.

ü The appropriate Quick DC-Link DL6B22 rear section module for the DC link connection is already mounted at the
installation position for the supply module.

1. Place the supply module on the bottom threaded bolts of the Quick DC-Link module and properly align the supply
module vertically with the bottom and top threaded bolts.

2. Fasten the supply module to both threaded bolts of the Quick DC-Link module using the nut and washer assemblies
(M5, 3.5 Nm). The nut and washer assemblies are included with the Quick DC-Link module.

3. Unscrew both fastening screws on the cover of terminal X22 and remove the cover.

4. Unscrew the 3 screw and washer assemblies on terminal X22.
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5. Use the screw and washer assemblies (M6, 4.5 Nm, 40 Lb.inch) to fasten the flex cable D+ to D+ of terminal X22, flex

cable D− to D− and flex cable of the grounding conductor to .

6. Reattach the cover of X22 using the two fastening screws (2.3–2.9 Nm).

7. On the top of the device, connect the grounding conductor to  of terminal X10 of the supply module (5.5 Nm). As
an alternative to the grounding conductor connection over the 3rd copper rail (PE rail) in the rear section modules, the
drive controllers can be connected individually to the grounding conductor system by their ground bolts. Obey the
instructions and requirements for Protective grounding [} 125].

ð The installation is completed. In the next step, connect the drive controllers and supply modules.
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11 Connection
The following chapters describe the connection of the supply modules and drive controllers as well as the available
accessories.

11.1 Line routing
Observe the valid provisions for your machine or system, e.g. IEC 60364 or EN 50110, during the installation of electrical
equipment.

11.2 Protective measures
Take the following protective measures into account.

11.2.1 Power supply
All supply modules must be connected to the same supply grid.

ATTENTION!

Damage to device due to the emission of electromagnetic interference!

If the EMC threshold limits are exceeded during the operation of a DC link connection, devices in the immediate area can be
interrupted or damaged.

▪ Take suitable measures to comply with the electromagnetic compatibility.

▪ Always route the shortest possible connections for DC links. If they are longer than 30 cm, they must be shielded.

ATTENTION!

Device damage in the event of failure of a device in the DC link group!

The failure of a drive controller or supply module in the DC link group can result in damage to additional devices.

▪ A failure must trigger the isolation of the entire DC link group from the grid.

▪ For the most comprehensive equipment protection possible, follow the recommendations for device protection.

Wiring example

The examples in the appendix (see Wiring examples [} 381]) illustrate the basic connection based on a DC link connection
with Quick DC-Link DL6B.
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11.2.2 Line fuse
All device types are intended exclusively for operation on TN networks or wye sources that supply a maximum differential
short-circuit current in accordance with the following table.

For UL-compliant operation:
All device types supplied with 480 VAC are intended solely for operation with grounded wye sources at 480/277 VAC.
For all device types with a 480 VAC supply, the supply grid must not deliver a differential short-circuit current above the
specification in the following table.

Type of supply module Max. differential short-circuit current

PS6A24, PS6A34 5000 A

PS6A44 10000 A

Tab. 101: Short circuit current rating (SCCR)

The line fuse ensures the line and overload protection in the supply module. To that end, observe the requirements
described below, which vary based on the configuration.

11.2.2.1 Line fuses

Line fuses for size 2 or 3

Every supply module in the group supplied with power must be protected against overload and short-circuit at the line
input. To do this, a safety combination consisting of overload protection and semiconductor short-circuit protection is
connected in series.

Information

The installation of short-circuit fuses is not necessary under ideal requirements and ambient conditions. However, if the
application conditions pose the risk of contaminating the drive controllers and supply modules, short-circuit fuses can
protect against damage to or failure of other devices within the DC link group.

You can use the following fuse combinations:

Size Type I1N,PU [A] Overload protection Solid state short-circuit
protection

2 PS6A24 25 EATON
Type FAZ-Z25/3

Order number 278929
Z 25 A

SIBA
Type URZ 

Art. No. 50 124 06.40 
gR 40 A

3 PS6A34 50 EATON
Type FAZ-Z50/3

Order number 278932
Z 50 A

SIBA 
Type URZ

Order number 50 140 06.80 
gR 80 A

Tab. 102: Line fuses for sz. 2 or 3

Information

To ensure problem-free operation, always comply with the recommended trigger limits and trigger characteristics of the
fuse elements.
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Line fuses for size 4

Supply modules of size 4 are equipped with internal protection against short-circuit, which is why only overload protection
is required.

You can use the following protective devices:

§ Full-range safety fuses for cable and line protection with operating class gG in accordance with IEC 60269-2-1 or time
delay triggering characteristics in accordance with DIN VDE 0636

§ Miniature circuit breakers with triggering characteristic C in accordance with EN 60898

§ Circuit breakers

Information on the recommended maximum line fuse can be found in the following table:

Size Type I1N,PU [A] Recommended max. line fuse [A]

4 PS6A44 92 100

Tab. 103: Line fuses for sz. 4

Information

To ensure problem-free operation, always comply with the recommended trigger limits and trigger characteristics of the
fuse elements.

11.2.2.2 UL-compliant line fuses

For UL compliance, use one of the following protection measures:

§ Class CC, CF, J, T, G or RK1 safety fuses

§ Circuit breakers

More detailed specifications about the appropriate fuses can be found in the following table:

Size Type Safety fuse Circuit breakers

IN [A] UN [VAC]

2 PS6A24 30 600 EATON
NZMB1-AF30-NA

Manufacturer No. 281556

3 PS6A34 60 600 EATON
NZMB1-AF60-NA

Manufacturer No. 272208

4 PS6A44 125 600 EATON
NZMB1-A125-NA 

Manufacturer no. 281562

Tab. 104: UL-compliant line fuses

Information

To ensure problem-free operation, always comply with the recommended trigger limits and trigger characteristics of the
fuse elements.



STOBER 11 | Connection
02

/2
02

4 
| 

ID
 4

42
72

8.
12

123

11.2.3 Grid connection
The grid must be switched on at all supply modules simultaneously. Simultaneously in this case means that the time
difference may be a maximum of 20 ms. This condition is generally met if you use contactors of identical design from one
manufacturer.

Provided that the grid connection is made simultaneously, a design with a contactor for each supply module is permitted.

ATTENTION!

Damage due to overload!

If the grid does not connect to all modules simultaneously in a design with a contactor for each supply module, their
charging resistors can be damaged.



11 | Connection STOBER

124

02
/2

02
4 

| 
ID

 4
42

72
8.

12

11.2.4 Residual current protective device
Depending on the function, leakage currents may occur when operating drive controllers. Leakage currents are interpreted
as residual currents by residual current protective devices (RCDs) and may therefore lead to false triggering. Depending on
the relevant power supply connections, residual currents may occur with or without a DC current component. Because of
this, you should take into consideration both the magnitude as well as the profile of the possible leakage or residual current
when selecting a suitable residual current protective device.

Leakage and residual currents with a DC current component can restrict the functionality of type A and AC residual current
protective devices.

Protect 1-phase installations using type B universal current-sensitive residual current protective devices or type F mixed
frequency-sensitive devices.

Protect 3-phase installations with type B universal current-sensitive residual current protective devices.

DANGER!

Electrical voltage! Risk of fatal injury due to electric shock!

In 3-phase installations, this product can cause a direct current in the protective grounding conductor.

▪ If a residual current protective device (RCD) or residual current monitoring device (RCM) is used for protection in case
of direct or indirect contact, only one RCD or RCM of type B is permitted on the power supply side of this product.

False triggering – Causes

Depending on stray capacitances and imbalances, leakage currents above 30 mA may occur during operation.

Undesirable false triggering occurs under the following conditions:

§ Connecting the installation to the supply voltage:
This false triggering can be remedied by using short-time delayed (super-resistant), delayed switch-off (selective)
residual current protective devices or those with increased tripping current (e.g. 300 or 500 mA).

§ Higher frequency leakage currents for long power cables under normal operating conditions:
For example, use low-capacitance cables or use an output choke.

§ High imbalances in the supply grid.
This false triggering can be rectified, e.g. using an isolating transformer.

DANGER!

Electrical voltage! Risk of fatal injury due to electric shock!

Residual current protective devices with increased tripping current as well as with short-time delayed or delayed switch-off
trigger characteristics may not meet the requirements for personal protection.

▪ Check whether the use of the selected residual current protective device is permitted in your application.
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11.2.5 Protective grounding
In order to dimension the grounding, it must be ensured that the upstream fuse is triggered in the event of a short-circuit.
Observe the requirements described below for the correct connection of the protective grounding.

11.2.5.1 Minimum cross-section of the grounding conductor

Leakage currents > 10 mA can arise in normal operation. The minimum cross-section of the protective grounding conductor
must comply with the local safety regulations for protective grounding conductors with high leakage current. To fulfill
regulations such as EN 60204-1, connect a copper conductor according to the following table:

Cross-section A
Power grid line

Minimum cross-section Amin

Grounding conductor

A ≤ 2.5 mm² 2.5 mm²

2.5 mm² < A ≤ 16 mm² A

16 mm² < A ≤ 35 mm² ≥ 16 mm²

> 35 mm² A/2

Tab. 105: Minimum cross-section of the grounding conductor

11.2.5.2 Cable shields and sheaths

In accordance with EN 60204-1, the following parts of a machine and its electrical equipment must be connected to the
grounding conductor system, but must not be used as grounding conductors:

§ Metal cable shields

§ Sheath
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11.2.5.3 Connection of the grounding conductor

Connect the grounding conductor to the supply module over terminal X10.

Additional requirements for protective equipotential bonding apply in the event of ground leakage currents > 10 mA. At
least one of the following conditions must be fulfilled:

§ The grounding conductor must have a minimum cross-section of 10 mm² Cu over its overall length

§ If the grounding conductor has a cross-section of less than 10 mm², a 2nd grounding conductor must be provided with
a cross-section of at least the same size, as at terminal X10, up to the point at which the grounding conductor exhibits
the minimum cross-section of 10 mm²

A ground bolt is mounted to the devices for connecting the 2nd grounding conductor. The ground bolt is marked with the
grounding symbol according to IEC 60417 (symbol 5019).

For correct housing ground, connect the 2nd grounding conductor to the grounding bolt of the supply module. Housing
grounds for the SI6 drive controllers in the group are connected via the PE rail of the Quick DC-Link modules to the
grounding conductor circuit.

Information

As an alternative to the grounding conductor connection over the 3rd copper rail (PE rail) in the rear section modules, the
drive controllers can be connected individually using their ground bolts to the grounding conductor system.

You will need an open-ended wrench or external hex key with a width across flats of 10 mm.

Obey a tightening torque of 4.0 Nm (35 Lb.inch).

Observe the order for assembly:

1

4

5

2
3

Fig. 44: Connection of the grounding conductor

1 M6 ground bolt

2 Contact disk

3 Cable lug

4 Washer

5 Nut

The contact disk, washer and nut are supplied with the supply module.
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11.2.5.4 UL-compliant connection of the grounding conductor

Note that UL-compliant operation requires just a single grounding conductor.

PS6A24, PS6A34: The grounding at terminal X10 of the PS6 supply module must not be used for the protective grounding of
the PS6 drive system in combination with SI6. The housing for the PS6 supply modules must be connected to the protective
grounding by the M6 ground bolt. Obey a tightening torque of 4.0 Nm (35 Lb.inch).

PS6A44: Connect the grounding conductor to the supply module via terminal X10. Obey a minimum cross-section of
10 mm² for the grounding conductor and a tightening torque of 5.5 Nm (49 Lb.inch).

Connect the drive controller housing to the DL6B modules of the DC link connection by using the two or four M5 fastening
nuts to install the drive controllers properly. The specified tightening torque for these fastening screws at the DL6B modules
is 3.5 Nm (31 Lb.inch).

The connection for the protective grounding on the housing is identified by the grounding symbol in accordance with 
IEC 60417 (symbol 5019).

You will need an open-ended wrench or external hex key with a width across flats of 10 mm.

Observe the order for assembly:

1

4

5

2
3

Fig. 45: Connection of the grounding conductor

1 M6 ground bolt

2 Contact disk

3 Cable lug

4 Washer

5 Nut

The contact disk, washer and nut are supplied with the supply module.

Obey the wiring example to ensure correct connection of the supply module (see UL-compliant connection of the supply
module [} 384]).
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11.2.6 EMC recommendations

Information

The following information on EMC-compliant installation is only a recommendation. Depending on the application, the
ambient conditions as well as the legal requirements, measures beyond these recommendations may be required.

Lay the power line, power cable and signal lines separately from each other, e.g. in separate cable ducts.

Only use shielded, low-capacitance cables as power cables.

If the brake line is carried in the power cable, it must be shielded separately.

Ground and insulate free line ends if they cannot be connected to the terminals provided for this purpose on the drive
controller, e.g. using a connecting terminal.

Connect the shield of the power cable to the grounding conductor system over a wide area and in the immediate vicinity of
the drive controller. For this purpose, use the shield contact provided for the drive controllers or suitable accessories.

The connection lines for braking resistors as well as the cores of the Quick DC-Link modules must be implemented as
twisted pairs. At line lengths of 30 cm or more, the lines also must be implemented with shielding and the shield must be
applied over a wide area in the immediate vicinity of the drive controller.

For motors with terminal boxes, connect the shield to the terminal box over large contact areas. For example, use EMC
cable glands.

Connect the shield of the control lines on one side to the reference potential of the source, e.g. the PLC or CNC.

You may use chokes to improve the EMC and protect the drive system. Power chokes are used to dampen voltage and
current peaks and reduce the load of the power feed-in of the drive controllers or supply modules. Output chokes reduce
current peaks caused by line capacity at the power output of the drive controller.

ATTENTION!

Material damage due to incorrect or uncontrolled movement!

When connecting Lean motors in combination with an output choke, a successful position and speed determination is not
ensured. This can lead to an incorrect or uncontrolled movement right from the start.

▪ If Lean motors are connected, output chokes must not be used.
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11.3 Supply module
For detailed information about the terminals and correct connection of the supply module, refer to the following chapters.

Information

For UL-compliant operation: The connections marked with PE are intended solely for the functional grounding.

11.3.1 Overview of PS6A24 and PS6A34

DC-Link

max. 1000 V/DC

High Voltage

D+

D-

-
+

-
+X11

2X10

3

4X100
5

1
2
3
4

6

1

X22 D-
D+

PE
L3
L2
L1

8X21 RB
RB

1
2

7

X23 6

5

9

10
11

1
S1

Fig. 46: Connection overview using the example of the PS6A34

Top of the device Bottom of the device Front of the device

1 Ground bolt 5 S1 operating button 9 3 diagnostic LEDs

2 X10: 400 VAC supply 6 X23: Braking resistor
temperature
monitoring

10 D+ DC link potential measuring
point

3 X11: 24 VDC supply 7 X22: DC link
connection

11 D− DC link potential measuring
point

4 X100: Status output 8 X21: Braking resistor
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11.3.2 Overview of PS6A44

L2
L1

L3
2
1

5

3
4

2
1

6

4S1

1

2

3X100

X11

X23
5 X10

Fig. 47: PS6A44 connection overview, top of device

Top of the device

1 X23: Braking resistor
temperature
monitoring

2 X11: 24 VDC supply

3 X100: Status output

4 S1 operating button

5 X10: 400 VAC supply

RB
RB

D
D
PE

X22 X216 7

Fig. 48: PS6A44 connection overview, bottom of device

Bottom of the device

6 X22: DC link
connection

7 X21: Braking resistor
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8

9
10

Fig. 49: PS6A44 connection overview, front of device

Front of the device

8 3 diagnostic LEDs

9 D+ DC link potential measuring point

10 D− DC link potential measuring point
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11.3.3 X10: 400 V supply
Terminal X10 is used to connect the supply module to the supply grid.

Conductor cross-sections for the power connection

When selecting the conductor cross-section, note the line fuse, the maximum permitted conductor cross-section of
terminal X10, the routing method and the surrounding temperature.

UL-compliant operation

PS6A24, PS6A34: The grounding at terminal X10 of the PS6 supply module must not be used for the protective grounding of
the PS6 drive system in combination with SI6. The housing for the PS6 supply modules must be connected to the protective
grounding by the M6 ground bolt. Obey a tightening torque of 4.0 Nm (35 Lb.inch).

PS6A44: Connect the grounding conductor to the supply module via terminal X10. Obey a minimum cross-section of
10 mm² for the grounding conductor and a tightening torque of 5.5 Nm (49 Lb.inch).

Connection

Size 2

Terminal Pin Designation Function

 
1 | 2 | 3 | 4

1 L1 Power supply

2 L2

3 L3

4 PE Grounding conductor

Tab. 106: X10 connection description, size 2

For the connecting wiring, obey the terminal specification SPC 16 -ST-10,16 [} 381].

Size 3

Terminal Pin Designation Function

 
1 | 2 | 3 | 4

1 L1 Power supply

2 L2

3 L3

4 PE Grounding conductor

Tab. 107: X10 connection description, size 3

For the connecting wiring, obey the terminal specification BUZ 10.16IT 180 MF [} 375].

Size 4

Terminal Pin Designation Function

1 | 2 | 3 | 4

1 L1 Power supply

2 L2

3 L3

4 Grounding conductor

Tab. 108: X10 connection description, size 4

For the connecting wiring, obey the terminal specification MKDSP 50 -17.5 [} 380].
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11.3.4 X11: 24 V supply – Control unit
The connection of 24 VDC to X11 is required for the power supply of the control unit.

ATTENTION!

Device damage due to overload!

If the 24 VDC power supply is looped to multiple devices over the terminal, the terminal may be damaged by a current that is
too high.

▪ Make sure that the current over the terminal does not exceed the value 15 A (UL: 10 A).

Technical data

Electrical data All types

U1CU 24 VDC, +20%/−15%

I1maxCU 1.5 A

Tab. 109: Control unit electrical data

Connection

Information

The device may not be connected to a DC supply grid. Instead, supply it over a local 24 VDC power supply unit.

Pin Designation Function

1 | 3

2 | 4

1 + 24 VDC supply for the control unit; bridged in the
terminal; design in accordance with EN 60204: PELV,
secondary grounded, recommended fuse protection:
max. 15 AT9

2

3 − Reference potential for +24 VDC, bridged in the
terminal4

Tab. 110: X11 connection description

For the connecting wiring, obey the terminal specification BLDF 5.08 180 SN [} 374].

Feature All sizes

Max. core/cable length 30 m

Tab. 111: Maximum core/cable length [m]

9 For UL-compliance, use of a 10 A fuse (time delay) is required. Be sure that the fuse meets certification requirements for
DC voltage in accordance with UL 248.
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11.3.5 X21: Braking resistor
Terminal X21 is available for the connection of a braking resistor.

Connection

Sizes 2 and 3

Terminal Pin Designation Function

 
1 | 2

1 RB Braking resistor connection

2 RB

Tab. 112: X21 connection description, sizes 2 and 3

For the connecting wiring, obey the terminal specification ISPC 5 -STGCL-7,62 [} 378].

Size 4

Terminal Pin Designation Function

1 | 2

1 RB Braking resistor connection

2 RB

Tab. 113: X21 connection description, size 4

For the connecting wiring, obey the terminal specification LPT 16 -10,0-ZB [} 379].

Feature All sizes

Max. core/cable length 3 m, > 30 cm shielded

Tab. 114: Maximum core/cable length [m]
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11.3.6 X22: DC link connection
Terminal X22 is available for the DC link connection of the supply module.

Information

You can check the output voltage at the marked measuring points at the front of the housing of the PS6 supply module that
are used for the DC link connection of the drive controllers.

ATTENTION!

Material damage due to overload!

Insufficient electrical strength of the voltage measuring device can cause damage to or failure of the measuring device.

▪ Make sure that the measuring device has an electrical strength of at least 1000 VDC.

Project configuration

For setting up the Quick DC-Link, note the information on project configuration (see DC link connection [} 89]).

Connection

Size 2

Terminal Pin Designation Function

 
1 | 2

1 D− DC link connection

2 D+

Tab. 115: X22 connection description, size 2

For the connecting wiring, obey the terminal specification ISPC 16 -ST-10,16 [} 379].

Size 3

Terminal Pin Designation Function

 
1 | 2

1 D− DC link connection

2 D+

Tab. 116: X22 connection description, size 3

For the connecting wiring, obey the terminal specification BUZ 10.16IT 180 MF [} 375].

Feature Sizes 2 and 3

Max. core/cable length 3 m, > 30 cm shielded

Tab. 117: Maximum core/cable length [m]
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Size 4

Terminal Pin Designation Function

1 | 2 | 3

1 Grounding conductor

2 D− DC link connection

3 D+

Tab. 118: X22 connection description, size 4

When fastening the flex cables with the screw and washer assemblies (M6), obey a tightening torque of 4.5 Nm
(40 Lb.inch).

Wiring example

The examples in the appendix (see Wiring examples [} 381]) illustrate the basic connection based on a DC link connection
with Quick DC-Link DL6B.

11.3.7 X23: Temperature monitoring of braking resistor
Connect the temperature monitoring of the braking resistor to terminal X23.

UL-compliant operation

When making the project configuration of the braking resistor, obey the notes on UL-compliant use (see UL-compliant use
[} 27]).

Connection

Pin Designation Function

 
1 | 2

1 1TP1 Temperature monitoring connection

2 1TP2

Tab. 119: X23 connection description

For the connecting wiring, obey the terminal specification FKC 2,5 -ST-5,08 [} 375].

Feature All sizes

Max. core/cable length 3 m, > 30 cm shielded

Tab. 120: Maximum core/cable length [m]
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11.3.8 X100: Status output
The relay status output of terminal X100 in conjunction with the 3 diagnostic LEDs on the front of the device provides
information about the status of the supply module.

UL-compliant operation

During UL-compliant operation, the PS6 supply module must be removed from the power supply using the Warning 1 relay.
An associated application is a notification from the temperature switch when the braking resistor is overloaded.

For information on diagnostics, see Supply module [} 267].

Technical data

Obey the technical data for X100 (see Status output [} 48]).

Connection

Terminal Pin Designation Function

 
6|5|4|3|2|1

1 Ready NO contact;
Operational readiness status;
recommended fuse protection: max. 2 ATa)

2

3 Warning 1 NO contact;
Warning 1 status: Overload;
recommended fuse protection: max. 2 ATa)

4

5 Warning 2 NO contact;
Warning 2 status: Grid phase failure;
recommended fuse protection: max. 2 ATa)

6

Tab. 121: X100 connection description

a) Use a 2 A fuse (time delay) before the 3 relays for fuse protection. For UL-compliant use, be sure that the fuse meets
certification requirements for DC voltage in accordance with UL 248.

For the connecting wiring, obey the terminal specification FMC 1,5 -ST-3,5 [} 376].

Feature All sizes

Max. core/cable length 30 m

Tab. 122: Maximum core/cable length [m]
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11.3.9 Connecting the supply module

WARNING!

Electrical voltage! Risk of fatal injury due to electric shock!

▪ Always switch off all power supply voltage before working on the devices!

▪ Note the discharge time of the DC link capacitors in the general technical data. You can only determine the absence
of voltage after this time period.

Tools and material

You will need:

§ A suitable terminal set for the supply module

§ Tool for tightening the fastening screws

Sizes 2 and 3: Requirements and connection

Bottom of the device:

ü You have a system circuit diagram describing the connection of the supply module.

1. Connect the braking resistor to terminal X21 and attach the terminal. Make sure that the conductors are twisted pairs.

2. Connect the temperature monitoring of the braking resistor to terminal X23 and attach the terminal.

Top of the device:

ü You have a system circuit diagram describing the connection of the supply module.

ü You have already connected the grounding conductor to the ground bolt of the supply module during installation.

1. Connect the power supply to terminal X10 and attach the terminal.

2. Connect the 24 VDC power supply for the control electronics to terminal X11 and attach the terminal.

3. Connect the status output to terminal X100 and attach the terminal.

Size 4: Requirements and connection

Bottom of the device:

ü You have a system circuit diagram describing the connection of the supply module.

ü You have already connected the flex cables of the Quick DC-Link module to terminal X22 of the supply module during
installation.

1. Connect the braking resistor to terminal X21. Make sure that the conductors are twisted pairs.

Top of the device:

ü You have a system circuit diagram describing the connection of the supply module.

ü You have already connected the grounding conductor to terminal X10 of the supply module during installation.

1. Connect the power supply to terminal X10.

2. Connect the 24 VDC power supply for the control electronics to terminal X11 and attach the terminal.

3. Connect the status output to terminal X100 and attach the terminal.

4. Connect the temperature monitoring of the braking resistor to terminal X23 and attach the terminal.
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11.4 Drive controllers
The following section contains detailed information about the terminals and the correct connection of the drive controller.

Information

For UL-compliant operation: The connections marked with PE are intended solely for the functional grounding.

11.4.1 Overview

12
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16

15

10
9

PE
W
V
U

D-
D+

PE
W
V
U

8
7
6
5
4
3
2
1

1
2
3
4
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1
2
3
4
5

X20B

6
5

8
7

6
5

8
7

-
+

-
+

-
+

-
+ X20A

X22

X2A

X2B

X300

X4A

X4B

4 X12

2X11

3

5

6
7

X103

X101

X201

X200

1

20

19

18

17

X700

X9

1

8S1

Fig. 50: Connection overview using the example of the SI6A162

Top of the device Bottom of the device Front of the device

1 Ground bolt 9 X4B: Encoder B (only for double-axis
controllers)

17 3 diagnostic
LEDs for communication and
safety technology

2 X11: 24 VDC supply 10 X4A: Encoder A 18 3 diagnostic LEDs for drive
controller

3 X103: DI6 – DI9 11 X20B: Motor B (only for double-axis
controllers)

19 X700: SD slot

4 X12: STO via terminals (only for
SR6 option)

12 X2B: Brake B (pin 5/6)
and temperature sensor B (pin 7/8);
(only for double-axis controllers)

20 X9: Ethernet service interface

5 X101: DI1 – DI4 13 X300: Brake 24 VDC supply

6 X201: EtherCAT Out / PROFINET 14 X2A: Brake A (pin 5/6)
and temperature sensor A (pin 7/8)

7 X200: EtherCAT In / PROFINET 15 X20A: Motor A

8 S1 operating button 16 X22: DC link connection
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11.4.2 X2A: Brake A or digital output
All device types of the SI6 drive controller can control a 24 VDC brake as standard. The brake of axis A is connected to X2A.
Alternatively, you can use X2A as a digital output (see Brake connection as digital output [} 244]).

Information

Note that brakes from other manufacturers may be connected only after consultation with STOBER.

Information

You can deactivate brake monitoring for cable breaks and undervoltage in parameter F105.

Technical data

Note the technical data of the brakes controllable at X2A (see Controllable brakes [} 74]).

Connection

Sizes 0 to 2 (single-axis controllers)

Pin Designation Function

 
5 | 6

5 1BD1 Brake actuation

6 1BD2 Reference potential

Tab. 123: X2A connection description, brake A, sizes 0 to 2 (single-axis controllers)

For the connecting wiring, obey the terminal specification BCF 3,81 180 SN [} 373].

Sizes 2 (double-axis controllers) and 3

Pin Designation Function

 
5 | 6

5 1BD1 Brake actuation

6 1BD2 Reference potential

Tab. 124: X2A connection description, brake A, sizes 2 (double-axis controllers) and 3

For the connecting wiring, obey the terminal specification BLF 5.08HC 180 SN [} 374].

Feature Use All sizes

Max. core/cable length Direct brake control 100 m, shielded

Indirect brake control or digital output 3 m

Tab. 125: Maximum core/cable length [m]
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11.4.3 X2A: Motor temperature sensor A
The motor temperature sensor of axis A is connected to terminal X2A. All device types of the SI6 drive controller have
connections for PTC thermistors.

Information

Evaluation of the temperature sensor is always active. If operation without a temperature sensor is permitted, the
connections must be bridged to X2. Otherwise a fault is triggered when the device is switched on.

Information

Note that a temperature sensor does not have to be connected to terminal X2 for EnDat 3 or HIPERFACE DSL encoders. In
this case, the temperature sensor signal is transferred together with the encoder signal over connector X4.

Connection

Sizes 0 to 2 (single-axis controllers)

Pin Designation Function

 
7 | 8

7 1TP1 PTC connection

8 1TP2

Tab. 126: X2A connection description, motor temperature sensor A, sizes 0 to 2 (single-axis controller)

For the connecting wiring, obey the terminal specification BCF 3,81 180 SN [} 373].

Sizes 2 (double-axis controllers) and 3

Pin Designation Function

 
7 | 8

7 1TP1 PTC connection

8 1TP2

Tab. 127: X2A connection description, motor temperature sensor A, sizes 2 (double-axis controller) and 3

For the connecting wiring, obey the terminal specification BLF 5.08HC 180 SN [} 374].

Feature All sizes

Max. cable length 100 m, shielded

Tab. 128: Maximum cable length [m]

11.4.4 X2B: Brake B or digital output
The brake of axis B is connected to X2B for double-axis controllers. Alternatively, you can use X2B as a digital output (see
Brake connection as digital output [} 244]). The connection description of X2B matches the X2A description.
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11.4.5 X2B: Motor temperature sensor B
The motor temperature sensor of axis B is connected to X2B for double-axis controllers. Only X2A is available for single-axis
controllers. The connection description of X2B matches the X2A description.

11.4.6 X4A: Encoder A
The encoder of axis A is connected to terminal X4A.

ATTENTION!

Risk of encoder destruction!

Only encoders with a suitable input voltage range (minimum 12 VDC) may be connected to X4.

Unsuitable encoder models

The following encoder models must not be connected due to their supply voltage:

Encoder model Code according to type designation

ECI 1118 C0

EQI 1130 Q0

ECI 1319 CR

EQI 1329 QP

EQI 1331 QR

Tab. 129: Encoder models with unsuitable supply voltage range

ATTENTION!

Risk of encoder destruction!

X4 may not be plugged in or unplugged when the device is switched on!

Technical data

Note the technical data of the evaluable encoders at X4 (see Evaluable encoders [} 68]).
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Connection

EnDat 2.1/2.2 digital encoders and SSI encoders

Bush Pin Designation Function

8|7|6|5|4|3|2|1

15|14|13|12|11|10|9

1 — —

2 0 V GND Reference potential for encoder supply to pin 4

3 — —

4 U2 Encoder supply

5 Data + Differential input for DATA

6 — —

7 — —

8 Clock + Differential input for CLOCK

9 — —

10 — —

11 — —

12 — —

13 Data − Inverse differential input for DATA

14 — —

15 Clock − Inverse differential input for CLOCK

Tab. 130: X4A connection description for EnDat 2.1/2.2 digital encoders and SSI encoders
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Differential TTL and differential HTL incremental encoders (HTL via HT6 adapter)

Information

Using an HT6 adapter for level conversion from HTL signals to TTL signals, it is also possible to connect a differential HTL
incremental encoder to terminal X4. Note that, with an external power supply, the maximum level of 20 VDC for the HTL
signals may not be exceeded.

Bush Pin Designation Function

8|7|6|5|4|3|2|1

15|14|13|12|11|10|9

1 — —

2 0 V GND Reference potential for encoder supply to pin 4

3 — —

4 U2 Encoder supply

5 B + Differential input for B track

6 — —

7 N + Differential input for N track

8 A + Differential input for A track

9 — —

10 — —

11 — —

12 — —

13 B − Inverse differential input for B track

14 N − Inverse differential input for N track

15 A − Inverse differential input for A track

Tab. 131: X4A connection description for differential TTL and differential HTL incremental encoders (HTL via HT6 adapter)
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Resolver

Information

For connecting resolver cables with a 9-pin D-sub connector, such as the standard design for ED/EK synchronous servo
motors, you must use interface adapter AP6A00 (ID No. 56498) or AP6A01 (ID No. 56522, with motor temperature sensor
leads), available separately.

Socket Pin Designation Function

8|7|6|5|4|3|2|1

15|14|13|12|11|10|9

1 S4 Sin + Sin input

2 R1 Ref − Reference potential for pin 6

3 S3 Cos + Cos input

4 — —

5 — —

6 R2 Ref + Resolver excitation signal

7 — —

8 — —

9 S2 Sin − Reference potential for pin 1

10 — —

11 S1 Cos − Reference potential for pin 3

12 — —

13 — —

14 — —

15 — —

Tab. 132: X4A connection description for resolvers
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EnDat 3 and HIPERFACE DSL encoders

Socket Pin Designation Function

8|7|6|5|4|3|2|1

15|14|13|12|11|10|9

1 — —

2 P_D − Inverse EnDat 3 or HIPERFACE DSL signal (motor
temperature sensor evaluation over EnDat or DSL
communication)

3 — —

4 P_D + EnDat 3 or HIPERFACE DSL signal (motor temperature
sensor evaluation over EnDat or DSL communication)

5 — —

6 — —

7 — —

8 — —

9 — —

10 — —

11 — —

12 — —

13 — —

14 — —

15 — —

Tab. 133: X4A connection description for EnDat 3 and HIPERFACE DSL encoders

Cable requirements

Feature All sizes

Max. cable length 100 m, shielded

Tab. 134: Maximum cable length [m]

Information

To ensure proper functionality, we recommend using cables from STOBER that are matched to the complete system. If
unsuitable cables are used, we reserve the right to reject claims under the warranty.



STOBER 11 | Connection
02

/2
02

4 
| 

ID
 4

42
72

8.
12

147

11.4.6.1 HT6 interface adapter (HTL to TTL)

HT6 – HTL to TTL (15-pin to 15-pin)

Interface adapter for level conversion from HTL signals to TTL signals for connecting the encoder cable to the drive
controller.

Socket10 Pin Designation Function Pin Connector11

8|7|6|5|4|3|2|1

15|14|13|12|11|10|9

1 B + Differential input for B track 5 1|2|3|4|5|6|7|8|9

10|11|12|13|14|15

2 0 V GND Reference potential for
encoder supply to pin 4

2

3 N + Differential input for N track 7

4 U2 Encoder supply 4

5 — — —

6 A + Differential input for A track 8

7 — — —

8 — — —

9 B − Inverse differential input for
B track

13

10 N − Inverse differential input for
N track

14

11 A − Inverse differential input for
A track

15

12 — — —

13 — — —

14 — — —

15 — — —

Tab. 135: HT6 connection description for HTL differential encoder (15-pin to 15-pin)

10 View of 15-pin D-sub for connecting the encoder cable
11 View of 15-pin D-sub for connecting to terminal X4
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11.4.6.2 AP6 interface adapter (resolver)

AP6A00 – Resolver (9-pin to 15-pin)

Interface adapter for connecting the resolver cable with 9-pin D-sub connector to the drive controller.

Socket12 Pin Designation Function Pin Connector13

1 | 2 | 3 | 4 | 5 

6 | 7 | 8 | 9

1 — — — 1|2|3|4|5|6|7|8|9

10|11|12|13|14|15

2 1TP1 — —

3 S2 Sin − Reference potential for sin
input

9

4 S1 Cos − Reference potential for cos
input

11

5 R1 Ref − Reference potential for
resolver excitation signal

2

6 1TP2 — —

7 S4 Sin + Sin input 1

8 S3 Cos + Cos input 3

9 R2 Ref + Resolver excitation signal 6

Tab. 136:  AP6A00 connection description for resolver (9-pin to 15-pin)

12 View of 9-pin D-sub for connecting the SDS 4000-compatible resolver cable
13 View of 15-pin D-sub for connecting to terminal X4
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AP6A01 – Resolver and motor temperature sensor (9-pin to 15-pin)

Interface adapter with temperature sensor cores led out at the side (core length: approx. 11 cm) for connecting the resolver
cable with 9-pin D-sub connector to the drive controller.

Socket14 Pin Designation Function Pin Connector15

1 | 2 | 3 | 4 | 5 

6 | 7 | 8 | 9

1 — — — 1|2|3|4|5|6|7|8|9

10|11|12|13|14|15

2 1TP1 Motor temperature sensor
connection, if included in the
encoder cable connector;
routed out for the direct
connection to terminal X2

—

3 S2 Sin − Reference potential for sin
input

9

4 S1 Cos − Reference potential for cos
input

11

5 R1 Ref − Reference potential for
resolver excitation signal

2

6 1TP2 Motor temperature sensor
connection, if included in the
encoder cable connector;
routed out for the direct
connection to terminal X2

—

7 S4 Sin + Sin input 1

8 S3 Cos + Cos input 3

9 R2 Ref + Resolver excitation signal 6

Tab. 137: AP6A01 connection description for the resolver and motor temperature sensor (9-pin to 15-pin)

11.4.7 X4B: Encoder B
The encoder of axis B is connected to X4B for double-axis controllers. Only X4A is available for single-axis controllers. The
connection description of X4B matches the X4A description.

Information

Note that a master encoder must be connected to axis A during synchronous operation.

14 View of 9-pin D-sub for connecting the SDS 4000-compatible resolver cable
15 View of 15-pin D-sub for connecting to terminal X4
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11.4.8 X9: Ethernet service interface
X9 is used to connect the drive controller to a PC with DriveControlSuite commissioning software installed.

Connection

Socket Pin Designation Function

1|2|3|4|5|6|7|8 1 TxData+ Ethernet communication

2 TxData−

3 RecvData+

4 ─ ─

5 ─ ─

6 RecvData− Ethernet communication

7 ─ ─

8 ─ ─

Tab. 138: X9 connection description

Cable requirements

Feature All sizes

Max. cable length 100 m, shielded

Tab. 139: Maximum cable length [m]

Information

To ensure proper functionality, we recommend using cables from STOBER that are matched to the complete system. If
unsuitable cables are used, we reserve the right to reject claims under the warranty.

It is also possible to use cables with the following specification:

Feature Design

Connector wiring Patch or crossover

Quality CAT 5e

Shielding SF/FTP, S/FTP or SF/UTP

Tab. 140: Cable requirements

Device addressing

For information on device addressing, see Device addressing [} 397].
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11.4.9 X11: 24 V supply – Control unit
The connection of 24 VDC to X11 is required for the power supply of the control unit.

ATTENTION!

Device damage due to overload!

If the 24 VDC power supply is looped to multiple devices over the terminal, the terminal may be damaged by a current that is
too high.

▪ Make sure that the current over the terminal does not exceed the value 15 A (UL: 10 A).

Technical data

Electrical data All types

U1CU 24 VDC, +20%/−15%

I1maxCU 1.5 A

Tab. 141: Control unit electrical data

Connection

Information

The device may not be connected to a DC supply grid. Instead, supply it over a local 24 VDC power supply unit.

Pin Designation Function

1 | 3

2 | 4

1 + 24 VDC supply for the control unit; bridged in the
terminal; design in accordance with EN 60204: PELV,
secondary grounded, recommended fuse protection:
max. 15 AT16

2

3 − Reference potential for +24 VDC, bridged in the
terminal4

Tab. 142: X11 connection description

For the connecting wiring, obey the terminal specification BLDF 5.08 180 SN [} 374].

Feature All sizes

Max. core/cable length 30 m

Tab. 143: Maximum core/cable length [m]

16 For UL-compliance, use of a 10 A fuse (time delay) is required. Be sure that the fuse meets certification requirements for
DC voltage in accordance with UL 248.



11 | Connection STOBER

152

02
/2

02
4 

| 
ID

 4
42

72
8.

12

11.4.10 X12 (SR6 option): Safety technology
The SR6 option adds the STO safety function to the SI6 drive controller via terminal X12.

For double-axis controllers, the STO safety function has a two-channel structure that acts upon both axes.

Information

If you would like to use the STO safety function via terminals, be sure to read the manual for the SR6 safety module.

Technical data

Obey the technical data of the safety options at X12 (see SR6 safety module [} 66]).

Connection

Terminal Pin Designation Function

 
1|2|3|4|5|6|7|8

1 STOa Input of safety channel 1

2

3 STOb Input of safety channel 2

4

5 0 V GND Reference potential for STOa

and STOb, internally bridged
with pin 7

6 STOstatus Feedback signal of safety
channels 1 and 2 for
diagnostic purposes

7 0 V GND Reference potential for STOa

and STOb, internally bridged
with pin 5

8 U1status STO supply status;
recommended fuse
protection: max. 3.15 AT17

Tab. 144: X12 connection description

For the connecting wiring, obey the terminal specification BCF 3,81 180 SN [} 373].

Feature All sizes

Max. core/cable length 30 m

Tab. 145: Maximum core/cable length [m]

17 For UL-compliance, use of a 3.15 A fuse (time delay) is required. The fuse must be certified for DC voltage in accordance
with UL 248.
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11.4.11 X20A: Motor A
The motor of axis A is connected to X20A.

UL-compliant operation

The protective grounding of motors connected to the drive controller must not be connected using terminals X20A and
X20B. The grounding conductor connection of the motor must be ensured for the respective application in accordance with
the valid electrical standards.

For the protective grounding of the motor, use the grounding conductor connection available on the motor.

Connection

Size 0

Terminal Pin Designation Function

1 | 2 | 3 | 4

1 U Motor phase U connection

2 V Motor phase V connection

3 W Motor phase W connection

4 PE Grounding conductor

Tab. 146: X20A connection description, size 0

For the connecting wiring, obey the terminal specification GFKC 2,5 -ST-7,62 [} 377].

Sizes 1 and 2 (single-axis controllers)

Terminal Pin Designation Function

1 | 2 | 3 | 4

1 U Motor phase U connection

2 V Motor phase V connection

3 W Motor phase W connection

4 PE Grounding conductor

Tab. 147: X20A connection description, sizes 1 and 2 (single-axis controllers)

For the connecting wiring, obey the terminal specification SPC 5 -ST-7,62 [} 380].

Sizes 2 (double-axis controllers) and 3

Terminal Pin Designation Function

1 | 2 | 3 | 4

1 U Motor phase U connection

2 V Motor phase V connection

3 W Motor phase W connection

4 PE Grounding conductor

Tab. 148: X20A connection description, sizes 2 (double-axis controllers) and 3

For the connecting wiring, obey the terminal specification SPC 16 -ST-10,16 [} 381].
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Cable requirements

Motor type Connection Size 0 to 2 Size 3

Synchronous servo motor,
asynchronous motor

Without output choke 50 m, shielded 100 m, shielded

Synchronous servo motor,
asynchronous motor

With output choke 100 m, shielded —

Lean motor Without output choke 50 m, shieldeda) 50 m, shieldeda)

Tab. 149: Maximum cable length of the power cable [m]

a) The use of cables with a length greater than 50 m and up to maximum 100 m must be checked by STOBER for the
application.

Information

To ensure proper functionality, we recommend using cables from STOBER that are matched to the complete system. If
unsuitable cables are used, we reserve the right to reject claims under the warranty.

Shielded connection of the power cable

Note the following points for the connection of the power cable:

§ Ground the shield of the power cable on the shield contact on the drive controller intended for this.

§ Keep the exposed conductors as short as possible. All devices and circuits that are sensitive to EMC must be kept at a
distance of at least 0.3 m.

11.4.12 X20B: Motor B
The motor of axis B is connected to X20B for double-axis controllers. Only X20A is available for single-axis controllers. The
connection description of X20B matches the X20A description.



STOBER 11 | Connection
02

/2
02

4 
| 

ID
 4

42
72

8.
12

155

11.4.13 X22: DC link connection
Terminal X22 is available for the DC link connection of the drive controller.

Project configuration

For setting up the Quick DC-Link, note the information on project configuration (see DC link connection [} 89]).

Connection

Size 0

Terminal Pin Designation Function

 
1 | 2

1 D− DC link connection

2 D+

Tab. 150: X22 connection description, size 0

For the connecting wiring, obey the terminal specification ISPC 5 -STGCL-7,62 [} 378].

Sizes 1 and 2 (single-axis controllers)

Terminal Pin Designation Function

 
1 | 2

1 D− DC link connection

2 D+

Tab. 151: X22 connection description, sizes 1 and 2 (single-axis controllers)

For the connecting wiring, obey the terminal specification ISPC 16 -ST-10,16 [} 379].

Sizes 2 (double-axis controllers) and 3

Terminal Pin Designation Function

 
1 | 2

1 D− DC link connection

2 D+

Tab. 152: X22 connection description, sizes 2 (double-axis controllers) and 3

For the connecting wiring, obey the terminal specification BUZ 10.16IT 180 MF [} 375].

Feature All sizes

Max. core/cable length 3 m, > 30 cm shielded

Tab. 153: Maximum core/cable length [m]
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Wiring example

The examples in the appendix (see Wiring examples [} 381]) illustrate the basic connection based on a DC link connection
with Quick DC-Link DL6B.

11.4.14 X101: DI1 – DI4
Digital inputs 1 to 4 are available at terminal X101.

X101 for digital signals

For evaluating digital signals at X101, obey the specification for the digital inputs in the technical data of the drive controller
(see Digital inputs [} 54]).

Connection

Terminal Pin Designation Function

 
5|4|3|2|1

1 DI1 Digital inputs

2 DI2

3 DI3

4 DI4

5 0 V DGND Reference potential; not bridged with X103, pin 5

Tab. 154: X101 connection description for digital signals

For the connecting wiring, obey the terminal specification FMC 1,5 -ST-3,5 [} 376].

Feature All sizes

Max. core/cable length 30 m

Tab. 155: Maximum core/cable length [m]

X101 for encoders

If you would like to use X101 as an encoder connection, obey the technical data of the evaluable encoders at X101 (see
X101: Encoder [} 72]).

Connection

Single-ended HTL incremental encoders

Terminal Pin Designation Function

 
5|4|3|2|1

1 DI1 —

2 DI2 N track

3 DI3 A track

4 DI4 B track

5 0 V DGND Reference potential; not bridged with X103, pin 5

Tab. 156: X101 connection description for single-ended HTL incremental signals, axis A
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Single-ended HTL pulse/direction interface

Terminal Pin Designation Function

 
5|4|3|2|1

1 DI1 —

2 DI2 —

3 DI3 Frequency

4 DI4 Direction

5 0 V DGND Reference potential; not bridged with X103, pin 5

Tab. 157: X101 connection description for single-ended HTL pulse/direction signals, axis A

For the connecting wiring, obey the terminal specification FMC 1,5 -ST-3,5 [} 376].

Feature All sizes

Max. core/cable length 30 m

Tab. 158: Maximum core/cable length [m]

11.4.15 X103: DI6 – DI9
Digital inputs 6 to 9 are available at terminal X103.

X103 for digital signals

For the evaluation of digital signals at X103, obey the technical data of the drive controller (see Digital inputs [} 54]).

Connection

Terminal Pin Designation Function

 
5|4|3|2|1

1 DI6 Digital inputs

2 DI7

3 DI8

4 DI9

5 0 V DGND Reference potential; not bridged with X101, pin 5

Tab. 159: X103 connection description for digital signals

For the connecting wiring, obey the terminal specification FMC 1,5 -ST-3,5 [} 376].

Feature All sizes

Max. core/cable length 30 m

Tab. 160: Maximum core/cable length [m]
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X103 for encoders

If you would like to use X103 as an encoder connection, obey the technical data of the evaluable encoders at X103 (see
X103: Encoder [} 73]).

Connection

Information

Note that a master encoder must be connected to X101 during synchronous operation.

Single-ended HTL incremental encoders

Terminal Pin Designation Function

5|4|3|2|1

1 DI6 —

2 DI7 N track

3 DI8 A track

4 DI9 B track

5 0 V DGND Reference potential; not bridged with X101, pin 5

Tab. 161: X103 connection description for single-ended HTL incremental signals, axis B

Single-ended HTL pulse/direction interface

Terminal Pin Designation Function

 
5|4|3|2|1

1 DI6 —

2 DI7 —

3 DI8 Frequency

4 DI9 Direction

5 0 V DGND Reference potential; not bridged with X101, pin 5

Tab. 162: X103 connection description for single-ended HTL pulse/direction signals, axis B

For the connecting wiring, obey the terminal specification FMC 1,5 -ST-3,5 [} 376].

Feature All sizes

Max. core/cable length 30 m

Tab. 163: Maximum core/cable length [m]
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11.4.16 X200, X201: EtherCAT
The drive controllers have both RJ-45 sockets X200 and X201. The sockets are located on top of the device. The associated
pin assignment and color coding correspond to the EIA/TIA-T568B standard.

Connection

X200 is to be connected as an input with the cable coming from the EtherCAT master. X201 is to be connected as an output
with any subsequent EtherCAT nodes.

Socket Pin Designation Function

1|2| ... |7|8 1 Tx+ Communication

2 Tx−

3 Rx+

4 — —

5 — —

6 Rx− Communication

7 — —

8 — —

Tab. 164: X200 and X201 connection description

Cable requirements

Information

To ensure proper functionality, we recommend using cables from STOBER that are matched to the complete system. If
unsuitable cables are used, we reserve the right to reject claims under the warranty.

STOBER provides ready-made cables for the EtherCAT connection. It is also possible to use cables with the following
specification:

Ethernet patch cables or crossover cables meeting the CAT 5e quality level are the ideal cables. The Fast Ethernet
technology allows a maximum cable length of 100 m between two nodes.

Information

Ensure that you only use shielded cables with an SF/FTP, S/FTP or SF/UTP design.

Device addressing and fieldbus connection

For information on device addressing, see Device addressing [} 397].

Detailed information about the fieldbus connection can be found in the corresponding manual for communication with
EtherCAT.
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11.4.17 X200, X201: PROFINET
In order to be able to connect the drive controllers to other PROFINET nodes, an integrated switch with both X200 and X201
RJ-45 sockets is provided. The sockets are located on top of the device. The associated pin assignment and color coding
correspond to the EIA/TIA-T568B standard.

Connection

Connect X200 or X201 with the IO controller and the remaining connection with the next drive controller.

Socket Pin Designation Function

1|2| ... |7|8 1 Tx+ Communication

2 Tx−

3 Rx+

4 — —

5 — —

6 Rx− Communication

7 — —

8 — —

Tab. 165: X200 and X201 connection description

Cable requirements

The connections between the nodes of a PROFINET network generally consist of symmetrical, shielded copper cables
twisted in pairs (shielded twisted pair, CAT 5e quality level). Fiber-optic cables are also a possible means of transmission.

Signals are transmitted according to the 100BASE TX method, i.e. with a transfer rate of 100 Mbps at a frequency of
125 MHz. A maximum of 1440 bytes can be transferred per frame. The maximum cable length is 100 m.

PROFINET cables exist in different versions that are tailored to different application scenarios and ambient conditions.

We recommend using the cables and plug connectors specified in the PROFINET installation guidelines. They are adjusted
for use in automation technology with regard to usage, resistance, EMC properties and color coding.

There are type A, B and C cables, differentiated by installation type:

§ Type A
4-wire shielded copper cable for fixed installation

§ Type B
4-wire shielded copper cable for flexible installation

§ Type C
4-wire shielded copper cable for constant movements

Device addressing and fieldbus connection

For information on device addressing, see Device addressing [} 397].

Detailed information about the fieldbus connection can be found in the corresponding manual for communication with
PROFINET.
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11.4.18 X300: 24 V supply – Brakes or digital outputs
X300 is used to supply the brakes and digital outputs.

ATTENTION!

Device damage due to overload!

If the 24 VDC power supply is looped to multiple devices over the terminal, the terminal may be damaged by a current that is
too high.

▪ Make sure that the current over the terminal does not exceed the value 15 A (UL: 10 A).

Technical data

Electrical data Single-axis controller Double-axis controller

U1 +24 VDC, +20%

I1max 5 A 5 A

Tab. 166: X300 electrical data – Supply of brakes and digital outputs

Connection

Pin Designation Function

1 | 3

 
2 | 4

1 + 24 VDC supply for the brakes or outputs; bridged in the
terminal; design in accordance with EN 60204-1:
PELV, secondary grounded, recommended fuse
protection: max. 15 AT18

2

3 − Reference potential for supply voltage

4

Tab. 167: X300 connection description

For the connecting wiring, obey the terminal specification BLDF 5.08 180 SN [} 374].

Feature All sizes

Max. core/cable length 30 m

Tab. 168: Maximum core/cable length [m]

18 For UL-compliance, use of a 10 A fuse (time delay) is required. Make sure that the fuse meets certification requirements
for DC voltage in accordance with UL 248.
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11.4.19 X700: SD slot
The SD slot is used for data backup in case of service. SD and SDHC cards with storage capacity from 128 MB to 32 GB are
supported. SDHC cards with a storage capacity of 64 GB can be used only if they have been first reformatted to max. 32 GB
(FAT32). Since higher capacities increase the controller starting time, STOBER recommends the use of cards with a storage
capacity from 2 to 4 GB.

Information

The drive controller has internal configuration memory and can therefore be operated without an inserted SD card. In the
DriveControlSuite commissioning software, the action Save values always saves to both the internal configuration memory
and the inserted SD card. Back up your configuration to an SD card after completing commissioning in order to allow
transfer of the configuration to the replacement drive controller in case of service. When the replacement drive controller
is switched on, the data is loaded with priority given to the inserted SD card. To make a non-volatile back-up in the internal
configuration memory, you must run the action Save values in parameter A00.

11.4.20 Connecting a drive controller

WARNING!

Electrical voltage! Risk of fatal injury due to electric shock!

▪ Always switch off all power supply voltage before working on the devices!

▪ Note the discharge time of the DC link capacitors in the general technical data. You can only determine the absence
of voltage after this time period.

Tools and material

You will need:

§ A suitable terminal set for the drive controller

§ Tool for tightening the fastening screws

Requirements and connection

Bottom of the device:

ü You have a system circuit diagram describing the connection of the drive controller.

1. In order to connect the motor temperature sensor, the control of the brake and the motor itself to the drive
controller, wire the cores of the power cables with terminals X2A and X20A.

2. Attach the power cable with the shield clamp to the shield contact of terminal X20A.



STOBER 11 | Connection
02

/2
02

4 
| 

ID
 4

42
72

8.
12

163

3. Attach terminals X20A and X2A and tighten the screws of X20A.

X2
X20

4. Optional: Connect the supply voltage for the brakes to terminal X300 and attach it.

5. For double-axis controllers: Repeat steps 2 to 4 for the terminals X2B and X20B.

6. Optional: Connect an encoder to terminal X4A.

7. Optional for double-axis controllers: Connect an encoder to terminal X4B.

Top of the device:

ü There is a circuit diagram of the system that describes the connection of the drive controller.

1. Connect the 24 VDC power supply for the control electronics to terminal X11 and attach the terminal.

2. If you use the STO safety function, connect it as follows:

2.1. SR6 option: Connect terminal X12 according to your safety configuration and attach the terminal.

2.2. SY6 option: In order to be able to identify the safety module in the FSoE network, you must transfer its unique
address in the FSoE network to the drive controller using the DIP switches.

2.3. SU6 option: In order to be able to identify the safety module in the PROFIsafe network, you must transfer its
unique address in the PROFIsafe network to the drive controller using the DIP switches.

3. Optional: Connect the digital inputs to terminals X101 and X103 and attach the terminals.

4. Connect the fieldbus to the sockets X200 and X201.

Examples can be found in the appendix (see Wiring examples [} 381])
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11.5 Braking resistor with temperature monitoring

WARNING!

Risk of burns! Fire hazard! Material damage!

Chokes and braking resistors can heat up to over 100 °C under permitted operating conditions.

▪ Take protective measures against accidental and intentional contact with the choke or braking resistor.

▪ Make sure that no flammable material is in the vicinity of the choke or braking resistor.

▪ Note the specified minimum clearances for installation.

WARNING!

Fire hazard due to overheating!

Using chokes or braking resistors outside of the nominal data (cable length, current, frequency, etc.) can cause them to
overheat.

▪ Always comply with the maximum nominal data when operating the chokes and braking resistors.

Information

The temperature switch reports a resistor overload. The evaluation in the form of a warning or line-side shutdown of the
energy supply must take place separately, e.g. using the PS6 supply module. Observe the wiring example for the supply
module to ensure UL-compliant operation (see UL-compliant connection of the supply module [} 384]).

Housing grounding of the braking resistor

When grounding the housing of the braking resistor, obey the information on how to connect the grounding conductor
correctly (see Connection of the grounding conductor [} 126]).
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11.5.1 KWADQU connection description
The flat resistor has a gray and white core for connecting the braking resistor to the supply module as well as two blue
cores for connecting the temperature switch.

1 2/3 4/5

Fig. 51: KWADQU connection overview

No. Core color Function

1 — Grounding conductor

2 BU 1TP1 temperature monitoring supply module connection: X23, pin 1

3 BU 1TP2 temperature monitoring supply module connection: X23, pin 2

4 GY RB braking resistor supply module connection: X21, pin 1

5 WH RB braking resistor supply module connection: X21, pin 2

Tab. 169: KWADQU connection description

11.5.2 FZZMQU connection description
The internal connections of the tubular fixed resistor are wired to terminals with heat-resistant, silicone-insulated strands
of wire. Also ensure a heat-resistant and sufficiently surge-proof design for the connection!

42

1

3 5

Fig. 52: FZZMQU connection overview

No. Function

1 Grounding conductor

2 RB braking resistor supply module connection: X21, pin 1

3 RB braking resistor supply module connection: X21, pin 2

4 1TP1 temperature monitoring supply module connection: X23, pin 1

5 1TP2 temperature monitoring supply module connection: X23, pin 2

Tab. 170: FZZMQU connection description

For the connecting wiring of the braking resistor, obey the terminal specification G 10/2 [} 377].

For the connecting wiring of the temperature monitoring, obey the terminal specification G 5/2 [} 376].
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11.5.3 FGFKQU connection description

4 532

1

Fig. 53: FGFKQU connection overview

No. Function

1 Grounding conductor

2 1TP1 temperature monitoring supply module connection: X23, pin 1

3 1TP2 temperature monitoring supply module connection: X23, pin 2

4 RB braking resistor supply module connection: X21, pin 1

5 RB braking resistor supply module connection: X21, pin 2

Tab. 171: FGFKQU connection description

For the connecting wiring of the braking resistor, obey the terminal specification G 10/2 [} 377].

For the connecting wiring of the temperature monitoring, obey the terminal specification G 5/2 [} 376].
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11.6 Power choke

WARNING!

Risk of burns! Fire hazard! Material damage!

Chokes and braking resistors can heat up to over 100 °C under permitted operating conditions.

▪ Take protective measures against accidental and intentional contact with the choke or braking resistor.

▪ Make sure that no flammable material is in the vicinity of the choke or braking resistor.

▪ Note the specified minimum clearances for installation.

WARNING!

Fire hazard due to overheating!

Using chokes or braking resistors outside of the nominal data (cable length, current, frequency, etc.) can cause them to
overheat.

▪ Always comply with the maximum nominal data when operating the chokes and braking resistors.

11.6.1 Connection description

Designation Function

1U1 Phase L1 supply module connection: X10, pin 1

1U2 Phase L1 network connection

1V1 Phase L2 supply module connection: X10, pin 2

1V2 Phase L2 network connection

1W1 Phase L3 supply module connection: X10, pin 3

1W2 Phase L3 network connection

PE Grounding conductor

Tab. 172: TEP power choke connection description

Choke housing grounding

When grounding the housing of the choke, obey the information on how to connect the grounding conductor correctly (see
Connection of the grounding conductor [} 126]).



11 | Connection STOBER

168

02
/2

02
4 

| 
ID

 4
42

72
8.

12

11.7 Output choke

WARNING!

Risk of burns! Fire hazard! Material damage!

Chokes and braking resistors can heat up to over 100 °C under permitted operating conditions.

▪ Take protective measures against accidental and intentional contact with the choke or braking resistor.

▪ Make sure that no flammable material is in the vicinity of the choke or braking resistor.

▪ Note the specified minimum clearances for installation.

WARNING!

Fire hazard due to overheating!

Using chokes or braking resistors outside of the nominal data (cable length, current, frequency, etc.) can cause them to
overheat.

▪ Always comply with the maximum nominal data when operating the chokes and braking resistors.

11.7.1 Connection description

Designation Function

1U1 Phase U drive controller connection: X20, pin 1

1U2 Motor phase U connection

1V1 Phase V drive controller connection: X20, pin 2

1V2 Motor phase V connection

1W1 Phase W drive controller connection: X20, pin 3

1W2 Motor phase W connection

7 Drive controller grounding conductor: X20, Pin 4

8 Power cable grounding conductor

Tab. 173: TEP output choke connection description

M

1 32 PE 1 32 PE 1 32 PE

X20

U V W PE 1U
1

1V
1

1W
1

7 1U
2

1V
2

1W
2

8

Fig. 54: TEP output choke connection example
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Shielded connection of the power cable

Note the following points for the connection of the power cable for a motor with output choke:

§ Ground the shield of the power cable over large contact areas in the immediate vicinity of the output choke, for
example with electrically conductive metal cable clips on a grounded busbar.

§ Keep the exposed conductors as short as possible. All devices and circuits that are sensitive to EMC must be kept at a
distance of at least 0.3 m.

The following graphic shows an example of the shielded connection of the power cable.

Fig. 55: Shielded connection of the power cable

Choke housing grounding

When connecting the grounding conductor, obey the requirements described (see Connection of the grounding conductor
[} 126]).

11.8 Cables
Note that the motor, cables and drive controller each have electrical properties which influence one another. Unfavorable
combinations could possibly result in impermissible voltage peaks on the motor and drive controller and increased wear as
a result.

Take into consideration the following instructions when selecting suitable cables:

§ Cable cross-sections for connection to the motor:
Note the permitted stall current I0 for the motor when making your selection.

§ Conductor cross-sections for the power connection:
Note the line fuse, the maximum permitted conductor cross-section for terminal X10, the routing method and the
surrounding temperature when making your selection.

§ Also pay attention to the trailing and torsional strength of the lines.

§ When using a motor brake, pay attention to the voltage drop in the supply voltage on the line.

Information

To ensure proper functionality, we recommend using cables from STOBER that are matched to the complete system. If
unsuitable cables are used, we reserve the right to reject claims under the warranty.

Information

Please observe the motor connection diagram that is delivered with every STOBER motor.
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11.8.1 Power cables
The synchronous servo motors and Lean motors are equipped with plug connectors as standard, while asynchronous
motors are equipped with terminal boxes.

STOBER provides suitable cables in various lengths, conductor cross-sections and connector sizes.

11.8.1.1 Connection description

Depending on the size of the motor plug connector, power cables are available in the following designs:

§ Quick lock for con.15

§ speedtec quick lock for con.23 and con.40

Information

Note the identification clips on the cores.

Motor-side connection

x

y op
en

con.23

con.40

con.15 E

1

A
B

C

5 1
2

4
35

1 2
3

4

7 68
9

10

11
12

EA B

C

1 Plug connectors
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Drive controller-side connection

53

58

100

1

2

3

5
6

7
8

3 4 52

50

1

2

3 1W1

1V1

1U1

4 PE
5
6

1BD1
1BD2

7
8

1TP1
1TP2

2 Power cable with cable shield

3 Connection to terminal X20, motor

4 Connection of terminal X2, brake

5 Connection to terminal X2, temperature sensor

Maximum cable length

Motor type Connection Size 0 to 2 Size 3

Synchronous servo motor,
asynchronous motor

Without output choke 50 m, shielded 100 m, shielded

Synchronous servo motor,
asynchronous motor

With output choke 100 m, shielded —

Lean motor Without output choke 50 m, shieldeda) 50 m, shieldeda)

Tab. 174: Maximum cable length of the power cable [m]

a) The use of cables with a length greater than 50 m and up to maximum 100 m must be checked by STOBER for the
application.
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Power cables – con.15 plug connectors

Motor
(1)

Cable
(2)

Drive controller
(3) – (5)

Motor
connection

diagram

Pin Designation Int. motor
Core color

Identification
/

Core color

Pin
X20

Pin
X2

Pin
X2

 A 1U1 BK 1 1 — —

B 1V1 BU 2 2 — —

C 1W1 RD 3 3 — —

1 1TP1 BKa) 7 — — 7

2 1TP2 WHa) 8 — — 8

3 1BD1 RD 5 — 5 —

4 1BD2 BK 6 — 6 —

5 — — — — — —

PE GNYE GNYE 4 — —

Housing Shield — — Shield
contact

— —

Tab. 175: con.15 power cable pin assignment

a) Color depends on the type of temperature sensor (PTC), which is specified on the motor nameplate.

Length x [mm] Diameter y [mm]

42 18.7

Tab. 176: con.15 connector dimensions
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Power cables – con.23 plug connectors

Motor
(1)

Cable
(2)

Drive controller
(3) – (5)

Motor
connection

diagram

Pin Designation Int. motor
Core color

Identification
/

Core color

Pin
X20

Pin
X2

Pin
X2

1 1U1 BK 1 1 — —

3 1V1 BU 2 2 — —

4 1W1 RD 3 3 — —

 A 1BD1 BK/RDa) 5 — 5 —

B 1BD2 BK 6 — 6 —

C 1TP1 BKb) 7 — — 7

D 1TP2 WHb) 8 — — 8

PE GNYE GNYE 4 — —

Housing Shield — — Shield
contact

— —

Tab. 177: con.23 power cable pin assignment

a) Color depends on the type of motor
b) Color depends on the type of temperature sensor (PTC) which is specified on the motor nameplate.

Length x [mm] Diameter y [mm]

78 26

Tab. 178: con.23 connector dimensions
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Power cables – con.40 plug connectors

Motor
(1)

Cable
(2)

Drive controller
(3) – (5)

Motor
connection

diagram

Pin Designation Int. motor
Core color

Identification
/

Core color

Pin
X20

Pin
X2

Pin
X2

U 1U1 BK 1 1 — —

V 1V1 BU 2 2 — —

W 1W1 RD 3 3 — —

+ 1BD1 RD 5 — 5 —

− 1BD2 BK 6 — 6 —

1 1TP1 BKa) 7 — — 7

2 1TP2 WHa) 8 — — 8

PE GNYE GNYE 4 — —

Housing Shield — — Shield
contact

— —

Tab. 179: con.40 power cable pin assignment

a) Color depends on the type of temperature sensor (PTC), which is specified on the motor nameplate.

Length x [mm] Diameter y [mm]

99 46

Tab. 180: con.40 connector dimensions
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11.8.2 Encoder cables
The motors are equipped with encoder systems and plug connectors as standard.

STOBER provides suitable cables in various lengths, conductor cross-sections and connector sizes.

Depending on the respective motor types, different encoder systems can be used.

11.8.2.1 EnDat 2.1/2.2 digital encoders

Suitable encoder cables are described below.

11.8.2.1.1 Connection description

Depending on the size of the motor plug connector, encoder cables are available in the following designs:

§ Quick lock for con.15

§ speedtec quick lock for con.17 and con.23

con.23

1 2 3A

con.17

con.15 op
en

x

y

AES

E

P

1

15

E
2

1

3
456

7
8

9
10

1112

2

1

3
4 5

6

7

89

10

11

12

5

1 2
3

4

7 68
9

10

11
12

A
B

C

E 5 1
2

4
3

1 Plug connectors

2 Encoder cables

 A Only con.15 and con.17: Optional Absolute Encoder Support (AES) battery module

3 D-sub X4
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Encoder cables – con.15 plug connectors

The supply voltage is buffered for EnDat 2.2 digital "EBI 1135" and "EBI 135" inductive encoders with a multi-turn function.
In this case, pin 2 and pin 3 of the motor are assigned to the U2BAT buffer battery. Note that the encoder cable must not be
connected to the encoder interface of the drive controller, but rather to the AES battery module for these encoders.

Motor
(1)

Cable
(2)

Drive controller
(3)

Connection diagram Pin Designation Core color Core color Pin
X4

1 Clock + VT YE 8

2 U2 Sense BNGN PK 12

U2BAT +
19 BU

3 — — GY 3

U2BAT −
20 WH

4 — — — —

5 Data − PK BN 13

6 Data + GY WH 5

7 — — — —

8 Clock − YE GN 15

9 — — — —

10 0 V GND WHGN BU 2

11 — — — —

12 U2 BNGN RD 4

Housing Shield — — Housing

Tab. 181: con.15 encoder cable pin assignment, EnDat 2.1/2.2 digital

Length x [mm] Diameter y [mm]

42 18.7

Tab. 182: con.15 connector dimensions

19 Only relevant for EBI encoders
20 Only relevant for EBI encoders
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Encoder cables – con.17 plug connectors

The supply voltage is buffered for EnDat 2.2 digital "EBI 1135" and "EBI 135" inductive encoders with a multi-turn function.
In this case, pin 2 and pin 3 of the motor are assigned to the U2BAT buffer battery. Note that the encoder cable must not be
connected to the encoder interface of the drive controller, but rather to the AES battery module for these encoders.

Motor
(1)

Cable
(2)

Drive controller
(3)

Connection diagram Pin Designation Core color Core color Pin
X4

1 Clock + VT YE 8

2 U2 Sense BNGN PK 12

U2BAT +
21 BU

3 — — GY 3

U2BAT −
22 WH

4 — — — —

5 Data − PK BN 13

6 Data + GY WH 5

7 — — — —

8 Clock − YE GN 15

9 — — — —

10 0 V GND WHGN BU 2

11 — — — —

12 U2 BNGN RD 4

Housing Shield — — Housing

Tab. 183: con.17 encoder cable pin assignment, EnDat 2.1/2.2 digital

Length x [mm] Diameter y [mm]

56 22

Tab. 184: con.17 connector dimensions

21 Only relevant for EBI encoders
22 Only relevant for EBI encoders
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Encoder cables – con.23 plug connectors

Motor
(1)

Cable
(2)

Drive controller
(3)

Connection diagram Pin Designation Core color Core color Pin
X4

1 Clock + VT YE 8

2 U2 Sense BNGN PK 12

3 — — — —

4 — — — —

5 Data − PK BN 13

6 Data + GY WH 5

7 — — — —

8 Clock − YE GN 15

9 — — — —

10 0 V GND WHGN BU 2

11 — — — —

12 U2 BNGN RD 4

Housing Shield — — Housing

Tab. 185: con.23 encoder cable pin assignment, EnDat 2.1/2.2 digital

Length x [mm] Diameter y [mm]

58 26

Tab. 186: con.23 plug dimensions



STOBER 11 | Connection
02

/2
02

4 
| 

ID
 4

42
72

8.
12

179

11.8.2.2 SSI encoders

Suitable encoder cables are described below.

11.8.2.2.1 Connection description

The encoder cable is available in plug connector size con.23 with a speedtec quick lock.

1 32
x

ycon.23

1

15

P2

1

3
4 5

6

7

89

10

11

12

1 Plug connectors

2 Encoder cables

3 D-sub X4

Encoder cables – con.23 plug connectors

Motor
(1)

Cable
(2)

Drive controller
(3)

Connection diagram Pin Designation Core color Core color Pin
X4

1 Clock + VT YE 8

2 U2 Sense BNGN PK 12

3 — — — —

4 — — — —

5 Data − PK BN 13

6 Data + GY WH 5

7 — — — —

8 Clock − YE GN 15

9 — — — —

10 0 V GND WHGN BU 2

11 — — — —

12 U2 BNGN RD 4

Housing Shield — — Housing

Tab. 187: con.23 encoder cable pin assignment, SSI

Length x [mm] Diameter y [mm]

58 26

Tab. 188: con.23 plug dimensions
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11.8.2.3 Differential HTL incremental encoders

Suitable encoder cables are described below.

11.8.2.3.1 Connection description

The encoder cable is available in plug connector size con.23 with a speedtec quick lock.

1 32
x

ycon.23

1

15

P2

1

3
4 5

6

7

89

10

11

12

1 Plug connectors

2 Encoder cables

3 D-sub X4

Information

For the connection of an HTL incremental encoder to terminal X4 of SC6 or SI6 drive controllers, you need the HT6 adapter
(ID No. 56665). HT6 takes over level conversion from HTL signals to TTL signals.

Encoder cables – con.23 plug connectors

Motor
(1)

Cable
(2)

Drive controller
(3)

Connection diagram Pin Designation Core color
up to size 80

Core color
size 90 or larger

Core color Pin
X4

1 B − PK BK YE 9

2 — — YE — —

3 N + BU PK PK 3

4 N − RD WH GY 10

5 A + GN GN BN 6

6 A − YE BN WH 11

7 — — — — —

8 B + GY GY GN 1

9 — — — — —

10 0 V GND WH BU BU 223

11 — — VT — —

12 U2 BN RD RD 4

Housing Shield — — — Housing

Tab. 189: con.23 encoder cable pin assignment, incremental HTL

Length x [mm] Diameter y [mm]

58 26

Tab. 190: con.23 plug dimensions

23 Pin 12 (U2 Sense) with pin 2 (0 V GND) bridged: The bridge is constructed in the cable connector that is connected to X4.
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11.8.2.4 Resolver

Suitable encoder cables are described below.

11.8.2.4.1 Connection description

Depending on the size of the motor plug connector, encoder cables are available in the following designs:

§ Quick lock for con.15

§ speedtec quick lock for con.17 and con.23

con.23

1 2

con.17

con.15

3

1

15

E

E

op
en

x

y

P2

1

3
4 5

6

7

89

10

11

12

2
1

3
456

7
8

9
10

1112

5

1 2
3

4

7 68
9

10

11
12

A
B

C

E 5 1
2

4
3

1 Plug connectors

2 Encoder cables

3 D-sub X4/adapter

Information

Note that the cores for the temperature sensor are routed in the power cable as standard. For motors that provide the
temperature sensor at the encoder connection, you need an interface adapter to lead out the temperature sensor cores for
connecting the cable to the drive controller.

Information

For connecting resolver cables with a 9-pin D-sub connector, such as the standard design for ED/EK synchronous servo
motors, you must use interface adapter AP6A00 (ID No. 56498) or AP6A01 (ID No. 56522, with motor temperature sensor
leads), available separately.
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11.8.3 One Cable Solution
The synchronous servo motors are equipped with plug connectors as standard.

A motor connection as a One Cable Solution (OCS) combined with an EnDat 3 or HIPERFACE DSL encoder requires hybrid
cables which feature encoder communication and power transmission in a shared cable.

STOBER provides suitable cables in various lengths, conductor cross-sections and connector sizes.

For applications with a cable length of up to 12.5 m, conductor cross-sections of 1.0 or 1.5 mm² and a non-moving
installation, STOBER recommends the OCS-Basic hybrid cables. For longer lengths or installation in moving cable runs (such
as a drag chain), use the OCS-Advanced hybrid cables.

Information

For connecting as a One Cable Solution, use exclusively hybrid cables from STOBER. The use of unsuitable cables or poorly
made connections can cause subsequent damage. For this reason, we reserve the right to reject claims under the warranty
in this case.

11.8.3.1 Connection description

The hybrid cables are available in plug connector size con.23 with a speedtec quick lock.

con.23

2 3 4 5

5
6 1BD2

1

PE

4 P_D+

1/L1

WH

1U1

y

x

1

2/L2
3/L3 3

2
1W1
1V1

6
5 1BD1

BU 2 P_D-

1

15

53

58

100

50

290

4

1 Plug connectors

2 Hybrid cables

3 Connection to terminal X20, motor

4 Connection of terminal X2, brake

5 D-sub X4
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Hybrid cables – con.23 plug connectors

Motor
(1)

Cable
(2)

Drive controller
(3) – (5)

Connection diagram Pin Designation Core color Core No./
Core color

Pin
X20

Pin
X2

Pin
X4

A 1U1 BK 1/L1 1 — —

B 1V1 BU 2/L2 2 — —

C 1W1 RD 3/L3 3 — —

E P_D− YE BU — — 2

F P_D shield — — — — Housing

G 1BD1 RD 5 — 5 —

H P_D+ VT WH — — 4

L 1BD2 BK 6 — 6 —

PE GNYE GNYE 4 —

Housing Shield — — Shield
contact

— —

Tab. 191: con.23 hybrid cable pin assignment

Length x [mm] Diameter y [mm]

78 26

Tab. 192: con.23 connector dimensions
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12 Operation
The S1 operating button is located on the top of the drive controller and can be used to save the configuration to the drive
controller in non-volatile memory, for example. The operating button on the supply module is used to temporarily
deactivate the fan. For supply modules of sizes 2 and 3, the button is located on the underside of the device; for supply
modules of size 4, it is located on the top of the device.

12.1 S1 operating button of the drive controller
A drive controller hardware version ≥ 50 and firmware version V 6.5-L or later (nameplate: HW ≥ 50; parameter: E52[1] ≥
50) are required for the S1 operating button.

Non-volatile memory

To save the configuration to the drive controller in non-volatile memory, press and hold the operating button for 3 seconds.

Activating and executing a function

The following additional functions are available to you:

§ 1: Temporarily deactivate the fan (A15 = 0: Inactive)

§ 2: Acknowledge faults in both axes

Information

Function 1 is used exclusively for project configuration and commissioning purposes; using it in normal or automatic mode
is not permitted.

At a power unit temperature E25[0] greater than 45 °C or a control unit temperature E25[1] greater than 60 °C, an inactive
fan is switched on automatically (A15 = 1: Active). The fan can be deactivated once. As soon as the fan is activated again
afterwards, the drive controller must be restarted to deactivate the fan. It is not possible to deactivate it again using the
S1 operating button.

To activate and execute one of these functions, proceed as follows:

1. To activate function selection, press the operating button briefly (< 3 s).

ð Both LEDs light up for approx. 1 s.

ð Then only the green LED lights up.

ð Function 1 is activated (default).

2. Then press the operating button again to change the function.

ð The LEDs on the front of the drive controller light up depending on the selected function.

3. To confirm the selected function, press and hold the operating button for 3 seconds.

ð Both LEDs flash twice.

ð The selected function is executed.

ð The LEDs then switch back to the normal operating display.



STOBER 12 | Operation
02

/2
02

4 
| 

ID
 4

42
72

8.
12

185

1
2

Fig. 56: LEDs for the functions of the S1 operating button

1 Green

2 Red

LEDs:
(Green/Red)

Conduct Function

On 1: Temporarily deactivate the fan (A15 = 0: Inactive)

Off

Off 2: Acknowledge faults in both axes

On

Tab. 193: Status of the LEDs when selecting functions via the S1 operating button

Acknowledging the function selection

If the operating button is not pressed again within 10 seconds of activating the function selection, the function selection is
exited and the LEDs switch back to the normal operating display.

12.2 S1 operating button of the supply module
The S1 operating button on the supply module is used to temporarily deactivate the fan or, by pressing the button again,
reactivate it.

Information

The function is used exclusively for project configuration and commissioning purposes; using it in normal or automatic
mode is not permitted.

If the temperature of the rectifier rises above 45 °C, an inactive fan is automatically switched on.
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13 What you should know before commissioning
The following chapters provide a quick introduction to the structure of the program interface and accompanying window
designations as well as relevant information about parameters and generally saving your project configuration.

13.1 DS6 program interface
Using the graphical interface of the DriveControlSuite commissioning software (DS6), you can project, parameterize and
commission your drive project quickly and efficiently. In case of service, you can evaluate diagnostic information such as
operating states, fault memories and fault counters of your drive project using DriveControlSuite.

Information

The program interface of DriveControlSuite is available in German, English and French. To change the language of the
program interface, select Settings > Language.

Information

The DriveControlSuite help in the menu bar can be reached via Help > Help for DS6 or via the [F1] key on your keyboard.
When you press [F1] in an area of the program, the corresponding help topic opens.

1 2

3

4

5

6 7 8
9

Fig. 57: DS6: Program interface
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No. Area Description

1 Menu bar Using the File, View, Settings and Window menus, you can open and save projects, display
and hide program windows, select the interface language and access level and change
between different windows in the workspace.

2 Toolbar The toolbar enables quick access to frequently needed functions, like opening and saving
projects and hiding and displaying windows in the program interface.

3 Project tree The project tree forms the structure of your drive project in the form of modules and drive
controllers. Select an element using the project tree first in order to edit it using the
project menu.

4 Project menu The project menu offers you various functions for editing the project, module and drive
controller. The project menu adapts to the element that you selected in the project tree.

5 Workspace The different windows which can be used to edit your drive project, such as the
configuration dialog, wizards, the parameter list or the scope analysis tool, open in the
workspace.

6 Parameter check The parameter check points out irregularities and inconsistencies that were detected in
the plausibility check of calculable parameters.

7 Messages The entries in the messages log the connection and communication status of the drive
controllers, incorrect inputs caught by the system, errors when opening a project or rule
violations in the graphical programming.

8 Variable parameter
lists

You can use variable parameter lists to compile any parameters in individual parameter
lists for a quick overview.

9 Status bar In the status bar, you can find the specifications of the software version and get additional
information about the project file, the devices and the progress of the process during
processes such as loading projects.
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13.2 Meaning of parameters
You can use parameters to adapt the function of the drive controller to your individual application. In addition, parameters
visualize the current actual values (actual velocity, actual torque, etc.) and trigger actions such as Save values, Test phase,
etc.

Interpretation of parameter identification

Parameter identification consists of the following elements, where short forms are also possible, i.e. only specifying a
coordinate or the combination of coordinate and name.

E50 V0

Coordinate Name Version

Drive controller G6

Drive controller
generation/series

13.2.1 Parameter groups
Parameters are assigned to individual groups by topic. The 6th generation of drive controllers differentiates between the
following parameter groups.

Group Topic

 A Drive controllers, communication, cycle times

B Motor

C Machine, velocity, torque/force, comparators

D Set value

E Display

F Terminals, analog and digital inputs and outputs, brake

G Technology – Part 1 (application-dependent)

H Encoder

I Motion (all motion settings)

J Motion blocks

K Control panel

L Technology – Part 2 (application-dependent)

M Profiles (application-dependent)

N Additional functions (application-dependent; e.g. extended cam control unit)

P Customer-specific parameters (programming)

Q Customer-specific parameters, instance-dependent (programming)

R Production data for the drive controller, motor, brakes, motor adapter, gear unit and geared motor

S Safety (safety technology)

T Scope

U Protection functions

Z Fault counter

Tab. 194: Parameter groups
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13.2.2 Parameter types and data types
In addition to topic-based sorting in individual groups, all parameters belong to a certain data type and parameter type. The
data type of a parameter is displayed in the parameter list, properties table. The connections between parameter types,
data types and their value range can be found in the following table.

Data type Parameter type Length Value range (decimal)

INT8 Integer or selection 1 byte (signed) -128 – 127

INT16 Integer 2 bytes (1 word, signed) -32768 – 32767

INT32 Integer or position 4 bytes (1 double word,
signed)

-2147483648 – 2147483647

BOOL Binary number 1 bit (internal: 
LSB in 1 byte)

0, 1

BYTE Binary number 1 byte (unsigned) 0 – 255

WORD Binary number 2 bytes (1 word, unsigned) 0 – 65535

DWORD Binary number or parameter
address

4 bytes (1 double word,
unsigned)

0 – 4294967295

REAL32
(single type according to
IEE754)

Floating-point number 4 bytes (1 double word,
signed)

-3.40282 × 1038 – 3.40282 ×
1038

STR8 Text 8 characters —

STR16 Text 16 characters —

STR80 Text 80 characters —

Tab. 195: Parameters: data types, parameter types, possible values

Parameter types: Use

§ Integer, floating-point number
For general computing processes
Example: Set and actual values

§ Selection
Numeric value to which a direct meaning is assigned
Example: Sources for signals or set values

§ Binary number
Bit-oriented parameter information that is collected in binary
Example: Control and status words

§ Position
Integer combined with associated units and decimal places
Example: Actual and set values of positions

§ Velocity, acceleration, deceleration, jerk
Floating-point number combined with associated units
Example: Actual and set values for velocity, acceleration, deceleration, jerk

§ Parameter address
Referencing of a parameter
Example: In F40 AO1 source, for example, E08 n-motor filtered can be parameterized

§ Text
Outputs or messages
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13.2.3 Parameter types
The following types of parameters are differentiated.

Parameter type Description Example

Simple parameters Consist of one group and one line with a
defined value.

A21 Brake resistor R: Value = 100 ohms

Array parameters Consist of a group, a line and multiple
sequential (listed) elements, which have the
same properties but different values.

A10 Access level

§ A10[0] access level: Value = Access level
via operating unit

§ A10[2] access level: Value = Access level
via CANopen and EtherCAT

§ A10[4] access level: Value = Access level
via PROFINET

Record parameters Consist of a group, a line and multiple
sequential (listed) elements, which can have
different properties and different values.

A00 Save values

§ A00[0] Start: Value = Start action

§ A00[1] Progress: Value = Display action
progress

§ A00[2] Result: Value = Display action
result

Tab. 196: Parameter types

13.2.4 Parameter structure
Every parameter has specific coordinates with the following structure.

E250 [2] .3

Axis
Group

Line

1.

Element
Bit

§ Axis (optional)
In case of multiple axes, the one to which a parameter is assigned; not applicable for global parameters 
(value range: 1 – 4).

§ Group
The thematic group to which a parameter belongs (value range: A – Z).

§ Line
Distinguishes the parameters within a parameter group (value range: 0 – 999).

§ Element (optional)
Elements of an array or record parameter (value range: 0 – 16000).

§ Bit (optional)
Selection of a single bit for complete data addressing; depends on the data type (value range: 0 – 31).
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13.2.5 Parameter visibility
The visibility of a parameter is primarily controlled by the access level you set in DriveControlSuite and by the properties
you project for the respective drive controller (e.g. hardware, firmware and application). A parameter can also be shown or
hidden depending on other parameters or settings. For example, the parameters of an additional function are only shown
as soon as you activate the relevant additional function.

Access level

The access options for the individual software parameters are ranked hierarchically and divided into individual levels. This
means that parameters can be hidden for a specific purpose and, relatedly, their configuration options can be locked
starting from a specific level.

Each parameter has one access level for read access (visibility) and one access level for write access (editability). The
following levels are present:

§ Level 0
Elementary parameters

§ Level 1
Important parameters of an application

§ Level 2
Important parameters for service with extensive diagnostic options

§ Level 3
All parameters needed for commissioning and optimizing an application

The parameter A10 Access level controls general access to parameters:

§ Over CANopen or EtherCAT (A10[2])

§ Over PROFINET (A10[3])

Information

It is not possible to write to or read the parameter hidden in DriveControlSuite during communication via fieldbus.

Hardware

Which parameters are available to you in DriveControlSuite is determined by which series you select in the configuration
dialog for the drive controller, for example, or whether you project an option module. Basically, the only parameters that
are displayed are the ones you need to parameterize the configured hardware.

Firmware

Due to the further development and updating of functions for the 6th generation of drive controllers, new parameters and
also new versions of existing parameters are continuously being implemented in DriveControlSuite and in the firmware. The
parameters are displayed in the software according to the DriveControlSuite version used and the configured firmware
version of the respective drive controller.

Applications

Applications generally differ in terms of functions and their control. For this reason, different parameters are available with
each application.
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13.3 Signal sources and process data mapping
The transmission of control signals and set values in DriveControlSuite meets the following principles.

Signal sources

Drive controllers are controlled either over a fieldbus, using mixed operation consisting of a fieldbus system and terminals
or exclusively using terminals. 
You can use the corresponding selection parameters, referred to as signal sources, to configure whether the control signals
and set values of the application are obtained over a fieldbus or using terminals.

In case of activation over a fieldbus, parameters that are selected as data sources for control signals or set values must be
part of the subsequent process data mapping. In the case of activation using terminals, the respective analog or digital
inputs are specified directly.

Process data mapping

If you are working with a fieldbus system and have selected the source parameters for control signals and set values,
configure the fieldbus-specific settings, e.g. the assignment of the process data channels for transmitting receive and
transmit process data, as the last step. The respective procedure can be found in the accompanying STOBER fieldbus
manuals.

13.4 Non-volatile memory
All project configurations, parameterizations and related changes to parameter values are in effect after transmission to the
drive controller, but are only stored in volatile memory.

Saving to a drive controller

To save the configuration in non-volatile memory on a drive controller, you have the following options:

§ Saving the configuration using the Save values wizard:
Project menu > Wizards area > Projected axis > Save values wizard: Select the Save values action

§ Saving the configuration using the parameter list:
Project menu > Parameter list area > Projected axis > Group A: Drive controller > A00 Save values: Set the parameter
A00[0] to the value 1: Active

§ Saving the configuration using the S1 operating button:
Drive controller with S1 operating button: Press the operating button for 3 seconds

Saving to all drive controllers within a project

To save the configuration in non-volatile memory on several drive controllers, you have the following options:

§ Saving the configuration using the toolbar:
Toolbar > Save values icon: Click the Save values icon

§ Saving the configuration using the Online functions window:
Project menu > Online connection button > Online functions window: Click on Save values (A00)

Information

Do not shut off the drive controller while saving. If the supply voltage to the control unit is interrupted while saving, the
drive controller will start without an executable configuration the next time it is switched on. In this case, the configuration
must be transferred to the drive controller again and stored in non-volatile memory.
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14 Commissioning
The following chapters describe how to commission your drive system using the DriveControlSuite commissioning software.

Information on system requirements and software installation can be found in the appendix (see DriveControlSuite [} 398]).

For the components of your axis model, we require one of the following two combinations as an example:

Synchronous servo motor with EnDat 2.2 digital or EnDat 3 encoder (and optional brake)

These motors are saved along with all relevant data for the project configuration in the DriveControlSuite motor database
and in the electronic nameplate. 
Upon selecting the motor from the database, such as when reading out the nameplate, all data is transferred to the
corresponding parameters. There is no need for complex parameterization of the motor, encoder and brake.

LM Lean motor without encoder (with optional brake)

These motors are stored in the motor database of the DriveControlSuite, along with all the data relevant for project
configuration. Furthermore, the motor data and the release and engaging times of the brake are part of the firmware. 
Upon selecting the desired motor from the database, all data is transmitted to the corresponding parameters. The release
and engaging times of the brake are also stored. If a brake is present, you must only activate this manually. However,
complex parameterization of the motor and brake is not necessary.

For asynchronous motors, the motor data relevant for project configuration is also taken from the motor database. All
other motor types, as well as motors from third-party manufacturers, need to have their parameters configured manually.

Make sure that the system nodes are wired and supplied with control voltage before commissioning.

Information

The commissioning process described below is particularly suitable for quick initial commissioning of your drive system with
subsequent testing of your projected axis model. Since steps or their sequence may vary depending on the application,
refer to the corresponding application manual for detailed information.

Information

Always perform the steps described below in the specified order!

Some parameters are interdependent and do not become accessible to you until you have first configured certain settings.
Follow the steps in the specified sequence so that you can finish the parameterization completely.
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14.1 Initiating the project
In order to be able to configure all drive controllers and axes of your drive system using DriveControlSuite, you must record
them as part of a project.

14.1.1 Projecting the drive controller and axis
Create a new project and project the first drive controller along with the accompanying axis.

Creating a new project

1. Start DriveControlSuite.

2. On the start screen, click Create new project.

ð The new project is created and the configuration dialog for the first drive controller opens.

ð The Drive controller button is active.

Projecting the drive controller

1. Properties tab: 
Establish the relationship between your circuit diagram and the drive controller to be projected in DriveControlSuite.
Reference: Specify the reference code (equipment code) of the drive controller.
Designation: Give the drive controller a unique name.
Version: Version your project configuration.
Description: If necessary, specify additional supporting information, such as the change history of the project
configuration.

2. Drive controller tab: 
Select the series, device type and firmware version of the drive controller.

3. Option modules tab:
Safety module: If the drive controller is part of a safety circuit, select the SR6, SU6 or SY6 safety module.

4. Device controller tab:
Device controller: Select the device controller that defines the underlying activation signals for the drive controller. 
Rx process data, Tx process data: If you control the drive controller using a fieldbus, select the fieldbus-specific receive
and send process data.
If you operate the drive controller in combination with the SY6 safety module, select EtherCAT Rx and EtherCAT Tx for
transmitting the EtherCAT process data.
If you operate the drive controller in combination with the SU6 safety module, select PROFINET Rx and PROFINET Tx
for transmitting the PROFINET process data.
If you operate the drive controller in combination with the SR6 safety module or without safety technology (SZ6), the
fieldbus connection is optional. If you do not use a fieldbus, project No transmission.

Information

Make sure that you project the correct series in the Drive controller tab. The projected series cannot be changed
afterwards.
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Projecting the axis

1. Click on Axis 1.

2. Properties tab: 
Establish the connection between your circuit diagram and the axis to be projected in DriveControlSuite.
Reference: Specify the reference code (equipment code) of the axis.
Designation: Give the axis a unique name.
Version: Version your project configuration.
Description: If necessary, specify supporting additional information such as the change history of the project
configuration.

3. Application tab: 
Select the desired control or drive-based application.

4. Motor tab: 
Select the motor category, the series and the type of motor operated using this axis. If you are working with motors
from third-party suppliers, enter the accompanying motor data at a later time.

5. Repeat steps 2 – 4 for the 2nd axis (only for double-axis controllers).

6. Confirm with OK.

14.1.2 Configuring safety technology
If the drive controller is part of a safety circuit, you must configure the safety technology in accordance with the
commissioning steps outlined in the corresponding manual in the next step (siehe Detailed information [} 429]).

14.1.3 Creating other modules and drive controllers
We recommend sorting all drive controllers of your project in DriveControlSuite either functionally by groups and
combining a group under a module, or organizing several drive controllers in corresponding modules based on their
distribution to different control cabinets.

1. Select your P1 project in the project tree > Context menu Create new module.

ð Your M2 module is created in the project tree.

2. Select your M2 module in the project tree > Context menu Create new drive controller.

ð Your T2 drive controller is created in the project tree.

3. Mark your T2 drive controller in the project tree.

4. Change to the project menu and click Project configuration.

5. Project the drive controller and specify the newly created module.

6. Repeat the steps for all other drive controllers and modules of your project.
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14.1.4 Projecting the module
Give your module a unique name, enter the reference code and, as an option, store additional information like the version
and change history of the module.

1. Select the module in the project tree and click on Project configuration in the project menu.

ð The configuration dialog for the module opens.

2. Establish the relationship between your circuit diagram and the module in DriveControlSuite.
Reference: Specify the reference code (equipment code) of the module.
Designation: Give the module a unique name.
Version: Version the module.
Description: If necessary, specify additional supporting information, such as the change history of the module.

3. Confirm with OK.

14.1.5 Projecting the project
Give your project a unique name, enter the reference code and, as an option, store additional information like the version
and change history of the project.

1. Mark the project in the project tree and click on Project configuration in the project menu.

ð The configuration dialog for the project opens.

2. Establish the relationship between your circuit diagram and the project in DriveControlSuite.
Reference: Specify the reference code (equipment code) of the project.
Designation: Give the project a unique name.
Version: Version the project.
Description: If necessary, specify additional supporting information, such as the change history of the project.

3. Confirm with OK.
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14.2 Mapping the mechanical axis model
To be able to put your real drive train with one or more drive controllers into operation, you must map your complete
mechanical environment in DriveControlSuite.

14.2.1 Parameterizing the motor
You have projected one of the following motors:

Synchronous servo motor with EnDat 2.2 digital encoder or EnDat 3 (with optional brake)

By projecting the corresponding motor, limiting values for currents and torques as well as associated temperature data are
automatically transferred to the respective parameters of the individual wizards. All additional data on the brake and
encoder is transferred at the same time.

Lean motor without encoder (with optional brake)

By projecting the corresponding motor, limiting values for currents and torques as well as associated temperature data are
automatically transferred to the respective parameters of the individual wizards. You only have to parameterize the cable
length in use. Even the brake purging and engaging times are already stored. You just have to activate the brake.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the Motor wizard.

3. B101 Cable length:
Select the cable length of the power cable in use.

4. Repeat the steps for the 2nd axis (only for double-axis controllers).

Then activate the brake.

1. Select the relevant drive controller in the project tree and click on the first projected axis in the Project menu > Wizard
area.

2. Select the Brake wizard.

3. F00 Brake:
Select 1: Active.

4. Repeat the steps for the 2nd axis (only for double-axis controllers).

Motor protection

All models of the 6th drive controller generation feature an i²t model ─ a computational model for thermal monitoring of
the motor. To activate it and set up the protective function, configure the following settings (deviating from the presets):
U10 = 2: Warning and U11 = 1.00 s. This model can be used instead of or in addition to temperature-monitored motor
protection.
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14.2.2 Parameterizing the axis model
Parameterize the setup of your drive in this order:

§ Define the axis model

§ Scale the axis

§ Parameterize the position and velocity window

§ Limit the axis (optional)

• Limit the position

• Limit the velocity, acceleration and jerk

• Limit the torque and force

Information

If you are using a double-axis controller with two projected axes, you must parameterize the axis model for each axis
individually.
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14.2.2.1 Define the axis model

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the Axis model wizard.

3. I05 Type of axis:
Define whether the axis type is rotational or translational.

3.1. If you would like to configure the units of measure and the number of decimal places individually for specifying
and displaying positions, velocities, accelerations and jerk, select 0: User defined, rotational or 1: User defined,
translational.

3.2. If the units of measure and the number of decimal places for specifying and displaying positions, velocities,
accelerations and jerk are to be fixed, select 2: Rotational or 3: Translational.

4. B26 Motor encoder:
Define the interface to which the motor encoder is connected.

5. I02 Position encoder (optional):
Define the interface to which the position encoder is connected.

6. I00 Position range:
Define whether the travel range of the axis is limited or endless (modulo).

7. If you select I00 = 1: Endless, parameterize a revolution length when you scale the axis.

Information

When you parameterize I05 Type of axis, you can either use selection 0: User defined, rotational or 1: User defined,
translational to configure units of measure and the number of decimal places for the axis model individually or use
selections 2: Rotational and 3: Translational to revert to preset values.

Selection 0: User defined, rotational and selection 1: User defined, translational let you configure the unit of measure (I09)
and the decimal places (I06) individually. Velocity, acceleration and jerk are represented as the derivative of the unit of
measure with respect to time.

Selection 2: Rotational sets the following units of measure for the axis model: position in °, velocity in rpm, acceleration in
rad/s2, jerk in rad/s3.

Selection 3: Translational sets the following units of measure for the axis model: position in mm, velocity in m/s,
acceleration in m/s2, jerk in m/s3.

Information

If you do not parameterize it differently for I02 Position encoder, B26 Motor encoder is used for position control as
standard.
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14.2.2.2 Scale the axis

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the Axis model wizard > Axis: Scaling.

3. Scale the axis by configuring the overall gear ratio between the motor and output.
To simplify this scaling for you, you are provided with the scaling calculator Conversion of positions, velocities,
accelerations, torque/force, which calculates the effects of changed motion variables on the entire system.

4. I01 Circular length:
If you have selected 1: Endless for I00 Position range, enter the revolution length.

5. I06 Decimal places position (optional):
If you have selected 0: User defined, rotational or 1: User defined, translational for I05 Type of axis, define the desired
number of decimal places.

6. I09 Measure unit (optional):
If you have selected 0: User defined, rotational or 1: User defined, translational for I05 Type of axis, define the desired
unit of measure.

7. Use the polarity to specify the direction of interpretation between the axis movement and motor movement.

Information

A change to parameter I06 moves the decimal separator for all axis-specific position values! Ideally, define I06 before
parameterizing other position values and then check them.

If the axis receives set value specifications from a controller or follows the master values of a master, the resolution of
position values directly impacts the smooth operation of the axis. Therefore, you should define a sufficient number of
decimal places appropriate for your application.

Information

Parameter I297 Maximum speed position encoder must be parameterized according to your application case. If I297 is set
too low, the permitted maximum speed is exceeded even at normal operating speeds. On the other hand, if I297 is set too
high, measuring errors of the encoder can be overlooked.

I297 depends on the following parameters: I05 Type of axis, I06 Decimal places position, I09 Measure unit as well as
I07 Distance factor numerator position and I08 Distance factor denominator position or A585 Feed constant for CiA 402. If
you have made changes to one of the parameters listed, select I297 accordingly as well.
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14.2.2.3 Parameterize the position and velocity window

Enter position limits and velocity zones for set values. To do so, parameterize boundary values for reaching a position or
velocity.

1. Select the Axis model wizard > Window position, velocity.

2. C40 Velocity window:
Parameterize a tolerance window for velocity tests.

3. I22 Target window:
Parameterize a tolerance window for position tests.

4. I87 Actual position in window time:
Parameterize how long a drive must stay in the specified position window before a corresponding status message is
output.

5. Parameterize a tolerance range for lag tests.
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14.2.2.4 Limiting the axis

If necessary, limit the movement variables for position, velocity, acceleration, jerk as well as torque/force according to the
applicable conditions for your axis model.

Limiting the position (optional)

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the Axis model wizard > Limit: Position.

3. If necessary, limit the position of your axis using a software or hardware limit switch to secure the travel range.

Limiting velocity, acceleration, jerk (optional)

The default values are designed for slow velocities without gear units. For this reason, adapt the saved values.

For example, verify the maximum velocity of the motor (B83) against the velocity of the output (I10).

1. Select the Motor wizard.

2. Determine the maximum possible motor velocity in parameter B83 v-max motor.

3. Select the Axis model wizard > Axis: Scaling > Conversion of positions, velocities, accelerations, torque/force area.

4. Velocity line: 
Enter the maximum motor velocity from B83 in the Velocity line of the Motor column and confirm with ENTER.

ð The maximum velocity of the motor is converted to the output.

5. Repeat the procedure for other limits, such as for the gear unit input speed (C11).

6. Select the Axis model wizard > Limit: Velocity, acceleration, jerk.

7. I10 Maximal speed: 
Limit the maximum velocity of the output, taking into account the determined system limits.

8. Determine the limiting values for acceleration and jerk if necessary and enter them into the associated parameters.

Limiting torque/force (optional)

The default values take into account the rated operation together with the overload reserves.

1. Select the Axis model wizard > Limit: Torque/force.

2. If the motor force must be limited, adapt the saved values as necessary.
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14.3 Transmitting and saving the configuration
In order to transmit and save the configuration to one or more drive controllers, you must connect your PC and the drive
controllers over the network.

WARNING!

Injury to persons and material damage due to axis movement!

If there is an online connection between DriveControlSuite and the drive controller, changes to the configuration can lead
to unexpected axis movements.

▪ Only change the configuration if you have visual contact with the axis.

▪ Make sure that no people or objects are within the travel range.

▪ For access via remote maintenance, there must be a communication link between you and a person on site with eye
contact to the axis.

Information

During the search, all drive controllers within the broadcast domain are found via IPv4 limited broadcast.

Requirements for finding a drive controller in the network:

▪ Network supports IPv4 limited broadcast

▪ All drive controllers and the PC are in the same subnet (broadcast domain)

Transmitting the configuration

ü The drive controllers are switched on.

1. In the project tree, select the module under which you have recorded your drive controller and click Online
connection in the project menu.

ð The Add connection dialog box opens. All drive controllers found via IPv4 limited broadcast are displayed.

2. Direct connection tab > IP address column: 
Activate the IP addresses in question and confirm your selection with OK.

ð The Online functions window opens. All drive controllers connected through the selected IP addresses are
displayed.

3. Select the drive controller to which you would like to transfer the configuration. Change the selection of transmission
type from Read to Send.

4. Change the selection Create new drive controller:
Select the configuration that you would like to transfer to the drive controller.

5. Repeat steps 3 and 4 for all other drive controllers to which you would like to transfer your configuration.

6. Online tab:
Click Establish online connections.

ð The configuration is transferred to the drive controllers.
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Saving a configuration

ü You have successfully transmitted the configuration.

1. Online functions window:
Click Save values (A00).

ð The Save values (A00) window opens.

2. Click Start action.

ð The configuration is stored on the drive controllers in non-volatile memory.

3. Close the Save values (A00) window.

Information

For the configuration to take effect on the drive controller, a restart is required when the configuration is saved on the
drive controller for the first time or when changes are made to the firmware or process data mapping.

Restarting a drive controller

ü You have stored the configuration on the drive controller in non-volatile memory.

1. Online functions window:
Click Restart (A09).

ð The Restart (A09) window opens.

2. Select which of the connected drive controllers you want to restart.

3. Click Start action.

4. Confirm the safety note with OK.

ð The Restart (A09) window closes.

ð The fieldbus communication and connection between DriveControlSuite and drive controllers are interrupted.

ð The selected drive controllers restart.

14.4 Testing the configuration
Before you continue with the parameterization, we recommend testing your projected axis model using the jog control
panel.

Check your projected axis model as well as your configured electrical and mechanical data for plausibility by transferring
your configuration to one of your drive controllers for test purposes and controlling the drive using the jog control panel
instead of using a controller.

Information

Check the suitability of the default values for your application before starting the test. If they appear too large or unsuitable
compared with the results of the scaling calculator, replace them with values that are more suitable for test operation.
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14.4.1 Activating the control panel and testing the configuration

WARNING!

Injury to persons and material damage due to axis movement!

When you activate the control panel, DriveControlSuite gives you sole control of the motions of the axis. If you are using a
controller, it no longer monitors the axis movements after the control panel is activated. The controller cannot intervene to
prevent collisions. The controller takes over control again when the control panel is deactivated, which can cause
unexpected axis movements.

▪ Do not switch to other windows when the control panel is active.

▪ Only use the control panel if you have visual contact with the axis.

▪ Make sure that no people or objects are within the travel range.

▪ For access via remote maintenance, there must be a communication link between you and a person on site with eye
contact to the axis.

ü You have successfully saved the configuration.

ü There must not be any active safety function.

ü The drive controller is switched on and connected to the network.

ü There is an online connection between DriveControlSuite and the drive controller.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the Jog control panel wizard.

3. Click Control panel on and then Enable.

ð The drive is controlled using the activated control panel.

4. Move the axis step-by-step and test the direction of motion, velocity, distances, etc. using the Jog+, Jog−, Jog step+
and Jog step− buttons.

5. Optimize your project configuration based on your test results as necessary.

6. To deactivate the control panel, click on Control panel off.

Information

Jog+ and Jog− cause a continual manual movement in the positive or negative direction. Jog step+ and Jog step- move the
axis relative to the current actual position by the increment specified in I14.

Jog+ and Jog− have a higher priority than Jog step+ and Jog step−.

14.5 Commissioning the supply module
When the power supply is switched on, the supply module switches to the Operation state after the self-test has been
successfully completed.

Observe the following information for commissioning the supply module:

§ The controller may only permit drive controller operation in the Operation state

§ The controller must stop the drive controllers at the next opportunity in the Warning 1 state

§ The controller must immediately stop the drive controllers in the Warning 2 or Fault states

For more information on diagnostics and the supply module states, see Supply module [} 267].
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15 Communication
The following options are available for communicating with the SI6 drive controller:

§ Communication between drive controller and controller

• Fieldbus

• Terminals

§ Communication between drive controller and PC for commissioning, optimization and diagnostics

• Direct connection

• Fieldbus

The DriveControlSuite project configuration and commissioning software installed on the PC is able to handle multiple
direct connections simultaneously.

15.1 Direct connection
A direct connection is a network connection in which all nodes are in the same network.

In its simplest form, a direct connection is a point-to-point cable connection between the network interface of the PC
where DriveControlSuite is installed and the network interface of the drive controller. Switches or routers can also be used
in place of a simple network cable.

The IP address required for direct connection is either assigned automatically by DriveControlSuite or using DHCP, or it is
specified manually.

Requirements

Type of direct connection Requirements

Automatic The A166 parameter in DriveControlSuite must be set to 2: DHCP + DS6
for the direct connection to be established automatically. In addition,
the network adapter used on the PC side should be set to "Obtain IP
address automatically".

Manual If the IP address of the drive controller was specified manually, the
socket of the gateway device and the network connection of the PC
must have IP addresses from the same subnet.

Tab. 197: Requirements for a direct connection

In addition, obey the requirements (see Communication requirements [} 400]).

Virtual machines

If you want to connect STOBER drive controllers to DriveControlSuite from a virtual machine, pay attention to the
configuration information (see Configuring virtual machines [} 401]).
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15.1.1 Starting a drive controller in emergency operation
If you cannot establish a network connection to the drive controller via DriveControlSuite, DriveControlSuite cannot assign
a network address to the drive controller or the drive controller is not displayed in DriveControlSuite, you can use an empty
SD card to start the drive controller in emergency operation.

If an SD card is inserted when the drive controller is started, it is started from this card. Any existing configuration in the
internal memory of the drive controller is ignored. If there is no configuration on the SD card or if it is invalid, the drive
controller starts in emergency operation. For drive controllers with firmware V 6.5-A or higher, the fixed IP address
192.168.3.2 and fixed subnet mask 255.255.255.0 are used for service interface X9 in emergency operation.

Reading out the internal configuration

If you want to read out the internal configuration, save a file with the information on the desired IP address, subnet mask
and address assignment to the SD card. The drive controller adopts these settings after reading the internal configuration
for interface X9. You can then establish a manual direct connection to the drive controller.

1. Create a text file with the file name ParaWr.cmd and the following content:
A164 = "192.168.3.2"

A165 = "255.255.255.0"

A166 = "0"

Make sure that each line, including the last, ends with a line break (CR LF).

2. Create the \command directory on the SD card.

3. Save the text file to the newly created directory on the SD card.

4. Adjust the IP address and subnet mask of your PC.

5. Establish a manual direct connection to the drive controller in DriveControlSuite.

15.2 Fieldbus
For detailed information about the fieldbus connection, refer to the corresponding manual (see Detailed information
[} 429]).
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16 Optimizing the control cascade
The following chapters describe the structure of the control cascade first as a basis, as well as the general procedure for
optimizing it. Then, you learn how you can check your control cascade based on a few parameters for nearly 80% of all
applications and, if necessary, optimize the pre-set values for your specific application case. Special cases are addressed at
the end of the chapter.

16.1 Structure of the control cascade
The control cascade triggers the appropriate electrical actuation of the motor for a requested movement. The structure of
the control cascade depends on the control mode set in B20.

The following graphic shows the control cascade using a motor with encoder in vector-controlled operation as an example.
The representation of the control cascade follows the signal course: Position controller > Velocity controller > Current
controller.

M
xset vset M/FsetPosition

controller
Velocity

controller
Current

controller

Current
measure-

ment

Load-independentLoad-dependent Load-dependent

Load-independent

Fig. 58: Structure of the control cascade

Position controller

The position controller is a P controller (proportional controller) with feedforward control. The settings for the position
controller are load-dependent.

The following applications use position control:

§ Drive Based applications for the following commands:

• MC_MoveAbsolute

• MC_MoveRelative

• MC_MoveAdditive

• MC_MoveVelocity

§ CiA 402 application in the following operating modes:

• Cyclic synchronous position mode

• Profile position mode

§ PROFIdrive application in the following application classes:

• Application class 3 (AC3)

§ Application-independent with position control in jog mode
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Velocity controller

The velocity controller is a PI controller (proportional-integral controller). The settings for the velocity controller are load-
dependent. Velocity control is always required for vector control.

Current controller

The current controller is a PID controller (proportional-integral-differential controller). The settings for the current
controller are load-independent. The current controller is always required for vector control.

16.2 General procedure
Before making changes to your control cascade, observe the following information on the general procedure for
optimization.

Defining the optimization goal

First, define the goal that you want to reach through optimization:

§ High dynamics

§ High energy efficiency

§ Positioning accuracy

§ Smooth operation

§ Minimal control deviation

§ High velocity

Some goals can only be combined under certain conditions or are mutually exclusive.

Hardware components as possible limits of optimization

An optimal drive train always consists of a coordinated system of all hardware components (gear unit, motor, encoder,
drive controller and cable). Consequently, optimization depends not only on your parameter settings, but also on the
hardware components used.

Drive controller presets

If you use components from STOBER, all data is transmitted to the corresponding parameters when reading out the
electronic nameplate or upon selection of the motor from the motor database ─ eliminating the need for complex
parameterization of the motor, encoder and brake. These default values are carefully selected and checked, and generally
deliver good results. Only change the default values when necessary, taking the following points into consideration:

1. First, record the current behavior of your drive train with a scope image.

2. Carry out the optimization of your control cascade in the opposite order of the signal course: Current controller >
velocity controller > position controller, i.e. from the motor back to the set value specification. However, do not make
adjustments to the current controller if you are using components from STOBER.

3. If adjustments are necessary, only ever change one setting and then check every change with a scope image.
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16.3 Example project
The optimization described in the following chapters is based on the following general conditions and settings.

Specified goal

High dynamics with the highest possible velocity, but without the system overshooting.

System components

§ 6th generation drive controller

§ Synchronous servo motor with absolute encoder and electronic nameplate

§ DriveControlSuite commissioning software

§ Load supplied to the motor

Application and device control

§ Drive Based application

§ Drive Based device control

16.3.1 Scope settings
For the scope image at the beginning and after each adjustment, we recommend the settings described below to be able to
compare the different results with each other.

General settings

§ Sampling time: 250 µs

§ Pre-trigger: 5%

Channels

Using the Parameter selection and the associated picklists, define the relevant parameters for the scope image.

Trigger condition

§ Simple trigger

§ Source: Parameter E15 v-motor-encoder

§ Absolute value: Yes

§ Condition: Greater

§ Edge: Yes

§ Comparison value: 5.0 rpm
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16.3.2 Jog settings
During optimization, test each change using the Jog control panel with the following settings:

§ I26 Jog control mode:

• Optimization of the velocity controller: Select 0: Velocity control to receive pure velocity control without a higher-
level position controller with the Jog+ and Jog− bit.

• Optimization of the position controller: Select 1: Position control with the Jog step+ und Jog step− bit.

§ I14 Jog step:
Define the increment.

§ I12 Jog velocity:
Define the jog velocity.

§ I13 Jog acceleration:
For the jog acceleration, select a value that is higher than the velocity by a factor of 10.

§ I45 Jog deceleration:
For the jog deceleration, select a value that is higher than the velocity by a factor of 10.

§ I18 Jog jerk:
For the jog jerk, select a value that is higher than the acceleration by a factor of 10.
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16.4 Schematic sequence
The following graphic shows the schematic sequence for optimizing the control cascade. The specific steps that are required
depend on the control mode. The information on optimization assumes the following control modes:

§ B20 = 64: SSM - vector control for synchronous servo motors

§ B20 = 2: ASM - vector control for asynchronous motors

§ B20 = 32: LM - sensorless vector control for Lean motors

I25

I20

C32

C31

C34

C30
I26 = 0!

I26 = 1!

Drive train

Synchronous servo motor,
asynchronous motor Lean motor

Fig. 59: Schematic sequence of optimization based on relevant parameters

0 Default Lean motors settings ─ Estimating the speed

1 Velocity controller ─ Defining filters for the actual velocity

2 Velocity controller ─ Defining the proportional coefficient

3 Velocity controller ─ Defining the integral coefficient

4 Position controller ─ Defining the proportional coefficient

5 Position controller ─ Defining the feedforward control of the velocity controller
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16.5 Current controller ─ Notes
The current controller settings depend exclusively on the motor type, not on the load or application.

Do not make any changes to the current controller if you are using components from STOBER!

The data of a STOBER motor is part of the DriveControlSuite motor database as well as the electronic nameplate. This data
is transferred to the respective parameters during project configuration or when reading out the nameplate. All additional
data on the brake and encoder is transferred at the same time. These settings were calibrated in the STOBER test bay and
no longer need to be adjusted.

16.6 0: Default Lean motor settings ─ Speed estimation
When using a Lean motor of the LM series, two methods are available in DriveControlSuite for determining the speed. An
observer-based process is set by default in parameter B104 that is suitable for most applications. However, the specification
of the mass inertia ratio of load to motor in parameter C30 is crucial for this process.

Effects

By specifying the mass inertia ratio, the speed determination of the model adjusts to the real conditions of the machine.

Procedure

1. Work with the default value of B104 = 0: Robust.

2. In C30, enter the mass inertia ratio of load to motor based on the estimated mass inertia at the motor shaft.

Information

Only change the setting of B104 if either the mass inertia cannot be determined or the load occurring is changing rapidly.

Information

For C30, note that a deviation up to factor 2 only has a slight influence on the dynamics. If more is still needed, you can
optimize the value through a comparison with the actual velocity I88 during acceleration and braking.
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16.7 1: Velocity controller ─ Actual velocity filters
The following graphic shows the influence of the lowpass filter time constant on the velocity controller.

vset

vact

M/Fset

 

KP

Time

Reference

Time

Lowpass filter

PI controller

Fig. 60: Velocity controller ─ Filters for the actual velocity

The lowpass filter time constant for the actual velocity of the motor encoder is defined in C34.

Effects

C34 affects the smooth operation of the motor and the dynamics that can be achieved with the drive; as C34 increases,
smooth operation rises and the dynamics drop.

Furthermore, C34 also has a direct influence on the maximum possible coefficient, since a large filter time also requires a
large downtime.

Procedure

Select a value for C34 that is large enough to minimize the measurement and quantization noise, but is as small as possible
to avoid unnecessary downtime, since this makes the system unstable and reduces dynamics.

Guide values for C34 can be found in the following table.

Encoder model Encoder interface Guide value C34 [ms]

EBI 135 EnDat 2.2 digital 0.4 – 0.6

EBI 1135 EnDat 2.2 digital 0.4 – 0.6

ECI 119 EnDat 2.2 digital 0.4 – 0.6

ECI 1118-G1 EnDat 2.1 digital 1.4 – 1.8

ECI 1118-G2 EnDat 2.2 digital 0.4 – 0.6

ECI 1119 EnDat 2.2 digital 0.4 – 0.6

ECI 1319 EnDat 2.1 digital 1.2 – 1.8

ECN 1113 EnDat 2.1 digital 0.8 – 1.2

ECN 1123 EnDat 2.2 digital 0.2 – 0.4

ECN 1313 EnDat 2.1 digital 0.8 – 1.2

ECN 1313 EnDat 2.1 sin/cos 0.2 – 0.8

ECN 1325 EnDat 2.2 digital 0.0 – 0.2

EDM 35 HIPERFACE DSL 0.4 – 0.6

EDS 35 HIPERFACE DSL 0.4 – 0.6

EKM 36 HIPERFACE DSL 0.4 – 0.6

EKS 36 HIPERFACE DSL 0.4 – 0.6
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Encoder model Encoder interface Guide value C34 [ms]

EQI 1130 EnDat 2.1 digital 1.4 – 1.8

EQI 1131 EnDat 2.2 digital, EnDat 3 0.4 – 0.6

EQI 1329 EnDat 2.1 digital 1.2 – 1.8

EQI 1331 EnDat 2.1 digital 1.2 – 1.8

EQN 425 EnDat 2.1 0.8 – 1.2

EQN 425 SSI 0.8 – 1.2

EQN 1125 EnDat 2.1 digital 0.8 – 1.2

EQN 1125 EnDat 2.1 sin/cos 0.4 – 0.8

EQN 1135 EnDat 2.2 digital 0.2 – 0.4

EQN 1325 EnDat 2.1 digital 0.8 – 1.2

EQN 1325 EnDat 2.1 sin/cos 0.2 – 0.8

EQN 1337 EnDat 2.2 digital 0.0 – 0.2

Incremental; 1024 increments/revolution HTL/TTL 2.0

Incremental; 2048 increments/revolution HTL/TTL 1.4

Incremental; 4096 increments/revolution HTL/TTL 0.8

Resolver; 2 poles Analog 1.4 – 2.0

Resolver; 4 poles Analog 1.2 – 1.8

Resolver; 6 poles Analog 1.0 – 1.6

Resolver; 8 poles Analog 0.8 – 1.4

Tab. 198: Guide values for C34

In Lean motors, the value is automatically taken from the drive controller firmware during the initial coupling of the motor
and drive controller (prerequisite: B100 is not 0: User defined).

Scope image

Requirements:

§ I26 = 0: Velocity control

§ C34 = Guide value or value taken from firmware

Parameter for the scope image:

§ E06 V-reference motor

§ E15 v-motor-encoder
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16.8 2: Velocity controller ─ Proportional coefficient
The following graphic shows the influence of the proportional coefficient on the velocity controller.

:

K I

vact

vset

M/Fset

KP

KP

Reference

Lowpass filter

Time

Time

Integral

PI controller

Fig. 61: Velocity controller ─ Proportional coefficient

The proportional coefficient KP of the velocity controller can be defined in C31.

Effects

An adjustment of the P-share always has an effect on the I-share as well. The reason for this is the following dependency:

The integral coefficient KI of the velocity controller results from the proportional coefficient KP and reset time Ti (KI = KP ÷ Ti

= C31 × C35 ÷ C32).

Procedure

1. Start with the default value for C31.

2. First, enter the value 0 ms for the reset time in C32 to deactivate the I-share initially.

3. Increase the value of C31 up to the stability limit.

4. Define the value of C31 approximately 10% below the stability limit.

Scope image

Requirements:

§ I26 = 0: Velocity control

§ C34 = Guide value or value taken from firmware

§ C32 = 0 ms

§ C31 = e.g. 10, 20, 50, 150 and 200%

Parameter for the scope image:

§ E06 V-reference motor

§ E15 v-motor-encoder
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Fig. 62: Scope ─ Proportional coefficient of the velocity controller (C31), default value

Green Set value

Brown Actual value with default value

Fig. 63: Scope ─ Proportional coefficient of the velocity controller (C31), continuous oscillations

Green Set value

Red Actual value that exhibits continuous oscillation upon reaching the stability limit
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Fig. 64: Scope ─ Proportional coefficient of the velocity controller (C31), optimized value

Green Set value

Yellow Actual value with optimized coefficient
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The zoom factor was increased for the following scope image to show overshooting based on additional values, which
devolves into continuous oscillations upon reaching the stability limit.

Fig. 65: Scope ─ Proportional coefficient of the velocity controller (C31), overshooting

Green Set value

Turquoise Actual value that shows brief overshooting

Yellow Actual value with optimized coefficient

Brown Actual value with default value

Pink Actual value that shows long overshooting with phase-out
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16.9 3: Velocity controller ─ Integral coefficient
The following graphic shows the influence of the integral coefficient on the velocity controller.

:

vset

vact

M/Fset

KP

KP

K I

PI controller

Lowpass filter

Reference
Integral

Time

Time

Fig. 66: Velocity controller ─ Integral coefficient

The integral coefficient KI of the velocity controller results from the proportional coefficient KP and reset time Ti (KI = KP ÷ Ti

= C31 × C35 ÷ C32).

Effects

Since the value of C31 was already optimized in the previous step, the integral coefficient is optimized in this step by
adjusting the reset time in C32.

Procedure

1. Start with the default value for C32.

2. Reduce the value of C32 in order to recover more quickly. In this process, note that if C32 ≤ 1 ms, the I-share is
deactivated.

3. Increase the value of C32 up to the stability limit.

4. Define the value of C32 approximately 10% above the stability limit.

Scope image

Requirements:

§ I26 = 0: Velocity control

§ C34 = Guide value or value taken from firmware

§ C31 = Already optimized value

§ C32 = e.g. 0, 5, 10 and 50 ms

Parameter for the scope image:

§ E06 V-reference motor

§ E15 v-motor-encoder
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Fig. 67: Scope ─ Integral coefficient of the velocity controller (C32)

Green Set value

Red Actual value that exhibits overshooting

Yellow Actual value with optimized coefficient

Brown Actual value with default value

Turquoise Actual value with deactivated coefficient (≤ 1)

16.10 Velocity controller ─ Summary
In summary, the following conclusions can be drawn for the optimization of the velocity controller:

§ Simple encoders must be filtered more heavily.

§ The maximum possible coefficient is lower with heavier filtering.

§ The default coefficient is sufficient in simpler applications.

§ You only require a higher coefficient in case of higher dynamics.

§ Without the integral coefficient, you do not maintain any stationary accuracy, since the set velocity is not reached.
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16.11 4: Position controller ─ Proportional coefficient
The following graphic shows the influence of the proportional coefficient on the position controller.

vset    

∆x

xset

vset

xset

xact

KP

Feedforward control

P controller

Fig. 68: Position controller ─ Proportional coefficient

The proportional coefficient KP of the position controller can be defined in I20.

Effects

A higher coefficient produces a lower following error, but the system becomes more sensitive.

Procedure

1. Start with the default value for I20.

2. Increase the value of I20 up to the stability limit.

3. Define the value of I20 about 10% below the stability limit.

Scope image

Requirements:

§ I26 = 1: Position control

§ C34 = Guide value or value taken from firmware

§ C31 = Already optimized value

§ C32 = Already optimized value

§ I20 = e.g. 10, 20, and 50

Parameter for the scope image:

§ I96 Reference position

§ I80 Current position

§ I84 Following error

§ E06 V-reference motor

§ E15 v-motor-encoder



STOBER 16 | Optimizing the control cascade
02

/2
02

4 
| 

ID
 4

42
72

8.
12

223

16.12 5: Position controller ─ Velocity controller feedforward
control

The following graphic shows the influence of the feedforward control on the position controller.

xact

xset

∆x

xset

vset

vset    

KP

P controller

Feedforward control

Fig. 69: Position controller ─ Feedforward control of the velocity controller

In case of external controller-generated or internal drive-generated feedforward control, the set velocity is also calculated
in addition to the set position. In I25, you can define how much of that is directly communicated to the velocity controller.

Effects

Feedforward control reduces the load of the position controller and reduces the following error; however, stronger
feedforward control makes the system more sensitive.

Procedure

1. Start with the default value of 95% for I25.

2. Reduce the value of I25 if the system is oscillating.

Scope image

Requirements:

§ I26 = 1: Position control

§ C34 = Guide value or value taken from firmware

§ C31 = Already optimized value

§ C32 = Already optimized value

§ I20 = Already optimized value

§ I25 = e.g. 50 and 95%

Parameter for the scope image:

§ I96 Reference position

§ I80 Current position

§ I84 Following error

§ E06 V-reference motor

§ E15 v-motor-encoder
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16.13 Position controller ─ Summary
In summary, the following conclusions can be drawn for the optimization of the position controller:

§ If the velocity controller is optimized, only small adjustments are required for the position controller.

16.14 Special cases
In the cases described below, additional parameters are relevant for optimization.

16.14.1 Current controller ─ Motor reaches saturation
Synchronous servo motors show a saturation effect at high currents.

Effects

Upon reaching the saturation limits, a higher motor current no longer generates higher field strength and it begins to
fluctuate if the current continues to increase.

Procedure

1. Carry out the action B41 Calibrate motor.

ð The electrical data of the motor is calibrated and the coefficients of the saturation characteristic are defined (B60).

2. Activate current control tracking in B59.

ð The controller coefficients are tracked according to the saturation characteristic of the motor.

Scope image

Parameter for the scope image:

§ E166 Iq-ref

§ E93 Iq

Fig. 70: Scope ─ Motor reaches saturation without tracking (B59)

Green Set current

Red Actual current
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Fig. 71: Scope ─ Motor reaches saturation with tracking (B59)

Green Set current

Red Actual current

16.14.2 Velocity controller ─ High set torque
C36 Reference torque/force low pass:

If the set torque becomes very high, such as in case of maximum utilization of the drive controller, the set torque can be
filtered using this parameter. The filter prevents the overshooting of the torque and thus the occurrence of overcurrents.
The effect of C36 is defined using C37.

16.14.3 Position controller ─ Friction or play
I23 Position controller deadband:

To prevent control oscillations due to friction or play in the mechanics, the position control can be deactivated in a narrow
range using this parameter.

16.14.4 Position controller ─ Poor resolution
C33 Lowpass reference speed:

Using this parameter, the set velocity can be smoothed if the calculation of the set or actual position is too rough due to
one of the following conditions:

§ In case of controller-based applications with poor or low quantization of the set value

§ In case of drive-based applications with poor resolution of the master encoder
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17 Brake
The following chapter describes the basic brake settings using the DriveControlSuite commissioning software.

Gravity-loaded axis with brake

Information

If you use a gravity-loaded axis with a brake, always switch off the drive using a controlled stop, e.g. quick stop. This
prevents the load from dropping until the brake is fully engaged.

For more detailed information on the application, refer to the corresponding manual (see Detailed information [} 429]).

17.1 Activating the brake
You activate the brake in parameter F00.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the Brake wizard.

3. F00 Brake:
Select 1: Active if you are operating the motor in a regulated control mode and if the torque is to be saved at the time
that the brake engages. In this case, the saved torque is restored before releasing the brakes. Select this option for
gravity-loaded axes, for example.
However, select 2: Do not save torque/force if only the motor magnetization is to be restored when the brake is
released.

4. If necessary, store the release and engaging time of the brake (see Brake release time and brake engaging time
[} 237]).
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17.2 Calibrate brake
You can calibrate the release and engaging times for brakes with unknown release and engaging times.

For more detailed information on the requirements as well as the exact procedure, see Calibrating the brake [} 239].

DANGER!

Risk of fatal injury due to gravity-loaded vertical axis!

During this action, the brakes are released and movement starts. The motor cannot generate any or can only generate
limited torque/force during this time. This can cause a gravity-loaded vertical axis to drop.

▪ Make sure that safe movement in the specified travel range is possible.

▪ Secure the area extending beyond the travel range for the case of further lowering of the gravity-loaded vertical axis.

ü The drive controller is switched on and ready to switch on (E48 = 2: Ready for switch-on).

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the Brake wizard > Test brake.

3. B306 Permitted direction for actions of the brake:
Define the permitted travel direction. Calibration only takes place in one travel direction. If both directions of rotation
are permitted, travel proceeds in the positive direction.

4. B307 Standstill window brake test:
Enter the angle of rotation that the drive evaluates as a standstill.

5. Select the Brake wizard > Calibrate brake.

6. Click Calibrate release/engaging time for brake.

ð Calibration of the brake is executed.

ð The determined times are stored in F04 and F05.

ð F96[1] indicates the progress.

ð F96[2] outputs the result of the action.

7. Afterwards, save the determined values in non-volatile memory (A00).
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17.3 Testing a functional brake
Using the brake test, check whether the brake can still apply the required holding torque or holding force.

For more information on the test and calculation of test torques, see Brake test [} 241] and Torque calculation [} 242].

DANGER!

Risk of fatal injury due to gravity-loaded vertical axis!

During this action, the closed brake is loaded with a specified test torque or a specified test force. If the test torque or test
force exceeds the holding torque or holding force of the brake, this results in movement of the axis. This can cause a
gravity-loaded vertical axis to drop.

▪ Make sure that safe movement is possible.

ü The drive controller is switched on and ready to switch on (E48 = 2: Ready for switch-on).

ü The brake is activated.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the Brake wizard > Test brake.

3. B304 Positive torque/force limit for brake test:
Enter the test torque or test force that that brake must hold in case of a positive direction of rotation.

4. B305 Negative torque/force limit for brake test:
Enter the test torque or test force that that brake must hold in case of a negative direction of rotation.

5. E65 Current maximum positive torque/force:
Make sure that the limit in the drive controller permits the value stored in B304.

6. E66 Current maximum negative torque/force:
Make sure that the limit in the drive controller permits the value stored in B305.

7. B306 Permitted direction for actions of the brake:
Define the permitted travel direction. If both directions of rotation are permitted, travel first proceeds in the positive
direction.

8. B307 Standstill window brake test:
Enter the permitted standstill window.

9. Click on Test brake.

ð The brake test is executed.

ð B300[1] indicates the progress.

ð B300[2] outputs the result of the action.
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17.4 Bedding in the brake
By bedding in the brake, any deposits on the friction surface are removed that can negatively influence the holding function
of the brake. For more information, see Bedding in the brake [} 244].

DANGER!

Risk of fatal injury due to gravity-loaded vertical axis!

During this action, the brakes are released and movement starts. The motor cannot generate any or can only generate
limited torque/force during this time. This can cause a gravity-loaded vertical axis to drop.

▪ Make sure that safe movement in the specified travel range is possible.

▪ Secure the area extending beyond the travel range for the case of further lowering of the gravity-loaded vertical axis.

ü The drive controller is switched on and ready to switch on (E48 = 2: Ready for switch-on).

ü The brake is activated.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the Brake wizard > Bend in brake.

3. B306 Permitted direction for actions of the brake:
Define the permitted travel direction. If both directions of rotation are permitted, travel first proceeds in the positive
direction.

4. B308 Number of intervals for grind:
Enter how often the brake is to engage when rotating in one direction.

5. B309 Number of cycles for grind:
Enter how often the drive is to bed in in any direction.

6. Click on Bed in brake.

ð The bedding in of the brake is executed.

ð B301[1] indicates the progress.

ð B301[2] outputs the result of the action.
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17.5 More about the brake?
The following chapters summarize the important terms and settings.

17.5.1 Direct and indirect brake connection
The SI6 drive controller provides the option of directly connecting 24 VDC brakes with a current draw of up to 2.5 A. Brakes
with a different supply voltage or higher current draw can be connected indirectly, e.g. through a contactor.

You have the following options for the connection:

§ Directly to X2A, X2B (with or without monitoring)

§ Indirectly to X2A, X2B (with or without monitoring)

You define the monitoring of the brake in parameter F105. A drive controller hardware version ≥ 100 and firmware version
V 6.5-L or later (nameplate: HW ≥ 100; parameter: E52[1] ≥ 100) are required.

17.5.2 Internal brake control
With internal brake control, the drive controller controls the brakes and the release and engaging times are taken into
account. You activate the internal brake control in parameter F00. You select the brakes in F01.

Information

To protect the holding brake, avoid engaging a brake when an axis is moving:

▪ Avoid uncontrolled stopping of a moving axis.

▪ If you would like to deactivate the enable signal for a moving axis, select A44 = 1: Active (default) so that a quick stop
is carried out with Enable-off.

▪ As a fault response, always select a quick stop (A29 = 1: Active, default) or emergency braking (U30 = 1: Active).
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17.5.2.1 Operation with 1 brake

After Enable-on, the brake releases along with the first command and remains released until one of the following events
occurs:

§ Event with fault response:

• Power unit is locked

• Quick stop (brake only engages at the end of the quick stop)

• Emergency braking

§ Enable-off

§ Quick stop signal (brake only engages at the end of the quick stop)

§ Brake is engaged at the end of the motion command (Drive Based applications: J27/J53; parameter depends on
selected operating mode):

• 1: MC_MoveAbsolute

• 2: MC_MoveRelative

• 3: MC_MoveAdditive

• 5: MC_Stop

• 6: MC_Home (requirement: I30 ≠ 5: Define home)

• 11: MC_Halt

The brake can be released for commissioning or for service work by means of a release override. This must be defined in
parameter F06 (signal: F07).

The brake can be monitored for short-circuits and cable breaks. A drive controller hardware version ≥ 100 and firmware
version V 6.5-L or later (nameplate: HW ≥ 100; parameter: E52[1] ≥ 100) are required. Monitoring can be set or deactivated
in F105.
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17.5.3 External brake control up to V 6.5-K
For the CiA 402 or PROFIdrive application, parameter F92[0] offers the option of switching from internal (automatic) brake
control through the drive controller to external brake control through a controller.

WARNING!

Injury to persons and material damage due to axis movement!

For external brake control, the brake does not engage automatically in the event of faults or Enable-off. For Enable-on or
the start of a motion, the brake is not automatically released. The external brake control is independent of the device state
and motion core through the controller.

▪ Guarantee a suitable process in the controller and take suitable measures to ensure safety.

▪ When releasing the brake, also take into account the motor-side requirements (e.g. required time for building up
magnetization in the case of asynchronous motors or for position determination in the case of Lean motors).

In parameter F06, you define the source of the digital signal that can be used to release the brakes in the Switch-on
disabled, Ready to switch on, and Switched on states. In the CiA 402 and PROFIdrive applications, F06 = 2: Parameter is
preset.

The controller can check whether the brakes are engaged or released (E201, bits 3 and 4) before set values for position and
velocity are specified.

The following table shows the correlation between parameters F92[0] and F06.

F92[0] (brake control) F06 (release override signal source) Type of brake control

0: Internal (automatic) 3: DI1 – 28: DI13 inverted Internal automatic system; release
override through terminal input
(source: E19)

1: External (plc) 3: DI1 – 28: DI13 inverted Externally through terminal input
(source: E19); no release override

0: Internal (automatic) 2: Parameter Internal automatic system; release
override through parameter (Drive
Based source: A180, bit 6; CiA 402
source: A515, bit 14; PROFIdrive
source, telegram ≠ 111: M515, bit 12)

1: External (plc) 2: Parameter Externally through parameter (CiA 402
source: A515, bit 14; PROFIdrive
source, telegram ≠ 111: M515, bit 12);
no release override

Tab. 199: Correlation between F92[0] and F06

For external brake control, bit 14 of parameter A515 is the source of F92[1] in the CiA 402 application and bit 12 of M515 in
the PROFIdrive application (prerequisite: F92[0] = 1: External (plc) and F06 = 2: Parameter).

F92[2] shows the current setting of the brake control.
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17.5.4 External brake control in V 6.5-L or later
For the CiA 402 or PROFIdrive application, parameter F108 offers the option of switching from internal (automatic) brake
control through the drive controller to external brake control through a controller.

WARNING!

Injury to persons and material damage due to axis movement!

For external brake control, the brake does not engage automatically in the event of faults or Enable-off. For Enable-on or
the start of a motion, the brake is not automatically released. The external brake control is independent of the device state
and motion core through the controller.

▪ Guarantee a suitable process in the controller and take suitable measures to ensure safety.

▪ When releasing the brake, also take into account the motor-side requirements (e.g. required time for building up
magnetization in the case of asynchronous motors or for position determination in the case of Lean motors).

The controller can check whether the brakes are engaged or released (E201, bits 3 and 4) before set values for position and
velocity are specified.

For external brake control, bit 14 of parameter A515 is the source of F101[0] in the CiA 402 application and bit 12 of M515
in the PROFIdrive application (prerequisite: F108 = 1: External (plc)).

17.5.5 Brake control based on control mode
The following chapters show the brake control depending on the control mode (B20) for one brake with internal brake
control through the drive controller.

17.5.5.1 B20 = 0 or 1

Terminal = 0

Engaged

F04

Terminal = 1

Released

F05

Terminal = 0

Engaged

t

t

StandstillF0
3

Motion

F0
2

Standstill

v

Fig. 72: Brake control for control mode B20 = 0: ASM - V/f-control or 1: ASM - V/f-slip compensated

In these control modes for asynchronous motors without a motor encoder, the axis is controlled to move within the release
time F04.

Here, F02 is the velocity of the asynchronous motor that is built up during the release time F04. F03 is the velocity starting
from which the brakes are controlled to engage.

During the release process, a set acceleration calculated from the velocity and release time takes effect (F02, F04). During
the engaging process, a set deceleration calculated from the velocity and engaging time takes effect (F03, F05).
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17.5.5.2 B20 = 2

Terminal = 0

Engaged Engaged

Terminal = 0

F05F04

Released

Terminal = 1

Standstill

Motion

Standstill

M/F

F00 = 1
F102 + F103

F00 = 2
F102

E170

Magnetization current100%

0%

I42

B27

B2
5

t

t

t

t

I

v

Fig. 73: Brake control for control mode B20 = 2: ASM - vector control

In this control mode for asynchronous motors with a motor encoder, the axis is controlled to move after the release time
F04 has expired.

In the motion block and command operating modes, you can define a wait time for the brake to engage at the end of the
motion command in parameter I42 (J27, J53). When this is done, multiple motion commands can be executed in succession
without interruption from the brake engaging.

For specification of torque/force, E170 is the currently required set torque or the currently required set force M/Fset of the
motor control (limit: E65, E66).

In F102, define a static feedforward control for torque/force for the velocity controller if you would like to set a base load
for gravity-loaded axes. Depending on the boundary conditions of the machine, it may make sense to use different settings.
For commissioning recommendations for gravity-loaded axes, see Special case of load changes when the power unit is
switched off [} 245].

With the setting F00 = 1: Active, the torque or force for the next brake release process (F103) is determined automatically
and stored in non-volatile memory. The torque or force is not saved if F00 = 2: Do not save torque/force.

F103 is determined only for steady-state control and a completely released brake (F09). F103 is determined if the actual
velocity of the motor encoder is less than the velocity window (|E15| < |C40|).

The hold magnetization B25 ensures that the motor is still supplied with current when the brake is engaged. The
magnetization is reduced as soon as the motor has come to a standstill and the wait time B27 has expired.

B25 influences the thermal machine utilization. The thermal machine utilization is reduced as B25 decreases, but the
reaction time simultaneously increases as the brakes are released.
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17.5.5.3 B20 = 3

Terminal = 0

Engaged

Terminal = 1

Released

F04 F05

Terminal = 0

Engaged

t

t

Standstill

Motion

I

100%

0%

Magnetization current

B27

B2
5

t

StandstillF0
2

F0
3

v

Fig. 74: Brake control for control mode B20 = 3: ASM - sensorless vector control

In this control mode for asynchronous motors without a motor encoder, the axis is controlled to move within the release
time F04.

Here, F02 is the velocity of the asynchronous motor that is built up during the release time F04. F03 is the velocity starting
from which the brakes are controlled to engage.

During the release process, a set acceleration calculated from the velocity and release time takes effect (F02, F04). During
the engaging process, a set deceleration calculated from the velocity and engaging time takes effect (F03, F05).

The hold magnetization B25 ensures that the motor is still supplied with current when the brake is engaged. The
magnetization is reduced as soon as the motor velocity has undershot the brake-engaging velocity F03 and the wait time
B27 has expired.

B25 influences the thermal machine utilization. The thermal machine utilization is reduced as B25 decreases, but the
reaction time simultaneously increases as the brakes are released.
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17.5.5.4 B20 = 32, 48, 64, or 70

Terminal = 0

Engaged Engaged

Terminal = 0

F05F04

Released

Terminal = 1

Standstill

Motion

Standstill

M/F

F00 = 1
F102 + F103

F00 = 2
F102

E170

I42
t

t

t

t

v

Fig. 75: Brake control for control mode B20 = 32: LM - sensorless vector control, 48: SSM-vector control incremental
encoder, 64: SSM - vector control or 70: SLM - vector control

In these control modes for synchronous servo motors or synchronous linear motors with a motor encoder or Lean motors
with sensorless vector control, the axis is controlled to move after the release time F04 has expired.

In the motion block and command operating modes, you can define a wait time for the brake to engage at the end of the
motion command in parameter I42 (J27, J53). When this is done, multiple motion commands can be executed in succession
without interruption from the brake engaging.

For specification of torque/force, E170 is the currently required set torque or the currently required set force M/Fset of the
motor control (limit: E65, E66).

In F102, define a static feedforward control for torque/force for the velocity controller if you would like to set a base load
for gravity-loaded axes. Depending on the boundary conditions of the machine, it may make sense to use different settings.
For commissioning recommendations for gravity-loaded axes, see Special case of load changes when the power unit is
switched off [} 245].

With the setting F00 = 1: Active, the torque or force for the next brake release process (F103) is determined automatically
and stored in non-volatile memory. The torque or force is not saved if F00 = 2: Do not save torque/force.

F103 is determined only for steady-state control and a completely released brake (F09). F103 is determined if the actual
velocity of the motor encoder is less than the velocity window (|E15| < |C40|).
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Commutation finding process using Wake and Shake in combination with a brake

DANGER!

Risk of fatal injury due to gravity-loaded vertical axis!

Gravity-loaded axes can sink during a commutation finding process using Wake and Shake because the brake for the
commutation finding process has to be released.

▪ Use the 48: SSM-vector control incremental encoder and 70: SLM - vector control control modes in combination with
a commutation finding process using Wake and Shake only for axes without a gravity load.

▪ For gravity-loaded axes, use motors with an absolute encoder.

For more information on commutation finding via Wake and Shake, see Commutation finding [} 396].

17.5.6 Brake release time and brake engaging time
The release time of the connected brake is defined in parameter F04 and the engaging time in parameter F05:

§ F04[0]: Release time of the brake

§ F05[0]: Engaging time of the brake

When a movement is started, the movement and status signals are delayed by the time F04 to prevent movement against a
brake that is not yet fully open.

When the brake engages, the control still remains active for the time F05 to prevent a gravity-loaded axis from sinking. For
STO, the brake engages immediately. The behavior for deactivation of the enable signal can be defined with A44 (brake
engages immediately or after a quick stop).

Motors with an electronic nameplate

In motors with an electronic nameplate, the values during initial coupling of the motor and drive controller or when the
action B06 is started are taken over from the electronic nameplate (prerequisite: B04 = 64: Active).

If the electronic nameplate contains the release time and engaging time of the brake integrated into the motor adapter
(ServoStop), then these are taken into account. The following additional setting is required for this, up to and including
firmware V 6.5-H: B28 = 1: All data.

Sources for the values from the electronic nameplate:

§ R50: nameplate release time of the motor brake

§ R51: nameplate engaging time of the motor brake

§ R67: nameplate release time of the motor adapter brake

§ R68: nameplate engaging time of the motor adapter brake
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Motors without an electronic nameplate

Depending on the connection type, you have to calculate the release time and engaging time of the brake differently.

For a direct connection of the brake, take into account a safety factor of 1.3 for the release and engaging times when
transferring the values to the drive controller.

Guide values:

§ F04 = 1.3 × t2B

§ F05 = 1.3 × t1B

For an indirect connection of the brake, e.g. through a contactor, take into account 1.2 × the switching time of the
contactor in addition to the guide value for direct connection for both the release time and engaging time.

If you do not know the release time and engaging time of the brake, you can calibrate these using the action F96.

17.5.7 Time between 2 release processes

Information

The time between two brake release processes must be at least 1 s. If this is not observed, the 2nd release process will be
delayed.

1 s

Release time (F04) Engaging time (F05)

Brake engaged (F08)

Deceleration

Release
brake

Engage
brake

Brake released (F09)

Release
brake

t

Fig. 76: Minimum time between two release processes for the brake
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17.5.8 Calibrating the brake
The release and engaging times of the brake can be calibrated using the action F96. This action is not required for motors
with an electronic nameplate because these values are taken over from the electronic nameplate during initial coupling of
the motor for the drive controller.

DANGER!

Risk of fatal injury due to gravity-loaded vertical axis!

During this action, the brakes are released and movement starts. The motor cannot generate any or can only generate
limited torque/force during this time. This can cause a gravity-loaded vertical axis to drop.

▪ Make sure that safe movement in the specified travel range is possible.

▪ Secure the area extending beyond the travel range for the case of further lowering of the gravity-loaded vertical axis.

Prerequisites

The action F96 is only available in the following control modes (B20):

§ 2: ASM - vector control

§ 3: ASM - sensorless vector control

§ 32: LM - sensorless vector control

§ 48: SSM-vector control incremental encoder

§ 64: SSM - vector control

§ 70: SLM - vector control

F96 can be carried out also for loaded axes. In this case, the velocity controller should be optimized and the load must not
be more than 2/3 of the maximum torque or force currently permitted (E65, E66).

Required parameters

Define the permitted direction of motion for calibrating the brake in parameter B306, the standstill window in parameter
B307.

The travel range with unloaded axis is approx. 2 motor revolutions (synchronous linear motors: approx. 2 m). To determine
the travel path exactly, please include the gear unit and feed in the calculation.

Sequence of the action

During the action, the axis rotates at a fixed set speed of 20 rpm (set velocity for synchronous linear motors: 2 m/min).
Initially, for a released brake, a measurement run is carried out for the duration of 1 s. Then the axis moves against the
engaging brake. After detection of the brake engaging (timeout 2 s), the axis stops. This is followed by a standstill of 2 s
(recovery phase). Then the axis moves against the releasing brake. After detection of the brake release (timeout 2 s), the
axis continues moving for 0.5 s and then stops.

The determined times are stored in F04 and F05:

§ F04[0]: Release time of the brake

§ F05[0]: Engaging time of the brake
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Saving values

For the measured values to be saved in non-volatile memory, the action A00 has to be carried out after this.

Alternatively, the action B06 can be used to retrieve the values from the electronic nameplate, provided that it contains the
brake data.

Results

After the action F96 is started, the progress can be observed in parameter F96[1], and after the action is completed, F96[2]
can be used to call up the results of calibrating.

The action F96 evaluates the measured time with the safety factor of 1.2. This means that the values entered in F04 and
F05 are 1.2 times greater than the actually measured values.
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17.5.9 Brake test
The action B300 Test brake checks whether the brake can still apply the required holding torque or holding force.

DANGER!

Risk of fatal injury due to gravity-loaded vertical axis!

During this action, the closed brake is loaded with a specified test torque or a specified test force. If the test torque or test
force exceeds the holding torque or holding force of the brake, this results in movement of the axis. This can cause a
gravity-loaded vertical axis to drop.

▪ Make sure that safe movement is possible.

Requirements

The action B300 requires a position encoder and is permitted only in the following control modes (B20):

§ 2: ASM - vector control

§ 32: LM - sensorless vector control

§ 48: SSM-vector control incremental encoder

§ 64: SSM - vector control

§ 70: SLM - vector control

Required parameters

Enter the test torque or test force in the parameters B304 and B305:

§ B304[0]: Positive set torque/positive set force for the brake

§ B305[0]: Negative set torque/negative set force for the brake

Define the permitted travel direction in B306. If both directions of rotation are permitted, travel first proceeds in the
positive direction. Enter the angle of rotation of the motor that the drive evaluates as a standstill in B307.

To define the test torques or test forces, note that the motor is limited to the values in C03 and C05. If larger values are
entered in B304 and B305, they cannot be achieved. In addition, make sure that no device-specific limitations take effect.
To do so, check the parameters E65 and E66 during the brake test.

Travel path for brake test

§ Synchronous servo motors, Lean motors and asynchronous motors: If the brake can hold the test torque, then the
maximum travel path is 0.125 motor revolutions.

§ Synchronous linear motors: If the brake can hold the test force, then the maximum travel path is 0.8 mm.

Sequence of the action

If the brake is released, then the encoder is tested first. For the encoder test, the motor rotates at approximately 60 rpm at
a maximum of 45° in both directions of rotation. Then the brake engages and a parameterizable test torque or test force is
applied to the drive in each permitted direction of rotation. If the drive detects motion, then the brake was unable to apply
the required holding torque or holding force and the test has failed.

Results

After the action B300 is started, the progress can be observed in parameter B300[1], and after the action is completed,
B300[2] can be used to call up the test results.
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17.5.10 Torque calculation
In the following chapters, you will find information for calculating the torques that you have to enter in B304 and B305 for
the brake test.

17.5.10.1 Torques for synchronous servo motors

To calculate the torques, you need the following values:

§ MB: Select the braking torque that you have designed and that is required for your application. M1Bstat

§ M0: Stall torque

§ I0: Stall current

§ I2N,PU: Nominal output current of the drive controller

In the first step, calculate the ratio of torques as a percentage:

= ´B
 

0

M
K 100 %

M

In the next step, determine the current for MB:

I = I0 × K

Compare I to I2N,PU of the drive controller:

If I ≤ 2 × I2N,PU, then:
B304 = K and B305 = −K

If I > 2 × I2N,PU, then the drive controller cannot generate the test torque that you have designed.

Example

§ MB = 10 Nm

§ M0 = 6.6 Nm

§ I0 = 4.43 A

§ I2N,PU = 6 A

= ´ =  
10 Nm

K 100 % 151%
6,6 Nm

I = 4.43 A × 151% = 6.69 A

I2N,PU × 2 = 12 A

6.69 A < 12 A

Results: B304 = 151% and B305 = −151%
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17.5.10.2 Torques for asynchronous motors

To calculate the torques, you need the following values:

§ MB: Select the braking torque that you have designed and that is required for your application. Alternatively, perform a
calculation with the nominal braking torque of the motor brake MN,B

§ MN: Nominal torque of the motor

§ Mk: Breakdown torque of the motor

§ I2N,PU: Nominal output current of the drive controller

§ Id,ref (E171): Magnetization-generating reference current in the d/q coordinate system

§ Iq,ref (E172): Torque/force-generating reference current in the d/q coordinate system

To obtain the correct values from E171 and E172, complete the project configuration of the motor, transfer the project to
the drive controller and save it. Then read out the values in online operation.

In the first step, calculate the ratio of torques as a percentage:

= ´B
 

N

M
K 100 %

M

In the next step, determine the current for MB:

= + ´d,ref q,ref
² ²I I (K I )

Compare I to I2N,PU of the drive controller:

If I ≤ 1.8 × I2N,PU, then:
B304 = K and B305 = −K

If I > 1.8 × I2N,PU, then the drive controller cannot generate the test torque that you have designed.

Check whether the motor can apply the required test torque:

Mk/MB > 1

Example

§ MB = 10 Nm

§ MN = 5.12 Nm

§ Mk = 11.8 Nm

§ I2N,PU = 2.3 A

§ Id,ref = 1.383 A

§ Iq,ref = 1.581 A

= ´ =  
10 Nm

K 100 % 195 %
5,12 Nm

    
² ²I (1,383 A) (195 % 1,581A) 3,38 A= + ´ =

I2N,PU × 1.8 = 4.14 A

3.38 A < 4.14 A

Mk/MB = 1.18

1.18 > 1

Results: B304 = 195% and B305 = −195%
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17.5.11 Bedding in the brake
For the action B301 Grind brake, the brake repeatedly engages for approximately 0.7 s and then is released for
approximately 0.7 s while the motor rotates at approximately 20 rpm. This grinds off any deposits on the friction surface
that can negatively influence the holding function of the brake.

DANGER!

Risk of fatal injury due to gravity-loaded vertical axis!

During this action, the brakes are released and movement starts. The motor cannot generate any or can only generate
limited torque/force during this time. This can cause a gravity-loaded vertical axis to drop.

▪ Make sure that safe movement in the specified travel range is possible.

▪ Secure the area extending beyond the travel range for the case of further lowering of the gravity-loaded vertical axis.

Required parameters

You can define the following parameters:

§ How often the brake engages while rotating in one direction (B308)

§ How often the drive should rotate in each direction (B309)

§ Whether a direction of rotation is blocked (B306)

Set speed/velocity and travel range

§ Synchronous servo motors, Lean motors and asynchronous motors:

• Fixed set speed: 20 rpm

• Travel range: B308 × 0.5 motor revolutions

§ Synchronous linear motors:

• Fixed set velocity: 20 m/min

• Travel range: B308 × 0.5 m

Results

After the action is started, the progress can be observed in parameter B301[1]. After the action is completed, the result can
be called up using B301[2].

17.5.12 Brake connection as digital output
Terminal X2A is used to connect the brake of axis A. For double-axis controllers, the brake of axis B is connected to X2B.
Alternatively, both terminals can be used as digital outputs.

The 24 VDC supply must be guaranteed via terminal X300. Furthermore, the setting for brake control must be deactivated
(F00 = 0: Inactive).

In DriveControlSuite, you can define the source of the digital signals via the parameters F59 and F60 (Terminals wizard >
Brake connection as digital output).

Information

By default, parameter A900 is stored as the source so that the output is switched on when Enable-on is activated. This
serves to protect any connected brake.

When using a brake connection as a digital output, it is not monitored and the switch limit at 1 Hz is not active.
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17.5.13 Special case of load changes when the power unit is switched off
Depending on the boundary conditions of the machine, it may make sense to use different settings.

Recommendation for commissioning with gravity-loaded axes

If load changes occur only when the power unit is switched on, leave the presets.

On the other hand, if load changes also occur when the power unit is switched off, reduce the correcting process when the
brakes are released:

1. F00 Brake:
Select 2: Do not save torque/force to save F103 only in volatile memory.

2. F102 Torque/force feed forward:
Enter the determined value for the base load so that only the load difference needs to be adjusted when the load
changes.

3. Reduce the correcting process when releasing the brakes by optimizing the velocity controller.

Determining the base load

1. F102 Torque/force feed forward:
Set the value to 0.0%.

2. Load the axis with the base load.

3. Select the Jog control panel wizard.

4. Enable the axis and let it stand in one position with released brakes in active position control.

5. Determine a stable value for E02 using a scope image; this value corresponds to the base load.

6. Select the Jog control panel wizard.

7. Deactivate the enable signal of the axis.

8. F102 Torque/force feed forward:
Enter the determined base load.

9. A00 Save values:
Save the value in non-volatile memory.
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18 Predictive Maintenance
Predictive Maintenance (PMR) in the context of Industry 4.0 enables a machine to predict and signal the optimal time when
components should be serviced or replaced.

Especially in industrial automation technology, geared motors are system-relevant components and therefore very
important for predictive analysis. One way to infer the service life of a geared motor is based on the loads to which the gear
unit is subjected during its lifetime.

The Predictive Maintenance function in the drive controller monitors your connected geared motor. Its life performance is
calculated using a model-based analysis procedure and mapped in parameters. These parameters can be displayed via the
higher-level controller or in the DriveControlSuite commissioning software. This allows you to plan maintenance optimally
and proactively. The solution includes 3 essential components. The load matrix is a solid data base for recording the real-
world load situations of your machine and improving quality and economic efficiency. The life performance indicator is the
value for the calculated life performance of the geared motor. The recommendation to replace the geared motor can be
displayed in DriveControlSuite and is also provided to the controller as a parameter that can be read out.

Predictive Maintenance is automatically active for geared motors with an electronic nameplate as of production date
04/2022. For geared motors without an electronic nameplate or for older geared motors, monitoring can be activated
manually in the DriveControlSuite commissioning software by using a wizard (V 6.5-G and later and associated firmware in
V 6.5-G and later).

Your advantages at a glance

§ Prognosis of the optimal time for maintenance

§ Extension of the maintenance intervals

§ Reduction of spare part inventories through controlled procurement

§ Service concepts

Predictive Maintenance requires no additional external sensors, no additional wiring and no additional components.

18.1 Legal disclaimer
As of 2022 in DriveControlSuite in V 6.5-G or later, functions that estimate the aging and wear of the components used have
been implemented in our drive systems.

The estimates are used to make various kinds of predictions to provide support for decisions about preventative
replacement. This computer-based support is usually called Predictive Maintenance or something similar.

As development matures, this support is expected to become increasingly precise. On the one hand, this is partly due to our
growing statistical knowledge. On the other hand, the algorithms are also refined over time and the number of sensors
used increases.

Nevertheless, statistical errors are to be expected. In principle, there are two types of errors:

§ False positive: The algorithm predicts failure in the future, although damage has already occurred in the system.

§ False negative: The algorithm recommends replacement although the service life is evidently still long.

By using this function, it is acknowledged that the occurrence of statistical errors is typical of the system and is not cause
for any liability on the part of the manufacturer. There is no entitlement to compensation for damages due to a
miscalculation by the algorithm.
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18.2 Displaying the state
Open the corresponding wizard in DriveControlSuite if you want to check the state of Predictive Maintenance and the
relevant parameters.

ü There is an online connection between DriveControlSuite and the drive controller or reverse documentation is
available.

1. Select the respective drive controller in the project tree and click on the configured axis whose monitoring you would
like to check in the Project menu > Wizard area.

2. Select the Predictive Maintenance wizard.

ð The state is displayed directly as an icon with a corresponding note.

ð R100 PRM state:
Displays the state of Predictive Maintenance. If R100 = 0: Inactive, you must configure Predictive Maintenance
manually.

ð R101 PRM life performance indicator:
Displays the calculated life performance of the geared motor; from a value ≥ 90%, replacement of the geared motor is
recommended.

ð R112 PRM gear unit designation:
Displays the type designation of the geared motor being monitored in Predictive Maintenance.
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18.3 Configuring Predictive Maintenance
Predictive Maintenance is automatically active for geared motors with an electronic nameplate as of production date
04/2022. Configure monitoring in DriveControlSuite only in the following cases:

§ Geared motors with a manufacturing date prior to 04/2022

§ Geared motors without an electronic nameplate

In the cases mentioned above, Predictive Maintenance is inactive. First check the status of Predictive Maintenance with an
existing online connection (see Displaying the state [} 247]). If R100 = 0: Inactive, you can then carry out the manual
configuration in offline mode.

Configuring Predictive Maintenance via the serial number

ü You have the serial number of the gear unit.

1. Select the relevant drive controller in the project tree and click on the first projected axis in the Project menu > Wizard
area.

2. Select the Predictive Maintenance wizard.

3. Click Configure Predictive Maintenance (Internet).

ð The Configure Predictive Maintenance (Internet) dialog box opens.

4. Click Proxy settings.

ð The Proxy settings dialog box opens.

5. Select the desired option for the proxy setting.
For manual proxy configuration:

5.1. If you are using a proxy server, specify the name of the proxy server or the IP address in the address field and
the port of the proxy server in the Port field.

5.2. If you are using a proxy server with a login, also specify the username and password for login.

5.3. Use Test connection to make sure that a connection to the proxy server is possible.

6. Confirm with OK.

ð The Proxy settings dialog box closes.

7. Enter the serial number of your gear unit in the Configure Predictive Maintenance (Internet) dialog box.

8. Click Start download.

ð The data is downloaded and automatically written to the associated parameters.

9. After a successful download, confirm with OK

10. Repeat the steps for the 2nd axis (only for double-axis controllers).

ð You have activated Predictive Maintenance.

Then transfer the configuration to the drive controller, save it and restart the drive controller (see Transmitting and saving
the configuration [} 203]).
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Configuring Predictive Maintenance manually

If automatic configuration via the serial number fails, you can alternatively configure Predictive Maintenance manually.

Information

The required information can be found in the order confirmation for your gear unit, for example. Alternatively, you can scan
the QR code on the nameplate or retrieve it online using the serial, delivery note or invoice number at:
https://id.stober.com.

ü The order confirmation is available to you or you have access to the electronic product ID of your gear unit.

1. Select the relevant drive controller in the project tree and click on the first projected axis in the Project menu > Wizard
area.

2. Select the Predictive Maintenance wizard.

3. Click Configure Predictive Maintenance (local).

ð The Configure Predictive Maintenance (local) dialog box opens.

4. Select the series of your gear unit.

5. Select the size of your gear unit.

6. Then select your gear unit from the list.

7. Confirm with OK.

8. Repeat the steps for the 2nd axis (only for double-axis controllers).

ð You have activated Predictive Maintenance manually.

Then transfer the configuration to the drive controller, save it and restart the drive controller (see Transmitting and saving
the configuration [} 203]).

https://id.stober.com
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18.4 Sending the load matrix
Open the associated wizard in DriveControlSuite and send the load matrix to STOBER, for example, if you need assistance
with data analysis. With an existing online connection, the load matrix is read from the drive controller and sent as a JSON
file. In offline mode, you can send a load matrix already exported in JSON format.

Information

It is not possible to infer specific machine cycles based on the load matrix. The load matrix contains only highly condensed,
statistical features.

Sending the load matrix

ü Predictive Maintenance is active (R100 = 1: Active).

ü There is an online connection between DriveControlSuite and the drive controller or reverse documentation is
available.

1. Select the relevant drive controller in the project tree and in the Project menu > Wizard area click on the configured
axis whose load matrix you want to send to STOBER.

2. Select the Predictive Maintenance wizard > Load matrix.

3. Fill in the required fields.

4. Click Send load matrix.

ð The Send load matrix dialog box opens.

ð The source, destination and amount of data of the current load matrix are displayed.

5. Click Proxy settings.

ð The Proxy settings dialog box opens.

6. Select the desired option for the proxy setting.
For manual proxy configuration:

6.1. If you are using a proxy server, specify the name of the proxy server or the IP address in the address field and
the port of the proxy server in the Port field.

6.2. If you are using a proxy server with a login, also specify the username and password for login.

6.3. Use Test connection to make sure that a connection to the proxy server is possible.

7. Confirm with OK.

ð The Proxy settings dialog box closes.

8. In the Send load matrix dialog box, click Send.

ð The sending process starts and the data is transmitted to STOBER.

9. Close the dialog box after sending has been completed successfully.

Sending the load matrix (export)

ü You have exported the load matrix in JSON format.

1. Select the relevant drive controller in the project tree and in the Project menu > Wizard area click on the projected
axis whose exported load matrix you want to send to STOBER.

2. Select the Predictive Maintenance wizard > Load matrix.

3. Click Send load matrix (export).

ð The dialog box for selecting the file opens.
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4. Navigate to the load matrix previously exported in JSON format and select it.

5. Click Open.

ð The Send load matrix (export) dialog box opens.

ð The source, destination and data volume of the current load matrix are displayed in the dialog box.

6. Click Proxy settings.

ð The Proxy settings dialog box opens.

7. Select the desired option for the proxy setting.
For manual proxy configuration:

7.1. If you are using a proxy server, specify the name of the proxy server or the IP address in the address field and
the port of the proxy server in the Port field.

7.2. If you are using a proxy server with a login, also specify the username and password for login.

7.3. Use Test connection to make sure that a connection to the proxy server is possible.

8. Confirm with OK.

ð The Proxy settings dialog box closes.

9. In the Send load matrix (export) dialog box, click Send.

ð The sending process starts and the data is transmitted to STOBER.

10. Close the dialog box after sending has been completed successfully.

18.5 Exporting the load matrix
If you want to review or analyze the data, use the associated DriveControlSuite wizard to export the load matrix. With an
existing online connection, the load matrix is read directly from the drive controller for export. If the data in your project is
already available in DriveControlSuite, you can also export the data in offline mode.

ü Predictive Maintenance is active (R100 = 1: Active).

ü There is an online connection between DriveControlSuite and the drive controller or reverse documentation is
available.

1. Select the relevant drive controller in the project tree and in the Project menu > Wizard area click on the projected
axis whose load matrix you want to export.

2. Select the Predictive Maintenance wizard > Load matrix.

3. Fill in the required fields.

4. Click Export load matrix.

ð The Export load matrix dialog box opens.

5. Select the directory to which you want to export the load matrix.

6. Select the desired file type (JSON or CSV).

7. Assign a file name and select .json or .csv as the file extension.

8. Confirm with Save.

ð The load matrix is saved as a JSON or CSV file (*.json, *.csv).
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18.6 Resetting the load matrix
The load matrix is stored in non-volatile memory on the SD card along with the life performance indicator every 30 minutes.

You can manually reset the load matrix as necessary.

If an SD card is inserted, the existing load matrix is moved to a backup folder before resetting. When resetting, both the
load matrix on the SD card and the load matrix stored in volatile memory in the drive controller are reset.

ü Predictive Maintenance is active (R100 = 1: Active).

1. Select the relevant drive controller in the project tree and click on the projected axis whose load matrix you want to
reset in the Project menu > Wizard area.

2. Select the Predictive Maintenance wizard > Load matrix > Reset load matrix.

3. Click Reset load matrix.

ð The load matrix is reset.

ð R105[1] indicates the progress.

ð R105[2] outputs the result of the action.

18.7 Displaying a 3D load matrix
The load matrix represents the frequency distribution of speeds and torques that occurred at the output of the monitored
geared motor. If you want to check the speeds and torques that have occurred, open the associated wizard in
DriveControlSuite for a three-dimensional, rotatable display of the load matrix. With an existing online connection, the load
matrix is read directly from the drive controller for the display. If the data in your project is already available in
DriveControlSuite, the load matrix can also be displayed in offline mode.

ü Predictive Maintenance is active (R100 = 1: Active).

ü There is an online connection between DriveControlSuite and the drive controller or reverse documentation is
available.

1. Select the relevant drive controller in the project tree and click on the projected axis whose load matrix you want to
display in the Project menu > Wizard area.

2. Select the Predictive Maintenance wizard > Load matrix > Load matrix 3D.

ð The load matrix is displayed as a 3D column diagram.

3. Customize the display by changing the default settings for time and scaling according to your needs.

For more information on operation, see 3D load matrix [} 256].
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18.8 Resetting the life performance indicator
The life performance indicator is stored in non-volatile memory in the drive controller every 10 minutes, and on the SD card
together with the load matrix every 30 minutes.

In certain cases, you may need to manually reset the life performance indicator:

§ After replacing a geared motor without an electronic nameplate with an identical geared motor

§ After servicing a geared motor (with or without electronic nameplate)

In both cases, monitoring remains active for the entire period. However, since the life performance indicator of the
replaced or serviced geared motor has the value 0%, you must also reset the life performance indicator in the drive
controller.

Information

Resetting the life performance indicator also resets the operating time of the gear unit and the counter for instances of
exceeding the torque for Predictive Maintenance (R123, R124).

ü Predictive Maintenance is active (R100 = 1: Active).

1. Select the relevant drive controller in the project tree and click on the first projected axis whose life performance
indicator must be reset in the Project menu > Wizard area.

2. Select the Predictive Maintenance wizard > Reset life performance indicator.

3. Click Reset life performance indicator.

ð The life performance indicator is reset.

ð R104[1] indicates the progress.

ð R104[2] outputs the result of the action.

ð R101 displays the life performance indicator.

18.9 Information on activation, operation and replacement
Pay attention to the following information on activating Predictive Maintenance and for operating and replacing
components.

Activation

The following requirements apply for successful activation of Predictive Maintenance:

§ STOBER system (consisting of drive controllers and geared motors from STOBER)

§ Automatic activation for geared motors with a manufacturing date as of 04/2022

§ Manual configuration required for geared motors with an older manufacturing date or geared motors without an
electronic nameplate

§ Plugged-in SD card for non-volatile storage of the load matrix

§ No linear motor (control mode B20 ≠ 70: SLM - vector control)

§ Gear units not connected in series, as this is not supported by the life performance indicator
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Operation

Predictive Maintenance is continued without interruption after restarting the drive controller if the following requirements
are met:

§ SD card permanently inserted in the drive controller

§ Uninterrupted connection of drive controller and geared motor

§ Constant gear ratio of the gear unit (Drive Based or PROFIdrive: C15, C16; CiA 402: A584)

Replacement

After the drive controller has been replaced, monitoring can be continued without interruption by transferring the data
from the SD card.

After replacing a geared motor with an electronic nameplate, the existing data is not overwritten if it is replaced with a new
motor, but a new data record is created. With the original data, the drive controller is able to continue monitoring the
geared motor after the geared motor has been replaced.

In certain cases, you may need to manually reset the life performance indicator:

§ After replacing a geared motor without an electronic nameplate with an identical geared motor

§ After servicing a geared motor (with or without electronic nameplate)

In both cases, monitoring remains active for the entire period. However, since the life performance indicator of the
replaced or serviced geared motor has the value 0%, you must also reset the life performance indicator in the drive
controller.

18.10 More about Predictive Maintenance?
The following chapters summarize the essential terms of Predictive Maintenance and provide you with further relevant
information on the subject.

18.10.1 Load matrix
The load matrix represents the data base for recording the real-world load situations of machines and improving the quality
and economic efficiency. It represents the frequency distribution of speeds and torques that occurred at the output of the
geared motor. The load matrix and other information are stored in DriveControlSuite in parameter R118. The information
relevant for Predictive Maintenance is also made available to the controller via this parameter.

Information

For performance reasons, parameter R118 is not displayed in the parameter list of DriveControlSuite. The parameter data
can be accessed indirectly via the load matrix wizard or via acyclic fieldbus communication.

Information

The load matrix is only recorded if the axis is enabled (A900 = 1).
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Structure and scope

The load matrix divides speed and torque into equidistant classes. For the speed, 21 classes are available for both directions
of rotation. The speed range covers -150% to +150% of the nominal speed. For the torque, 31 classes are available for the
torque range from -250% to +250% of the nominal torque.

The nominal speed and nominal torque of the load matrix refer to the gear unit output of the geared motor.

The speed range includes:

-1.5 × n2N to +1.5 × n2N

The speed is stored in rpm.

The torque range includes:

-2.5 × M2N to +2.5 × M2N

The torque is stored in %. The reference value for the percentage torque value is C09.

Torques and speeds outside the respective specified range are assigned to the outermost class:
Values that fall below the lower limit are sorted into the lowest class. Values that exceed the upper limit are sorted into the
highest class.

Scaling

The recorded speed classes are scaled as follows, with the label representing the average of the two class limits in each
case:
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Fig. 77: Scaling of the recorded speed classes

The recorded torque classes are scaled as follows, with the label representing the average of the two class limits in each
case:
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Fig. 78: Scaling of the recorded torque classes

Data export or data transmission

From the DriveControlSuite commissioning software, the load matrix can be exported in JSON data format (*.json) or in CSV
data format (*.csv).

Alternatively, you can send the load matrix to STOBER for analysis (see Reading out and transmitting the load matrix
[} 265]).
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18.10.1.1 3D load matrix

The Load matrix 3D wizard shows a graphical display of the load matrix as a 3D column diagram. You can customize the
display according to your needs.

3D display

Button Function Description

[Left mouse button] Select Left-clicking on a column:
Selects or deselects a column in the diagram for the Zoom
to button button.
Selected columns are displayed in turquoise, deselected
columns in blue.

[Right mouse button] Rotate Holding down the right mouse button anywhere on the 3D
display and moving the mouse pointer:
Rotates the 3D display.

[Mouse wheel] Zoom Turning the mouse wheel forwards or backwards anywhere
on the 3D display:
Enlarges or reduces the 3D display.

Toolbar of the workspace

Picklist Option Description

Scaling Linear Columns are displayed linearly scaled.

Logarithmic Columns are displayed logarithmically scaled.

Time basis Seconds Columns are shown in the respective unit.

Minutes

Hours

Days

Months

Years

Button Description

Updates the 3D display (prerequisite: online connection between DriveControlSuite and
drive controller).

Zooms in on the column when selected and rotates the display accordingly or resets the
display when the column is not selected (100% scaling, standard angle).

Reduces the size of the 3D display (zoom out).

Sets the 3D display to 100% scaling.

Enlarges the 3D display (zoom in).
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18.10.1.2 Information on the load matrix

The load matrix is stored in DriveControlSuite in parameter R118 along with the life performance indicator in JSON data
format. The parameter contains all the information necessary to understand the load matrix.

Information

For performance reasons, parameter R118 is not displayed in the parameter list of DriveControlSuite. The parameter data
can be accessed indirectly via the load matrix wizard or via acyclic fieldbus communication.

Key Value Description

"version" String Version name of the JSON format

"id" String ID for the type of JSON document

"ds6-username" String User name that is entered by DriveControlSuite when
exporting or sending

"ds6-email" String Email address that is entered by DriveControlSuite when
exporting or sending

"ds6-company" String Company name that is entered by DriveControlSuite when
exporting or sending

"ds6-comment" String Comment that is entered by DriveControlSuite when
exporting or sending

"ds6-date" String Date on which the file was exported or sent

"database-id" Number Database ID of the parameterized geared motor

"paramodul-sn" String Number on the SD card (generated upon first use and acts
as identification)

"encoder-type" Number Type of the connected encoder (0: none, 1: incremental,
2: SSI, 3: EnDat 2.x, 4: HIPERFACE, 5: Resolver, 6: EnDat 3.x)

"gearmotor-type" String Geared motor type

"drive-controller-type" String Drive controller type

"reference" String Reference of the drive controller

"motor-type" String Motor type

"axis-number" Number Axis number (0/1)

"gear-ratio" Number Gear ratio of the geared motor

"operating-time-h" Number Hour value of the operating time

"operating-time-m" Number Minute value of the operating time

"operating-time-s" Number Seconds value of the operating time

"motor-serial-number" Number Serial number of the motor

"gearbox-serial-number" Number Serial number of the gear unit

"encoder-serial-number" Number Encoder serial number

"drive-production-number" Number Production number of the drive controller according to
nameplate (S/N)

"t-reference" Number Reference torque for "t-average" and "t-limits"

"t-reference-unit" String Unit of reference torque for "t-average" and "t-limits"

"t-limits" Array of numbers Load matrix: upper limits of the torque classes

"t-limit-unit" String Load matrix: unit of the upper limits of the torque classes

"n-limits" Array of numbers Load matrix: upper limits of the speed classes



18 | Predictive Maintenance STOBER

258

02
/2

02
4 

| 
ID

 4
42

72
8.

12

Key Value Description

"n-limit-unit" String Load matrix: unit of the upper limits of the speed classes

"t-average" Array of numbers Load matrix: mean value of the class limits of the torque
classes

"t-average-unit" String Load matrix: unit of the mean value of the class limits of the
speed classes

"n-average" Array of numbers Load matrix: mean value of the class limits of the speed
classes

"n-average-unit" String Load matrix: unit of the mean value of the class limits of the
torque classes

"t-bucket-count" Number Load matrix: number of torque classes

"n-bucket-count" Number Load matrix: number of speed classes

"time-resolution" String Load matrix: resolution

"m2>m2not-counter" Number Number of times 90% of the maximum emergency off
torque was exceeded M2NOT

"gearmotor-run-time" Number Operating time of the geared motor

"gearmotor-run-time-unit" Number Unit for the operating time of the geared motor

"life-work-indicator" Number Value of the life performance indicator

"load-matrix" Array of numbers Two-dimensional array containing the load matrix; torque is
applied to the rows and speed to the columns

Tab. 200: Information on the load matrix

The following characters or control characters are not allowed in the values of the load matrix:

Symbol Description

" Quotation marks

\ Backslash

\b Backspace

\f Form feed

\n Line feed

\r Carriage return

\t Horizontal tab character

Tab. 201: Load matrix: impermissible characters or control characters



STOBER 18 | Predictive Maintenance
02

/2
02

4 
| 

ID
 4

42
72

8.
12

259

18.10.1.3 Example of a load matrix in JSON format

The following example shows a load matrix in JSON format.

{
"version": "1.1",
"id": "LoadMatrix",
"ds6-username": "unknown-username",
"ds6-email": "unknown-email",
"ds6-company": "unknown-company",
"ds6-comment": "unknown-comment",
"ds6-date": "unknown-date",
"database-id": 3156,
"paramodul-sn": "123456789123",
"encoder-type": 3,
"gearmotor-type": "PH932_0400",
"drive-controller-type": "SD6A36",
"reference": "T1",
"motor-type": "EZ805U",
"axis-number": 0,
"gear-ratio": 40.0,
"operating-time-h": 129,
"operating-time-m": 13,
"operating-time-s": 24,
"motor-serial-number": 123456789,
"gearbox-serial-number": 123456789,
"encoder-serial-number": 123456789,
"drive-production-number": 1234567,
"t-reference": 2644.0,
"t-reference-unit": "Nm",
"t-limits": [-2.417, -2.250, -2.083, -1.917, -1.750, -1.583, -1.417, -1.250,
-1.083, -0.917, -0.750, -0.583, -0.417, -0.250, -0.083, 0.083, 0.250, 0.417, 0.583,
0.750, 0.917, 1.083, 1.250, 1.417, 1.583, 1.750, 1.917, 2.083, 2.250, 2.417,
2.583],
"t-limit-unit": "%",
"n-limits": [-71.250, -63.750, -56.250, -48.750, -41.250, -33.750, -26.250,
-18.750, -11.250, -3.750, 3.750, 11.250, 18.750, 26.250, 33.750, 41.250, 48.750,
56.250, 63.750, 71.250, 78.750],
"n-limit-unit": "rpm",
"t-average": [-2.500, -2.333, -2.167, -2.000, -1.833, -1.667, -1.500, -1.333,
-1.167, -1.000, -0.833, -0.667, -0.500, -0.333, -0.167, 0.000, 0.167, 0.333, 0.500,
0.667, 0.833, 1.000, 1.167, 1.333, 1.500, 1.667, 1.833, 2.000, 2.167, 2.333,
2.500],
"t-average-unit": "%",
"n-average": [-75.000, -67.500, -60.000, -52.500, -45.000, -37.500, -30.000,
-22.500, -15.000, -7.500, 0.000, 7.500, 15.000, 22.500, 30.000, 37.500, 45.000,
52.500, 60.000, 67.500, 75.000],
"n-average-unit": "rpm",
"t-bucket-count": 31,
"n-bucket-count": 21,
"time-resolution": "1us",
"m2>m2not-counter": 0,
"gearmotor-run-time": 0,
"gearmotor-run-time-unit": "s",
"life-work-indicator": 0.000280,
"load-matrix": [
[0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0],
[0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0],
[0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0],
[0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0],
[0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0],
[0, 0, 0, 0, 1000, 3000, 4000, 4000, 3000, 4000, 1000, 0, 0, 0, 0, 0, 0, 0, 0, 0,
0],
[0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0],
[0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 2000, 4000, 4000, 3000, 4000, 3000, 0, 0, 0, 0, 0],
[0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0],
[0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0],
[0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0],
[0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0],
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[0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0],
[0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0],
[0, 0, 0, 0, 20000, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0],
[0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 41000, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0],
[0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 20000, 0, 0, 0, 0],
[0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0],
[0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0],
[0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0],
[0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0],
[0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0],
[0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0],
[0, 0, 0, 0, 0, 3000, 4000, 4000, 3000, 4000, 2000, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0],
[0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0],
[0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 1000, 4000, 4000, 3000, 4000, 3000, 1000, 0, 0, 0,
0],
[0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0],
[0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0],
[0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0],
[0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0],
[0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0]
] 
}

18.10.1.4 Memory requirement of the load matrix

The maximum required memory space is 16 KiB (Kibibyte) per load matrix in JSON format.

The load matrix is saved separately for each axis and in duplicate to prevent data loss. Consequently, the maximum
required memory space is 32 KiB on the SD card of a single-axis controller and 64 KiB on the SD card of a double-axis
controller.

When a geared motor is replaced by a new geared motor, new JSON files are generated for it. Accordingly, the required
memory space for each new geared motor increases by a maximum of 32 KiB.

The required memory space per day depends on the application, but is within the maximum required memory space.

18.10.1.5 Export of the load matrix

You can export the load matrix as a JSON or CSV file.

The load matrix in JSON format is particularly suitable for simple evaluation, comparison and display of the load matrix
using programming languages such as Python, C#, C++ or Java and for use in IIoT applications.

The load matrix in CSV format can be displayed and evaluated as a diagram using spreadsheet programs such as Microsoft
Excel.
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18.10.1.5.1 JSON

The data of the load matrix in JSON format corresponds to the data of parameter R118.

For information on the individual elements, see Information on the load matrix [} 257].

Evaluation

The data in the JSON file can be analyzed as a diagram using Python and Matplotlib.

Prerequisites:

§ Python programming language in V 3.0 or later

§ Matplotlib program library in V 1.0.0 or later

§ NumPy program library in V 1.0.0 or later

Example

# Import required libraries
import json
import matplotlib.pyplot as plt
import numpy as np

# File path for the JSON file
file_path = r"C:\Temp\LoadMatrix_20230912_095707.json"

# Open and read data from the JSON file
with open(file_path, 'r') as file:

data = json.load(file)

# Create a 3D plot
fig, ax = plt.subplots(subplot_kw={"projection": "3d"})

# Extract and prepare data from the JSON file
speeds = np.array(data["n-average"])
torques = np.array(np.multiply(data["t-average"], data["t-reference"]))

# Set axis labels
ax.set(ylabel="torque in Nm", xlabel="speed in rpm", zlabel="amount in min")

# Define the number of ticks on the axes
plt.locator_params(axis='x', nbins=data["n-bucket-count"])
plt.locator_params(axis='y', nbins=data["t-bucket-count"])

# Prepare data for the 3D surface
speeds, torques = np.meshgrid(speeds, torques)
loads_us = np.array(data["load-matrix"])
loads_minutes = np.divide(loads_us, 1000 * 1000 * 60)

# Draw the 3D surface
ax.plot_surface(speeds, torques, loads_minutes, cmap=plt.cm.coolwarm, linewidth=0,
antialiased=True)

# Display the plot
plt.show()

Information

If copying and pasting the example, correct the syntax indentation after pasting if necessary.
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18.10.1.5.2 CSV

The CSV file contains the Metadata and Load-Matrix sections.

For information on the individual elements, see Information on the load matrix [} 257].

Metadata

The metadata includes all the information required to identify the axis within the machine. It also contains information on
the operating time of the axis, the serial numbers of motor, gear unit and encoder components, and the production
number of the drive controller. The axis labels of the load matrix, the units in which the load matrix is recorded, and the life
performance indicator can also be found in the metadata.

Load-Matrix

The Load-Matrix section contains the data and axis labels of the load matrix. The speed axis label is in the first row after
Start Load-Matrix; the torque axis label follows in the first column. The speeds can be found in the line n-average
and the corresponding unit in the line n-average-unit. The torques are the result of multiplying t-average and t-
reference. The corresponding unit can be found in the line t-reference-unit.

Evaluation

Proceed as follows to create a 3D column chart in Microsoft Excel from the load matrix data:

1. Open the CSV file in Excel.

2. Select all cells with content between the rows Start Load-Matrix and End Load-Matrix.

3. On the Insert tab, select Charts > Insert column or bar chart > 3D column.

ð The 3D column diagram is inserted.



STOBER 18 | Predictive Maintenance
02

/2
02

4 
| 

ID
 4

42
72

8.
12

263

18.10.2 Life performance indicator
The life performance indicator is the value for the calculated life performance of the geared motor. No additional external
sensor is required to determine it. In DriveControlSuite, the life performance indicator is displayed in the Predictive
Maintenance wizard (R101). Values below 100% mean that the geared motor is being operated within its life performance.
For values above 100%, the probability of failure increases. From a value of 90%, it is recommended to replace the geared
motor and a corresponding message is output in parameter R100.

Information

Increasing values do not mean that there is damage to the geared motor. Operation of the geared motor is also possible at
values > 100%.

Information

The life performance indicator is calculated and updated only if the axis is enabled (A900 = 1).

The life performance indicator increases monotonically: faster with greater load, slower with lesser load.
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Fig. 79: Signaling area

The algorithm for the life performance indicator is continuously being further developed.
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18.10.3 Update and storage cycles
The action A00 Save values has no influence on the saving of Predictive Maintenance data.

Load matrix

The load matrix is stored in non-volatile memory on the SD card along with the life performance indicator every 30 minutes.

The data for the load matrix (speeds and torques) is sampled with the cycle time set in A150.

In the drive controller, the load matrix is updated with the cycle time set in A150.

If the drive controller is switched off before the load matrix data is automatically saved every 30 minutes, the data will be
lost.

Life performance indicator

The life performance indicator is stored in non-volatile memory in the drive controller every 10 minutes, and on the SD card
together with the load matrix every 30 minutes.

The value of the life performance indicator is updated in the drive controller twice per minute.

Unlike for the load matrix, an SD card is not absolutely necessary for the life performance indicator because of the non-
volatile storage in the drive controller.

18.10.4 Recommendation for geared motor replacement
The recommendation to replace the geared motor is displayed in DriveControlSuite in the Predictive Maintenance wizard
(R100). The recommendation is triggered when Predictive Maintenance is active and the life performance indicator reaches
a value ≥ 90% (R101).
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18.10.5 Reading out and transmitting the load matrix
Would you like to know more about the real-world load situation of your machine and its optimization potential? Would
you like to support the further development of our algorithm? If you send us your load matrix, we will help you in analyzing
or visualizing your data. We will also be able to take your specific machine behavior into consideration for further
development.

Information

It is not possible to infer specific machine cycles based on the load matrix. The load matrix contains only highly condensed,
statistical features.

Reading out data

The following graphic describes the 3 options for reading out the data.

Shortcut icon for .exe Shortcut icon for .exe

DS6
DS6

DS6
DS6

AS6
AS6

AS6
AS6

DS6 AS6

Icon for document Icon for document

AS6
AS6

AS6
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DS6

DS6

{;}
JSON

{;}
JSON

{;}
JSON

CSV

1
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3

R118

SD card

R118

PLC

PC

PC

Fig. 80: Predictive Maintenance: Options for readout

1. Via the controller (in preparation)

Function blocks for controllers are in preparation that will enable the controller to read the parameter R118 and write the
data to a JSON file.



18 | Predictive Maintenance STOBER

266

02
/2

02
4 

| 
ID

 4
42

72
8.

12

2. From the SD card

The JSON files are stored in the following form:

§ If a serial number is available for the motor, it is used for the file name.

§ If no serial number is available for the motor, the file name consists of 8 characters (hexadecimal) which are generated
from the CRC checksum of B00.

File name Example

PRM\[Serial number].PXX 03774434.P00

PRM\[8 characters].PXX 0BB5A846.P00

Tab. 202: Predictive Maintenance files on SD card

To avoid data loss, the files are each stored twice on the SD card.

The file extensions have the following meaning:

File extension Meaning

P00 JSON for axis A

P01 JSON for axis A (backup file)

P10 JSON for axis B

P11 JSON for axis B (backup file)

Tab. 203: Meaning of file extensions on SD card

3. Via DriveControlSuite

Use the associated wizard in DriveControlSuite to export the load matrix. For the export, parameter R118 is read out from
the drive controller directly if an online connection exists or from your project in offline mode.

Transmitting the data

You can provide the data to STOBER via upload through DriveControlSuite or by email to prm_data@stober.de.

mailto:
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19 Diagnostics
LEDs on the top and front give you initial information about the device state of the respective device as well as the states of
the physical connection and the communication. In the event of an error or fault, you will receive detailed information
through the DriveControlSuite commissioning software.

19.1 Supply module
The PS6 supply module has 3 diagnostic LEDs on the front of the device that light up in different combinations and
frequencies and provide information about the state of the supply module.

1
2
3

PS6

Fig. 81: Diagnostic LEDs on the front of the PS6 device

1 Green: Run

2 Red: Error

3 Yellow: Warning

LED and relay state display

The relay and LEDs always display the same state. The states are displayed using the priority list Initialization and
Operation < Warning 1 < Warning 2 < Fault. The display of states with higher priority replaces the display of states with
lower priority (example: Warning 2 overwrites Warning 1). States with a lower priority are only displayed if a higher-priority
state is no longer active and has finished being displayed.

LEDs:
Green/Red/Yellow

Conduct Description Relay (X100)

Ready Warning 1 Warning 2

Flashing Initialization Open Closed Closed

Off

Off

On Operation Closed Closed Closed

Off

Off

On Warning 1:
Supply module
overtemperature,
braking resistor
overtemperature or
failure of a grid phase

Closed Open Closed

Off

Single flash

On Warning 2:
Short-term power
failure (< 5 s)

Closed Closed Open

Off

2x flash
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LEDs:
Green/Red/Yellow

Conduct Description Relay (X100)

Ready Warning 1 Warning 2

Off Fault (1):
Overtemperature

Open Closed Closed

Single flash

Off

Off Fault (2):
Overvoltage

Open Closed Closed

2x flash

Off

Off Fault (3):
Short-circuit

Open Closed Closed

3x flash

Off

Off Fault (4):
Power failure

Open Closed Closed

4x flashing

Off

Off Fault (5):
Ground fault or
switch-on in the short-
circuited DC link

Open Closed Closed

5x flash

Off

Off Fault (6):
Hardware defect

Open Closed Closed

6x flash

Off

Off Fault (7):
Overcurrent

Open Closed Closed

7x flash

Off

Off Device is switched off Open Open Open

Off

Off

Tab. 204: Meaning of the 3 LEDs (Run, Error and Warning) on the front of the PS6 device

UL-compliant operation: When making the project configuration of Warning 1, obey the information on the braking resistor
(see UL-compliant use [} 27]).
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19.1.1 Causes, check and actions

Warning 1 and Fault (1)

Cause Check and action

Surrounding temperatures too high
or too low

Check the surrounding temperature of the supply module and adjust it to the
operating conditions of the drive controller if necessary

Too little air circulation in the
control cabinet

Check minimum clearance and adjust it if necessary

Defective or blocked fan Switch on control unit supply; check that the fan starts and replace the supply
module if necessary

Assembly protection film Remove the assembly protection film

Wrong design of the supply
module

Check the design and change the supply module type if necessary

Increased or reduced mechanical
friction

Check the service status of the mechanical system of all axes and service them if
necessary

Mechanical block Check the output of all axes and remove the block if necessary

Short deceleration/acceleration
times

Check the actual current of all axes during the braking process using a scope image
(E00); adjust deceleration and acceleration values if necessary; check whether a
braking resistor with lower resistance can be used

Tab. 205: Supply module overtemperature – Check and actions

Information

If the braking resistor is overloaded, it can dissipate energy for another 5 s. After this 5 s, the brake chopper can be
activated again only if the braking resistor has left the critical temperature range.

Cause Check and action

Short deceleration/acceleration
times

Check the DC link voltage of an axis during the braking process using the scope image
(E03); reduce the deceleration and acceleration values if necessary

Braking resistor too low Check that the maximum permitted braking resistor power loss is suitable for the
application and replace the braking resistor if necessary

Tab. 206: Braking resistor overtemperature – Check and actions

Cause Check and action

Failure of a grid phase Check the line fuse and connection and correct them if necessary

Tab. 207: Failure of a grid phase – Check and actions

Warning 2

Cause Check and action

Short-term power failure Check the connection and correct it if necessary

Tab. 208: Short-term power failure – Check and actions
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Fault (2)

Cause Check and action

Short delay times Check the DC link voltage of all axes during the braking process using the scope
image (E03), reduce the deceleration values, use a (larger) braking resistor if
necessary

Braking resistor connection error Check the connection to the braking resistor and drive controller and correct them if
necessary

Pulse power of the braking resistor
is too low

Check that the braking resistor pulse power is suitable for the application; replace
the braking resistor if necessary

Brake chopper is defective Check the DC link voltage of an axis during the braking process using the scope
image (E03); the brake chopper is defective if the DC link voltage exceeds the on
limit of the brake chopper without the DC link voltage dropping; replace the supply
module if necessary

Supply voltage exceeded Check the supply voltage for an overrun of the permitted input voltage and adjust it
if necessary

Tab. 209: Overvoltage – Check and actions

Fault (3)

ATTENTION!

Material damage due to repeated activation and deactivation!

Repeated activation and deactivation with an existing short-circuit can lead to a device fault.

▪ Before the new activation or enable signal, the cause must be found and corrected.

Cause Check and action

Short-circuit Check the connection, cable and braking resistor and replace if necessary; restart
required

Tab. 210: Braking resistor short-circuit – Check and actions

Fault (4)

Cause Check and action

Power failure Check the line fuse and connection and correct them if necessary

Tab. 211: Lasting power failure – Check and actions
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Fault (5)

ATTENTION!

Material damage due to repeated activation and deactivation!

Repeated activation and deactivation with an existing short-circuit can lead to a device fault.

▪ Before the new activation or enable signal, the cause must be found and corrected.

Cause Check and action

Ground fault or switch-on in the
short-circuited DC link

Check the connection and correct it if necessary; restart required

Protective grounding missing Check the grounding conductor connection and correct it if necessary; restart
required

Tab. 212: Ground fault, switch-on in the short-circuited DC link or missing protective grounding – Check and actions

Fault (6)

Cause Check and action

Hardware defect Replacing the supply module

Tab. 213: Hardware defect – Check and actions

Fault (7)

Cause Check and action

Short acceleration times Check the actual current of all axes using the scope image and reduce the
acceleration values if necessary (E00)

Large torque/force limits Check the actual current of all axes using the scope image (E00) and reduce the
torque/force limits if necessary (C03, C05)

Wrong design of the supply
module

Check the design and change the supply module type if necessary

Tab. 214: Overcurrent – Check and actions
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19.1.2 Device state machine of the supply module
The device state machine describes the various device states of the supply module, including possible state changes.

Initialization

Operation

Warning 1

Warning 2

Fault

0

1

3 6

2

12

49

10

11

8

5

7

Fig. 82: PS6 device state machine

19.1.3 States, transitions and conditions
The supply module states all have specific features. A state either transitions into another state automatically or requires
specific checks and actions, such as a restart.

19.1.3.1 Initialization

Features

§ The supply module is initialized and tested (prerequisite: 24 VDC supply is switched on)

§ Green LED flashes

Transition to Operation (1)

The supply module switches to Operation after the self-test has been successfully completed (prerequisite: power supply is
switched on).

Transition to Fault (2)

If one of the possible causes for a fault is present, the supply module switches to Fault immediately or after 5 s.
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19.1.3.2 Operation

Features

§ Supply module is operational

§ Green LED lights up

Transition to Warning 1 (3)

If one of the possible causes for Warning 1 is present, the supply module switches to Warning 1 and the connected drives
must be stopped at the next opportunity.

Transition to Warning 2 (4)

If one of the possible causes for Warning 2 is present, the supply module switches to Warning 2 and the connected drives
must be stopped immediately with a quick stop.

Transition to Fault (5)

If one of the possible causes for a fault is present, the supply module switches to Fault and the connected drives must be
immediately switched off.

19.1.3.3 Warning 1

The connected drives must be stopped at the next opportunity.

Features

§ Covers all warnings that are likely to result in a fault if the load remains constant

§ Yellow LED flashes 1x

Transition to Operation (6)

If the fault cause for Warning 1 is no longer present, the supply module switches to Operation and operation can be
continued.

Transition to Warning 2 (7)

In case of a grid phase failure, the supply module switches to Warning 2 and the connected drives must be stopped
immediately with a quick stop.

Transition to Fault (8)

If a fault is present, the supply module switches to Fault and the connected drives must be immediately switched off.
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19.1.3.4 Warning 2

The connected drives must be stopped immediately with a quick stop.

Features

§ Covers all warnings that may result in a fault in a very short time

§ Yellow LED flashes 2x

Transition to Operation (9)

If the power supply returns within 5 s and the DC link is not yet discharged, the supply module switches back to Operation.

Initialization (10)

If the power supply returns after 5 s have passed, the supply module switches to Initialization.

Transition to Fault (11)

If the power supply does not return within 15 s or if a fault is detected, the supply module switches to Fault and the
connected drives must be immediately switched off.

19.1.3.5 Fault

The connected drives must be switched off immediately.

Features

§ Red LED flashes in different frequencies depending on the cause

Transition to Initialization (12)

If the fault cause has been remedied, the supply module switches to Initialization.

If a hardware defect is detected, in case of a short-circuit or ground fault or in case of a switch-on in the short-circuited DC
link, the fault is retained until the supply module is restarted.
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19.2 Drive controllers
The drive controllers have diagnostic LEDs that visually indicate the state of the drive controller as well as the states of the
physical connection and communication.

1
2

3

4

Err
Run
FSoE/Psafe

5

Fig. 83: Positions of the diagnostic LEDs on the front and top of the drive controller

1 Fieldbus state

2 FSoE or PROFIsafe state

3 Drive controller state

4 Service network connection

5 Fieldbus network connection
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19.2.1 State of the fieldbus and safety technology
The LEDs for diagnosing the fieldbus state and the safety technology vary depending on the fieldbus system and safety
module used.

19.2.1.1 EtherCAT state

There are 2 LEDs on the front of the drive controller that provide information about the connection between EtherCAT
master and slave and about the state of the data exchange. This information can also be read out in parameter A255. If the
drive controller includes the SY6 safety module, the STO and SS1 safety functions are activated via EtherCAT FSoE. In this
case, an additional LED on the front of the device provides information about the FSoE state.

1
2

Err
Run
FSoE

Fig. 84: LEDs for the EtherCAT state

1 Red: Error

2 Green: Run

Red LED Conduct Error Description

Off No Error No error

Flashing Invalid Configuration Invalid configuration

Single flash Unsolicited State Change The EtherCAT slave changed operating states
by itself

2x flash Application Watchdog
Timeout

The EtherCAT slave did not receive new PDO
data during the configured watchdog
timeout

Tab. 215: Meaning of the red LED (error)

Green LED Conduct Operating state Description

Off Init No communication between the EtherCAT
master and slave; the configuration starts,
saved values are loaded

Flashing Pre-operational No PDO communication; the EtherCAT
master and slave exchange application-
specific parameters via SDOs

1x flash Safe-operational The EtherCAT slave sends the current actual
values to the EtherCAT master, ignores its set
values and refers to internal default values

On Operational Normal operation: The EtherCAT master and
slave exchange set and actual values

Tab. 216: Meaning of the green LED (Run)
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19.2.1.2 FSoE state

If the drive controller includes the SY6 safety module, the STO and SS1 safety functions are activated via EtherCAT FSoE. In
this case, an LED on the front of the device provides information about the state of FSoE communication. This information
can also be read out in parameter S20 FSoE status indicator.

Err
Run
FSoE1

Fig. 85: LED for the FSoE state

1 Green: FSoE

Green LED Conduct Description

Off Initialization

Flashing Ready for parameterization

On Normal operation

Single blink Failsafe command from FSoE master received

Rapid flashing Undefined connection error

Rapid flashing with 1x
flash

Error in the safety-related communication settings

Rapid flashing with 2x
flash

Error in the safety-related application settings

Rapid flashing with 3x
flash

Incorrect FSoE address

Rapid flashing with 4x
flash

Prohibited command received

Rapid flashing with 5x
flash

Watchdog error

Rapid flashing with 6x
flash

CRC error

Tab. 217: Meaning of the green LED (FSoE status indicator in accordance with IEC 61784-3)
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19.2.1.3 PROFINET state

There are 2 LEDs on the front of the drive controller that provide information about the connection between controller and
drive controller and about the state of the data exchange. This information can also be read out in parameter A271 PN
state.

BF
Run
Psafe

1
2

Fig. 86: LEDs for the PROFINET state

1 Red: BF (bus error)

2 Green: Run

Red LED Conduct Description

Off No error

Rapid flashing Data exchange with controller not
active

On No network connection

Tab. 218: Meaning of the red LED (BF)

Green LED Conduct Description

Off No connection

Single blink Connection is set up to controller

Single blink, inverse Controller activates DHCP signal service

Flashing Existing connection to controller; data
exchange expected

On Existing connection to controller

Tab. 219: Meaning of the green LED (Run)
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19.2.1.4 PROFIsafe status

If the drive controller includes the SU6 safety module, the STO and SS1 safety functions are activated via PROFIsafe. In this
case, an LED on the front of the device provides information about the status of PROFIsafe communication. This
information can also be read out in parameter S40 PROFIsafe state.

1

BF
Run
Psafe

Fig. 87: LEDs for the PROFIsafe status

1 Green: PROFIsafe

Green LED Conduct Description

Off Initialization

Flashing Ready for parameterization by
controller (F-CPU)

On Normal operation

Rapid flashing with 1x flash Error in the safety-related
communication settings

Rapid flashing with 2x flash Error in the safety-related application
settings

Rapid flashing with 3x flash Incorrect PROFIsafe destination
address

Rapid flashing with 5x flash Interruption of the PROFIsafe
connection (watchdog error)

Rapid flashing with 6x flash Error in the transmission of the
PROFIsafe data (CRC error)

Tab. 220: Meaning of the green LED (PROFIsafe status indicator in accordance with IEC 61784-3)

Information

Parameter S40 PROFIsafe state contains detailed information about the PROFIsafe communication status. The value of S40
can be read off in PROFINET wizard > Monitoring: PROFIsafe in DriveControlSuite.
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19.2.2 Drive controller state
3 LEDs on the front of the device provide information about the state of the drive controller.

1
2
3

SC6/SI6

Fig. 88: LEDs for the state of the drive controller

1 Green: Run

2 Red: Error in axis controller A

3 Red: Error in axis controller B (only for double-axis controllers)

Green LED Conduct Description

Off No supply voltage or axis controller A or B faulty

With firmware version 6.5-H or later:
No supply voltage, axis controller A or B faulty or STO for axis controller
A or B active

Single blink STO active for both axis controllers

With firmware version 6.5-H or later:
STO is indicated by a single blink of the red LED of the respective axis

Flashing Both axis controllers ready to switch on (E48 = 2: Ready for switch-on);
no axis controller faulty

On At least 1 axis controller enabled (E48 = 4: Enabled); no axis controller
faulty

Rapid flashing Data is written to internal memory and the SD card

Tab. 221: Meaning of the green LED (Run)

Red LED Conduct Description

Off No error or event

Single blink With firmware version 6.5-H or later:
STO for axis controller active

Flashing Axis controller has a warning

On Axis controller faulty

With firmware version 6.5-H or later:
Axis controller faulty, no STO active

Single blink, inverse With firmware version 6.5-H or later:
Axis controller faulty, STO active

Rapid flashing No configuration active

Tab. 222: Meaning of the red LEDs (error)
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Pattern when starting the drive controller

LEDs:
Green/Red/Red

Conduct Description

On Short phase while the firmware starts up

On

On

Tab. 223: States of the LEDS when starting the drive controller

Pattern when transferring a firmware file using DriveControlSuite

The states of the green and red LEDs also apply as described during a firmware file transfer using DriveControlSuite.

Pattern when transferring a firmware file using an SD card

When a firmware file is being transferred using an SD card, the three LEDs flash in various combinations and frequencies:

LEDs:
Green/Red/Red

Conduct Description

Off Deleting the second firmware memory on the drive controller

Rapid flashing

Off

Rapid flashing Copying the firmware from the SD card to the second firmware memory
of the drive controller

Rapid flashing

Rapid flashing

Single blink Copying process completed successfully; drive controller has to be
restarted

Off

Off

Off Error during copying process; remove card and restart drive controller

Single blink

Off

Tab. 224: States of the LEDs when using an SD card to transfer a firmware file
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Pattern after transferring a firmware file and restarting the drive controller

After restarting the drive controller (see pattern when starting the drive controller) during a firmware update, the three
LEDs flash in various combinations and frequencies:

LEDs:
Green/Red/Red

Conduct Description

Off Deleting the first firmware memory

Rapid flashing

Off

Rapid flashing Copying the second firmware memory into the first

Off

Off

Chaser light Error during firmware update; service required

Tab. 225: States of the LEDs after transferring a firmware file and restarting the drive controller

19.2.3 Service network connection
The LEDs at X9 on the front of the device display the state of the service network connection.

1

2

Fig. 89: LEDs for the state of the service network connection

1 Green: Link

2 Yellow: Activity

Green LED Behavior Description

Off No network connection

On Network connection present

Tab. 226: Meaning of the green LED (link)

Yellow LED Behavior Description

Off No network connection

Flashing Individual data packets are sent or received

On Active data exchange

Tab. 227: Meaning of the yellow LED (act.)
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19.2.4 Fieldbus network connection
The LEDs for communication diagnostics vary depending on implemented fieldbus system or communication module.

19.2.4.1 EtherCAT network connection

The LEDs LA ECIN and LA ECOUT at X200 and X201 on the top of the device indicate the state of the EtherCAT network
connection.

LA
LA

IN
EC

X2
00

:
O

U
T

EC
X2

01
:

1

2

3

4

Fig. 90: LEDs for the state of the EtherCAT network connection

1 Green: LA ECOUT at X201

2 Yellow: No function

3 Green: LA ECIN at X200

4 Yellow: No function

Green LED Behavior Description

Off No network connection

Flashing Active data exchange with other EtherCAT nodes

On Network connection exists

Tab. 228: Meaning of the green LEDs (LA)
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19.2.4.2 PROFINET network connection

The Act. and Link LEDs at X200 and X201 on the top of the device indicate the state of the PROFINET network connection.

Li
nk

Li
nk

X2
00

X2
01

Ac
t

Ac
t

1

2

3

4

Fig. 91: LEDs for the state of the PROFINET network connection

1 Green: Link at X201

2 Yellow: Activity at X201

3 Green: Link at X200

4 Yellow: Activity at X200

Green LED Conduct Description

Off No network connection

On Network connection exists

Tab. 229: Meaning of the green LEDs (Link)

Yellow LED Conduct Description

Off No data exchange

Flashing Active data exchange with controller

Tab. 230: Meaning of the yellow LEDs (Act.)
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19.2.5 Events
The drive controller has a self-monitoring system that uses test rules to protect the drive system from damage. Violating
the test rules triggers a corresponding event. There is no possible way for you as the user to intervene in some events, such
as the Short/ground event. In others, you can influence the effects and responses.

Possible effects include:

§ Message: Information that can be evaluated by the controller

§ Warning: Information that can be evaluated by the controller and becomes a fault after a defined time span has
elapsed without the cause being resolved

§ Fault: Immediate drive controller response; the power unit is disabled and axis movement is no longer controlled by
the drive controller or the axis is brought to a standstill by a quick stop or emergency braking

Depending on the event, there are various measures you can take to rectify the cause. As soon as the cause has been
successfully rectified, you can usually acknowledge the event immediately. If the drive controller has to be restarted, a
corresponding note can be found in the measures.

ATTENTION!

Damage to property due to interruption of a quick stop or emergency braking!

If, when executing a quick stop or emergency braking, a fault occurs or STO is active, the quick stop or emergency braking is
interrupted. In this case, the machine can be damaged by the uncontrolled axis movement.

Information

To make it easier for control programmers to set up the human-machine interface (HMI), a list of events and their causes
can be found in the STOBER download center at http://www.stoeber.de/en/downloads/ by searching for Events.

http://www.stoeber.de/en/downloads/
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19.2.5.1 Overview

The following table shows the possible events at a glance.

Event

Event 31: Short/ground [} 287]

Event 32: Short/ground internal [} 288]

Event 33: Overcurrent [} 289]

Event 34: Hardware fault [} 290]

Event 35: Watchdog [} 291]

Event 36: High voltage [} 292]

Event 37: Motor encoder [} 293]

Event 38: Temperature drive controller sensor [} 296]

Event 39: Overtemperature drive controller i2t [} 297]

Event 40: Invalid data [} 298]

Event 41: Temp.MotorTMP [} 299]

Event 44: External fault 1 [} 300]

Event 45: Overtemp.motor i2t [} 301]

Event 46: Low voltage [} 302]

Event 47: Torque/force-max. limit [} 303]

Event 48: Brake release monitoring [} 304]

Event 49: Brake [} 305]

Event 50: Safety module [} 306]

Event 51: Virtual master software limit switch [} 307]

Event 52: Communication [} 308]

Event 53: Limit switch [} 309]

Event 54: Following error [} 310]

Event 56: Overspeed [} 311]

Event 57: Runtime requirement [} 312]

Event 59: Overtemperature drive controller i2t [} 313]

Event 60: Application event 0 – Event 67: 
Application event 7 [} 314]

Event 68: External fault 2 [} 315]

Event 69: Motor connection [} 316]

Event 70: Parameter consistency [} 317]

Event 71: Firmware [} 319]

Event 76: Position encoder [} 320]

Event 77: Master encoder [} 323]

Event 78: Position limit cyclic [} 325]

Event 79: Motor/position encoder plausibility [} 326]

Event 80: Illegal action [} 327]

Event 81: Motor allocation [} 328]

Event 85: Excessive jump in reference value [} 329]

Event 86: Unknown LeanMotor record [} 330]
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Event

Event 87: Reference lostReference loss [} 330]

Event 88: Control panel [} 331]

Event 89: Maximum current LM [} 332]

Event 90: Motion block [} 333]

Tab. 231: Events

19.2.5.2 Event 31: Short/ground

The drive controller has a fault:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The behavior of the brakes depends on the configuration of the safety module

Information

An edge change for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

The brake chopper is switched off.

ATTENTION!

Material damage due to repeated activation and deactivation or new enable signal!

Repeated activation and deactivation or a new enable signal with an existing short-circuit can lead to a device fault.

▪ Before the new activation or enable signal, the cause must be found and corrected.

Cause Check and action

Connection error at the motor Check the connection and correct it if necessary

Defective power cable Check the cable and replace it if necessary

Short-circuit in the motor winding Check the motor and replace it if necessary

Short-circuit in the braking resistor Check the braking resistor and replace it if necessary

Short-circuit/ground fault inside
the device

Check whether the fault occurs when switching on the power unit and replace the
drive controller if necessary; the fault can only be acknowledged after 30 s

Tab. 232: Event 31 – Causes and actions
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19.2.5.3 Event 32: Short/ground internal

The drive controller has a fault:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The behavior of the brakes depends on the configuration of the safety module

Information

An edge change for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

The brake chopper is switched off.

ATTENTION!

Material damage due to repeated activation and deactivation!

Repeated activation and deactivation with an existing short-circuit can lead to a device fault.

▪ Before the new activation or enable signal, the cause must be found and corrected.

Cause Check and action

Short-circuit/ground fault inside
the device

Replace the drive controller; the fault cannot be acknowledged

Tab. 233: Event 32 – Causes and actions
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19.2.5.4 Event 33: Overcurrent

The drive controller has a fault if:

§ U30 = 0: Inactive

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with emergency braking if:

§ U30 = 1: Active and

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ U30 = 1: Active and

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by emergency braking

§ The brakes engage

§ At the end of emergency braking, the power unit is disabled and axis movement is no longer controlled by the drive
controller

Information

Emergency braking is only possible for the synchronous servo, Lean, torque, and synchronous linear motor types.

Information

An edge change for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

1: Normal
(shutdown in software), 
2: Fast
(shutdown in hardware)

Short acceleration times Check the actual current using the scope image
and reduce the acceleration values if necessary
(E00); the fault can only be acknowledged 3 s
after the cause has been corrected

Large torque/force limits Check the actual current using the scope image
(E00) and reduce the torque/force limits if
necessary (C03, C05); the fault can only be
acknowledged 3 s after the cause has been
corrected

Wrong drive controller design Check the design and change the drive
controller type if necessary; the fault can only
be acknowledged 3 s after the cause has been
corrected

Short-circuit/ground fault If cause 2 occurs repeatedly, check whether
there is a short-circuit/ground fault

Tab. 234: Event 33 – Causes and actions
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19.2.5.5 Event 34: Hardware fault

The drive controller has a fault:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The behavior of the brakes depends on the configuration of the safety module

Information

An edge change for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

1: FPGA,
2: NOV control unit,
3: NOV-Power Unit,
6: NOV safety module,
7: Current measurement,
8: power supply,
9: power supply,
10: power supply,
11: power supply,
12: Timer control board

Defective drive controller Exchange drive controller; fault cannot be
acknowledged

23: FPGA,
24: FPGA,
25: FPGA,
26: CPU,
27: CPU,
28: CPU,
29: Communication

Defective drive controller Exchange drive controller; fault cannot be
acknowledged

30: power supply Defective drive controller Check encoder power consumption; replace
defective or incorrectly selected component;
fault cannot be acknowledged

Defective encoder

Power output of encoder interface
outside specification

Tab. 235: Event 34 – Causes and actions
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19.2.5.6 Event 35: Watchdog

The drive controller has a fault:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The behavior of the brakes depends on the configuration of the safety module

Information

An edge change for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

The brake chopper and brake release override are non-functional while the runtime system restarts.

Cause Check and action

1: Core 0,
2: Core 1

Microprocessor at full load Check the runtime utilization using the scope
image (E191) and reduce it using a longer cycle
time if necessary (A150)

Microprocessor faulty Check the connection and shielding and correct
them if necessary; replace the drive controller
if necessary

Tab. 236: Event 35 – Causes and actions
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19.2.5.7 Event 36: High voltage

The drive controller has a fault:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The behavior of the brakes depends on the configuration of the safety module

Information

An edge change for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

Short delay times Check the DC link voltage during the braking operation using the scope image (E03)
and, if necessary, reduce the delay values, use a (larger) braking resistor or connect a
DC link

Braking resistor connection error Check the connection to the braking resistor and supply module and correct them if
necessary

Braking resistor overloaded Check the supply module for Warning 1; check that the maximum permitted braking
resistor power loss is suitable for the application; replace the braking resistor if
necessary

Pulse power of the braking resistor
is too low

Check that the braking resistor pulse power is suitable for the application; replace
the braking resistor if necessary

Supply voltage exceeded Check the supply voltage for an overrun of the permitted input voltage and adjust it
if necessary

Tab. 237: Event 36 – Causes and actions
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19.2.5.8 Event 37: Motor encoder

The drive controller has a fault if:

§ U30 = 0: Inactive

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with emergency braking if:

§ U30 = 1: Active and

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ U30 = 1: Active and

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by emergency braking

§ The brakes engage

§ At the end of emergency braking, the power unit is disabled and axis movement is no longer controlled by the drive
controller

Information

Emergency braking is only possible for the synchronous servo, Lean, torque, and synchronous linear motor types.

Information

An edge change for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.
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Cause Check and action

1: Parameter <-> encoder Inconsistent parameterization Compare the specification of the connected
encoder to the corresponding values of the 
H parameters and correct them if necessary

2: Maximum speed Exceeded encoder maximum
velocity

Check the actual velocity during a movement
using the scope image (I88) and adjust the
permitted encoder maximum velocity if
necessary (I297)

Connection error Check the connection and shielding and correct
them if necessary

Mass inertia ratio of load to Lean
motor

Check the setting of the mass inertia ratio (C30)
and reduce it if necessary

Dynamic control of the Lean
motor

Check the control settings; if necessary, reduce
the gain (C31, I20) and increase the reset times
(C32)

Dynamic set values for the Lean
motor

Check the dynamics of the application set values
and reduce them if necessary

Dynamic acceleration of the Lean
motor

Use a scope image to check the actual velocity
and shifting speed during a movement (E15,
E959) and reduce the shifting filter time constant
if necessary (B137)

6: X4 EnDat encoder found Inconsistent parameterization Compare the connected encoder to the
parameterized encoder and correct it if
necessary (H00)

7: X4 A track/Incremental Connection error Check the connection and correct it if necessary

8: X4 no encoder found Connection error Check the connection and correct it if necessary

Defective encoder cable Check the cable and replace it if necessary

Faulty supply voltage Check the supply voltage of the encoder and
correct if necessary

Inconsistent parameterization Compare the connected encoder to the
parameterized encoder and correct it if
necessary (H00)

10: X4 A track/Clk,
11: X4 B track/Dat

Defective encoder cable Check the cable and replace it if necessary

13: X4-EnDat alarm Defective EnDat encoder Replace the motor; EnDat 2.1 digital, EnDat 2.2
digital, EnDat 3: Fault cannot be acknowledged

14: X4 EnDat CRC,
15: X4 double transmission

Connection error Check the connection and correct it if necessary

Electromagnetic interference Take EMC recommendations into account
[} 128] and, if necessary, increase the fault
tolerance (B298)

16: X4 busy Synchronization error Update firmware

17: EBI encoder low battery Battery in battery module weak Replace the battery; reference remains intact

18: EBI encoder battery empty Battery in battery module empty Replace the battery

Initial connection –

Connection error Check the connection and correct it if necessary

Defective encoder cable Check the cable and replace it if necessary

Faulty battery module Check the battery module and replace it if
necessary



STOBER 19 | Diagnostics
02

/2
02

4 
| 

ID
 4

42
72

8.
12

295

Cause Check and action

19: Alarm bit Encoder fault Check the specification of the encoder regarding
the alarm bit

20: Resolver carrier,
21: Resolver sin/cos undervoltage,
22: Resolver sin/cos overvoltage

Defective encoder cable Check the cable and replace it if necessary

Incompatible encoder Compare the specification of the encoder with
the corresponding specifications from STOBER
and replace the encoder or motor if necessary;
fault cannot be acknowledged

21: Resolver sin/cos undervoltage Incompatible encoder;
phase search or calibration of the
optimal resolver excitation failed

Compare the specification of the encoder with
the corresponding specifications from STOBER;
if necessary, calibrate the starting point for
calibrating the optimal resolver excitation and
the phase search (B40); fault cannot be
acknowledged

24: Resolver failure Defective encoder cable Check the cable and replace it if necessary

48: X4 zero pulse missing Defective encoder cable Check the cable and replace it if necessary

Connection error Check the connection and correct it if necessary

Late zero track Check number of encoder increments per
rotation and correct it if necessary (H02)

49: X4 zero pulse distance too
small

Defective encoder cable Check the cable and replace it if necessary

Connection error Check the connection and correct it if necessary

Early zero track Check number of encoder increments per
rotation and correct it if necessary (H02)

60: Hiperface synchronisation,
61: Hiperface timeout,
62: Hiperface signal quality,
63: Hiperface link

Defective encoder cable Check the cable and replace it if necessary

Connection error Check the connection and correct it if necessary

Electromagnetic interference Take EMC recommendations into account
[} 128] and, if necessary, increase the fault
tolerance (B298)

64: EnDat3 Timeout,
65: EnDat3 invalid Request,
66: EnDat3 Position Check

Defective encoder cable Check the cable and replace it if necessary

Connection error Check the connection and correct it if necessary

Electromagnetic interference Take EMC recommendations into account
[} 128] and, if necessary, increase the fault
tolerance (B298)

Tab. 238: Event 37 – Causes and actions
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19.2.5.9 Event 38: Temperature drive controller sensor

The drive controller has a fault if:

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ A540 = 0: Disable drive motor coasting for CiA 402 device controller

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with a quick stop if:

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by a quick stop

§ During the quick stop, the brakes remain released

§ At the end of the quick stop, the power unit is disabled and axis movement is no longer controlled by the drive
controller

§ The brakes engage

Information

An edge change for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

Surrounding temperatures
too high or too low

Check the surrounding temperature of the drive controller and adjust it to the operating
conditions of the drive controller if necessary; the fault can only be acknowledged 30 s
after the cause has been corrected

Too little air circulation in
the control cabinet

Check the minimum clearances and adjust them if necessary; the fault can only be
acknowledged 30 s after the cause has been corrected

Defective or blocked fan Switch on control unit supply; check that the fan starts and replace the drive controller if
necessary; the fault can only be acknowledged 30 s after the cause has been corrected

Assembly protection film Remove the assembly protection film

Wrong drive controller
design

Check the design and change the drive controller type if necessary; the fault can only be
acknowledged 30 s after the cause has been corrected

Increased or reduced
mechanical friction

Check the service status of the mechanical system of all axes and service them if necessary;
the fault can only be acknowledged 30 s after the cause has been corrected

Mechanical block Check the output of all axes and remove the block if necessary

Short deceleration/
acceleration times

Check the actual current during the braking process using the scope image (E00); reduce
the deceleration and acceleration values if necessary; the fault can only be acknowledged
30 s after the cause has been corrected

Clock frequency too high Check the utilization of the drive, taking into account derating and the configured clock
frequency (E20, B24); reduce the configured clock frequency or replace the drive controller
if necessary; the fault can only be acknowledged 30 s after the cause has been corrected

Tab. 239: Event 38 – Causes and actions
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19.2.5.10 Event 39: Overtemperature drive controller i2t

The possible effects depend on the configured level (U02):

§ 0: Inactive

§ 1: Message

§ 2: Warning

§ 3: Fault

The maximum permitted output current is limited to 100% of I2N,PU (R04). If the i2t value (E24) increases to 105%, event 
59: Overtemperature drive controller i2t is triggered.

The drive controller has a fault if:

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ A540 = 0: Disable drive motor coasting for CiA 402 device controller

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with a quick stop if:

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by a quick stop

§ During the quick stop, the brakes remain released

§ At the end of the quick stop, the power unit is disabled and axis movement is no longer controlled by the drive
controller

§ The brakes engage

Information

An edge change for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

Wrong drive controller design Check the design and change the drive controller type if necessary

Increased or reduced mechanical
friction

Check the service status of the mechanical system of all axes and service them if
necessary

Mechanical block Check the output of all axes and remove the block if necessary

Short deceleration/acceleration
times

Check the actual current during the braking process using the scope image (E00);
reduce the deceleration and acceleration values if necessary

Clock frequency too high Check the utilization of the drive, taking into account derating and the configured
clock frequency (E20, B24); reduce the configured clock frequency or replace the
drive controller if necessary

Tab. 240: Event 39 – Causes and actions
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19.2.5.11 Event 40: Invalid data

The drive controller has a fault:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The behavior of the brakes depends on the configuration of the safety module

Information

An edge change for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

1: Fault,
2: Block missing,
3: Data security,
4: Checksum,
5: Read only,
6: Read error,
7: Block missing,
8: Wrong/illegal serial number

Invalid data in the internal memory
of the drive controller

Determine the affected memory (Z730) and,
based on that, replace the drive controller or
motor; fault cannot be acknowledged

48: Reverse documentation Defective memory in the SD card
or internal memory of the drive
controller

Replace the SD card or drive controller; fault
cannot be acknowledged

Tab. 241: Event 40 – Causes and actions
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19.2.5.12 Event 41: Temp.MotorTMP

The possible effects depend on the configured level (U15):

§ 2: Warning

§ 3: Fault

The drive controller has a fault if:

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ A540 = 0: Disable drive motor coasting for CiA 402 device controller

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with a quick stop if:

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by a quick stop

§ During the quick stop, the brakes remain released

§ At the end of the quick stop, the power unit is disabled and axis movement is no longer controlled by the drive
controller

§ The brakes engage

Information

An edge change for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

Motor temperature sensor
connection error

Check the connection and correct it if necessary

Wrong sensor source for X2 –
 HIPERFACE DSL

Check the sensor settings and correct them if necessary (B35)

Wrong motor design Check the design and change the motor type if necessary

Surrounding temperatures at the
motor too high

Check the surrounding temperature and adjust it if necessary

Mechanical block of the motor Check the output and remove the block if necessary

Increased or reduced mechanical
friction

Check the service status of the mechanical system and service them if necessary

Tab. 242: Event 41 – Causes and actions
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19.2.5.13 Event 44: External fault 1

The drive controller has a fault if:

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ A540 = 0: Disable drive motor coasting for CiA 402 device controller

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with a quick stop if:

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by a quick stop

§ During the quick stop, the brakes remain released

§ At the end of the quick stop, the power unit is disabled and axis movement is no longer controlled by the drive
controller

§ The brakes engage

Information

An edge change for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

Application-specific Application-specific

Tab. 243: Event 44 – Causes and actions
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19.2.5.14 Event 45: Overtemp.motor i2t

The possible effects depend on the parameterized level (U10):

§ 0: Inactive

§ 1: Message

§ 2: Warning

§ 3: Fault

The drive controller has a fault if:

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ A540 = 0: Disable drive motor coasting for CiA 402 device controller

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with a quick stop if:

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by a quick stop

§ During the quick stop, the brakes remain released

§ At the end of the quick stop, the power unit is disabled and axis movement is no longer controlled by the drive
controller

§ The brakes engage

Information

An edge change for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

Wrong motor design Check the design and change the motor type if necessary

Mechanical block of the motor Check the output and remove the block if necessary

Increased or reduced mechanical
friction

Check the service status of the mechanical system and service them if necessary

Tab. 244: Event 45 – Causes and actions
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19.2.5.15 Event 46: Low voltage

The possible effects depend on the configured level (U00):

§ 0: Inactive

§ 1: Message

§ 2: Warning

§ 3: Fault

The drive controller has a fault if:

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ A540 = 0: Disable drive motor coasting for CiA 402 device controller

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with a quick stop if:

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by a quick stop

§ During the quick stop, the brakes remain released

§ At the end of the quick stop, the power unit is disabled and axis movement is no longer controlled by the drive
controller

§ The brakes engage

Information

An edge change for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

Supply voltage does not
correspond to the configured
supply voltage

Check the supply voltage, parameterized supply voltage and undervoltage limit and
correct them if necessary (A36, A35)

Supply voltage below undervoltage
limit

Check undervoltage limit and correct it if necessary (A35)

Tab. 245: Event 46 – Causes and actions
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19.2.5.16 Event 47: Torque/force-max. limit

The possible effects depend on the configured level (U20):

§ 0: Inactive

§ 1: Message

§ 2: Warning

§ 3: Fault

The drive controller has a fault if:

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ A540 = 0: Disable drive motor coasting for CiA 402 device controller

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with a quick stop if:

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by a quick stop

§ During the quick stop, the brakes remain released

§ At the end of the quick stop, the power unit is disabled and axis movement is no longer controlled by the drive
controller

§ The brakes engage

Information

An edge change for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

Incorrectly selected torque/force limits Check the general machine limit and adjust it if necessary (C03, C05); check
the application limits and the parameters dependent on the operating mode
and adjust them if necessary (Drive Based C132, C133 or CiA 402 A559)

Wrong motor design Check the design and change the motor type if necessary

Mechanical block Check the output and remove the block if necessary

Brake closed Check the connection, supply voltage and parameterization and correct them
if necessary (F00)

Connection error at the motor Check the connection and correct it if necessary

Connection error at the encoder Check the connection and correct it if necessary

Wrong encoder measurement direction Compare the attachment and measurement direction of the encoder with the
corresponding values of the H parameters and correct them if necessary

Tab. 246: Event 47 – Causes and actions
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19.2.5.17 Event 48: Brake release monitoring

The possible effects depend on the configured level (U26).

The drive controller has a fault if:

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ A540 = 0: Disable drive motor coasting for CiA 402 device controller

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with a quick stop if:

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by a quick stop

§ During the quick stop, the brakes remain released

§ At the end of the quick stop, the power unit is disabled and axis movement is no longer controlled by the drive
controller

§ The brakes engage

Information

An edge change for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

Connection error Check the connection and correct it if necessary

Release monitoring not adjusted Adjust release monitoring

Tab. 247: Event 48 – Causes and actions
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19.2.5.18 Event 49: Brake

The drive controller has a fault if:

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ A540 = 0: Disable drive motor coasting for CiA 402 device controller

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with a quick stop if:

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by a quick stop

§ During the quick stop, the brakes remain released

§ At the end of the quick stop, the power unit is disabled and axis movement is no longer controlled by the drive
controller

§ The brakes engage

Information

An edge change for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

10: Brake monitoring with engaged
brake,
11: Brake monitoring with released
brake,
12: Brake monitoring during
engaging time,
13: Brake monitoring during
release time

Connection error Check the connection and correct it if necessary

Defective power cable Check the cable and replace it if necessary

Indirect brake connection Check the connection and configured brake
connection and correct them if necessary
(F105)

Tab. 248: Event 49 – Causes and actions
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19.2.5.19 Event 50: Safety module

The drive controller has a fault:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The behavior of the brakes depends on the configuration of the safety module

Information

An edge change for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

1: Inconsistent request (single
channel)

Connection error Check the connection and correct it if
necessary; error cannot be acknowledged until
both STO channels have been requested for at
least 100 ms

2: Wrong safety module The projected E53 safety module
does not match the E54[0]
detected by the system

Check the project configuration and drive
controller and correct the project configuration
or exchange the drive controller if necessary;
fault cannot be acknowledged

3: Internal error Defective safety module Exchange drive controller; fault cannot be
acknowledged

Tab. 249: Event 50 – Causes and actions
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19.2.5.20 Event 51: Virtual master software limit switch

The possible effects depend on the configured level (U24).

§ 0: Inactive

§ 1: Message

§ 3: Fault

The drive controller has a fault if:

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ A540 = 0: Disable drive motor coasting for CiA 402 device controller

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with a quick stop if:

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by a quick stop

§ During the quick stop, the brakes remain released

§ At the end of the quick stop, the power unit is disabled and axis movement is no longer controlled by the drive
controller

§ The brakes engage

Information

An edge change for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Event 51: Virtual master software limit switch only affects the device control of the axis. A quick stop of the virtual master
can also be triggered with G57.

Cause Check and action

1: SW-limit switch positive,
2: SW-limit switch negative

End of the travel range reached Move in the travel range in the direction
opposite the limit switch

Travel range too small Check the positions of the software limit switch
and correct them if necessary (G146, G147)

3: +/- 31 bit computing limit
reached

Computing limit of the data type
reached

Check the command sequences for multiple
successive 3: MC_MoveAdditive commands
without a breakpoint and the number of
decimal places of the axis model and reduce
them if necessary (G46)

Tab. 250: Event 51 – Causes and actions
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19.2.5.21 Event 52: Communication

The drive controller has a fault if:

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ A540 = 0: Disable drive motor coasting for CiA 402 device controller

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with a quick stop if:

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by a quick stop

§ During the quick stop, the brakes remain released

§ At the end of the quick stop, the power unit is disabled and axis movement is no longer controlled by the drive
controller

§ The brakes engage

Information

An edge change for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

4: PZD-Timeout Missing process data Check the cycle time in the controller and tolerated
failure time for monitoring the PZD communication in
the drive controller and correct if necessary (A109)

6: EtherCAT PDO-Timeout Missing process data Check the task cycle time in the EtherCAT master and
the timeout time in the drive controller and correct
them if necessary (A258)

7: Reserved Synchronization error Check the synchronization settings in the EtherCAT
master and correct them if necessary

Connection error Check the connection and shielding and correct them
if necessary

14: PZD parameter figure faulty Missing mapping Check the mapping for unmappable parameters and
correct them if necessary

15: Wrong firmware for
applicataion

Projected fieldbus
identification and that of the
drive controller do not match

Check the projected fieldbus identification and the
fieldbus identification of the drive controller and
change the fieldbus if necessary (E59[2], E52[3])

16: PROFINET Sign-of-Life
synchronisation failed

Synchronization error Obey the information in the TIA Portal and update the
GSD file if necessary; check the controller or
technology object for clock synchronicity and correct
if necessary

Tab. 251: Event 52 – Causes and actions
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19.2.5.22 Event 53: Limit switch

The drive controller has a fault if:

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ A540 = 0: Disable drive motor coasting for CiA 402 device controller

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with a quick stop if:

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by a quick stop

§ During the quick stop, the brakes remain released

§ At the end of the quick stop, the power unit is disabled and axis movement is no longer controlled by the drive
controller

§ The brakes engage

Information

An edge change for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

1: Hardware-Limit-Switch
positive,
2: Hardware-Limit-Switch
negative

End of the travel range reached Move in the travel range in the direction opposite the
limit switch

Connection error Check the connection and source parameters and
correct them if necessary (I101, I102)

Defective cable Check the cable and replace it if necessary

3: SW-limit switch positive,
4: SW-limit switch negative

End of the travel range reached Move in the travel range in the direction opposite the
limit switch

Travel range too small Check the positions of the software limit switches and
correct them if necessary (Drive Based I50, I51 or CiA
A570[0], A570[1])

5: +/- 31 bit computing limit
reached

Computing limit of the data
type reached

Check the command sequences for multiple
successive 3: MC_MoveAdditive commands without a
breakpoint and the number of decimal places of the
axis model and reduce them if necessary (I06)

6: Linear motor moving range Axis is 200 m away from the
commutation reference point

Check the axis model and correct it if necessary

7: Both limit switches not
connected

Connection error Check the connection and source parameters and
correct them if necessary (I101, I102)

Defective cable Check the cable and replace it if necessary

Tab. 252: Event 53 – Causes and actions
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19.2.5.23 Event 54: Following error

The possible effects depend on the configured level (U22).

§ 0: Inactive

§ 1: Message

§ 2: Warning

§ 3: Fault

The drive controller has a fault if:

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ A540 = 0: Disable drive motor coasting for CiA 402 device controller

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with a quick stop if:

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by a quick stop

§ During the quick stop, the brakes remain released

§ At the end of the quick stop, the power unit is disabled and axis movement is no longer controlled by the drive
controller

§ The brakes engage

Information

An edge change for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

Incorrectly selected torque/force
limits

Check the general machine limit and adjust it if necessary (C03, C05); check the
application limits and adjust them if necessary (Drive Based/PROFIdrive: C132, C133
and the parameters dependent on the operating mode; CiA 402: A559)

Maximum permitted lag is too
small

Check the maximum permitted following error and correct it if necessary (Drive
Based/PROFIdrive: I21; CiA 402: A546)

Mechanical block Check the output and remove the block if necessary

Brake closed Check the connection, supply voltage and parameterization and correct them if
necessary (F00)

Tab. 253: Event 54 – Causes and actions
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19.2.5.24 Event 56: Overspeed

The drive controller has a fault if:

§ U30 = 0: Inactive

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with emergency braking if:

§ U30 = 1: Active and

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ U30 = 1: Active and

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by emergency braking

§ The brakes engage

§ At the end of emergency braking, the power unit is disabled and axis movement is no longer controlled by the drive
controller

Information

Emergency braking is only possible for the synchronous servo, Lean, torque, and synchronous linear motor types.

Information

An edge change for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Information

The event is only triggered if the checking rules for Enable-on are violated.

Cause Check and action

1: Motor encoder,
2: Position encoder,
3: Motor & position encoder

Maximum permitted velocity
too small

Check the maximum permitted velocity and increase
it if necessary (I10)

Overshooting control system Check the actual velocity using the scope image
(Sensing time: 250 µs, actual motor velocity: E15,
E91; actual position velocity I88) and, if necessary,
reduce the gain of the control system (I20, C31)

1: Motor encoder,
3: Motor & position encoder

Wrong commutation offset Check the commutation offset using the Test phase
action (B40)

Faulty motor encoder Check the velocity display of the encoder at a
standstill (E15, E91) and replace the encoder if
necessary

2: Position encoder,
3: Motor & position encoder

Faulty position encoder Check the velocity display of the encoder at a
standstill (I88) and replace the encoder if necessary

Tab. 254: Event 56 – Causes and actions
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19.2.5.25 Event 57: Runtime requirement

The drive controller has a fault if:

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ A540 = 0: Disable drive motor coasting for CiA 402 device controller

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with a quick stop if:

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by a quick stop

§ During the quick stop, the brakes remain released

§ At the end of the quick stop, the power unit is disabled and axis movement is no longer controlled by the drive
controller

§ The brakes engage

Information

An edge change for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

3: RT3,
4: RT4,
5: RT5

Exceeding the cycle time Check the utilization (E191) and increase the
cycle time if necessary (A150)

Tab. 255: Event 57 – Causes and actions
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19.2.5.26 Event 59: Overtemperature drive controller i2t

The drive controller has a fault if:

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ A540 = 0: Disable drive motor coasting for CiA 402 device controller

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with a quick stop if:

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by a quick stop

§ During the quick stop, the brakes remain released

§ At the end of the quick stop, the power unit is disabled and axis movement is no longer controlled by the drive
controller

§ The brakes engage

Information

An edge change for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

Wrong drive controller design Check the design and change the drive controller type if necessary; the fault can only
be acknowledged 30 s after the cause has been corrected

Increased or reduced mechanical
friction

Check the service status of the mechanical system and service them if necessary; the
fault can only be acknowledged 30 s after the cause has been corrected

Short deceleration/acceleration
times

Check the actual current during the braking process using the scope image (E00);
reduce the deceleration and acceleration values if necessary; the fault can only be
acknowledged 30 s after the cause has been corrected

Clock frequency too high Check the utilization of the drive, taking into account derating and the configured
clock frequency (E20, B24); reduce the configured clock frequency or replace the
drive controller if necessary; the fault can only be acknowledged 30 s after the cause
has been corrected

Tab. 256: Event 59 – Causes and actions
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19.2.5.27 Event 60: Application event 0 – Event 67: 
Application event 7

The possible effects depend on the configured level (U100, U110, U120, U130, U140, U150, U160, U170):

§ 0: Inactive

§ 1: Message

§ 2: Warning

§ 3: Fault

The drive controller has a fault if:

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ A540 = 0: Disable drive motor coasting for CiA 402 device controller

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with a quick stop if:

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by a quick stop

§ During the quick stop, the brakes remain released

§ At the end of the quick stop, the power unit is disabled and axis movement is no longer controlled by the drive
controller

§ The brakes engage

Information

An edge change for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

Application-specific Application-specific

Tab. 257: Events 60 – 67 – Causes and actions
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19.2.5.28 Event 68: External fault 2

The drive controller has a fault if:

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ A540 = 0: Disable drive motor coasting for CiA 402 device controller

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with a quick stop if:

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by a quick stop

§ During the quick stop, the brakes remain released

§ At the end of the quick stop, the power unit is disabled and axis movement is no longer controlled by the drive
controller

§ The brakes engage

Information

An edge change for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

Application-specific Application-specific

Tab. 258: Event 68 – Causes and actions



19 | Diagnostics STOBER

316

02
/2

02
4 

| 
ID

 4
42

72
8.

12

19.2.5.29 Event 69: Motor connection

The possible effects depend on the configured level (U12).

§ 0: Inactive

§ 3: Fault

The drive controller has a fault if:

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ A540 = 0: Disable drive motor coasting for CiA 402 device controller

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with a quick stop if:

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by a quick stop

§ During the quick stop, the brakes remain released

§ At the end of the quick stop, the power unit is disabled and axis movement is no longer controlled by the drive
controller

§ The brakes engage

Information

An edge change for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

2: No motor connected Connection error Check the connection and correct it if necessary

Defective power cable Check the cable and replace it if necessary

3: Wake and Shake failed
(Commutation finding with Wake
and Shake failed)

Increased or reduced mechanical
friction

Check the service status of the mechanical
system and service them if necessary

Mechanical block Check the output and remove the block if
necessary

Axis with large mass inertia Increase minimum wait time between Wake
and Shakes (B33)

4: Brake
(Commutation finding with Wake
and Shake failed)

Brake engaged Check control of the brakes and carry out
action B50 if necessary,
see Commutation finding [} 396]

Tab. 259: Event 69 – Causes and actions
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19.2.5.30 Event 70: Parameter consistency

The drive controller has a fault:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The behavior of the brakes depends on the configuration of the safety module

Information

An edge change for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Information

The event is only triggered if the checking rules for Enable-on are violated.

Cause Check and action

1: Wrong encoder model Encoder model unsuitable for
control type

Check the control mode, motor encoder and
encoder and correct them if necessary (B20,
B26, H parameters)

3: B12<->B20 Nominal current of the motor
exceeds the drive controller
nominal current (4 kHz)

Check the motor nominal current against 150%
of the drive controller nominal current at a
clock frequency of 4 kHz and, if necessary,
reduce the motor nominal current or change
the drive controller type (B12, R04[0])

4: B10<->H31 Unsupported combination of
resolver/motor number of poles

Check number of poles of the resolver and
number of poles of the motor and correct them
if necessary (H08, H148, B10)

5: Negative slip frequency Negative slip Check the nominal velocity, nominal frequency
and number of poles of the motor and, if
necessary, correct them (B13, B15, B10)

8: v-max (I10) exeeds maximum
(B83)

Maximum permitted velocity
exceeds the maximum motor
velocity

Check the maximum permitted velocity and the
maximum motor velocity and correct them if
necessary (I10, B83)

B83 parameterized too large Reduce B83 to max. 6000 rpm

11: Reference retaining Conditions for reference without
tracking not met

Check that the reference is retained and that
the measurement range covers the travel range
and make corrections if necessary (I46, limited
travel range I00: Software limit switch must be
parameterized; infinite travel range I00:
Measurement range must correspond to the
revolution length Drive Based/PROFIdrive I01
or CiA 402 A568[1] or an entire multiple)

12: Type of axis Rotational axis model not suitable
for synchronous linear motor

Correct the axis type of the axis model (I00)

13: Motor temperature sensor Unsupported temperature sensors Check the motor temperature sensor type in
the motor and the drive controller series and, if
necessary, change the motor or drive controller
series
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Cause Check and action

14: Max. acceleration I11>B143 Maximum permitted velocity is
above maximum motor
acceleration

Check the maximum permissible velocity and
maximum motor acceleration and correct them
if necessary (Drive Based/PROFIdrive: I11; CiA
402: minimum values of A604 and A605, B143)

SY6 option:
15: Safety watchdog time

Monitoring of PDO timeout
deactivated

Check the EtherCAT PDO timeout in the drive
controller and activate it if necessary (A258 = 0
or 65535)

SyncManager watchdog = 0 Check the EtherCAT SyncManager watchdog in
the EtherCAT master and increase it if
necessary (A258 = 65534, A259[0])

Ratio of FSoE watchdog time to
EtherCAT PDO timeout too small

Check the FSoE watchdog time in the FSoE
master and EtherCAT PDO timeout in the drive
controller; if necessary, increase the watchdog
time or reduce the timeout (guide value: FSoE
watchdog time = EtherCAT PDO timeout +
100 ms; S27, A258)

Ratio of FSoE watchdog time to
EtherCAT SyncManager watchdog
too small

Check the FSoE watchdog time in the FSoE
master and EtherCAT SyncManager watchdog
in the EtherCAT master; if necessary, increase
the watchdog time or reduce the SyncManager
watchdog (guide value: FSoE watchdog time =
EtherCAT SyncManager watchdog + 100 ms;
S27, A258 = 65534, A259[0])

SU6 option:
15: Safety watchdog time

Monitoring of PZD timeout
deactivated

Check the PZD timeout in the drive controller
and activate it if necessary (A109 = 0 or 65535)

Ratio of PROFIsafe watchdog time
to PZD timeout too small

Check the PROFIsafe watchdog time in
TIA Portal and PZD timeout in the drive
controller; if necessary, increase the watchdog
time or reduce the PZD timeout (guide value:
PROFIsafe watchdog time = PZD timeout +
PROFIsafe cycle time + 50 ms; S46 = A109 + S44
+ 50 ms)

16: I10 > C11 Maximum permitted velocity is
above maximum gear unit input
speed

Check the maximum permitted velocity and the
maximum gear unit input speed and correct
them if necessary (I10, C11)

Tab. 260: Event 70 – Causes and actions
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19.2.5.31 Event 71: Firmware

Cause 1:

The drive controller has a fault:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The behavior of the brakes depends on the configuration of the safety module

Information

An edge change for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause 3:

The drive controller has a fault if:

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ A540 = 0: Disable drive motor coasting for CiA 402 device controller

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with a quick stop if:

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by a quick stop

§ During the quick stop, the brakes remain released

§ At the end of the quick stop, the power unit is disabled and axis movement is no longer controlled by the drive
controller

§ The brakes engage

Information

An edge change for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

1: Firmware defective Defective firmware Update the firmware; fault cannot be acknowledged

Defective drive controller Exchange drive controller; fault cannot be
acknowledged

3: CRC-error Defective firmware Update the firmware; fault cannot be acknowledged

Defective drive controller Check for repeated triggering of the event after a
restart; if necessary, replace the drive controller

Tab. 261: Event 71 – Causes and actions
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19.2.5.32 Event 76: Position encoder

The drive controller has a fault if:

§ U30 = 0: Inactive and

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ U30 = 1: Active and

§ A540 = 0: Disable drive motor coasting for CiA 402 device controller

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with a quick stop if:

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by a quick stop

§ During the quick stop, the brakes remain released

§ At the end of the quick stop, the power unit is disabled and axis movement is no longer controlled by the drive
controller

§ The brakes engage

The drive controller has a fault with emergency braking if:

§ U30 = 1: Active and

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ U30 = 1: Active and

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by emergency braking

§ The brakes engage

§ At the end of emergency braking, the power unit is disabled and axis movement is no longer controlled by the drive
controller

Information

Emergency braking is only possible for the synchronous servo, Lean, torque, and synchronous linear motor types.

Information

An edge change for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

The reference is deleted (I86).
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Cause Check and action

1: Parameter <-> encoder Inconsistent parameterization Compare the specification of the connected
encoder to the corresponding values of the 
H parameters and correct them if necessary

2: Maximum speed Exceeded encoder maximum
velocity

Check the actual velocity during a movement using
the scope image (I88) and adjust the permitted
encoder maximum velocity if necessary (I297)

Connection error Check the connection and shielding and correct
them if necessary

Mass inertia ratio of load to
Lean motor

Check the setting of the mass inertia ratio (C30)
and reduce it if necessary

Dynamic control of the Lean
motor

Check the control settings; if necessary, reduce the
gain (C31, I20) and increase the reset times (C32)

Dynamic set values for the
Lean motor

Check the dynamics of the application set values
and reduce them if necessary

Dynamic acceleration of the
Lean motor

Use a scope image to check the actual velocity and
shifting speed during a movement (E15, E959) and
reduce the shifting filter time constant if necessary
(B137)

6: X4 EnDat encoder found Inconsistent parameterization Compare the connected encoder to the
parameterized encoder and correct it if necessary
(H00)

7: X4 A track/Incremental Connection error Check the connection and correct it if necessary

8: X4 no encoder found Connection error Check the connection and correct it if necessary

Defective encoder cable Check the cable and replace it if necessary

Faulty supply voltage Check the supply voltage of the encoder and
correct if necessary

Inconsistent parameterization Compare the connected encoder to the
parameterized encoder and correct it if necessary
(H00)

9: Referencing failed Reference set for inactive Lean
motor position determination

Check device status (E48) and, if necessary, activate
the enable signal

10: X4 A track/Clk,
11: X4 B track/Dat

Defective encoder cable Check the cable and replace it if necessary

13: X4-EnDat alarm Defective EnDat encoder Replace the motor; EnDat 2.1 digital, EnDat 2.2
digital, EnDat 3: Fault cannot be acknowledged

14: X4 EnDat CRC,
15: X4 double transmission

Connection error Check the connection and correct it if necessary

Electromagnetic interference Take EMC recommendations into account [} 128]
and, if necessary, increase the fault tolerance (I298)

16: X4 busy Synchronization error Update firmware

17: EBI encoder low battery Battery in battery module
weak

Replace the battery; reference is not deleted by the
event

18: EBI encoder battery empty Battery in battery module
empty

Replace the battery

Initial connection –

Connection error Check the connection and correct it if necessary

Defective encoder cable Check the cable and replace it if necessary

Faulty battery module Check the battery module and replace it if
necessary
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Cause Check and action

19: Alarm bit Encoder fault Check the specification of the encoder regarding
the alarm bit

20: Resolver carrier,
21: Resolver sin/cos undervoltage,
22: Resolver sin/cos overvoltage

Defective encoder cable Check the cable and replace it if necessary

Incompatible encoder Compare the specification of the encoder with the
corresponding specifications from STOBER and
replace the encoder or motor if necessary; fault
cannot be acknowledged

21: Resolver sin/cos undervoltage Incompatible encoder;
phase search or calibration of
the optimal resolver excitation
failed

Compare the specification of the encoder with the
corresponding specifications from STOBER;
if necessary, calibrate the starting point for
calibrating the optimal resolver excitation and the
phase search (B40); fault cannot be acknowledged

24: Resolver failure Defective encoder cable Check the cable and replace it if necessary

48: X4 zero pulse missing Defective encoder cable Check the cable and replace it if necessary

Connection error Check the connection and correct it if necessary

Late zero track Check number of encoder increments per rotation
and correct it if necessary (H02)

49: X4 zero pulse distance too
small

Defective encoder cable Check the cable and replace it if necessary

Connection error Check the connection and correct it if necessary

Early zero track Check number of encoder increments per rotation
and correct it if necessary (H02)

60: Hiperface synchronisation,
61: Hiperface timeout,
62: Hiperface signal quality,
63: Hiperface link

Defective encoder cable Check the cable and replace it if necessary

Connection error Check the connection and correct it if necessary

Electromagnetic interference Take EMC recommendations into account [} 128]
and, if necessary, increase the fault tolerance (I298)

64: EnDat3 Timeout,
65: EnDat3 invalid Request,
66: EnDat3 Position Check

Defective encoder cable Check the cable and replace it if necessary

Connection error Check the connection and correct it if necessary

Electromagnetic interference Take EMC recommendations into account [} 128]
and, if necessary, increase the fault tolerance (I298)

Tab. 262: Event 76 – Causes and actions
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19.2.5.33 Event 77: Master encoder

The drive controller has a fault if:

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ A540 = 0: Disable drive motor coasting for CiA 402 device controller

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with a quick stop if:

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by a quick stop

§ During the quick stop, the brakes remain released

§ At the end of the quick stop, the power unit is disabled and axis movement is no longer controlled by the drive
controller

§ The brakes engage

Information

An edge change for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

The reference is deleted (G89).

Cause Check and action

1: Parameter <-> encoder Inconsistent parameterization Compare the specification of the connected encoder
to the corresponding values of the 
H parameters and correct them if necessary

2: Maximum speed Exceeded encoder maximum
velocity

Check the actual velocity during a movement using
the scope image (G105) and adjust the permitted
encoder maximum velocity if necessary (G297)

Connection error Check the connection and shielding and correct them
if necessary

6: X4 EnDat encoder found Inconsistent parameterization Compare the connected encoder to the
parameterized encoder and correct it if necessary
(H00)

7: X4 A track/Incremental Connection error Check the connection and correct it if necessary

8: X4 no encoder found Connection error Check the connection and correct it if necessary

Defective encoder cable Check the cable and replace it if necessary

Faulty supply voltage Check the supply voltage of the encoder and correct
if necessary

Inconsistent parameterization Compare the connected encoder to the
parameterized encoder and correct it if necessary
(H00)
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Cause Check and action

10: X4 A track/Clk,
11: X4 B track/Dat

Defective encoder cable Check the cable and replace it if necessary

13: X4-EnDat alarm Defective EnDat encoder Replace the motor; EnDat 2.1 digital, EnDat 2.2
digital, EnDat 3: Fault cannot be acknowledged

14: X4 EnDat CRC,
15: X4 double transmission

Connection error Check the connection and correct it if necessary

Electromagnetic interference Take EMC recommendations into account [} 128]
and, if necessary, increase the fault tolerance (G298)

16: X4 busy Synchronization error Update firmware

17: EBI encoder low battery Battery in battery module weak Replace the battery; reference is not deleted by the
event

18: EBI encoder battery empty Battery in battery module
empty

Replace the battery

Initial connection –

Connection error Check the connection and correct it if necessary

Defective encoder cable Check the cable and replace it if necessary

Faulty battery module Check the battery module and replace it if necessary

19: Alarm bit Encoder fault Check the specification of the encoder regarding the
alarm bit

20: Resolver carrier,
21: Resolver sin/cos
undervoltage,
22: Resolver sin/cos overvoltage

Defective encoder cable Check the cable and replace it if necessary

Incompatible encoder Compare the specification of the encoder with the
corresponding specifications from STOBER and
replace the encoder or motor if necessary; fault
cannot be acknowledged

21: Resolver sin/cos
undervoltage

Incompatible encoder;
phase search or calibration of
the optimal resolver excitation
failed

Compare the specification of the encoder with the
corresponding specifications from STOBER;
if necessary, calibrate the starting point for
calibrating the optimal resolver excitation and the
phase search (B40); fault cannot be acknowledged

24: Resolver failure Defective encoder cable Check the cable and replace it if necessary

48: X4 zero pulse missing Defective encoder cable Check the cable and replace it if necessary

Connection error Check the connection and correct it if necessary

Late zero track Check number of encoder increments per rotation
and correct it if necessary (H02)

49: X4 zero pulse distance too
small

Defective encoder cable Check the cable and replace it if necessary

Connection error Check the connection and correct it if necessary

Early zero track Check number of encoder increments per rotation
and correct it if necessary (H02)

60: Hiperface synchronisation,
61: Hiperface timeout,
62: Hiperface signal quality,
63: Hiperface link

Defective encoder cable Check the cable and replace it if necessary

Connection error Check the connection and correct it if necessary

Electromagnetic interference Take EMC recommendations into account [} 128]
and, if necessary, increase the fault tolerance (G298)

64: EnDat3 Timeout,
65: EnDat3 invalid Request,
66: EnDat3 Position Check

Defective encoder cable Check the cable and replace it if necessary

Connection error Check the connection and correct it if necessary

Electromagnetic interference Take EMC recommendations into account [} 128]
and, if necessary, increase the fault tolerance (G298)

Tab. 263: Event 77 – Causes and actions
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19.2.5.34 Event 78: Position limit cyclic

The drive controller has a fault if:

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ A540 = 0: Disable drive motor coasting for CiA 402 device controller

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with a quick stop if:

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by a quick stop

§ During the quick stop, the brakes remain released

§ At the end of the quick stop, the power unit is disabled and axis movement is no longer controlled by the drive
controller

§ The brakes engage

Information

An edge change for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

1: Illegal direction Cyclical set position outside of the
software limit switch

Check the set position in the controller and
software limit switch in the drive controller and
correct it if necessary (PROFIdrive: I50, I51;
CiA 402: A570)

2: Reference value invalid Cyclical set position outside of the
travel range

Check the set position in the controller and
travel range in the drive controller and correct
it if necessary (PROFIdrive: I01; CiA 402: A568)

3: Extrapolation time I423
exceeded

Missing update of the cyclical set
position or cyclical set velocity

Check the task cycle time in the fieldbus master
of the controller and maximum permitted
extrapolation in the drive controller and correct
it if necessary (I423)

Tab. 264: Event 78 – Causes and actions
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19.2.5.35 Event 79: Motor/position encoder plausibility

The possible effects depend on the configured level (U28).

§ 0: Inactive

§ 1: Message

§ 3: Fault

The drive controller has a fault if:

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ A540 = 0: Disable drive motor coasting for CiA 402 device controller

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with a quick stop if:

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by a quick stop

§ During the quick stop, the brakes remain released

§ At the end of the quick stop, the power unit is disabled and axis movement is no longer controlled by the drive
controller

§ The brakes engage

Information

An edge change for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

Connection error Check the connection and shielding and correct them if necessary

Slip Check the mechanics between the motor and position encoder and maximum
permitted slip and correct them if necessary (I291, I292)

Mechanical damage Check the mechanics between the motor and position encoder and correct any
damage if necessary

Tab. 265: Event 79 – Causes and actions
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19.2.5.36 Event 80: Illegal action

The drive controller has a fault:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The behavior of the brakes depends on the configuration of the safety module

Information

An edge change for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

1: Illegal Not supported by the control type Check the control type and correct it if
necessary (B20)

2: Brake Loaded axis Remove the axis load and start the action again

Tab. 266: Event 80 – Causes and actions
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19.2.5.37 Event 81: Motor allocation

The possible effects depend on the configured level (U04):

§ 0: Inactive

§ 1: Message

§ 3: Fault

The drive controller has a fault:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The behavior of the brakes depends on the configuration of the safety module

Information

An edge change for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Depending on the cause, data for the motor (in the case of a change to the motor or motor type), current controller (in the
case of a change to the motor type), brake (in the case of a change to the brake or motor type), temperature sensor (in the
case of a change to the temperature sensor or motor type) or motor adapter, gear unit and geared motor (in the case of a
change to the gear unit type) are read out of the electronic nameplate and entered in the respective parameters. In the
event of a change to the motor, motor type or even just the commutation, the commutation offset (B05) is reset.

Cause Check and action

1: Different motor type Modified motor assignment Check the change to the motor assignment and
save the new motor assignment if necessary (A00)

Modified gear unit
assignment

Check the change to the gear unit assignment and
save the new assignment if necessary (A00)

32: Different motor,
33: Different motor & brake,
34: Different motor & temperature
sensor,
35: Different motor & brake &
temperature sensor,
38: Different motor, temperature
sensor & gear unit,
64: Different commutation,
65: Different commutation & brake,
66: Different commutation &
temperature sensor,
67: Different commutation & brake &
temperature sensor,
129: Different brake,
130: Different temperature sensor,
131: Different brake & temperature
sensor

Modified motor assignment Check the change to the motor assignment and
save the new assignment if necessary (A00)

36: Different motor & gear unit
37: Different motor, brake & gear
unit,
39: Different motor, brake,
temperature sensor & gear unit

Modified motor and gear
unit assignment

Check the change to the motor and gear unit
assignment and save the new assignment if
necessary (A00)

150: Temperature sensor unknown Motor with unknown
temperature sensor type

Update the firmware or change the motor

Tab. 267: Event 81 – Causes and actions
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19.2.5.38 Event 85: Excessive jump in reference value

The drive controller has a fault if:

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ A540 = 0: Disable drive motor coasting for CiA 402 device controller

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with a quick stop if:

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by a quick stop

§ During the quick stop, the brakes remain released

§ At the end of the quick stop, the power unit is disabled and axis movement is no longer controlled by the drive
controller

§ The brakes engage

Information

An edge change for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

1: Position Fast set position change leads to
acceleration that cannot be
performed

Check the current set acceleration against the
maximum permitted acceleration in the drive
controller (E64, E69) and reduce the set value
change in the controller or change the motor
type if necessary

2: Velocity Fast set velocity change leads to
acceleration that cannot be
performed

Check the current set acceleration against the
maximum permitted acceleration in the drive
controller (E64, E69) and reduce the set value
change in the controller or change the motor
type if necessary

Tab. 268: Event 85 – Causes and actions
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19.2.5.39 Event 86: Unknown LeanMotor record

The drive controller has a fault if:

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ A540 = 0: Disable drive motor coasting for CiA 402 device controller

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with a quick stop if:

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by a quick stop

§ During the quick stop, the brakes remain released

§ At the end of the quick stop, the power unit is disabled and axis movement is no longer controlled by the drive
controller

§ The brakes engage

Information

An edge change for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

1: Motor Motor type not supported by
firmware

Update the firmware or change the motor
(B100)

2: Cable length Cable length not supported by
firmware

Update the firmware or change the cable
(B101)

Tab. 269: Event 85 – Causes and actions

19.2.5.40 Event 87: Reference lostReference loss

A reference loss is issued as a message only.

Cause Check and action

Power unit switched off on moving
axis

Reference the drive again and, if necessary, only shut off the power unit at standstill
(I199)

Actual position (motor) changes
when power unit is shut off

Do not change the actual position (motor) when the power unit is shut off and, if
applicable, switch to a motor with a brake (F00)

Tab. 270: Event 87 – Causes and actions
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19.2.5.41 Event 88: Control panel

The drive controller has a fault if:

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ A540 = 0: Disable drive motor coasting for CiA 402 device controller

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with a quick stop if:

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by a quick stop

§ During the quick stop, the brakes remain released

§ At the end of the quick stop, the power unit is disabled and axis movement is no longer controlled by the drive
controller

§ The brakes engage

Information

An edge change for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

Commissioning and
parameterization computer heavily
loaded

Check the number of open windows (DS6) and the number of active programs and
reduce the number if necessary

Connection error Check the connection and correct it if necessary

Defective network cable Check the cable and replace it if necessary

Faulty network connection Check the network settings and, if applicable, the switch, router or wireless
connections and correct them or contact your network service provider if necessary

Tab. 271: Event 88 – Causes and actions
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19.2.5.42 Event 89: Maximum current LM

The drive controller has a fault if:

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ A540 = 0: Disable drive motor coasting for CiA 402 device controller

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with a quick stop if:

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by a quick stop

§ During the quick stop, the brakes remain released

§ At the end of the quick stop, the power unit is disabled and axis movement is no longer controlled by the drive
controller

§ The brakes engage

Information

An edge change for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

1: Id,
2: Iq

Excessive controller gain at low
speeds

Check the controller coefficients and speed
controller factors and reduce them if necessary
(I19, C31, B146, B147)

Tab. 272: Event 89 – Causes and actions
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19.2.5.43 Event 90: Motion block

The drive controller has a fault if:

§ A29 = 0: Inactive for Drive Based or PROFIdrive device control
or

§ A540 = 0: Disable drive motor coasting for CiA 402 device controller

Response:

§ The power unit is disabled and axis movement is no longer controlled by the drive controller

§ The brakes engage

The drive controller has a fault with a quick stop if:

§ A29 = 1: Active for Drive Based or PROFIdrive device control
or

§ A540 = 2: Slow down on quick stop ramp for CiA 402 device controller

Response:

§ The axis is stopped by a quick stop

§ During the quick stop, the brakes remain released

§ At the end of the quick stop, the power unit is disabled and axis movement is no longer controlled by the drive
controller

§ The brakes engage

Information

An edge change for the release override signal (source: F06) is expected in the Switch on disabled, Ready to switch on, and
Switched on states (E48) so that the brake is released.

Cause Check and action

1: Next motion block missing Subsequent motion block for
motion block with final velocity is
missing

Define buffered subsequent motion block

2: Target Position in reverse
direction

Set position is in the opposite
direction

A change of travel direction by the subsequent
motion block is not permitted for motion
blocks with final velocity; adjust the set
position

Set position cannot be reached
without reversing

Check limiting values for velocity, deceleration
and jerk and adjust if necessary

Tab. 273: Event 90 – Causes and actions
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19.3 Acknowledging faults
There are several options for acknowledging faults. As a rule, an acknowledgement is also transmitted to the safety module.

Application-independent

Irrespective of the application, you can acknowledge faults via the control panels in DriveControlSuite.

Drive Based application

In the Drive Based application, the following options for acknowledging are available in DriveControlSuite:

§ By defining the source of the signal in A61 (source: digital input or control byte A180, bit 1)

§ By additional enable signal via A60 (source: digital input or control byte A180, bit 0)

The drive controller has a configurable restart (A34) in the Drive Based application.

WARNING!

Injury to persons and material damage due to unexpected motor startup!

Only activate autostart if the standards and regulations applicable to the system or machine in question permit a direct
switch to the Operation enabled device state.

▪ In accordance with EN 61800-5-1, clearly mark an activated autostart on the system and in the associated system
documentation.

CiA 402 application

In the CiA 402 application, you can acknowledge faults in DriveControlSuite using control word A515, bit 3 (Enable
operation) or bit 7 (Fault reset).

PROFIdrive application

In the PROFIdrive application, you can acknowledge faults in DriveControlSuite using control word M515, bit 3 (Enable
operation) or bit 7 (Fault acknowledge).
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20 Analysis
Scope and multi-axis scope in DriveControlSuite are two analysis tools that help you commission single axes or entire
machines and troubleshoot.

You can select and record up to 12 parameters from the entire pool of drive controller parameters. The sampling time can
be set from 250 µs to several seconds to be able to observe both highly dynamic as well as very slow processes. Like for an
actual oscilloscope, there are a variety of trigger options and many statistical evaluation functions for the recorded data
(minimum value, maximum value, average, RMS value, standard deviation, etc.).

Tool Objectives Application cases

Scope Create multiple scope images of a single drive controller at
different times.

Optimize or diagnose a drive
controller

Create multiple scope images with the same settings
(channels, trigger, pre-trigger, sampling time), but differing
values for individual parameters.

Combine multiple scope images for the analysis.

Create a temporary direct image.

Multi-axis scope Create individual scope images of multiple drive controllers
or axes at the same time.

Check the machine
utilization or diagnosis in
synchronous operationCreate an individual scope image with the same settings or

individual settings (for each axis or for individual axes).

Tab. 274: Application cases for scope and multi-axis scope
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20.1 Scope and multi-axis scope
With the Scope and Multi-axis scope windows, you can create scope images for diagnostic purposes for one or more drive
controllers if an online connection is established.

Information

The Scope window can be reached using the button in the project menu if you have selected a drive controller in the
project tree.

The Multi-axis scope window can be reached using the button in the project menu if you have selected the project in the
project tree.

1

2

Fig. 92: Scope and multi-axis scope: Program interface

No. Area Description

1 Action area In the Action area, you can define settings for the scope image, start and stop the scope
image, and read information on the status, scope image progress and remaining recording
time.

2 Scope images In the Images area, you can open, delete, rename, comment on or export scope images
that have already been read out. In the scope, the Combinations and Direct image tabs are
also available in this area.



STOBER 20 | Analysis
02

/2
02

4 
| 

ID
 4

42
72

8.
12

337

Action area: Buttons

Button Availability Description

Start Scope, 
multi-axis scope

Starts the scope image (prerequisite: online connection).

Stop Scope, 
multi-axis scope

Stops the scope image (prerequisite: online connection).

Settings Scope,
multi-axis scope

Opens the Settings window where you can define the
trigger condition, channel assignment, sampling time and, in
the case of the multi-axis scope, the nodes for the scope
image.

Scope images: Buttons

Icon Description

Opens the dialog box for storing a comment for the scope image.

Shows/hides the bottom margin area.

Information

If you want to learn more about a particular scope image, click on it. Any comments and the properties of the scope image
are then displayed at the bottom of the window. You can show the lower margin area using the button in the Scope images
or Combinations tab.

Button Description

Close all windows Closes all open scope images and combinations.

Delete all scope images Deletes all individual scope images; combined scope images are retained (tab: Scope
images).

Delete all combinations Deletes all combined scope images; individual scope images are retained (tab:
Combinations).
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Scope images: Context menus

Tab Availability Description Context menu

Scope images Scope On the Images tab,
completed scope images are
listed after being read out
from the drive controller.
Double-click to open the
scope image. If you have
created multiple scope
images and select this, you
can combine and open them
via the context menu.

§ Open

§ Delete

§ Rename

§ Comment

§ Export

§ Combine and open

Multi-axis scope On the Images tab,
completed scope images are
listed after being read out
from the drive controller.
Double-click to open the
scope image.

§ Open

§ Delete

§ Rename

§ Comment

§ Export

Combinations Scope On the Combinations tab,
combined scope images are
listed that you can open by
double-clicking.

§ Open

§ Delete

§ Rename

§ Comment

§ Export

Direct image Scope In the Direct image tab, you
can create a temporary
scope image that is
discarded with the start of
the next scope image and
use the set value generation
to optimize the control
cascade.

—
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20.1.1 Scope settings
In the Settings window, you define the settings for the scope image and the trigger before you start the scope image. The
scope image settings are shown in the Channel assignment tab, the trigger settings in the Trigger condition tab (scope) or
Node and trigger condition tab (multi-axis scope).

Information

The Settings window for scope images can be reached via the Settings button in the Scope or Multi-axis scope window.

Tab Availability Description

Channel assignment Scope,
multi-axis scope

With the scope image settings in the Channel assignment
tab, you define which data of the respective axis you want
to record in the scope image, in which time intervals the
data is sampled and which time period is recorded before
triggering the trigger.

Trigger condition Scope With the trigger settings in the Trigger condition tab, you
define which event triggers the recording of a scope image.

Node and trigger condition Multi-axis scope With the trigger settings in the Node and trigger condition
tab, you define which event triggers the recording of a
scope image and for which axes a scope image is recorded.

Example: Trigger and scope image settings

Settings Example Results

Trigger settings § Simple trigger

§ Source: E15 v-motor-
encoder

§ Condition: greater

§ Comparison value:
50 rpm

The trigger condition is met if the value of parameter E15 v-
motor-encoder is greater than 50 rpm.

Scope image settings § Recorded channels: 1

§ Sampling time: 1 ms

§ Pre‐trigger: 33%

The recording time calculated from the number of channels
and the sampling time is 6.6 s. 2.2 s (33%) are recorded
before the trigger is triggered and 4.4 s afterwards.

Information

Additional settings for your scope images can be made using parameters T25 Automatic start and T26 Retrigger scope.
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20.1.1.1 Trigger settings

With the trigger settings in the Trigger condition tab (scope) or Node and trigger condition tab (multi-axis scope), you define
which event triggers the recording of a scope image. To do this, define the trigger for each axis and, if applicable, the trigger
condition. The selection of the trigger influences which of the settings described below are available to you.

Information

The Settings window for the scope image can be reached via the Settings button in the Scope or Multi-axis scope window.
For the scope, you can find the trigger settings directly in the Trigger condition tab. For the multi-axis scope, you can reach
the trigger settings for the respective axis via the Settings button in the Node and trigger condition tab.

Trigger Description

Manually at stop The trigger is triggered by the Stop button, without taking the pre-trigger time into
account.

Immediately at start The trigger is triggered by the Start button as soon as the pre-trigger time has elapsed.

Simple trigger The trigger is triggered automatically when the trigger condition is met and the pre-trigger
time has elapsed.

Trigger logic The trigger is triggered automatically when the trigger logic is satisfied and the pre-trigger
time has elapsed.

Trigger conditions

A simple trigger consists of a single trigger condition, while trigger logic is composed of 2 trigger conditions logically linked
by an operator. A trigger condition consists of the source, the condition and the comparison value.

Source Description

Inactive Default value if Manually at stop was selected as the trigger.

Immediately at start Default value if Immediately at stop was selected as the trigger.

Parameter Defines a parameter as the source for the trigger. You can enter the parameter either via
the [...] button and Add parameter dialog box or directly into the text field with auto-
completion by specifying the coordinate, name and, if applicable, axis number (example:
1.I80 Current position).

Signal name Defines a signal as the source for the trigger. You have assigned a signal name for this
signal in the graphical programming at the input or output of a block. If you have not yet
assigned a signal name in the graphical programming, the list is empty.

Physical address Defines a physical address in the drive controller memory as the source for the trigger.
Physical addresses can be assigned as part of an extended diagnosis by the development
team. They must be specified with the associated data type.

Information

If you record the value of a parameter or use a parameter as a trigger source, you can display the associated parameter

description as a tooltip in both the scope image settings and the trigger settings (button: ).
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Setting Description

Condition Condition for the trigger condition with which the source and the comparison value are
compared.

§ less than

§ less than or equal to

§ greater than

§ greater than or equal to

§ equal to

§ not equal to

Comparison value Comparison value for the trigger condition that is compared to the source.

Minimum time Time, in µs, in which the condition must at least be met for the trigger condition to be
considered met.

Option Description

Absolute value The Absolute value option enables you to ignore the sign when comparing the source and
comparison value.

Mask The Mask option allows you to evaluate only a single bit of the source.

Edge The Edge option activates/deactivates edge detection.

Information

You can switch the display of the Mask option between hexadecimal and binary display if required. The mask is displayed
with leading zeros according to the data type or data width of the selected parameter.

Operator Description

AND The trigger logic is satisfied if both trigger conditions are met.

OR The trigger logic is satisfied if one or both trigger conditions are met.

XOR The trigger logic is satisfied if one of the two trigger conditions is met, not both.

NAND The trigger logic is satisfied if neither or one of the two trigger conditions is met, not both.

NOR The trigger logic is satisfied if neither of the two trigger conditions is satisfied.

XNOR The trigger logic is satisfied if neither or both of the two trigger conditions are met.

Trigger 1 The trigger logic is satisfied if the first trigger condition is met.

Trigger 2 The trigger logic is satisfied if the second trigger condition is met.

Button Description

Export Exports all settings (trigger and scope image settings) to a
text file (*.txt).

Import Imports all settings from a text file (*.txt).

Close Closes the window. All settings are accepted.
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Information

Export your settings if you want to reuse the same or similar settings in other projects or import existing settings and adjust
them as necessary.

20.1.1.2 Scope image settings

With the scope image settings in the Channel assignment tab, you define which data of the respective axis you want to
record in the scope image, in which time intervals the data is sampled and which time period is recorded before triggering
the trigger. To do this, define the channel assignment, the sampling time and the pre-trigger for each axis.

Information

The Settings window for the scope image can be reached via the Settings button in the Scope or Multi-axis scope window.
For the scope and multi-axis scope, the scope image settings are shown in the Channel assignment tab.

Information

For a multi-axis scope, you must first select at least 2 nodes before you can specify the settings in the Channel assignment
tab. You can specify identical channel assignments for all axes or use the Individual option to store differing settings for
each axis. The calculation of the recording time and pre-trigger time relate to the axis with the shortest recording time.

Setting Selection Description

Channel assignment Inactive When Inactive is selected, no value is recorded in the scope
image for the channel.

Parameters When Parameter is selected, the value of a parameter is
recorded in the scope image for the channel.

Signal names When Signal name is selected, the value of a signal is
recorded in the scope image for the channel. You defined a
signal name for this signal in the graphic programming at
the input or output of a block.

Physical address When Physical address is selected, the value of a physical
address in the memory of the drive controller is recorded in
the scope image for the channel.

Sampling time 250 µs - 100 ms With the Sampling time setting, you define the time interval
in which the signals are sampled for the scope image.

Pre-trigger 0 % – 100 % With the Pre-Trigger setting, you define the percentage of
the scope memory that must be occupied for the axis to be
trigger-ready and thus the percentage of the recording time
before the trigger.

Information

If you record the value of a parameter or use a parameter as a trigger source, you can display the associated parameter

description as a tooltip in both the scope image settings and the trigger settings (button: ).
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Information

The scope memory has approximately 32 KB available for the scope image. The recording time is calculated from the
sampling time, the number of recorded channels and the available disk space. The larger the number of recorded channels
and the more frequently the channels are sampled, the faster the available disk space is occupied and the shorter the scope
image becomes.

The pre-trigger time is calculated from the set pre-trigger and the recording time.

Information

If a large pre-trigger value is entered with a long recording time, the scope image may remain in the Started state for a
period after the start until the pre-trigger is fulfilled and recording readiness is signaled by the Trigger-ready state. Status
and progress of the scope image are displayed in DriveControlSuite. The scope image is then read out from the drive
controller and transmitted to DriveControlSuite.

Button Description

Export Exports all settings (trigger and scope image settings) to a
text file (*.txt).

Import Imports all settings from a text file (*.txt).

Close Closes the window. All settings are accepted.

Information

Export your settings if you want to reuse the same or similar settings in other projects or import existing settings and adjust
them as necessary.
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20.1.2 Image editor
The image editor contains all the functions you need to edit your scope images.

Information

The image editor can be reached by double-clicking a scope image or via the context menu of the respective scope image.

1 2

3

4

5

Fig. 93: Scope and multi-axis scope: Image editor

No. Area Description

1 Assignment of channel
to band

For combinations or multi-axis scope images, you can change the assignment to a section
within the scope image (= band) for each channel in the Channels and bands area.

2 Scope image In the Scope image area, you see the graphical representation of the recorded and visible
channels.

3 Channel selection In the Channel selection area, you manage the bands and channels of a scope image.

4 Channel settings In the Channel settings area, you can adjust the graphical representation of the channels.

5 Measured values In the Measured values area, values for different measured variables are output with
measuring points A and B for the selected channel. For scope images, there is also the
option to carry out a frequency analysis.

Assignment of channel to band

This area is only available in case of combinations or multi-axis scope images. By default, each scope image is assigned a
band with the recorded channels. You can hide each channel (parameter, signal name or physical address) or change the
assignment to a band via the corresponding picklist. However, new bands must be created beforehand in the Channel
selection area.
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Scope image

A scope image shows a graphical representation of the recorded and visible channels.

Icon/Button Description Context menu

 Left-clicking on measuring line A or B allows the line to be
shifted to the left or right as desired.

—

[Right mouse button] Right-clicking on any point of the scope image opens the
context menu.

§ Set marking A here

§ Set marking B here

§ Jump to marking A

§ Jump to marking B

[Left mouse button] Left-clicking on any point of the scope image activates the
quick measurement. The values are output in the Channel
selection area in the Measured value column.

—

Marking the zero line of a channel. —

Marking the trigger line. —

Icon Description

Opens the image editor settings for the coloring of the drawing area and channels.

Opens the dialog box for storing a comment for the scope image.

Opens the list of scope images in order to take over the channel scaling from a scope image
that has already been adjusted. Button only available for scope images, not for
combinations or multi-axis scope images.

Channel selection

In the Channel selection area, you manage the bands and the channels assigned to them. You can delete existing bands or
create new bands. You can activate or deactivate the display of a channel. For each channel, a channel number and the
name of the scope image is output. If you click any point within the scope image, the associated measured value is also
displayed.

Element Description Context menu

Band Section of a scope image § Delete band

§ Create new band

Channel Recorded parameter, signal name or physical address § Hide channel

§ Only show this channel

§ Show all channels

§ Invert display of channels

§ Create new band
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Channel settings

The channel settings are used to adjust the graphical representation of the channels and scope image. In the display above
the buttons, you see the color, complete designation and scaling of the selected channel. You can use the buttons to
change the display of the channel or time axis. In the display next to the button for the time axis, the current scaling of the
x-axis is displayed.

Button Section Description

Channel display Opens the color palette for changing the channel color.

Channel settings Moves the curve of the activated channel up or down by a
grid interval:

§ [Shift] + [button]: Moves curve up or down by a pixel

§ [Ctrl] + [button]: Moves curve up or down to the next grid
line

§ [Shift] + [Ctrl] + [button]: Centers curve vertically

Enlarges or reduces the channel scaling (fixed point =
horizontal image center):

§ [Shift] + [button]: Autoscaling

Displays or hides the channel.

Inverts the channel display.

Indicates the zero line of the channel.

Opens the list of parameter signals for selecting an
individual bit. Button can only be used for whole-number
parameters without decimal places (BYTE, WORD or
DWORD data types), but not for selection parameters.

Time axis settings Enlarges or reduces the scaling of the x-axis:

§ [Ctrl] + [button]: Autoscaling

Moves the scope image left or right by a grid interval:

§ [Shift] + [button]: Moves scope image left or right by a
pixel

§ [Ctrl] + [button]: Moves scope image left or right to the
next grid line

§ [Shift] + [Ctrl] + [button]: Centers scope image horizontally
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Measured values

In the Measured values area, values for different measured variables are output with measuring points A and B for the
selected channel. For scope images, there is also the option to carry out temporary frequency analyses in the form of a
discrete Fourier transform (DFT). When the image editor is closed, DFT calculations are discarded again.

Tab Availability Description

Scope Scope, multi-axis scope The Scope tab has a list of the values for various variables
referring to measuring points A and B for the selected
channel.

Frequency analysis Scope The Frequency analysis tab can be used for performing
Fourier transforms on scope images.

20.1.3 Frequency analysis
Between measuring points A and B in the Frequency analysis tab of the image editor, a blue transparent window appears
for which a discrete Fourier transform can be carried out. Interval and measured values (= number of sensing points
between A and B) are displayed for you.

Information

You can reach the tab where you can carry out a frequency analysis in the image editor of a scope image through the
Measured values area > Frequency analysis tab.

Setting Selection Description

Window function Hamming Minimizes the leakage effect for the Fourier transform.

Without weighting Calculation without correction.

Button Description

Calculate DFT The DFT is calculated and opened in a separate window.

DFT window

The calculated DFT opens in a separate window. When the window is closed, the calculation is discarded again. You can
adjust the display:

§ [Ctrl] + [Left mouse button]: Zoom in on section

§ [Ctrl] + [Right mouse button]: Reset display to initial value (100%)

Button Description

OFF Displays or hides the selected channel.

Log Logarithmically scales the y- or x-axis.

Lin Linearly scales the y- or x-axis.
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20.2 Scope image
Scope image recording is divided into 3 steps:

§ Preparation of the scope image in DriveControlSuite

• Establish online connection

• Configure channels of the participating axis

• Define trigger settings

• Start the recording

§ Loading the data in the drive controller

• Process of trigger communication (independent of DriveControlSuite)

• Monitoring of recording by DriveControlSuite

§ Reading out and displaying the scope image

• Read the scope image out of the drive controller

• Display the scope image in DriveControlSuite

20.2.1 Creating a scope image
Create a scope image by specifying the scope image and trigger settings. Then start the scope image with an existing online
connection.

Information

During the search, all drive controllers within the broadcast domain are found via IPv4 limited broadcast.

Requirements for finding a drive controller in the network:

▪ Network supports IPv4 limited broadcast

▪ All drive controllers and the PC are in the same subnet (broadcast domain)
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Establishing an online connection (existing project)

Connect your PC and the drive controller to the network.

ü The drive controller is switched on.

ü A suitable project file for your drive system already exists.

1. Start DriveControlSuite.

2. Click on Open project.

3. Navigate to the directory and load the file.

4. In the project menu, click Online connection.

ð The Add connection window opens. All drive controllers found via IPv4 limited broadcast are displayed.

5. Direct connection tab > IP address column: 
Activate the IP address in question and confirm your selection with OK.

ð The Online functions window opens. The drive controller that is connected using the previously selected IP
address is displayed.

6. Online tab:
Click Set all to read in order to activate the drive controller for read data synchronization.

7. Click Assign all based on reference to assign the drive controller to the configured drive controller.

8. Then click Establish online connection.

ð The data connection is established and the project configuration data is compared; if the project configuration
data is identical, only the parameter values are transmitted from the drive controller to the PC.

ð The drive controller in the project tree is active.

Establishing an online connection (new project)

Connect your PC and the drive controller to the network.

ü The drive controller is switched on.

1. Start DriveControlSuite.

2. Click on Read project.

ð The Add connection window opens. All drive controllers found via IPv4 limited broadcast are displayed.

3. Direct connection tab > IP address column: 
Activate the IP address in question and confirm your selection with OK.

ð The Online functions window opens. The drive controller that is connected using the previously selected IP
address is displayed.

4. Online tab:
Click Set all to read in order to activate the drive controller for read data synchronization.

5. Click on Set all to create new drive controller to create the new drive controller in the project tree.

6. Then click Establish online connection.

ð The data connection is established and the project configuration data is transmitted from the drive controller to
the PC.

ð The drive controller is created in the project tree and is active.
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Define the settings for scope images and triggers

Define the scope image settings and the trigger settings before you start the scope image.

1. Select the relevant drive controller in the project tree and click Scope in the project menu.

ð The Scope window opens.

2. Action area:
To define the settings for the scope image, click Settings.

ð The Settings window opens.

3. Trigger condition tab:
Define which event triggers the scope image.

3.1. Select Manual at stop to activate the trigger via the Stop button (without pre-trigger).

3.2. Select Immediately at start to activate the trigger via the Start button (with pre-trigger).

3.3. Select Simple trigger to activate the trigger automatically when a trigger condition occurs.

3.4. Select Trigger logic to activate the trigger automatically when two logically linked trigger conditions occur.

4. Trigger condition tab:
If you have selected Simple trigger or Trigger logic, define the Source, Condition and Comparison value for the trigger
condition.

4.1. If you have selected Single trigger, define the individual trigger condition.

4.2. If you have selected Trigger logic, define both trigger conditions and the operator for the logical operation.

5. Channel assignment tab:
Select which data is to be recorded with the scope image.

5.1. Parameter:
To record the value of a parameter, enter the coordinate, name and, if applicable, axis number of the
parameter with the Add parameter dialog box via ... or by writing directly into the text field and using auto-
completion (example: 1.I80 Current position).

5.2. Signal name:
To record the value of a signal, select a signal for which you have assigned a signal name in the graphic
programming.

5.3. Physical address:
To record the value of a physical address in the drive controller memory, select the data type and specify the
address.

6. Channel assignment tab, Sampling time selection:
Select the time interval at which the channel is to be sampled.

7. Channel assignment tab, Pre-trigger selection:
Define the percentage of the recording time before the trigger.

ð The calculated recording time and pre-trigger time are displayed.

8. Confirm your settings with Close.



STOBER 20 | Analysis
02

/2
02

4 
| 

ID
 4

42
72

8.
12

351

Creating a scope image

Start the scope image of the data in the drive controller and read out the scope image to DriveControlSuite according to the
scope image and trigger settings.

ü You are in the Scope window, Scope images tab.

ü You have configured the settings for the scope image.

ü There is an online connection between DriveControlSuite and the drive controller.

1. Action area:
To start the scope image of the data in the drive controller, click Start.

ð The drive controller records the data in the scope memory in accordance with the scope image settings.

ð The Action area of DriveControlSuite displays information about the status of the scope image.

2. Optional: Click Stop if you use the Manually at stop trigger setting or if you want to stop the scope image early before
the recording time expires.

ð When the trigger is triggered, DriveControlSuite reads the data from the scope memory according to the scope
image settings.

ð The finished scope image is listed in the Scope images tab and can be opened via double-click.

20.2.2 Combining scope images
Combine scope images with each other to easily compare the recorded data.

ü You are in the Scope window, Scope images tab.

ü You have created multiple scope images for a drive controller.

1. Scope images tab:
Select the scope images you want to combine and choose Combine and open from the context menu.

ð Combinations tab:
The combined scope image is listed in the Combinations tab and opens in the image editor.
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20.2.3 Creating a direct image
Create a scope image by specifying the scope image and trigger settings. Then start the scope image with an existing online
connection.

Information

During the search, all drive controllers within the broadcast domain are found via IPv4 limited broadcast.

Requirements for finding a drive controller in the network:

▪ Network supports IPv4 limited broadcast

▪ All drive controllers and the PC are in the same subnet (broadcast domain)

Establishing an online connection (existing project)

Connect your PC and the drive controller to the network.

ü The drive controller is switched on.

ü A suitable project file for your drive system already exists.

1. Start DriveControlSuite.

2. Click on Open project.

3. Navigate to the directory and load the file.

4. In the project menu, click Online connection.

ð The Add connection window opens. All drive controllers found via IPv4 limited broadcast are displayed.

5. Direct connection tab > IP address column: 
Activate the IP address in question and confirm your selection with OK.

ð The Online functions window opens. The drive controller that is connected using the previously selected IP
address is displayed.

6. Online tab:
Click Set all to read in order to activate the drive controller for read data synchronization.

7. Click Assign all based on reference to assign the drive controller to the configured drive controller.

8. Then click Establish online connection.

ð The data connection is established and the project configuration data is compared; if the project configuration
data is identical, only the parameter values are transmitted from the drive controller to the PC.

ð The drive controller in the project tree is active.
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Establishing an online connection (new project)

Connect your PC and the drive controller to the network.

ü The drive controller is switched on.

1. Start DriveControlSuite.

2. Click on Read project.

ð The Add connection window opens. All drive controllers found via IPv4 limited broadcast are displayed.

3. Direct connection tab > IP address column: 
Activate the IP address in question and confirm your selection with OK.

ð The Online functions window opens. The drive controller that is connected using the previously selected IP
address is displayed.

4. Online tab:
Click Set all to read in order to activate the drive controller for read data synchronization.

5. Click on Set all to create new drive controller to create the new drive controller in the project tree.

6. Then click Establish online connection.

ð The data connection is established and the project configuration data is transmitted from the drive controller to
the PC.

ð The drive controller is created in the project tree and is active.

Define the settings for scope images and triggers

Define the scope image settings and the trigger settings before you start the scope image.

1. Select the relevant drive controller in the project tree and click Scope in the project menu.

ð The Scope window opens.

2. Action area:
To define the settings for the scope image, click Settings.

ð The Settings window opens.

3. Trigger condition tab:
Define which event triggers the scope image.

3.1. Select Manual at stop to activate the trigger via the Stop button (without pre-trigger).

3.2. Select Immediately at start to activate the trigger via the Start button (with pre-trigger).

3.3. Select Simple trigger to activate the trigger automatically when a trigger condition occurs.

3.4. Select Trigger logic to activate the trigger automatically when two logically linked trigger conditions occur.

4. Trigger condition tab:
If you have selected Simple trigger or Trigger logic, define the Source, Condition and Comparison value for the trigger
condition.

4.1. If you have selected Single trigger, define the individual trigger condition.

4.2. If you have selected Trigger logic, define both trigger conditions and the operator for the logical operation.
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5. Channel assignment tab:
Select which data is to be recorded with the scope image.

5.1. Parameter:
To record the value of a parameter, enter the coordinate, name and, if applicable, axis number of the
parameter with the Add parameter dialog box via ... or by writing directly into the text field and using auto-
completion (example: 1.I80 Current position).

5.2. Signal name:
To record the value of a signal, select a signal for which you have assigned a signal name in the graphic
programming.

5.3. Physical address:
To record the value of a physical address in the drive controller memory, select the data type and specify the
address.

6. Channel assignment tab, Sampling time selection:
Select the time interval at which the channel is to be sampled.

7. Channel assignment tab, Pre-trigger selection:
Define the percentage of the recording time before the trigger.

ð The calculated recording time and pre-trigger time are displayed.

8. Confirm your settings with Close.

Creating a direct image

Start the scope image of the data in the drive controller and read out the scope image to DriveControlSuite according to the
scope image and trigger settings.

ü You are in the Scope window, Direct image tab.

ü You have configured the settings for the scope image.

ü There is an online connection between DriveControlSuite and the drive controller.

1. Action area:
To start the scope image of the data in the drive controller, click Start.

ð The drive controller records the data in the scope memory in accordance with the scope image settings.

ð The Action area of DriveControlSuite displays information about the status of the scope image.

2. Optional: Click Stop if you use the Manually at stop trigger setting or if you want to stop the scope image early before
the recording time expires.

ð When the trigger is triggered, DriveControlSuite reads the data from the scope memory according to the scope
image settings.

ð The finished scope image is displayed in the Direct image tab.
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20.3 Multi-axis scope images
Recording via multi-axis scope is divided into 3 steps:

§ Preparation of the scope images in DriveControlSuite

• Establish online connections

• Select participating axes and define settings for triggering axes

• Configure channels of the participating axes

• Start recording

§ Loading of the data in the drive controllers

• Process of trigger communication (independent of DriveControlSuite)

• Monitoring of individual recordings by DriveControlSuite

§ Reading out and displaying the scope images

• Read out scope images from the drive controllers

• Display scope images in DriveControlSuite

20.3.1 Requirements
To find the participating drive controllers in the network and their communication with each other via broadcast, you must
observe the following requirements:

§ Network supports IPv4 limited broadcast

§ All drive controllers are in the same subnet (broadcast domain)

§ All drive controllers are connected with a switch via the X9 service interface

§ Your PC with installed DriveControlSuite commissioning software is also connected with the switch

§ Optional: EtherCAT‐based controller takes over synchronization of the scope images via distributed clocks

The following graphic shows the basic network structure for multi-axis scope images.

EtherCAT

Subnet
Switch

Fig. 94: Multi-axis scope: network structure
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20.3.2 Creating a multi-axis scope image
Establish an online connection to the participating drive controllers, define the nodes, trigger settings and channels, and
then start the recordings.

Information

During the search, all drive controllers within the broadcast domain are found via IPv4 limited broadcast.

Requirements for finding a drive controller in the network:

▪ Network supports IPv4 limited broadcast

▪ All drive controllers and the PC are in the same subnet (broadcast domain)

Establishing an online connection (existing project)

Connect your PC and the drive controllers to the network.

ü The drive controllers are switched on.

ü A suitable project file for your drive system already exists.

1. Start DriveControlSuite.

2. Click on Open project.

3. Navigate to the directory and load the file.

4. In the project menu, click Online connection.

ð The Add connection window opens. All drive controllers found via IPv4 limited broadcast are displayed.

5. Direct connection tab > IP address column: 
Activate the IP addresses in question and confirm your selection with OK.

ð The Online functions window opens. All drive controllers connected through the previously selected IP addresses
are displayed.

6. Online tab:
Click Set all to read in order to activate all drive controllers for read data synchronization.

7. Click Assign all based on reference to assign all drive controllers to the configured drive controllers.

8. Then click Establish online connection.

ð The data connection is established and the project configuration data is compared; if the project configuration
data is identical, only the parameter values are transmitted from the drive controllers to the PC.

ð The drive controllers in the project tree are active.
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Establishing an online connection (new project)

Connect your PC and the drive controllers to the network.

ü The drive controllers are switched on.

1. Start DriveControlSuite.

2. Click on Read project.

ð The Add connection window opens. All drive controllers found via IPv4 limited broadcast are displayed.

3. Direct connection tab > IP address column: 
Activate the IP addresses in question and confirm your selection with OK.

ð The Online functions window opens. All drive controllers connected through the previously selected IP addresses
are displayed.

4. Online tab:
Click Set all to read in order to activate all drive controllers for read data synchronization.

5. Click on Set all to create new drive controller to create the new drive controllers in the project tree.

6. Then click Establish online connection.

ð The data connection is established and the project configuration data is transmitted from the drive controllers to
the PC.

ð The drive controllers are created in the project tree and are active.

Defining nodes and triggering axes

Define which axes are recorded for the multi-axis scope image and which of the axes can trigger the scope image.

1. Select the project in the project tree and click Multi-axis scope in the project menu.

ð The Multi-axis scope window opens.

2. Action area:
To define the settings for the scope image, click Settings.

ð The Settings window opens.

3. Node and trigger condition tab, Node column:
Activate all axes that you want to record with the multi-axis scope image.

4. Node and trigger condition tab, Distribute trigger column:
Activate all axes for which you want to define a trigger that triggers the scope image for all participating axes.

ð The Settings button is displayed for each triggering axis.

Information

If you define more than one trigger for a multi-axis scope image, the scope image is triggered for all participating axes as
soon as one of the trigger conditions occurs (logical OR operation).
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Define the settings for scope images and triggers

Define the scope image settings and the trigger settings before you start the scope image.

ü You are in the Multi-axis scope window > Settings window.

1. Node and trigger condition tab:
To define the trigger condition, click Settings next to the respective triggering axis.

ð The Settings window opens.

2. Node and trigger condition > Settings tab:
For each triggering axis, define which event triggers the scope image.

2.1. Select Manual at stop to activate the trigger via the Stop button (without pre-trigger).

2.2. Select Immediately at start to activate the trigger via the Start button (with pre-trigger).

2.3. Select Simple trigger to activate the trigger automatically when a trigger condition occurs.

2.4. Select Trigger logic to activate the trigger automatically when two logically linked trigger conditions occur.

3. Node and trigger condition > Settings tab:
If you have selected Simple trigger or Trigger logic, define the Source, Condition and Comparison value for the trigger
condition.

3.1. If you have selected Single trigger, define the individual trigger condition.

3.2. If you have selected Trigger logic, define both trigger conditions and the operator for the logical operation.

4. Confirm your settings with Close.

ð The Settings window closes.

5. Node and trigger condition tab:
If you have defined more than one triggering axis, repeat the procedure for the remaining triggering axes.

6. Channel assignment tab:
Select which data is to be recorded with the scope image.

6.1. Parameter:
To record the value of a parameter, enter the coordinate, name and, if applicable, axis number of the
parameter with the Add parameter dialog box via ... or by writing directly into the text field and using auto-
completion (example: 1.I80 Current position).

6.2. Signal name:
To record the value of a signal, select a signal for which you have assigned a signal name in the graphic
programming.

6.3. Physical address:
To record the value of a physical address in the drive controller memory, select the data type and specify the
address.

7. Channel assignment tab, Sampling time selection:
Select the time interval at which the channel is to be sampled.

8. Channel assignment tab, Pre-trigger selection:
Define the percentage of the recording time before the trigger.

ð The calculated recording time and pre-trigger time are displayed.

9. Confirm your settings with Close.
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Information

In a multi-axis scope image, you can define per channel whether the same data is recorded for all participating axes or
individual data per axis. To do this, activate the Individual option in the Channel assignment tab, click Open settings and
define the data to be recorded per participating axis for the respective channel.

Creating a multi-axis scope image

Start the scope image of the data in the drive controller and read out the scope image to DriveControlSuite according to the
scope image and trigger settings.

ü You are in the Multi-axis scope window.

ü You have configured the settings for the scope image.

ü There is an online connection between DriveControlSuite and the drive controller.

1. Action area:
To start the scope image of the data in the drive controller, click Start.

ð The drive controller records the data in the scope memory in accordance with the scope image settings.

ð The Action area of DriveControlSuite displays information about the status of the scope image.

2. Optional: Click Stop if you use the Manually at stop trigger setting or if you want to stop the scope image early before
the recording time expires.

ð When the trigger is triggered, DriveControlSuite reads the data from the scope memory according to the scope
image settings.

ð The finished scope image is listed in the Scope images tab and can be opened via double-click.
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20.4 Parameters
You can use the following parameters to configure additional settings for the scope images.

20.4.1 T25 | Automatic start | G6 | V0
Automatically starts scope image recording after the drive controller is restarted.

Scope image is started with the settings that were last saved by the A00 action.

§ 0: Inactive

§ 1: Active

Double-axis controller: 1.T25 also applies to axis B; 2.T25 has no function.

Prepare the automatic creation of a scope image as described below.

ü You have established an online connection to the drive controller.

1. Select the relevant drive controller in the project tree and click on the button for the selected axis in the project menu
> Parameter list area.

2. Group T > Parameters T25 Automatic start:
Select 1: Active.

3. Click on Scope in the project menu.

ð The Scope window opens.

4. Click on Settings.

ð The Settings window opens.

5. Define the channel assignments and trigger conditions for the scope image, then close the window.

6. In the Scope window, click on Start to transmit the settings to the drive controller.

7. Save the settings in non-volatile memory (A00).

ð Scope image recording starts automatically after the next restart.

20.4.2 T26 | Retrigger scope | G6 | V1
Setting for the scope image.

§ 0: Inactive
Scope image is started by the user or once only by restarting the drive controller (T25 = 1: Active).
The completed scope image is temporarily saved in the drive controller and can be read out by the DriveControlSuite
(prerequisite: Scope window open).

§ 3: Active
Scope serial images are started initially by the user or by restarting the drive controller (T25 = 1: Active).
The completed scope image is temporarily saved in the drive controller and can be read out by the DriveControlSuite
(prerequisite: Scope window open).
As long as T26 = 3: Active, the next scope image is triggered automatically after each completed scope image and the
previous scope image is overwritten in the drive controller.
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21 Replacement
The following chapters describe the replacement of a drive controller and the available accessories.

21.1 Motor replacement
When replacing a synchronous servo motor with EnDat encoder and electronic nameplate, the drive controller detects that
a motor replacement has been performed upon switching on the drive controller (prerequisite: B04 = 64: Active).

As a response, the drive controller reads out the changed data from the electronic nameplate, transmits this data to the
corresponding parameters and reports the process using a fault of type 81: Motor allocation. Based on the cause of the
fault, you can recognize what has changed.

In order to take over the changed data onto the SD card and thus save it in non-volatile memory, you must carry out the
action Save values in parameter A00.

Otherwise, the next time the drive controller is switched on, the electronic nameplate is read out again and the changed
data is reported using a fault of type 81: Motor allocation.

21.2 Replacing the drive controller

WARNING!

Electrical voltage! Risk of fatal injury due to electric shock!

▪ Always switch off all power supply voltage before working on the devices!

▪ Note the discharge time of the DC link capacitors in the general technical data. You can only determine the absence
of voltage after this time period.

ATTENTION!

Loss of absolute position!

The absolute position in the encoder is lost if the encoder cable is disconnected from the AES battery module.

▪ Do not disconnect the encoder cable from the AES during service work! Disconnect the AES from the drive controller.

Information

Note that the SD card from the drive controller being replaced can be re-used only for drive controllers of the same series.

Information

The safety module is a permanently integrated component in the drive controller where any design, technical and electrical
modifications are prohibited!
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Tools and material

You will need:

§ Tool for loosening and tightening the fastening screws

Requirements and replacement

ü Drive controllers of the same series and same power can be replaced interchangeably.

ü The fieldbus variants of the firmware for the drive controller to be installed and to be replaced match. For information
on differing fieldbus variants, see Changing the fieldbus using DS6 [} 366].

ü The hardware and firmware of the drive controller to be installed is of the same or a newer version as that of the drive
controller to be replaced. For information on firmware updates, see Updating firmware [} 364].

ü The SD card is present in the drive controller being replaced; the original project is stored on the SD card. Or: The
control unit of the drive controller being replaced still works; copy the original project to the SD card before removing
the drive controller.

1. Optional: If an AES battery module is present, disconnect the AES from the drive controller.

2. Remove all terminals from the drive controller being uninstalled.

3. Loosen the fastening screws and take the drive controller out of the control cabinet.

4. Insert the SD card with the original project into the drive controller being installed.

5. Install the new drive controller in the control cabinet.

6. Connect the grounding conductor to the ground bolt of the supply module. As an alternative to the grounding
conductor connection over the 3rd copper rail (PE rail) in the rear section modules, the drive controllers can be
connected individually to the grounding conductor system by their ground bolts. Obey the instructions and
requirements for Protective grounding [} 125].

7. Reattach the terminals.

8. Optional: If an AES battery module was present, attach it to the drive controller with the associated encoder cable.
Tighten the knurled screws so that AES is securely connected to the drive controller.

9. Optional: If you are using the SY6 or SU6 safety module, you must transfer its unique address in the FSoE or PROFIsafe
network from the replaced drive controller to the new one via DIP switches in order to be able to identify it uniquely
in the network. For further information, refer to the manual for the corresponding safety module.

ð The replacement of the drive controller is complete.
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21.3 Replacing the SD card
STOBER recommends the use of cards with a storage capacity of 2 to 4 GB. The cards require FAT32 formatting (also refer
to X700: SD slot [} 162]).

Preparation

To prepare the new, formatted card for operation in the drive controller, proceed as follows:

1. Switch on the 24 VDC supply of the control unit.

2. Insert the formatted SD card.

3. Execute the action A00 and wait until saving is finished.

ð The preparation of the SD card is complete.

If an SD card is inserted when the drive controller is started, it is started from this card. Any existing configuration in the
internal memory of the drive controller is ignored. If there is no configuration on the SD card or if it is invalid, the drive
controller starts in emergency operation. For drive controllers with firmware V 6.5-A or higher, the fixed IP address
192.168.3.2 and fixed subnet mask 255.255.255.0 are used for service interface X9 in emergency operation.

In emergency operation, the internal configuration cannot be read out. If you require a data backup from the internal
memory of the drive controller, you must save the information of the desired IP address, subnet mask and address
assignment on the SD card (see Starting a drive controller in emergency operation [} 207]).

21.4 Replacing the supply module

WARNING!

Electrical voltage! Risk of fatal injury due to electric shock!

▪ Always switch off all power supply voltage before working on the devices!

▪ Note the discharge time of the DC link capacitors in the general technical data. You can only determine the absence
of voltage after this time period.

Tool and material

You will need:

§ Tool for loosening and tightening the fastening screws

Requirements and replacement

ü Supply modules of the same series and same power can be replaced interchangeably.

ü The hardware and firmware of the supply module being installed are of the same or a newer version than that of the
supply module being uninstalled.

1. Remove all terminals from the supply module being uninstalled.

2. Loosen the fastening screws and take the supply module out of the control cabinet.

3. Install the new supply module in the control cabinet.

4. Reattach the terminals.
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21.5 Updating firmware
The drive controllers are normally delivered with the latest firmware version. You can use the DriveControlSuite
commissioning software to update the firmware version of one or more drive controllers simultaneously and then monitor
the successful update. On the other hand, if a PC with a network connection is not available at the drive controller location,
you also have the option of using an SD card to transfer a more current firmware version.

21.5.1 Replacing or updating firmware using DS6
If you require a different firmware version or want to update the firmware of a drive controller, you can change the
firmware using the DriveControlSuite commissioning software. You can prepare a live firmware update while the drive
controller and machine are operating. The update does not take effect until after a restart. This dual firmware behavior
prevents a firmware loss or appearance of a case of service, since it ensures, for example, that the existing firmware can be
accessed if the connection is interrupted.

In order to perform a live firmware update, you must connect your PC and the drive controller over the network.

Information

During the search, all drive controllers within the broadcast domain are found via IPv4 limited broadcast.

Requirements for finding a drive controller in the network:

▪ Network supports IPv4 limited broadcast

▪ All drive controllers and the PC are in the same subnet (broadcast domain)

Carrying out a live firmware update

ü The drive controller is switched on.

1. Start DriveControlSuite.

2. Click Assignment and live firmware update.

ð The Add connection dialog box opens.

3. Direct connection tab > IP address column:
Activate the IP address in question and confirm your selection with OK.

ð The Online functions window opens. The drive controller that is connected by the selected IP address is displayed.

4. Live firmware update tab:
By default, the newest firmware version suitable for the DriveControlSuite version is selected. Click Assign default
version to all drive controllers.

ð The selection No live firmware update for the drive controller changes to Default version.

5. Optional: If you want to assign an alternative, locally saved firmware version to a drive controller, proceed as follows:

5.1. Click on Add new firmware version, navigate to the directory and load the file.

5.2. Then change the selection from Default version of the drive controller to Alternative version and select the
previously uploaded firmware version from the associated picklist.

6. Live firmware update tab:
Click Start live firmware update.

7. Confirm the safety note with OK.

ð The firmware update is transferred.

8. Since the firmware update only takes effect after the drive controller is restarted, click Restart all drive controllers
after completing the transfer.

9. Confirm the restart with Yes.

ð The fieldbus communication and connection to DriveControlSuite are interrupted and the drive controller restarts.
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21.5.2 Updating firmware using an SD card
If you would like to update the firmware of a drive controller, but do not have access to a PC with a network connection,
you can use an SD card to transfer a firmware version to the drive controller.

ü The firmware of the drive controller is at least version 6.4-A.

ü A more current version of DriveControlSuite is installed on your PC.

ü Prepare an SD card with the more current firmware version: To do so, create the firmware directory on the SD card.
Then use Windows Explorer to copy the firmware.slf file from the installation directory of DriveControlSuite 
(C:\Program Files (x86)\STOBER\DriveControlSuite\Suite) into this directory. For information on SD cards that can be
used, see X700: SD slot [} 162].

ü When a firmware file is being transferred by an SD card, the three LEDs flash in various combinations and frequencies.
For information on this, see Drive controller state [} 280].

1. Insert the prepared SD card into the drive controller.

2. Start the drive controller.

ð The transfer of the firmware file begins.

3. Remove the SD card when the transfer is complete.

ð The copying process is successfully completed as soon as the green LED of the drive controller flashes with a single
blink.

4. Since the firmware update only takes effect after the drive controller is restarted, restart the drive controller after
completing the transfer.

Information

The fieldbus variant of the firmware (EC or PN) cannot be changed. The fieldbus variant of the firmware on the SD card
must match the fieldbus variant of the drive controller firmware.

Information

You can also transfer an older firmware version to drive controllers with firmware version 6.5-H or later.



21 | Replacement STOBER

366

02
/2

02
4 

| 
ID

 4
42

72
8.

12

21.6 Changing the fieldbus using DS6
Fieldbus communication is determined by the firmware. The SI6 drive controller is delivered with the firmware version in
the required fieldbus variant. You can subsequently change the fieldbus using the DriveControlSuite commissioning
software.

For warranty reasons, when changing the fieldbus, you are prompted to notify our service department of the change with
an email to replace@stoeber.de. The information relevant for this can be transferred directly from DriveControlSuite to
your email program.

Information

Changing the fieldbus variant of the drive controller without contacting our Service department voids any warranty claims.

In order to perform a fieldbus change, you must connect your PC and the drive controller over the network.

Information

During the search, all drive controllers within the broadcast domain are found via IPv4 limited broadcast.

Requirements for finding a drive controller in the network:

▪ Network supports IPv4 limited broadcast

▪ All drive controllers and the PC are in the same subnet (broadcast domain)

ü The drive controller is switched on.

1. Start DriveControlSuite.

2. Click Assignment and live firmware update.

ð The Add connection dialog box opens.

3. Direct connection tab > IP address column: 
Activate the IP address in question and confirm your selection with OK.

ð The Online functions window opens. The drive controller that is connected by the selected IP address is displayed.

4. Live firmware update tab:
Change the drive controller selection of No live firmware update to Change fieldbus and click on Select fieldbus and
start.

5. Confirm the safety note with OK.

ð The Select fieldbus and start dialog box opens.

6. Click on the Send email link to open your default email program. Alternatively, you can copy the information to the
clipboard using the second link in order to paste it manually into your preferred email program.

7. Send the information to STOBER Service.

8. Then mark the option that indicates the email has been sent successfully in the dialog and click on Start live update.

ð The firmware update is transferred.

9. Since the firmware update only takes effect after the drive controller is restarted, click Restart all drive controllers
after completing the transfer.

10. Confirm the restart with Yes.

ð The fieldbus communication and connection to DriveControlSuite are interrupted and the drive controller restarts.

mailto:replace@stoeber.de
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22 Service
You can find important information all about our range of services in this chapter.

22.1 Information about the product
You can find information about your product online at the following address: https://id.stober.com.

In the search field there, enter the serial number, delivery note number or invoice number of the product.

Alternatively, you can use a suitable mobile device to scan in the QR code on the front of the device in order to directly
access product information that is available online.

22.2 STOBER electronics service
If you need support, please contact our service department (see Consultation, service and address [} 434]).

Please have the following descriptive information on hand so that we can provide you with quick, professional assistance.

Ordering a replacement device

If you would like to order a replacement device, our System Support requires the following information:

§ MV and serial number of the drive controller being replaced (see Material variant [} 36])

§ Information on subsequent changes (e.g. change in option modules, application or firmware)

The MV number indicates the ordered and delivered material variant, i.e. the device-specific combination of all hardware
and software components. The serial number is used to determine your customer information. Both numbers are stored in
the STOBER enterprise resource planning system and make reordering a drive controller easier in case of service.

Service request

If you need assistance or have any questions regarding commissioning, create reverse documentation for your project as
your first step. This makes it easier for our System Support to process your request.

https://id.stober.com
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22.3 Reverse documentation
If you have questions concerning commissioning and would like to contact our service department, start by first creating
reverse documentation and send this to our System Support email address (see Consultation, service and address [} 434]).

22.3.1 Creating reverse documentation in a new project
In order to create reverse documentation, you must connect your PC and the drive controller over the network.

Information

During the search, all drive controllers within the broadcast domain are found via IPv4 limited broadcast.

Requirements for finding a drive controller in the network:

▪ Network supports IPv4 limited broadcast

▪ All drive controllers and the PC are in the same subnet (broadcast domain)

ü The drive controller is switched on.

1. Start DriveControlSuite.

2. Click on Read project.

ð The Add connection dialog box opens.

3. Direct connection tab > IP address column: 
Activate the IP address in question. Confirm your selection with OK.

ð The Online functions window opens. The drive controller that is connected using the previously selected IP
address is displayed.

4. Online tab:
Click Establish online connection.

ð The data connection is established and the project configuration data is transmitted from the drive controller to
the PC.

ð The drive controller is created in the project tree and is active.

5. Then in the Online connection window > Online tab, click on Set all drive controllers to offline (with reverse
documentation).

6. Confirm the Reverse documentation dialog box with OK.

ð The connection is disconnected.

ð The drive controller is write-protected (lock status with red R).

7. Save the project in a local directory and send the file to us.
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22.3.2 Loading reverse documentation in an existing project
In order to create reverse documentation, you must connect your PC and the drive controller over the network.

Information

During the search, all drive controllers within the broadcast domain are found via IPv4 limited broadcast.

Requirements for finding a drive controller in the network:

▪ Network supports IPv4 limited broadcast

▪ All drive controllers and the PC are in the same subnet (broadcast domain)

ü The drive controller is switched on.

ü A project file for your drive system exists.

1. Start DriveControlSuite.

2. On the start screen, click Open project or select a project from the Last projects used list.

ð The existing project is opened.

3. In the project menu, click Online connection.

ð The Add connection dialog box opens.

4. Direct connection tab > IP address column: 
Activate the IP address in question. Confirm your selection with OK.

ð The Online functions window opens. The drive controller that is connected using the previously selected IP
address is displayed. By default, it is ignored for the data synchronization.

5. Online tab:
Click Set all to read in order to activate the drive controller for read data synchronization.

6. Click Assign all based on reference to assign the drive controller to the configured drive controller.

7. Then click Establish online connection.

ð The data connection is established and the project configuration data is compared; if the project configuration
data is identical, only the parameter values are transmitted from the drive controller to the PC.

ð The drive controller is updated in the project and is active.

8. Then in the Online functions window > Online tab, click Set all drive controllers to offline (with reverse
documentation).

9. Confirm the Reverse documentation dialog box with OK.

ð The connection is disconnected.

ð The drive controller is write-protected (lock status with red R).

10. Save the project in a local directory and send the file to us.
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23 Appendix

23.1 Weights

Description Type ID No. Weight without
packaging [g]

Weight with
packaging [g]

Single-axis controller sz. 0 SI6A061 56645 2980 4600

Double-axis controller sz. 0 SI6A062 56646 3460 5060

Single-axis controller sz. 1 SI6A161 56647 3880 5260

Double-axis controller sz. 1 SI6A162 56648 4820 6240

Single-axis controller sz. 2 SI6A261 56649 4760 6200

Double-axis controller sz. 2 SI6A262 56653 6240 7420

Single-axis controller sz. 3 SI6A361 56654 6180 7360

Supply module sz. 2 PS6A24 56650 2680 4180

Supply module sz. 3 PS6A34 56651 3820 4920

Supply module sz. 4 PS6A44 138679 6640 7640

Terminal set for supply module or
drive controller

All Diverse 100 100

Quick DC-Link for supply module sz. 2 DL6B20 56657 480 520

Quick DC-Link for supply module sz. 3 DL6B21 56658 740 780

Quick DC-Link for supply module sz. 4 DL6B22 5050114 1400 1440

Quick DC-Link for drive controller sz. 0 DL6B10 56655 440 480

Quick DC-Link for drive controller sz. 1
or 2 (single-axis controller)

DL6B11 56656 560 600

Quick DC-Link for drive controller sz. 2
(double-axis controller) or 3

DL6B12 56663 880 920

Cover for Quick DC-Link DL6B10 or
DL6B20

QDL6C10 5050128 130 130

Cover for Quick DC-Link DL6B11 or
DL6B21

QDL6C11 5050129 190 190

Cover for Quick DC-Link DL6B12 QDL6C12 5050130 300 300

Quick DC-Link insulation end section — 56659 50 50

Option module without safety
technology

SZ6 56660 50 50

Safety module ─ STO using terminals SR6 56661 50 50

Safety module – STO and SS1 using
PROFIsafe

SU6 56696 50 50

Safety module ─ STO and SS1 using
FSoE

SY6 56662 50 50

EtherCAT cable approx. 0.25 m — 49313 15 15

EtherCAT cable approx. 0.5 m — 49314 20 20

PC connecting cables — 49857 190 190

USB 2.0 Ethernet adapter — 49940 50 50
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Description Type ID No. Weight without
packaging [g]

Weight with
packaging [g]

Braking resistor KWADQU 420×91 with
MWS306L

138675 2620 2620

KWADQU 420×91 with
MWS310L

138676 2770 2770

FZZMQU 400×65 56635 4200 4200

FGFKQU 31005 56636 7500 7500

FGFKQU 31009 5050115 9500 9500

FGFKQU 31114 5050116 13000 13000

Power choke TEP4010-2US00 56528 9900 9900

Output choke TEP3720-0ES41 53188 2900 2900

TEP3820-0CS41 53189 5900 5900

TEP4020-0RS41 53190 8800 8800

Battery module AES 55452 60 60

HTL-to-TTL adapter HT6 56665 30 30

Interface adapters AP6A00 56498 30 30

AP6A01 56522 30 30

Tab. 275: Weights of PS6, SI6 and accessories
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23.2 Terminal specifications
Relevant information for project configuration of the connecting wiring can be taken from the following chapters.

EN 60204-1 contains basic recommendations that should be taken into account when selecting conductors. The chapter
"Conductors and cables" provides specifications for the maximum current carrying capacity of conductors based on the way
they are laid as well as tips for derating, for example in the case of increased surrounding temperatures or lines with
multiple loaded individual conductors.

WARNING!

Personal injury and material damage due to electric shock and thermal overload!

▪ Prepare the conductor ends according to the terminal specifications.

▪ In the case of pre-made cables and conductors, check the conductor ends and adjust them if necessary.

23.2.1 Overview
The following tables clarify which specifications must be observed for which connections depending on the type of drive
controller and accessory as well as the supply module.

Drive controller

Type X2A, X2B X11, X300 X20A, X20B X22 X101, X103

SI6A061 BCF 3,81 180 SN
[} 373]

BLDF 5.08 180 SN
[} 374]

GFKC 2,5 -ST-7,62
[} 377]

ISPC 5 -STGCL-7,62
[} 378]

FMC 1,5 -ST-3,5
[} 376]SI6A062

SI6A161 SPC 5 -ST-7,62
[} 380]

ISPC 16 -ST-10,16
[} 379]SI6A162

SI6A261

SI6A262 BLF 5.08HC 180 SN
[} 374]

SPC 16 -ST-10,16
[} 381]

BUZ 10.16IT 180
MF [} 375]SI6A361

Tab. 276: Terminal specifications for the base device

Safety technology

Type X12

SR6 BCF 3,81 180 SN [} 373]

Tab. 277: Terminal specifications of the safety technology

Supply module

Type X10 X11 X21 X22 X23 X100

PS6A24 SPC 16
-ST-10,16

[} 381]

BLDF 5.08 180
SN [} 374]

ISPC 5
-STGCL-7,62

[} 378]

ISPC 16
-ST-10,16

[} 379]

FKC 2,5 -ST-5,08
[} 375]

FMC 1,5 -ST-3,5
[} 376]

PS6A34 BUZ 10.16IT
180 MF [} 375]

BUZ 10.16IT
180 MF [} 375]

PS6A44 MKDSP 50 -17.5
[} 380]

LPT 16 -10,0-ZB
[} 379]

—

Tab. 278: Terminal specifications for the supply module
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Braking resistors

Type Braking resistor Temperature monitoring

FZZMQU G 10/2 [} 377] G 5/2 [} 376]

FGFKQU G 10/2 [} 377] G 5/2 [} 376]

Tab. 279: Terminal specifications for the braking resistors

23.2.2 BCF 3,81 180 SN

Feature Conductor type Value

Contact spacing — 3.81 mm

Nominal current at ϑamb = 40 °C — CE/UL/CSA: 16 A/10 A/
11 A

Max. conductor cross-section Flexible without end sleeve 1.5 mm²

Flexible with end sleeve without plastic collar 1.0 mm²

Flexible with end sleeve with plastic collar 1.0 mm²

2 conductors, flexible, with double end sleeve with
plastic collar

—

AWG according to UL/CSA 16

Min. conductor cross-section Flexible without end sleeve 0.14 mm²

Flexible with end sleeve without plastic collar 0.25 mm²

Flexible with end sleeve with plastic collar 0.25 mm²

2 conductors, flexible, with double end sleeve with
plastic collar

—

AWG according to UL/CSA 26

Insulation stripping length — 10 mm

Tightening torque — —

Tab. 280: BCF 3,81 180 SN BK specification
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23.2.3 BLF 5.08HC 180 SN

Feature Conductor type Value

Contact spacing — 5.08 mm

Nominal current at ϑamb = 40 °C — CE/UL/CSA: 16 A/10 A/
10 A

Max. conductor cross-section Flexible without end sleeve 2.5 mm²

Flexible with end sleeve without plastic collar 2.5 mm²

Flexible with end sleeve with plastic collar 2.5 mm²

2 conductors, flexible, with double end sleeve with
plastic collar

—

AWG according to UL/CSA 12

Min. conductor cross-section Flexible without end sleeve 0.2 mm²

Flexible with end sleeve without plastic collar 0.2 mm²

Flexible with end sleeve with plastic collar 0.25 mm²

2 conductors, flexible, with double end sleeve with
plastic collar

—

AWG according to UL/CSA 26

Insulation stripping length — 10 mm

Tightening torque — —

Tab. 281: BFL 5.08HC 180 SN specification

23.2.4 BLDF 5.08 180 SN

Feature Conductor type Value

Contact spacing — 5.08 mm

Nominal current at ϑamb = 40 °C — CE/UL/CSA: 14 A/10 A/
10 A

Max. conductor cross-section Flexible without end sleeve 2.5 mm²

Flexible with end sleeve without plastic collar 2.5 mm²

Flexible with end sleeve with plastic collar 2.5 mm²

2 conductors, flexible, with double end sleeve with
plastic collar

—

AWG according to UL/CSA 12

Min. conductor cross-section Flexible without end sleeve 0.2 mm²

Flexible with end sleeve without plastic collar 0.2 mm²

Flexible with end sleeve with plastic collar 0.25 mm²

2 conductors, flexible, with double end sleeve with
plastic collar

—

AWG according to UL/CSA 26

Insulation stripping length — 10 mm

Tightening torque — —

Tab. 282: BLDF 5.08 180 SN specification
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23.2.5 BUZ 10.16IT 180 MF

Feature Conductor type Value

Contact spacing — 10.16 mm

Nominal current at ϑamb = 40 °C — CE/UL/CSA: 61 A/60 A/
60 A

Max. conductor cross-section Flexible without end sleeve 16.0 mm²

Flexible with end sleeve without plastic collar 16.0 mm²

Flexible with end sleeve with plastic collar 16.0 mm²

2 conductors, flexible, with double end sleeve with
plastic collar

—

AWG according to UL/CSA 4

Min. conductor cross-section Flexible without end sleeve 0.5 mm²

Flexible with end sleeve without plastic collar 0.25 mm²

Flexible with end sleeve with plastic collar 0.25 mm²

2 conductors, flexible, with double end sleeve with
plastic collar

—

AWG according to UL/CSA 22

Insulation stripping length — 12 mm

Tightening torque — 2.0 Nm
(18 Lb.inch)

Tab. 283: Specification for BUZ 10.16IT 180 MF

23.2.6 FKC 2,5 -ST-5,08

Feature Conductor type Value

Contact spacing — 5.08 mm

Nominal current at ϑamb = 40 °C — CE/UL/CSA: 12 A/10 A/
10 A

Max. conductor cross-section Flexible without end sleeve 2.5 mm²

Flexible with end sleeve without plastic collar 2.5 mm²

Flexible with end sleeve with plastic collar 2.5 mm²

2 conductors, flexible, with double end sleeve with
plastic collar

1.0 mm²

AWG according to UL/CSA 12

Min. conductor cross-section Flexible without end sleeve 0.2 mm²

Flexible with end sleeve without plastic collar 0.25 mm²

Flexible with end sleeve with plastic collar 0.25 mm²

2 conductors, flexible, with double end sleeve with
plastic collar

0.5 mm²

AWG according to UL/CSA 26

Insulation stripping length — 10 mm

Tightening torque — —

Tab. 284: Specification for FKC 2,5 -ST-5,08
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23.2.7 FMC 1,5 -ST-3,5

Feature Conductor type Value

Contact spacing — 3.5 mm

Nominal current at ϑamb = 40 °C — CE/UL/CSA: 8 A

Max. conductor cross-section Flexible without end sleeve 1.5 mm²

Flexible with end sleeve without plastic collar 1.5 mm²

Flexible with end sleeve with plastic collar 0.75 mm²

2 conductors, flexible, with double end sleeve with
plastic collar

—

AWG according to UL/CSA 16

Min. conductor cross-section Flexible without end sleeve 0.2 mm²

Flexible with end sleeve without plastic collar 0.25 mm²

Flexible with end sleeve with plastic collar 0.25 mm²

2 conductors, flexible, with double end sleeve with
plastic collar

—

AWG according to UL/CSA 24

Insulation stripping length — 10 mm

Tightening torque — —

Tab. 285: FMC 1,5 -ST-3,5 specification

23.2.8 G 5/2

Feature Conductor type Value

Contact spacing — 17.5 mm

Nominal current at ϑamb = 40 °C — CE/UL/CSA: 32 A/30 A/
30 A

Max. conductor cross-section Flexible without end sleeve 4.0 mm²

Flexible with end sleeve without plastic collar 4.0 mm²

Flexible with end sleeve with plastic collar 2.5 mm²

2 conductors, flexible, with double end sleeve with
plastic collar

1.0 mm²

AWG according to UL/CSA 10

Min. conductor cross-section Flexible without end sleeve 0.2 mm²

Flexible with end sleeve without plastic collar 0.2 mm²

Flexible with end sleeve with plastic collar 0.2 mm²

2 conductors, flexible, with double end sleeve with
plastic collar

0.5 mm²

AWG according to UL/CSA 26

Insulation stripping length — 8 mm

Tightening torque — 0.6 – 0.8 Nm

Tab. 286: G 5/2 specification
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23.2.9 G 10/2

Feature Conductor type Value

Contact spacing — 17.5 mm

Nominal current at ϑamb = 40 °C — CE/UL/CSA: 57 A/65 A/
65 A

Max. conductor cross-section Flexible without end sleeve 10.0 mm²

Flexible with end sleeve without plastic collar 16.0 mm²

Flexible with end sleeve with plastic collar 16.0 mm²

2 conductors, flexible, with double end sleeve with
plastic collar

6.0 mm²

AWG according to UL/CSA 6

Min. conductor cross-section Flexible without end sleeve 0.5 mm²

Flexible with end sleeve without plastic collar 0.5 mm²

Flexible with end sleeve with plastic collar 0.5 mm²

2 conductors, flexible, with double end sleeve with
plastic collar

0.5 mm²

AWG according to UL/CSA 24

Insulation stripping length — 12 mm

Tightening torque — 1.5 – 1.8 Nm

Tab. 287: G 10/2 specification

23.2.10 GFKC 2,5 -ST-7,62

Feature Conductor type Value

Contact spacing — 7.62 mm

Nominal current at ϑamb = 40 °C — CE/UL/CSA: 12 A/10 A/
10 A

Max. conductor cross-section Flexible without end sleeve 2.5 mm²

Flexible with end sleeve without plastic collar 2.5 mm²

Flexible with end sleeve with plastic collar 2.5 mm²

2 conductors, flexible, with double end sleeve with
plastic collar

1.5 mm²

AWG according to UL/CSA 12

Min. conductor cross-section Flexible without end sleeve 0.2 mm²

Flexible with end sleeve without plastic collar 0.25 mm²

Flexible with end sleeve with plastic collar 0.25 mm²

2 conductors, flexible, with double end sleeve with
plastic collar

0.5 mm²

AWG according to UL/CSA 24

Insulation stripping length — 10 mm

Tightening torque — 0.3 – 0.7 Nm

Tab. 288: GFKC 2,5 -ST-7,62 specification
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23.2.11 GFKIC 2.5 -ST-7.62

Feature Conductor type Value

Contact spacing — 7.62 mm

Nominal current at ϑamb = 40 °C — CE/UL/CSA: 12 A/10 A/
10 A

Max. conductor cross-section Flexible without end sleeve 2.5 mm²

Flexible with end sleeve without plastic collar 2.5 mm²

Flexible with end sleeve with plastic collar 2.5 mm²

2 conductors, flexible, with double end sleeve with
plastic collar

1.0 mm²

AWG according to UL/CSA 12

Min. conductor cross-section Flexible without end sleeve 0.2 mm²

Flexible with end sleeve without plastic collar 0.25 mm²

Flexible with end sleeve with plastic collar 0.25 mm²

2 conductors, flexible, with double end sleeve with
plastic collar

0.5 mm²

AWG according to UL/CSA 26

Insulation stripping length — 10 mm

Tightening torque — —

Tab. 289: Specification for GFKIC 2.5 -ST-7.62

23.2.12 ISPC 5 -STGCL-7,62

Feature Conductor type Value

Contact spacing — 7.62 mm

Nominal current at ϑamb = 40 °C — CE/UL/CSA: 32 A/35 A/
35 A

Max. conductor cross-section Flexible without end sleeve 6.0 mm²

Flexible with end sleeve without plastic collar 6.0 mm²

Flexible with end sleeve with plastic collar 4.0 mm²

2 conductors, flexible, with double end sleeve with
plastic collar

1.5 mm²

AWG according to UL/CSA 8

Min. conductor cross-section Flexible without end sleeve 0.2 mm²

Flexible with end sleeve without plastic collar 0.25 mm²

Flexible with end sleeve with plastic collar 0.25 mm²

2 conductors, flexible, with double end sleeve with
plastic collar

0.25 mm²

AWG according to UL/CSA 24

Insulation stripping length — 15 mm

Tightening torque — —

Tab. 290: ISPC 5 -STGCL-7,62 specification
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23.2.13 ISPC 16 -ST-10,16

Feature Conductor type Value

Contact spacing — 10.16 mm

Nominal current at ϑamb = 40 °C — CE/UL/CSA: 55 A/66 A/
66 A

Max. conductor cross-section Flexible without end sleeve 16.0 mm²

Flexible with end sleeve without plastic collar 16.0 mm²

Flexible with end sleeve with plastic collar 10.0 mm²

2 conductors, flexible, with double end sleeve with
plastic collar

4.0 mm²

AWG according to UL/CSA 4

Min. conductor cross-section Flexible without end sleeve 0.75 mm²

Flexible with end sleeve without plastic collar 0.75 mm²

Flexible with end sleeve with plastic collar 0.75 mm²

2 conductors, flexible, with double end sleeve with
plastic collar

0.75 mm²

AWG according to UL/CSA 20

Insulation stripping length — 18 mm

Tightening torque — —

Tab. 291: SPC 16 -ST-10,16 specification

23.2.14 LPT 16 -10,0-ZB

Feature Conductor type Value

Contact spacing — 10 mm

Nominal current at ϑamb = 40 °C — CE/UL/CSA: 76 A/66 A/
66 A

Max. conductor cross-section Flexible without end sleeve 25.0 mm²

Flexible with end sleeve without plastic collar 16.0 mm²

Flexible with end sleeve with plastic collar 16.0 mm²

2 conductors, flexible, with double end sleeve with
plastic collar

6.0 mm²

AWG according to UL/CSA 4

Min. conductor cross-section Flexible without end sleeve 0.75 mm²

Flexible with end sleeve without plastic collar 0.75 mm²

Flexible with end sleeve with plastic collar 0.75 mm²

2 conductors, flexible, with double end sleeve with
plastic collar

4.0 mm²

AWG according to UL/CSA 18

Insulation stripping length — 18 – 20 mm

Tightening torque — —

Tab. 292: ISPC 5 -STGCL-7,62 specification
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23.2.15 MKDSP 50 -17.5

Feature Conductor type Value

Contact spacing — 17.5 mm

Nominal current at ϑamb = 40 °C — CE/UL/CSA: 192 A/160 A/
160 A

Max. conductor cross-section Flexible without end sleeve 70.0 mm²

Flexible with end sleeve without plastic collar 50.0 mm²

Flexible with end sleeve with plastic collar 50.0 mm²

2 conductors, flexible, with double end sleeve with
plastic collar

16.0 mm²

AWG according to UL/CSA 2

Min. conductor cross-section Flexible without end sleeve 1.5 mm²

Flexible with end sleeve without plastic collar 1.5 mm²

Flexible with end sleeve with plastic collar 1.5 mm²

2 conductors, flexible, with double end sleeve with
plastic collar

1.5 mm²

AWG according to UL/CSA 16

Insulation stripping length — 20 mm

Tightening torque — 5.5 Nm
(49 Lb.inch)

Tab. 293: Specification for MKDSP 50 -17.5

23.2.16 SPC 5 -ST-7,62

Feature Conductor type Value

Contact spacing — 7.62 mm

Nominal current at ϑamb = 40 °C — CE/UL/CSA: 32 A/35 A/
35 A

Max. conductor cross-section Flexible without end sleeve 6.0 mm²

Flexible with end sleeve without plastic collar 6.0 mm²

Flexible with end sleeve with plastic collar 4.0 mm²

2 conductors, flexible, with double end sleeve with
plastic collar

1.5 mm²

AWG according to UL/CSA 8

Min. conductor cross-section Flexible without end sleeve 0.2 mm²

Flexible with end sleeve without plastic collar 0.25 mm²

Flexible with end sleeve with plastic collar 0.25 mm²

2 conductors, flexible, with double end sleeve with
plastic collar

0.25 mm²

AWG according to UL/CSA 24

Insulation stripping length — 12 – 15 mm

Tightening torque — 0.3 – 0.7 Nm

Tab. 294: SPC 5 -ST-7,62 specification
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23.2.17 SPC 16 -ST-10,16

Feature Conductor type Value

Contact spacing — 10.16 mm

Nominal current at ϑamb = 40 °C — CE/UL/CSA: 55 A/66 A/
66 A

Max. conductor cross-section Flexible without end sleeve 16.0 mm²

Flexible with end sleeve without plastic collar 16.0 mm²

Flexible with end sleeve with plastic collar 10.0 mm²

2 conductors, flexible, with double end sleeve with
plastic collar

4.0 mm²

AWG according to UL/CSA 4

Min. conductor cross-section Flexible without end sleeve 0.75 mm²

Flexible with end sleeve without plastic collar 0.75 mm²

Flexible with end sleeve with plastic collar 0.75 mm²

2 conductors, flexible, with double end sleeve with
plastic collar

0.75 mm²

AWG according to UL/CSA 20

Insulation stripping length — 18 mm

Tightening torque — 0.3 – 0.7 Nm

Tab. 295: SPC 16 -ST-10,16 specification

23.3 Wiring examples
The following chapters show the basic connection using examples.

Information

For UL-compliant operation: The connections marked with PE are intended solely for the functional grounding.
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23.3.1 Operation with 1 supply module
The following graphic shows an example of the principal connection of a PS6A24 or PS6A34 supply module and an SI6 drive
controller based on a DC link connection with Quick DC-Link DL6B. Depending on the application, different wiring or
installations may be necessary.

Note the information on EMC-compliant installation (see EMC recommendations [} 128]).

T1

1 32

A1

F3

K1

T2

11

F4

M

24 VDC

X2A

22

R1
M

M1D+

D-
n
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F1

L1 L2 L3 PE
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1 3
+ -
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+ -
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1 42 3
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4
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3 5 6
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X22 X20A

1 42 3
U W PEV
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X300
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X201X200

1

STO
b

STO
a

DI

X12 option

STO
status

D-sub
15p

PS6 SI6

DL6BDL6B

SR6

Fig. 95: Wiring example with a PS6A24 or PS6A34 supply module

A1 Controller

F1 – F4 Fuse

K1 Safety relay

L1 – L3 Three-phase power supply

M Reference potential

M1 Motor

R1 Braking resistor

T1 Supply module

T2 Drive controller

1 Optional connection

2 Spring-loaded contact between DL6B and PS6 or SI6
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For UL-compliant operation:

The protective grounding of motors connected to the drive controller must not be connected using terminals X20A and
X20B. The grounding conductor connection of the motor must be ensured for the respective application in accordance with
the valid electrical standards.

23.3.2 Parallel connection
The following graphic shows the principal connection of 3 PS6A24 or PS6A34 supply modules and several SI6 drive
controllers based on the DC link connection with Quick DC-Link DL6B.

Note the information on EMC-compliant installation (see EMC recommendations [} 128]).

X10
L1 L3 PEL2 L1 L3 PEL2L1 L3 PEL2

X10 X10

X100X100X100

X22 X21X22 X21 X22 X21
D- D+ RBRB D- D+ RBRB D- D+ RBRB

X22
D- D+

X22
D- D+

2

L1

L3
PE

L2

3

1

4

1 2 1 2 1 2

5

D+
D-

PS6 SI6PS6 PS6 SI6

DL6B DL6B DL6B DL6B DL6B

SI6

PS6

Fig. 96: Wiring example with PS6A24 or PS6A34 supply modules connected in parallel

1 Contactor

2 Overload protection

3 Short-circuit protection

4 Status relay

5 Spring-loaded contact between DL6B and PS6 or SI6

For UL-compliant operation:

A single PS6A24 or PS6A34 supply module converts the 3-phase AC input voltage into a common DC bus output voltage,
which can be used to feed one or more SI6 drive controllers.
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23.3.3 UL-compliant connection of the supply module
The following graphics show the principle UL-compliant connection of a PS6 supply module and an SI6 drive controller
based on DC link connection with Quick DC-Link DL6B.

Note the information on EMC-compliant installation (see EMC recommendations [} 128]).

For UL-compliant operation:

PS6A24, PS6A34: The grounding at terminal X10 of the PS6 supply module must not be used for the protective grounding of
the PS6 drive system in combination with SI6. The housing for the PS6 supply modules must be connected to the protective
grounding by the M6 ground bolt. Obey a tightening torque of 4.0 Nm (35 Lb.inch).

PS6A44: Connect the grounding conductor to the supply module via terminal X10. Obey a minimum cross-section of
10 mm² for the grounding conductor and a tightening torque of 5.5 Nm (49 Lb.inch).

When making the project configuration of the braking resistor, obey the notes on UL-compliant use (see UL-compliant use
[} 27]).

Wiring example with PS6A24 or PS6A34 supply module
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Fig. 97: UL-compliant wiring example with a PS6A24 or PS6A34 supply module

A1 Controller

F1 – F3 Fuse (F2 is optional)

L1 – L3 Three-phase power supply

T1 Supply module

R1 Braking resistor

Q1 Circuit breakers

1 Spring-loaded contact between DL6B and PS6
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Wiring example with a PS6A44 supply module
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Fig. 98: UL-compliant wiring example with a PS6A44 supply module

A1 Controller

F1 – F3 Fuse (F2 is optional)

L1 – L3 Three-phase power supply

T1 Supply module

R1 Braking resistor

Q1 Circuit breakers

1 Spring-loaded contact between DL6B and PS6
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23.4 Example design for UL-compliant operation
The information and examples in this chapter are based on an input voltage of 480 VAC. For a more detailed design,
SERVOsoft is helpful mechanical and electrical sizing software for drive systems.

The maximum number of devices in the device group is limited by certain variables. The nominal output current I2N,PU of the
supply module, the charging capacity CN,PU of the supply module and the maximum copper rail length of 1500 mm must not
be exceeded.

The following rules must be observed when determining the maximum number of devices and the total load of the modular
drive system:

§ The sum of all input currents of the drive controllers connected to the supply module must not exceed the maximum
nominal output current of the supply module.

§ The sum of the self-capacitance of the drive controllers connected to the supply module must not exceed the charging
capacity of the supply module.

§ The total length of the copper rails used for the device group must not exceed 1500 mm.

Type Charging capacity CN,PU [µF]

PS6A24 5000

PS6A34 10000

PS6A44 20000

Tab. 296: Charging capacity of the PS6 supply module

Type Self-capacitance CPU [µF]

SI6A061 180

SI6A062 270

SI6A161 470

SI6A162 940

SI6A261 940

SI6A262 2250

SI6A361 2250

Tab. 297: Self-capacitance of the SI6 drive controllers connected to the PS6 supply module
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23.4.1 Maximum operation on PS6A24

Drive controller Quick DC-Link Limiting factor Examples24

Type Self-capacitance
CPU [µF]

Nominal input
current (DC)

I1N,PU [A]25

Width
[mm]

Type Charging
capacity

(CN,PU = max.
5000 µF)

Nominal output
current

(I2N,PU = max.
21.4 A)

Length of the
copper rails

[max. 1500 mm]

Partial load of
50%

Partial load of
25%

SI6A061 180 4.2 45 DL6B10 27 devices 5 devices 32 devices 10 devices 20 devices

SI6A062 270 8.4 45 DL6B10 18 devices 2 devices 32 devices 5 devices 10 devices

SI6A161 470 10.4 65 DL6B11 10 devices 2 devices 22 devices 4 devices 8 devices

SI6A162 940 20.7 65 DL6B11 5 devices 1 device 22 devices 2 devices 4 devices

SI6A261 940 19.0 65 DL6B11 5 devices 1 device 22 devices 2 devices 4 devices

SI6A262 2250 41.2 105 DL6B12 2 devices 0 devices 13 devices 1 device 2 devices

SI6A361 2250 41.2 105 DL6B12 2 devices 0 devices 13 devices 1 device 2 devices

Tab. 298: Maximum operation on a PS6A24 supply module with DL6B20 rear section module, b = 45 mm

24 Different part utilizations and deviation configurations are also possible. Note the rules described.
25 Measured value
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23.4.2 Maximum operation on PS6A34

Drive controller Quick DC-Link Limiting factor Examples26

Type Self-capacitance
CPU [µF]

Nominal input
current (DC)

I1N,PU [A]27

Width
[mm]

Type Charging
capacity

(CN,PU = max.
10000 µF)

Nominal output
current

(I2N,PU = max.
41.2 A)

Length of the
copper rails

[max. 1500 mm]

Partial load of
50%

Partial load of
25%

SI6A061 180 4.2 45 DL6B10 55 devices 10 devices 32 devices 20 devices 32 devices

SI6A062 270 8.4 45 DL6B10 37 devices 5 devices 32 devices 10 devices 20 devices

SI6A161 470 10.4 65 DL6B11 21 devices 4 devices 22 devices 8 devices 16 devices

SI6A162 940 20.7 65 DL6B11 10 devices 2 devices 22 devices 4 devices 8 devices

SI6A261 940 19.0 65 DL6B11 10 devices 2 devices 22 devices 4 devices 9 devices

SI6A262 2250 41.2 105 DL6B12 4 devices 1 device 13 devices 2 devices 4 devices

SI6A361 2250 41.2 105 DL6B12 4 devices 1 device 13 devices 2 devices 4 devices

Tab. 299: Maximum operation on a PS6A34 supply module with DL6B21 rear section module, b = 65 mm

26 Different part utilizations and deviation configurations are also possible. Note the rules described.
27 Measured value
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23.4.3 Maximum operation on PS6A44

Drive controller Quick DC-Link Limiting factor Examples28

Type Self-capacitance
CPU [µF]

Nominal input
current (DC)

I1N,PU [A]29

Width
[mm]

Type Charging
capacity

(CN,PU = max.
20000 µF)

Nominal output
current

(I2N,PU = max.
92 A)

Length of the
copper rails

[max. 1500 mm]

Partial load of
50%

Partial load of
25%

SI6A061 180 4.2 45 DL6B10 111 devices 21 devices 29 devices 43 devices 87 devices

SI6A062 270 8.4 45 DL6B10 74 devices 11 devices 29 devices 21 devices 43 devices

SI6A161 470 10.4 65 DL6B11 42 devices 8 devices 20 devices 17 devices 35 devices

SI6A162 940 20.7 65 DL6B11 21 devices 4 devices 20 devices 8 devices 17 devices

SI6A261 940 19.0 65 DL6B11 21 devices 4 devices 20 devices 9 devices 19 devices

SI6A262 2250 41.2 105 DL6B12 8 devices 2 devices 12 devices 4 devices 8 devices

SI6A361 2250 41.2 105 DL6B12 8 devices 2 devices 12 devices 4 devices 8 devices

Tab. 300: Maximum operation on a PS6A44 supply module with DL6B22 rear section module, b = 105 mm

28 Different part utilizations and deviation configurations are also possible. Note the rules described.
29 Measured value
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23.4.4 Sample calculation
Assume 20 motors, each with a nominal current of 2 A and an operating time of 100% (full load). The design calls for 10
double-axis controllers of type SI6A062 with a nominal output current of 2 × 5 A.

1. Checking the self-capacitance of the drive controllers versus the charging capacity of the supply module

The DC link capacitance in the group to be charged corresponds to the sum of the self-capacitances of all drive controllers in
the group: 10 × 270 µF = 2700 µF.

The charging capacity of the PS6A24 supply module is 5000 mF.

This means one PS6A24 supply module is sufficient.

2. Determining current requirements and checking utilization

The nominal input current (DC) of a SI6A062 is 8.4 A; the nominal output current is 5 A per axis. The motor's nominal
current is 2 A.

The current requirement for the specific application is 8.4 A ÷ 5 A × 2 A = 3.36 A per drive controller. As a result, 10 drive
controllers would need 33.6 A.

The nominal input current of a PS6A24 supply module is 21 A; the nominal input current of a PS6A34 is 42 A.

The PS6A24 supply module is not sufficient for the current requirements. A PS6A34 supply module is needed.

3. Checking the length of the copper rails

The width of an SI6A062 drive controller is 45 mm; the width of the PS6A34 supply module is 65 mm.

The total length of the group corresponds to: 10 × 45 mm + 65 mm − 2 × 2.5 mm = 510 mm.

At 1500 mm, the length of a standard copper rail is sufficient.
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23.5 Order overview of the hardware components
Note that the basic device is delivered without terminals. Suitable terminal sets are available separately for each size.

Information

The drive controller is delivered in the standard design without safety technology (option SZ6). If you want a drive
controller with integrated safety technology, you must order it together with the drive controller. The safety modules are
an integrated part of the drive controllers and must not be modified.

Device Safety
technology

Terminal set Quick DC-Link

Type ID No. ID No. ID No. Type ID No. Width [mm]

PS6A24 56650 — 138660 DL6B20 56657 45

PS6A34 56651 — 138661 DL6B21 56658 65

PS6A44 138679 — 5050112 DL6B22 5050114 158

SI6A061 56645 56660a) 138655 DL6B10 56655 45

56696b)

56662c)

56661d) 138683

SI6A062 56646 56660a) 138656 DL6B10 56655 45

56696b)

56662c)

56661d) 138684

SI6A161 56647 56660a) 138657 DL6B11 56656 65

56696b)

56662c)

56661d) 138685

SI6A162 56648 56660a) 138658 DL6B11 56656 65

56696b)

56662c)

56661d) 138686

SI6A261 56649 56660a) 138659 DL6B11 56656 65

56696b)

56662c)

56661d) 138687

SI6A262 56653 56660a) 138662 DL6B12 56663 105

56696b)

56662c)

56661d) 138688

SI6A361 56654 56660a) 138663 DL6B12 56663 105

56696b)

56662c)

56661d) 138689

Tab. 301: Overview of hardware components with ID No.
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a) SZ6 option: Without safety technology

b) SU6 safety module: STO and SS1 using PROFIsafe

c) SY6 safety module: STO and SS1 using FSoE

d) SR6 safety module: STO using terminals

For each device group, another two insulation end sections are needed for the left and right termination of the Quick DC-
Link modules (ID No. 56659, 2 pieces).

The quick fastening clamps for attaching the copper rails and an insulation connection piece are contained in the scope of
delivery of the Quick DC-Link.

All delivered components (drive controllers, supply modules and accessories) are marked to make it easy to assign
connected components (e.g. assignment of a terminal set to the drive controller or supply module).

Copper rails

Each device group requires 3 copper rails (DC+, DC−, grounding). The copper rails (EATON CU12X5 034121) with a standard
length of 1500 mm must be ordered from STOBER under the ID No. 56676.

The required length of the copper rails corresponds to the total length of the group minus 5 mm:

§ U = Number of DL6B20 × 45 mm

§ V = Number of DL6B21 × 65 mm

§ W = Number of DL6B22 × 158 mm

§ X = Number of DL6B10 × 45 mm

§ Y = Number of DL6B11 × 65 mm

§ Z = Number of DL6B12 × 105 mm

Total length = U + V + W + X + Y + Z − 5 mm

Ensure that the length of at least 3 of the ordered copper rails is sufficient for the calculated total length. During
installation, the copper rails must be cut to the actual length of the device group (see Length of copper rails [} 110]).
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23.6 SSI encoders
The following chapters provide you with more detailed information on setting SSI encoders with the help of the
DriveControlSuite commissioning software.

23.6.1 SSI: Evaluation at X4 with free setting (H00 = 78)
Obey the instructions described below if you use X4 as the connection for SSI encoders and want to use the free setting
option for the encoder function.

Information

The free setting of SSI encoders is supported by drive controllers in firmware V 6.5-G or higher.

Evaluation of an encoder

To evaluate an encoder connected to X4, configure the following settings in DriveControlSuite.

Parameters Description Value

Rotational single-turn
encoder

Rotational multi-turn
encoder

Linear encoder

H00 Function 78: SSI free setting 78: SSI free setting 78: SSI free setting

H14 Data bit Sum of single-turn bits +
alarm bits

Sum of single-turn bits +
multi-turn bits + alarm bits

Sum of position bits + alarm
bits

H01 Mechanical
value

1 rotation 1 rotation Measuring range, e.g.
200 mm

H02 Raw encoder
value

2Number of single-turn bits 2Number of single-turn bits Number of increments of the
measuring range

Tab. 302: Evaluation of an SSI encoder at X4 with free setting

Interpretation

The interpretation of the data bits as the position is carried out using the H01 and H02 parameters.

Relationship between resolution, clock frequency and double transmission in SSI encoders

Ideally, a new, valid position value in high resolution is available in every cycle of the control.

With a higher resolution of the position value, the amount of data to be transmitted (H14) increases and thus so does the
transmission time. The same applies if the position is read out twice to enable better detection of transmission errors (H11)
for increasing data security.

The transmission time of the position value should not exceed the cycle time of the control. To compensate for the
increased transmission time, you can transmit the bits at a higher clock frequency (H15) if the SSI encoder supports this
function. From approx. 600 kHz, cable lengths of 100 m are no longer possible.
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23.6.2 SSI: Evaluation at X4 with fixed setting (H00 = 65)
Obey the instructions described below if you use X4 as the connection for SSI encoders and want to use the fixed setting
option for the encoder function.

Information

For the setting of the data bit option (H10):
If none of the available data bit options matches the number or sum of bits of your encoder, use the nearest, larger data bit
option. If the number or sum of bits of the encoder is greater than the largest available data bit option, then use the largest
available data bit option.

Evaluation of an encoder

To evaluate an encoder connected to X4, configure the following settings in DriveControlSuite.

Parameters Description Value

Rotational single-turn
encoder

Rotational multi-turn
encoder

Linear encoder

H00 Function 65: SSI 65: SSI 65: SSI

H10 Data bit Number of single-turn bits Sum of single-turn bits +
multi-turn bits

Number of position bits

H01 Mechanical
value

1 rotation 1 rotation Position bits ≤ Data bits:
Distance per 1 LSB

Position bits > Data bits:
Distance per 2Number of position bits -

Number of data bits LSB

H02 Raw encoder
value

2Number of data bits 2Number of data bits - Number of multi-turn bits Position bits < Data bits: 
2Number of data bits - Number of position bits

Position bits ≥ Data bits: 
1

Tab. 303: Evaluation of an SSI encoder at X4 with fixed setting

Interpretation

The interpretation of the data bits as the position is carried out using the H01 and H02 parameters.

Relationship between resolution, clock frequency and double transmission in SSI encoders

Ideally, a new, valid position value in high resolution is available in every cycle of the control.

With a higher resolution of the position value, the amount of data to be transmitted (H10) increases and thus so does the
transmission time. The same applies if the position is read out twice to enable better detection of transmission errors (H11)
for increasing data security.

The transmission time of the position value should not exceed the cycle time of the control. To compensate for the
increased transmission time, you can transmit the bits at a higher clock frequency (H06) if the SSI encoder supports this
function and the cable length permits it.



STOBER 23 | Appendix
02

/2
02

4 
| 

ID
 4

42
72

8.
12

395

Examples of rotational encoders

Number of single-turn
bits

Number of multi-turn
bits

Guide value H10 Guide value H01 Guide value H02

Up to 12 – 2: 13 bit short 1 8192 = 213

13 – 2: 13 bit short 1 8192 = 213

14 – 23 – 1: 24 1 16777216 = 224

24 – 1: 24 1 16777216 = 224

25 – 0: 25 1 33554432 = 225

Starting from 26 – 0: 25 1 33554432 = 225

12 12 1: 24 1 4096 =224 - 12 = 12

13 12 0: 25 1 8192 = 225 - 12 = 13

14 12 0: 25 1 8192 = 225 - 12 = 13

13 13 0: 25 1 4096 = 225 - 13 = 12

13 14 0: 25 1 2048 = 225 - 14 = 11

Tab. 304: Examples of rotational SSI encoders at X4

Examples of translational encoders

Number of position bits Guide value H10 Guide value H01 Guide value H02

12 2: 13 bit short mm per 1 LSB 2 = 213 - 12 = 1

13 2: 13 bit short mm per 1 LSB 1

14 1: 24 mm per 1 LSB 1024 = 224 - 14 = 10

15 1: 24 mm per 1 LSB 512 = 224 - 15 = 9

24 1: 24 mm per 1 LSB 1

25 0: 25 mm per 1 LSB 1

26 0: 25 mm per 2 LSB (226 - 25 = 1 = 2) 1

Tab. 305: Examples of translational SSI encoders at X4
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23.7 Commutation finding
Obey the instructions on commutation finding described below when using the control types 48: SSM-vector control
incremental encoder or 70: SLM - vector control for synchronous servo motors or synchronous linear motors.

The following table provides an overview:

Control mode Encoder Commutation finding

48: SSM-vector control incremental
encoder

Incremental encoders Wake and Shake

70: SLM - vector control Linear encoders (incremental
encoders)

Wake and Shake

70: SLM - vector control Linear encoders (absolute encoders) Action B40

Tab. 306: Commutation finding with control mode B20 = 48 or 70

Commutation finding via Wake and Shake

DANGER!

Risk of fatal injury due to gravity-loaded vertical axis!

Gravity-loaded axes can sink during a commutation finding process using Wake and Shake because the brake for the
commutation finding process has to be released.

▪ Use the 48: SSM-vector control incremental encoder and 70: SLM - vector control control modes in combination with
a commutation finding process using Wake and Shake only for axes without a gravity load.

▪ For gravity-loaded axes, use motors with an absolute encoder.

Incremental encoders

With incremental encoders, commutation finding via Wake and Shake takes place automatically after the control unit is
switched on and the power unit is enabled for the first time. Select the velocity control control type for this first enable
(G90 = 2: Velocity control; alternatively: select a command with velocity control as the first motion command if G90 = 0:
Inactive).

Incremental encoder in combination with a brake

With incremental encoders in combination with a brake, automatic commutation finding via Wake and Shake after Enable-
on is not possible, as the brake is not released in this case (event 69: Motor connection, cause: 4: Brake).

Carry out the action B50 every time you switch on the control unit. The axis moves by up to one pole pitch during the
action.

Commutation finding via action B40

Absolute encoder

With absolute encoders, start commutation finding via the action B40 Test phase with a referenced axis. Then execute the
action A00 Save values.
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23.8 Device addressing

MAC address

A MAC address consists of a fixed and a variable portion. The fixed portion designates the manufacturer and the variable
portion distinguishes the individual network nodes and must be universally unique.

The MAC addresses of the interfaces are issued by STOBER and cannot be changed.

Information

The MAC address range of the STOBER hardware is: 00:11:39:00:00:00 – 00:11:39:FF:FF:FF

IP address – Value range

An IPv4 address always consists of 4 decimal numbers, each in a range from 0 to 255, and separated by periods. It must be
unique within a (sub)network.

Subnet and subnet mask – Value range

Subnets are created in order to provide standalone networks with their own address range. Each IP address is divided into a
network and host address. The subnet mask determines where this division takes place.

Like the IP address, the subnet mask consists of 4 decimal numbers, each in a range from 0 to 255, separated by periods.

Assignment for direct connection

In the default factory settings, both the IP address and the subnet mask are automatically assigned by DriveControlSuite or
using DHCP for a direct connection. Alternatively, you can switch to manual parameterization using parameter A166.

The active address is displayed in parameter A157 and the active subnet mask in parameter A158.

Assignment for fieldbus connection

Note that the IP address and subnet mask are assigned by the controller for a fieldbus connection.
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23.9 DriveControlSuite
The DriveControlSuite commissioning software uses wizards to guide you step by step through the installation process. You
can find more detailed information on the system requirements and installation in the following chapters.

23.9.1 System requirements
The following minimum requirements for the PC system apply to the installation and operation of the DriveControlSuite
commissioning software, including the integrated PASmotion component, for configuring the SE6 safety module:

§ Operating system: Windows 10 (32-bit, 64-bit *) or Windows 11 (32-bit, 64-bit *)

§ Processor: Intel Pentium 4 (2 GHz, Dual Core) or equivalent

§ Memory: 2 GB

§ Free disk space on the hard disk: 1 GB

§ Graphics: 1024 × 768 pixel resolution, 65536 colors

§ Font size: 100% (default)

§ Interfaces: 100 Mbps Ethernet (Fast Ethernet, copper)

§ Display of documentation: Adobe Acrobat Reader version 7.1.0 or later**

*) Only DriveControlSuite

**) Only PASmotion

23.9.2 Installation types
To install the DriveControlSuite commissioning software, select one of two installation types.

Default installation

Select this installation type if you want to install the latest version of DriveControlSuite. DriveControlSuite is installed in the
version-independent .../Programs/STOBER/DriveControlSuite/ directory. During the installation process, you do not need to
specify any additional installation instructions.

Provided that you are connected to the Internet, a check is performed prior to installation to determine if a newer software
version is available. If a newer version is already available, it is downloaded and installed in place of the started version.

If an older software version is already installed on your PC, it is deleted prior to installation. However, if the latest version is
already installed on your PC, a new installation is not performed.

User-defined installation

Select this installation type if you want to install a specific version of DriveControlSuite or if you still need an older version
that is already installed on your PC. You can use this installation type to change the default installation directory and
manage the version-dependent destination folders.

Checking whether the software version is up-to-date before installation is optional.
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23.9.3 Installing DriveControlSuite
Current versions of the DriveControlSuite commissioning software can be found in our download center at:
http://www.stoeber.de/en/downloads/.

Information

If you use the expanded safety function via the SE6 safety module, you also need the PASmotion component integrated into
DriveControlSuite. To this end, the PASmotion installation wizard starts at the end of the DriveControlSuite installation
process. You can either perform installation of the component for the safety configuration or cancel it if you do not need it.

ü You have administrator rights.

ü The DriveControlSuite software is currently not running.

ü You have downloaded the setup file from the STOBER Download Center and saved it locally.

1. Start the installation via the setup file.

2. Select the language for the installation and confirm with OK.

3. Select Default as the installation type.

ð If an Internet connection is available, the recency of the setup file is checked and, if necessary, the latest version is
downloaded.

ð The latest DriveControlSuite version is installed.

ð After successful installation, DriveControlSuite checks the access to the network.

ð If a firewall is active, a safety note opens according to the firewall settings.

4. If applicable, allow DriveControlSuite to communicate on public and private networks.

5. PASmotion:
If you are using the SE6 safety module, follow the steps in the PASmotion installation wizard.

ð After successful installation, DriveControlSuite opens automatically.

http://www.stoeber.de/en/downloads/
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23.9.4 Communication requirements
Note the following requirements for the direct connection.

23.9.4.1 Personal firewall

For communication, both DriveControlSuite and the SATMICL communication service must be enabled in the PC's firewall.

Test communication is initiated during the installation of DriveControlSuite that opens a dialog box for enabling
communication in case of an activated firewall. Note that operation on public networks must also be enabled for
communication using mobile network adapters.

The required setup file for installing DriveControlSuite can be found in our download center at:
http://www.stoeber.de/en/downloads/.

Program/service Path

DS6A.exe
(DriveControlSuite)

Standard installation:

C:\Program Files (x86)\STOBER\DriveControlSuite\bin

Parallel installation of different versions (version 6.X-X):

C:\Program Files (x86)\STOBER\DriveControlSuite (V 6.X-X)\bin

SATMICLSVC.exe 
(SATMICL service)

32-bit Windows 7, 32-bit Windows 10, or 32-bit Windows 11:

C:\Windows\System32

64-bit Windows 7, 64-bit Windows 10, or 64-bit Windows 11:

C:\Windows\SysWOW64

Tab. 307: Programs and services

23.9.4.2 Protocols and ports for communication using routers

For communication using routers, the protocols and ports used by DriveControlSuite and the SATMICL communication
service must be enabled in the routers, if applicable.

Protocol Port Use Program/service

UDP/IP 37915 Connection test (inquiry) SATMICL service

UDP/IP 37916 Node search SATMICL service

UDP/IP 30001 Primary port for connection
response (response)

SATMICL service

30002 – 39999 Alternative ports for
connection response
(response)

UDP/IP 40000 Primary port for IP address
specification

DriveControlSuite

40001 – 50000 Alternative ports for IP
address specification

TCP/IP 37915 Data transmission DriveControlSuite

Tab. 308: Protocols and ports for a direct connection

http://www.stoeber.de/en/downloads/
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23.9.5 Configuring virtual machines
If you would like to connect the drive controllers to the DriveControlSuite commissioning software from a virtual machine,
you have to configure the communication between the virtual machine and host so that, from the perspective of the
network, the virtual machine is no different from a physical PC.

VMware, Inc. VMware

If you use the VMware software from the company of the same name as a virtual machine, configure it in the VMware
Workstation. For the direct connection, the virtual network card is operated as a network bridge.

Microsoft Windows Virtual PC

If you use the Windows Virtual PC software from Microsoft as a virtual machine, configure it in the Virtual PC software and
in the Virtual Server. In both components, the name of the virtual network card has to match the physical network card. 
For Virtual PC network connections, Microsoft distinguishes between the Public and Private types. For the direct
connection, the virtual network card is operated on the Virtual Server with the Public connection type.

Microsoft Hyper-V

If you use the Hyper-V software from Microsoft as a virtual machine, configure a Virtual Switch Manager in the Hyper-V
Manager. 
For network connections through Virtual Switch, Microsoft distinguishes between the External, Internal and Private types.
For the direct connection, the virtual network card is operated with the External connection type.

Oracle VirtualBox

If you use the VirtualBox software from Oracle as a virtual machine, configure the network directly in VirtualBox. For the
direct connection, a virtual network adapter is operated in bridge mode.

23.9.6 Updates
In the Help menu of the DriveControlSuite commissioning software, you can search for a newer version and, if available,
download and install it.

Information

If the DriveControlSuite version is outdated, but the latest version is already installed on the computer, the check will yield
the result that no newer version is available.

23.9.7 Script mode
Script mode is an automation function of the DriveControlSuite commissioning software. In Script mode, commands can be
processed automatically. For example, this includes opening and closing project files or changing parameters. Processing
commands can be used for executing various actions, such as transmitting a firmware update to multiple drive controllers.

When Script mode is called up from DriveControlSuite, a window with the same name opens. Here, you can transfer
commands to DriveControlSuite in the form of a command script.

When you switch from Script mode to DriveControlSuite, the instance of DriveControlSuite being run in the background
becomes visible.
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23.9.7.1 Script mode window

In the DriveControlSuite – Script mode window, you can execute a command script and view information about the status
of the script.

Information

The DriveControlSuite – Script mode window can be reached using the key combination [Ctrl] + [F9] when DriveControlSuite
is open and by executing a command script by double-clicking the batch file when DriveControlSuite is closed.

1

2

3

Fig. 99: Script mode: Program interface

No. Area Description

1 Overview The Overview area informs you about the progress of the individual script sections.

2 Messages The entries in the messages log the connection and communication status of the drive
controllers, incorrect inputs caught by the system, errors when opening a project or rule
violations in the graphical programming.

3 Log file The Log file area shows the entries that are written to the log file while the command
script is running. Each entry is output with a time stamp and source and can be filtered by
its level through use of the options above the entries (Error, Warning, Info, Verbose). You
can use Save as to save the log file locally.

Button Description

Load file Loads a command script in Script mode.

Run Runs a loaded command script.

Switch to DriveControlSuite Exits Script mode and switches to DriveControlSuite.

Exit Exits Script mode and, where applicable, DriveControlSuite.
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23.9.7.2 Command script structure

The command script is structured in the JSON data format (*.json) with UTF-8 encoding with BOM. You can find an
introduction to JSON at:
https://www.json.org/json-en.html

Information

To create a script for DriveControlSuite, use a JSON editor such as JSON Editor Online, JSONViewer or Visual Studio Code.

Three data types are used in the script based on the standard JSON RFC-7159:

§ Boolean

§ String

§ Integer

The command script is divided into three sections: settings, sequence and commands.

Script section Description

settings In the settings section, you define basic settings for executing the command script.

sequence In the sequence section, you define the sequence of the individual commands.

commands In the commands section, you define the individual commands of the command script.

23.9.7.2.1 "settings" script section

In the settings section, you define basic settings for executing the command script. You specify whether a log file is created
when the script is executed and whether DriveControlSuite is closed after the script ends. The settings section is optional.

Attributes

§ "logFilePath": Path of the log file, <optional> <string>

§ "quitWhenDone": Behavior of DriveControlSuite after script end, <optional> <string>

Example

"settings": {
"logFilePath": "%COMMANDFILE%/LoadNewConfig.log",
"quitWhenDone": "never"

},

Creating a log file (logFilePath)

The log file logs the progress of a command script in chronological order. You create a log file by using the logFilePath
attribute to specify the file path under which the log file is to be created. If you specify a file path for the log file, the
command script will be executed only if the log file could be created successfully.

You can specify the file path for the log file either absolutely or relative to the command script directory
(%COMMANDFILE%), \\ or / serve as separators of the path. By specifying %TIMESTAMP%, you can add the current time
stamp (format: YYYYMMDD-hhmmss) to the file name and thus create a new log file each time the command script is
executed. Without a time stamp in the file name, the log file will be overwritten each time the command script is executed.

https://www.json.org/json-en.html
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Quit when done (quitWhenDone)

quitWhenDone can have three values assigned to it, which determine the behavior after the script is done.

"never" DriveControlSuite remains open after the script has ended
(default value).

"noErrors" DriveControlSuite is closed after the script has ended,
insofar as no errors have occurred.

"always" DriveControlSuite is closed after the script has ended in
every case.

23.9.7.2.2 "sequence" script section

In the sequence section, you define the sequence of the individual commands. The commands are specified as an array of
strings with the key "sequence" and the name you specify in the commands section. A command can occur any number of
times in the array.

The order in the array corresponds to the order in which the commands are executed in the command script. Set a
reasonable order for the commands so that the command script does not abort with an error if a command cannot be
executed. For example, you must first open a project (openProject) before you can change a parameter in it (setParameter).

Example

"sequence": [
"commandName 1",
"commandName 2",
"commandName 1",
"commandName 3"

],

23.9.7.2.3 "commands" script section

In the commands section, you define the individual commands of the command script. A command consists at least of a
name and the "command" attribute, which determines the command and the further attributes of the command.

Example

"commandName1": {
"command": "commandName",
"attributeKey": "attributeValue"

},
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23.9.7.3 Script mode commands

In the following, all available commands are described with the corresponding attributes.

The following table shows an overview of the available commands.

Command Description

openProject [} 406] Open project file

closeProject [} 406] Close project file

connect [} 407] Establish connection

disconnect [} 408] Disconnect connection

setOnline [} 408] Send/read out configuration

setOnlineByPreset [} 410] Send/read out configuration according to the presets

setOffline [} 411] Set offline

updateFirmware [} 411] Multiple live firmware updates

setParameter [} 412] Modify parameters

performAction [} 413] Executing an action

openMessageBox [} 413] Open message window

wait [} 414] Wait

exportParameter [} 414] Export parameters

importParameter [} 415] Import parameters

updateTemplates [} 416] Update project configuration

takeSnapShot [} 416] Delete reverse documentation

discardReverseDocumentation [} 417] Discard reverse documentation

Tab. 309: Script mode commands
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23.9.7.3.1 openProject

With the command openProject, you can open a project in Script mode, which is required for many commands. When you
open a project with openProject, closeProject is automatically called for the current project.

Attributes

§ "filePath": directory of the project file (*.ds6), <binding> <string>

Description

In the filePath attribute, you specify the name of the project file to be opened. The specification can be made either as an
absolute value or relative to the command script directory (%COMMANDFILE%).

Example

"openProjectfile": {
"command": "openProject",
"filePath": "<your path>"

},

23.9.7.3.2 closeProject

With the closeProject command, you can close an open project in Script mode. When you open a project with openProject,
closeProject is automatically called for the current project.

Attributes

§ "saveAs": Storage directory of the project file (*.ds6), <optional> <string>

§ "saveBeforeClose": <optional> <Boolean>

Description

saveAs specifies the storage location of the project. Alternatively, the project can be saved at the path specified in the
filePath attribute before it is closed with saveBeforeClose: true. By default, a dialog box opens if the project has
been modified.

Example

"closeProjectfile": {
"command": "closeProject",
"saveBeforeClose": true

},
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23.9.7.3.3 connect

With the connect command, you can establish a direct connection to the drive controllers of a module in Script mode.

Requirements for communication with the drive controllers include a direct connection to the drive controller and
assignment to the module within the project under which this drive controller is recorded.

Attribute

§ "module": Reference of the module in the project, <binding> <string>

One of the attributes listed below must be specified for the assignment. The IP address can always be used. The production
number can be used only if the drive controller can be found by searching in a network. The reference can be used only if
the drive controller can be found by searching in a network and a unique reference is defined for each drive controller that
is found:

§ "ipAddress": IPv4 address of the direct connection, <optional> <string>

§ "serialNumber": Production number of the drive controller, <optional> <integer>

§ "reference": Reference of the drive controller, <optional> <string>

Information

During the search, all drive controllers within the broadcast domain are found via IPv4 limited broadcast.

Requirements for finding a drive controller in the network:

▪ Network supports IPv4 limited broadcast

▪ All drive controllers and the PC are in the same subnet (broadcast domain)

Description

The command establishes a direct connection to the drive controller with the corresponding IP address, production number
or reference.

Example

"ipConnect": {
"command": "connect",
"module": "M1",
"ipAddress": "192.168.3.2"

},
"serialnumberConnect": {

"command": "connect",
"module": "M1",
"serialNumber": 70012345

},
"referenceConnect": {

"command": "connect",
"module": "M1",
"reference": "T123"

},
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23.9.7.3.4 disconnect

With the disconnect command, you can disconnect all existing direct connections in Script mode (without reverse
documentation).

Example

"DisconnectAll": {
"command": "disconnect"

},

23.9.7.3.5 setOnline

With the setOnline command, you can establish an online connection in Script mode to send a configuration from the
project to the drive controller or to read it from the drive controller into the project.

Attributes

§ "direction": Read or send access; read or write, <optional> <string>

§ "reference": Reference of the drive controller in the project, <optional> <string>

§ "targetId": Reference, production number or IGB position of the physical drive controller, <optional> <string> or
<integer>

§ "targetType": igbPosition, serialNumber or reference, <optional> <string>

§ "connectAndAssignMethod": serialNumber or reference, <optional> <string>

Description of single connection

The configuration of the active project file specified with "reference" is loaded into the specified drive controller or vice
versa. The specification must be unique. Based on the content of targetType, a decision is made about how to interpret the
content of targetId. The online connection is established in the reading or sending direction according to the attribute.

Value set of targetType:

1. "igbPosition": For position 0 (zero), the assignment is made using the most recently connected drive controller

2. "serialNumber": The assignment is made using the production number of the drive controller

3. "reference": The assignment is made based on the reference already existing in the drive controller (E120); this was
assigned during the most recently executed project configuration

It is always a prerequisite that a drive controller with this igbPosition, production number or reference must be in the
established connection.

Description of multi-connection

When using the connectAndAssignMethod attribute with the values serialNumber or reference (see example 4), the
configurations of the active project file are loaded to the corresponding drive controllers most recently connected or vice
versa. The online connection is established in the reading or sending direction according to the attribute.
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Examples

Example 1
The configuration of the projected drive controller T1 is loaded into the device with the production number 7000026.

"sendConfigFromT1to7000026": {
"command": "setOnline",
"direction": "write",
"reference": "T1",
"targetId": 7000026,
"targetType": "serialNumber"

},

Example 2

"readConfigOutOfIgb5intoT2": {
"command": "setOnline",
"direction": "read",
"reference": "T2",
"targetId": 5,
"targetType": "igbPosition"

},

Example 3

"writeFromT3ToArAlt": {
"command": "setOnline",
"direction": "write",
"reference": "T3",
"targetId": "ArAlt",
"targetType": "reference"

},

Example 4

"setOnline": {
"command": "setOnline",
"direction": "write",
"connectAndAssignMethod": "reference"

},
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23.9.7.3.6 Sending/reading out a configuration according to the presets (setOnlinebyPreset)

With the setOnlineByPreset command, you can establish an online connection in Script mode to send a configuration from
the project to the drive controller or to read it from the drive controller into the project. The command uses the presets
stored in the project to establish the connection. If you do not specify any specific drive controllers via the attributes, an
online connection is established for all drive controllers in the project.

If you store presets for the connection setup in the project, you can easily store a command script or reuse it for multiple
projects. For more information on the presets, see Presetting connections [} 419].

Attributes

§ "module": Reference of the module, <optional> <string>

§ "reference": Reference of the drive controller, <optional> <string>

§ "direction": Read of send access; read or write; overwrites the preset transmission direction, <optional> <string>

Description

The transmission applies to one individual drive controller based on the specification of module and reference (see example
1), but it can also be defined for all drive controllers pre-defined in the project (see example 2).

Examples

Example 1

"singleConnectByPresets": {
"command": "setOnlineByPreset", "module": "m1", "reference": "T1"

},

Example 2

"multiConnectByPresets": {
"command": "setOnlineByPreset"

},
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23.9.7.3.7 setOffline

With the setOffline command, you can disconnect the online connection to all connected drive controllers in Script mode
(with or without reverse documentation). You can save changes to the parameter values of the drive controller before
disconnecting.

Attribute

§ "reverseDocumentation": For true or false, reverse documentation is either created or not, <optional> <Boolean>
<default = false>

§ "saveValues": For true, the parameter A00 is set to active before setOffline is carried out, <optional> <Boolean>
<default = false>

Example

"setOfflineAndSaveValues":
{

"command": "setOffline",
"reverseDocumentation": false,
"saveValues": true

},

23.9.7.3.8 Updating firmware (updateFirmware)

With the updateFirmware command, you can perform a live firmware update in Script mode for a defined list of drive
controllers in the network.

Attributes

§ "ipAddresses": List of IP addresses of the drive controllers at the gateways

§ "serialNumbers": List of production numbers of the drive controllers at the gateways, <integer>

§ "references": List of references of the drive controllers at the gateways

§ "connectByMethod": serialNumber, reference or presets, <optional> <string>

• "serialNumber": In the open project, all drive controllers are provided with a firmware update whose production
number matches the production number defined in the project

• "reference": In the open project, all drive controllers are provided with a firmware update whose references
matches the reference defined in the project

• "presets": In the open project, all drive controllers are provided with a firmware update that corresponds to the
drive controllers defined in the presets

§ "firmwarePath": Directory in which the firmware files are stored, <optional>

§ "firmware": Firmware version

• "default": In this value, the version of the target firmware corresponds to the DriveControlSuite version (highest
firmware version that was loaded)

§ "restart": Restart after the update is finished, <optional> <Boolean> <default = false>

§ "waitForRenewedAvailability": Wait until the update has been completed and the drive controllers are available again
in the network, <optional> <Boolean> <default = false>



23 | Appendix STOBER

412

02
/2

02
4 

| 
ID

 4
42

72
8.

12

Example

"updateFirmwareToV_6_4_D": {
"command": "updateFirmware",
"firmware": "V 6.4-D",
"firmwarePath": "<your path>",
"ipAddresses": ["192.168.3.101",

"192.168.3.102",
"192.168.3.103"

],
"restart": true,
"waitForRenewedAvailability": true

},

23.9.7.3.9 Changing the parameter value (setParameter)

With the setParameter command, you can change the value of a parameter in Script mode. You can execute the command
both offline and with an existing online connection.

Attributes

§ "module": Reference of the module, <binding> <string>

§ "reference": Reference of the drive controller, <binding> <string>

§ "coordinate": Coordinate of the parameter, <binding> <string>

§ "value": Value of the parameter, <binding> <string>

Example

"setA10[3]:" {
"command": "setParameter",
"module": "M1",
"reference": "T2",
"coordinate": "A10[3]",
"value": "2"

},
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23.9.7.3.10 performAction

With the performAction command, you can perform an action in Script mode. You can only execute the command if there is
an existing online connection.

Attributes

§ "reference": Reference of the drive controller, <optional> <string>

• If the specification is missing, the action is executed on all connected drive controllers

§ "module": Reference of the module, <optional> <string>

• If the specification is missing, the action is executed on all connected drive controllers

§ "coordinate": Coordinate of the action parameter, <binding> <string>

§ "waitForDone": Wait until the action has been completed, <optional> <Boolean> <default=true>

§ "timeout", <optional> <integer><default = 60> (timeout in seconds):

• If waitForDone is true: If the timeout is reached before the action has been fully completed, the command was
unsuccessful and the sequence has been interrupted

• If waitForDone is false: After the action is started, there is a wait until the timeout has expired; then the sequence
is continued; the command is considered successfully processed

§ "livingSpace": Axis (in the case of multiple axes, those to which a parameter is assigned), <optional>
<string><default=Global>
Possible values:

"livingSpace": "Global",
"livingSpace": "Axis1",
"livingSpace": "Axis2",
"livingSpace": "Axis3",
"livingSpace": "Axis4",

Example

"restartSIAx1": {
"command": "performAction",
"module": "M1",
"reference": "SIAx1",
"coordinate": "A09",
"livingSpace": "Global",
"waitForDone": false,
"timeout": 10

},

23.9.7.3.11 Opening a message (openMessageBox)

With the openMessageBox command, you can open a message in Script mode that displays the specified text. The
command script is stopped until the message is confirmed with OK.

Attributes

§ "text": text of the message, <binding> <string>

Example

"ShowMsgBox": {
"command": "openMessageBox",
"text": "Please press OK!",

},
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23.9.7.3.12 wait

With the wait command, you can pause the command script in Script mode for the specified time.

Attribute

§ "seconds": Wait time in seconds, <binding> <integer>

Example

"Wait15Secs": {
"command": "wait",
"seconds": 15

},

23.9.7.3.13 Exporting parameter values (exportParameter)

With the exportParameter command, you can export the parameter values of a drive controller, a module or the entire
project in Script mode. If you do not define any specific drive controller or module via the attributes, the parameter values
of the entire project are exported. You can work with the variables listed below to have unique file names when exporting
the entire project. These are replaced by the actual values during export.

Attributes

§ "exportPath": Directory to which the parameter values are exported as a text file, <binding> <string>

§ "module": Reference of the module, <optional> <string>

§ "reference": Reference of the drive controller, <optional> <string>

Variables

Variable Description

%m% Module reference

%M% Designation of the module

%r% Reference of the drive controller

%d% Designation of the drive controller

%i% Iteration over the number of drive controllers

Tab. 310: Script mode: Variables for importing and exporting parameters

Example

"ExportSingle": {
"command": "exportParameter",
"module": "M1",
"reference": "T2",
"exportPath": "%COMMANDFILE%/parameters_%r%-%d%_ProjectName.txt"

},
,

"ExportMulti": {
"command": "exportParameter",
"exportPath": "%COMMANDFILE%/parameters_%r%-%d%_ProjectName.txt"

},
,
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23.9.7.3.14 Importing parameter values (importParameter)

With the importParameter command, you can import previously exported parameter values for a drive controller, a module
or the entire project in Script mode. If you do not define a specific drive controller or module via the attributes, the
parameter values of the entire project are imported. You can work with the variables listed below to have unique file
names when exporting the entire project. These are replaced by the actual values during export.

Attributes

§ "importPath": Path to the text file from which the parameter values are imported, <binding> <string>

§ "module": Reference of the module, <optional> <string>

§ "reference": Reference of the drive controller, <optional> <string>

§ "deleteAfter": If true, the text file with the parameter values will be deleted after import <optional> <Boolean><default
= true>

§ "reportPath": Path under which the change overview (*.html) is saved, <binding> <string>

Variables

Variable Description

%m% Module reference

%M% Designation of the module

%r% Reference of the drive controller

%d% Designation of the drive controller

%i% Iteration over the number of drive controllers

Tab. 311: Script mode: Variables for importing and exporting parameters

Example

"ImportSingle": {
"command": "importParameter",
"module": "M1",
"reference": "T2",
"importPath": "%COMMANDFILE%/parameters_%r%-%d%_ProjectName.txt",
"reportPath": "%COMMANDFILE%/parameterImportReport_ ProjectName.html",
"deleteAfter": false

},
,

"ImportMulti": {
"command": "importParameter",
"importPath": "%COMMANDFILE%/parameters_%r%-%d%_ProjectName.txt",
"reportPath": "%COMMANDFILE%/parameterImportReport_ ProjectName.html",
"deleteAfter": false

},
,
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23.9.7.3.15 updateTemplates

With the updateTemplates command, you can update the project configuration of the drive controllers to the latest version
in Script mode (templates and system parameter version).

Attributes

§ "reportPath": Generates an overview (*.html) of the changes in the project configuration, <optional> <string>

Example

"updateTemplates": {
"command": "updateTemplates",
"reportPath": "%COMMANDFILE%/updateReport.hmtl"

},

23.9.7.3.16 Creating reverse documentation (takeSnapShot)

With the takeSnapShot command, you can establish an online connection in Script mode to read out the configurations of
the connected drive controllers into the project and to create reverse documentation when disconnecting. The
configurations are read out into a new module in the project tree. If you do not use the attributes to specify any specific
drive controllers, the configuration is read out for all drive controllers in the network and reverse documentation is created.

If no project is open, the command creates a new, empty project.

Attributes

§ "ipAddresses": List of IP addresses of the drive controllers at the gateways, <optional> <string array>

§ "serialNumbers": List of production numbers of the drive controllers at the gateways, <optional> <integer array>

§ "references": List of references of the drive controllers at the gateways, <optional> <string array>

Information

During the search, all drive controllers within the broadcast domain are found via IPv4 limited broadcast.

Requirements for finding a drive controller in the network:

▪ Network supports IPv4 limited broadcast

▪ All drive controllers and the PC are in the same subnet (broadcast domain)

Description

The command establishes a direct connection to the gateway drive controllers with the corresponding IP addresses,
production numbers or references.

Example 1

"takeSnapShot": {
"command": "takeSnapShot"

},

Example 2

"takeSnapShotIpAddresses": {
"command": "takeSnapShot",
"ipAddresses": ["192.168.3.4","192.168.3.139"]

},
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Example 3

"takeSnapShotReferences": {
"command": "takeSnapShot",
"references": ["T3","T4"]

},

Example 4

"takeSnapShotSerialNumbers": {
"command": "takeSnapShot",
"serialNumbers": [9011564,9012296]

},

23.9.7.3.17 Deleting reverse documentation (discardReverseDocumentation)

With the discardReverseDocumentation command, you can delete one or all instances of reverse documentation in Script
mode. If you do not define any specific drive controller via the attributes, the reverse documentation of all drive controllers
in the project is deleted.

Attributes

§ "reference": Reference of the drive controller, <optional> <string>

§ "module": Reference of the module, <optional> <string>

Example

"discardReverseDocu": {
"command": "discardReverseDocumentation",
"reference": "T1"
"module": "M1"

},

23.9.7.4 Executing a command script

To execute a command script, in addition to the actual script, you need a batch file with which you pass the command script
to DriveControlSuite. You can execute the command script either when DriveControlSuite is opened from the
DriveControlSuite – Script mode window or when DriveControlSuite is closed by double-clicking on the corresponding batch
file.

Information

Place all the files you need to execute a command script in the same directory. To execute a command script, you need at
least 2 files (command script and batch file). If you want to log the script execution, you also need a log file. Depending on
the application, you may also need a project file if you want to create or import a backup, for example.

Information

For application examples for the Script mode, go to our download center at http://www.stoeber.de/en/downloads/ and
search for Script mode. The application examples contain sample files for the 3 following use cases: update firmware
(firmware update), save configuration (backup) and import configuration (restore). You can adapt the sample files to your
application by changing the number and addressing of the drive controllers and also the file names and path specifications.

http://www.stoeber.de/en/downloads/
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Creating a command script

Create a command script (*.json) that contains the appropriate commands and attribute values for your application.

ü You are in the directory for the command script files.

1. Create a new text file via the Windows Explorer context menu.

2. Assign a suitable file name and change the file extension from *.txt to *.json.

2.1. Example: FirmwareUpdate.json.

3. Open the file.

4. Write the command script for your application by defining the settings, sequence and commands script sections.

4.1. Example:
{ 

"settings": { 

"logFilePath": "%COMMANDFILE%/FirmwareUpdate.log", 

"quitWhenDone": "never" 

}, 

"sequence": [ 

"UpdateFirmware" 

], 

"UpdateFirmware": { 

"command": "updateFirmware", 

"firmware": "V 6.4-D", 

"ipAddresses": 

[ "200.0.0.1", 

"200.0.0.2", 

"200.0.0.3"

], 

"restart": true 

} 

}

5. Save the command script.

Creating a batch file

Create a batch file (*.bat) with which you pass the command script to DriveControlSuite.

ü You are in the directory for the command script files.

1. Create a new text file via the Windows Explorer context menu.

2. Assign a suitable file name and change the file extension from *.txt to *.bat.

2.1. Example: FirmwareUpdate.bat.

3. Open the file.

4. Specify the path to the EXE file of DriveControlSuite and assign the command script.

4.1. Example:
"C:\Program Files (x86)\STOBER\DriveControlSuite\bin\DS6A.exe"

FirmwareUpdate.json

5. Save the batch file.
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Executing a command script

Execute a command script with DriveControlSuite closed or open.

ü You are in DriveControlSuite.

1. Use the key combination [Ctrl] + [F9].

ð The DriveControlSuite – Script mode window opens.

2. Click Load file.

ð The Open file dialog box opens.

3. Navigate to the desired command script and click Open.

4. To run the command script, click Run.

ð The command script will be executed.

ð The DriveControlSuite – Script mode window displays information about the status of the command script in the
Overview, Messages and Log file areas.

Information

You can execute a command script even when DriveControlSuite is closed by double-clicking the associated batch file.
Double-clicking the batch file executes the command script and the DriveControlSuite – Script Mode window will open to
display information about the status of the command script.

23.9.7.5 Presetting connections

You need the presets for the connection setup for the setOnlineByPreset command in Script mode. If you store presets for
establishing the connection in the project, you can easily keep a command script or reuse it for multiple projects.

The IP addresses stored in the presets can be taken into account for establishing the connection when searching for drive
controllers in the local network.

ü You are in DriveControlSuite.

ü Your project is open.

1. Select the project in the project tree and choose Preset connections from the context menu.

ð The Preset connections window opens.

2. Direction selection:
Select whether read or send access to the drive controllers is to be made when the connection is established.

3. Target selection:
Select how the configuration and drive controller are to be assigned to each other when the connection is established
(IP address, reference, production number, PLC device name).

4. Confirm the presets with OK.

ð The presets are taken into account in the next execution of the setOnlineByPreset command.

ð The stored IP addresses can be taken into account when searching for drive controllers in the local network.

Adding a connection



23 | Appendix STOBER

420

02
/2

02
4 

| 
ID

 4
42

72
8.

12

23.9.7.6 Application examples for EtherCAT

Examples are provided to illustrate how Script mode functions and how you can use it.

The files required for running the application examples can be found in our download center at:
http://www.stoeber.de/en/downloads/.
Enter Script mode in the search field.

The package contains the example files for the following actions:

§ Carry out a firmware update (FirmwareUpdate)

§ Load the prepared configuration (Restore)

§ Saving the current configuration (Backup)

The requirements for executing the actions are almost identical for all example files (see Running a script).

If you would like to use the example files, you must adapt them (file names and paths, addressing of the drive controllers).

Test setup
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Fig. 100: Test setup of the application examples

Eight drive controllers of the SI6 series with fixed IP addresses 200.0.0.1 - 200.0.0.8 assigned by the EtherCAT master.

Variant 1

The DriveControlSuite runs on the same IPC as the EtherCAT master.

Variant 2

The DriveControlSuite runs on a PC or laptop. The PC or laptop are on the same network as the IPC, but not on the same
network as the EoE device group. A route must also be set here. For more information, see Network route [} 422].

http://www.stoeber.de/en/downloads/
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23.9.7.6.1 Carrying out a firmware update

Requirements

§ DriveControlSuite version 6.4-D or later is the default installation

§ All drive controllers are operated with firmware version 6.4-A or later

§ All drive controllers can be reached through a direct connection using IP addresses 200.0.0.1 to 200.0.0.8

Behavior of the script

The script for the drive controllers with the IP addresses 200.0.0.1 - 200.0.0.8 transfers a firmware update to firmware
version 6.4-D. The drive controllers are then restarted.

Information

Be aware that values that have been changed or only stored in volatile memory are lost and that fieldbus communication
and the connection to DriveControlSuite are interrupted in the event of a drive controller restart.

23.9.7.6.2 Load the prepared configuration (Restore)

Requirements

§ DriveControlSuite version 6.4-D or later is the default installation

§ All drive controllers are operated with firmware version 6.4-A or later

§ All drive controllers can be reached through a direct connection using IP addresses 200.0.0.1 to 200.0.0.8

§ A project file Restore.ds6 with the drive controllers

Behavior of the script

The configurations of the drive controllers projected in the Restore.ds6 project are transferred to the drive controllers with
the parameterized IP addresses by a script.

Information

Be aware that values that have been changed or only stored in volatile memory are lost and that fieldbus communication
and the connection to DriveControlSuite are interrupted in the event of a drive controller restart.

ATTENTION!

Machine damage from uncontrolled stopping!

Note that sending a configuration includes a brief stop of the device configuration. Communication with the EtherCAT
master is interrupted. For this reason, the script may be run only in the pre-operational state.
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23.9.7.6.3 Saving the current configuration (Backup)

Requirements

§ DriveControlSuite version 6.4-D or later is the default installation

§ All drive controllers are operated with firmware version 6.4-A or later

§ All drive controllers can be reached through a direct connection using IP addresses 200.0.0.1 to 200.0.0.8

§ A project file Backup.ds6 with the drive controllers.

Behavior of the script:

The configurations of the drive controllers with the parameterized IP addresses are saved in the Backup.ds6 file by a script.

23.9.7.6.4 Network route

The Internet Protocol (IP) ensures that data packets are communicated across network boundaries. Routing is the
determination of a suitable path for transferring the data packets.

Particularly when EoE is used, it is often necessary to create a route manually.

Information

Note that manually routing to the controller will function only if the IP address of the controller and the IP address of the PC
in question are in the same network. Otherwise, the network administration has to add a static route to the router's routing
table.

Creating a network route

In Windows, the route is created as follows:

route ADD 200.0.0.0 MASK 255.0.0.0 192.168.12.36

Explanation:

200.0.0.0 is the EoE network with a network mask of 255.0.0.0.
192.168.12.36 is the address of the controller that connects to the EoE network.

Deleting a network route

In Windows, the route is deleted as follows:

route delete 200.0.0.0
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23.9.7.7 Exit statuses

Calling a command script returns the exit statuses described below, which can be output on a Windows PC using the
command prompt, for example. The exit status for the successful execution of a command script is 0. An exit status not
equal to 0 signals an error.

Exit status Name Description or cause Check and action

0 SUCCESS Command script was executed
without errors

—

100 JSON-ERROR Error parsing the command script Check syntax of JSON file and correct
if necessary

101 JSON-FILE-NOT-EXISTING Command script was not found Check assignment of the command
script in the batch file and correct if
necessary

201 PROJECT-FILE-NOT-EXISTING Project file was not found Check attributes in the command
script and correct if necessary

202 PROJECT-FILE-NOT-OPENING Project file could not be opened Check whether the DS6 project is
already open and close it if necessary

203 PROJECT-FILE-NOT-
READABLE

Project file was not readable Check read access rights to the DS6
project and extend them if necessary

204 PROJECT-FILE-WRONG-FW Project file could not be loaded
due to wrong firmware; firmware
version of the project file does not
match the DriveControlSuite

Check firmware version in DS6
project and correct if necessary

210 CANNOT-SAVE-PROJECT-FILE Project file could not be saved Check write access rights to the DS6
project and extend them if necessary

300 CONNECTION-ERROR Error when establishing a
connection

Check network connection; check
attributes in the command script and
correct if necessary

400 SETONLINE-ERROR Error during online connection if
the error cannot be narrowed
down more precisely

Check attributes in the command
script and correct if necessary

401 SETONLINE-ERROR-READING Error with read online connection Check attributes in the command
script and correct if necessary

402 SETONLINE-ERROR-WRITING Error with write online connection Check attributes in the command
script and correct if necessary

500 FWUPDATE-ERROR Error during firmware update if the
error cannot be narrowed down
more precisely

Check attributes in the command
script and correct if necessary

501 FWUPDATE-FILE-NOT-
FOUND

Error during firmware update if the
firmware file was not found

Check attributes in the command
script and correct if necessary

502 FWUPDATE-CONTROLLER-
NOT-FOUND

Error during firmware update if the
drive controller was not found

Check attributes in the command
script and correct if necessary

601 PARAIMPORT-FILE-NOT-
FOUND

Error during parameter import if
the import file was not found

Check attributes in the command
script and correct if necessary

602 PARAEXPORT-FILE-NOT-
WRITABLE

Error during parameter export if
the file could not be written

Check access rights to the directory
and file and extend them if necessary

700 ACTION-ERROR Error when performing an action if
the error cannot be narrowed
down more precisely

Check attributes in the command
script and correct if necessary
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Exit status Name Description or cause Check and action

701 ACTION-WRONG-
PARAMETER

Error while executing an action if
the parameter coordinate was
wrong

Check attributes in the command
script and correct if necessary

800 SET-PARAMETER-ERROR Error when writing a parameter
value if the error cannot be
narrowed down more precisely

Check attributes in the command
script and correct if necessary

801 SET-PARAMETER-NOT-
WRITABLE

Error when writing a parameter
value if the parameter is write-
protected

Parameter value cannot be changed;
check attributes in the command
script and change parameter
coordinate if necessary

802 SET-PARAMETER-NOT-
EXISTING

Error writing a parameter value if
the parameter does not exist

Check attributes in the command
script and correct if necessary

900 UPDATE-TEMPLATES-ERROR Error when updating a template Check project configuration of the
drive controllers for compatibility
with the latest version of the
templates

1100 SNAPSHOT-ERROR Error when creating reverse
documentation

Check attributes in the command
script and correct if necessary

1150 DISCARD-SNAPSHOT-ERROR Error when deleting reverse
documentation

Check attributes in the command
script and correct if necessary

1200 ONLINE-BY-PRESET-ERROR Error during online connection
according to the default settings

Check network connection; check
attributes in the command script and
correct if necessary

1300 START-SAFETY-TOOL-ERROR Error when starting PASmotion If necessary, reinstall
DriveControlSuite with PASmotion

Tab. 312: Script mode: Exit statuses

Extending a batch file

The exit status can be queried with the following command:

echo %ERRORLEVEL%

The following example shows the content of a batch file (*.bat), extended by the output of the exit status in the
penultimate line:

echo off
"C:\Program Files (x86)\STOBER\DriveControlSuite\bin\DS6A.exe" FirmwareUpdate.json
IF %ERRORLEVEL% NEQ 0 Echo An error was found:
IF %ERRORLEVEL% EQU 0 Echo No error found:
echo %ERRORLEVEL%
pause
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23.9.8 Simple Network Time Protocol (SNTP)
An SNTP client is implemented in the drive controller in accordance with RFC4330. This client sets the internal clock of the
drive controller to the current time, which it obtains from an external time server. The internal clock runs with an
(inaccurate) controllable internal clock in the drive controller. As a result, the time is queried from the server in intervals. It
is compared with the internal time and the clock for the internal clock is readjusted accordingly. You define the settings in
parameter A199.

Two NTP servers can be defined as time sources, both of which are used as possible time servers. In the case of data traffic
via the service interface, the computer through which the drive controller is connected via DriveControlSuite automatically
counts as one of the possible time servers. The time servers must be accessible either via EoE, service interface X9 or
terminals X200 and X201. Make sure that the time server is accessible from the drive controller. It may be necessary to set
the gateway parameter A175 accordingly.

The time is always requested from the same NTP server and then cyclically repeated by the server to track the synchronicity
control loop. If the current server fails, the next one in the list is used. A server that was once active is discarded only in case
of connection failure to this server or server unavailability.

After the drive controller is switched on, it takes a random time of 1 to 5 minutes (in accordance with RFC4330) until the
SNTP client sends its first request to one of the time servers.

The cyclic repetition of a request occurs approximately every 5 to 6 hours.

23.9.8.1 Setting up time service on the computer

On a Windows PC with DriveControlSuite, you can use the registry editor to set up the time service. You must stop the time
server in advance and restart it after changing the registry. Proceed as follows:

1. Open the command prompt, e.g. as follows:

1.1. Use the [Windows]+[r] key combination to open the Run dialog box.

1.2. Enter the command cmd and confirm with OK.

ð The command prompt opens.

2. Stop the time server by using the command net stop w32time.

3. Open the registry editor, e.g. as follows:

3.1. Use the [Windows]+[r] key combination to open the Run dialog box.

3.2. Enter the command regedit and confirm with OK.

ð The registry editor opens.

4. Select HKEY_LOCAL_MACHINE > SYSTEM > CurrentControlSet > Services > W32Time > TimeProvider > NtpServer.

5. Set Enable to the value 1 and confirm with OK.

6. Close the registry editor.

7. Open the command prompt again.

8. Start the time server in the command prompt by using the command net start w32time.

ð The time service is set up on the PC.
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Automation using a command script

If you want to change the registry on the PC via a command script, create a *.reg file by creating an empty text file and
renaming the file extension. Then open the file and enter the following content:

[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\W32Time\TimeProviders\NtpServ

er] "Enabled"=dword:00000001

Run the file in the command line of the command prompt.

More commands

If you want to query the status on the current PC, use the following command in the command prompt:

w32tm /query /status

To query the IP address by PC name, use the following command at the command prompt:

nslookup <name>

Example:

nslookup ptbtime1.ptb.de
Name: ptbtime1.ptb.de
Addresses: 2001:638:610:be01::108 192.53.103.108

The IP address is: 192.53.103.108.
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23.9.9 Security log
The Security log window shows a complete, antichronological overview of all changes to the firmware and configuration of
the drive controller.

Information

In firmware V 6.5-K and later, the Security log window can be reached using either the context menu of the drive controller
in the project tree or the button in the Online functions window.

In the Online functions window, the current security log is read out from the drive controller to DriveControlSuite if a direct
connection or online connection exists. It can also be saved with the project file. In the project tree, the security log is only
read out if there is an existing online connection. If there is no online connection between DS6 and the drive controller, the
last security log read out is displayed.

Field Description

Production number Production number of the drive controller

Time stamp Time stamp of the readout (local date and time)

Column Description

Index Entry index

Event type Type of event

Date + time (UTC) Date and time of the event in UTC (source: DS6)

Operating time Operating time of the drive controller (source: E30)

Interface Interface through which the event occurred (DriveControlSuite, SD card)

Event information Information about the event

Information

The source for the Date + time (UTC) column of the event is the time that the drive controller has at the moment of the
event (e.g. via DriveControlSuite or fieldbus). If the configuration of the drive controller is changed via the SD card, the date
and time of the event are not recorded.

Button Description

Export Exports the security log to a CSV file (*.csv).

Close Closes the Security log window.
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23.9.9.1 Reading out the security log

With an existing online connection, you can read out the current version of the security log from the drive controller to
DriveControlSuite in order to track changes to the firmware and configuration of the drive controller and export them if
necessary.

Reading out the security log

Read out the security log from the drive controller into DriveControlSuite as described below.

ü You are in the Online functions window.

ü You have added a direct connection between DriveControlSuite and the drive controller.

1. Click next to the relevant drive controller on .

ð The security log is read out from the drive controller.

ð The Security log window opens.

Exporting the security log

Export the security log to be able to view it later.

ü You have read out the security log from the drive controller to DriveControlSuite.

ü You are in the Security log window.

1. Click Export.

ð The Export security log dialog box opens.

2. Select the directory where you want to save the security log.

3. Confirm with Save.

ð The security log is saved as a CSV file (*.csv).
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23.10 Detailed information
The documentation listed below provides you with further relevant information on the 6th STOBER drive controller
generation. The current status of the documentation can be found in our download center at:
http://www.stoeber.de/en/downloads/.
Enter the ID of the documentation in the search field.

The grouping of the documentation is intended to provide you with assistance, but is only relevant if you control the drive
controller using a fieldbus.

PROFINET

Title Documentation Contents ID

PROFINET communication – 
SC6, SI6

Manual Electrical installation, data transfer, commissioning,
diagnostics, detailed information

443039

PROFIdrive application – SC6, SI6 Manual Project configuration, configuration,
parameterization, function test, detailed information

443270

Drive Based (DB) application Manual Project planning, configuration, parameterization,
function test, detailed information

442706

Drive Based Synchronous (DBS)
application

Manual Project planning, configuration, parameterization,
function test, detailed information

443046

Drive Based Center Winder (DBCW)
application

Manual Project configuration, configuration,
parameterization, function test, detailed information

443346

SU6 safety technology – STO and
SS1 via PROFIsafe

Manual Technical data, installation, commissioning,
diagnostics, detailed information

443258

SR6 safety technology – STO via
terminals

Manual Technical data, installation, commissioning,
diagnostics, detailed information

442741

Connection method Manual Selection of encoder, power and hybrid cables,
accessories, technical data, connection

443102

EtherCAT

Title Documentation Contents ID

EtherCAT communication – 
SC6, SI6

Manual Electrical installation, data transfer, commissioning,
diagnostics, detailed information

443025

CiA 402 application – SC6, SI6 Manual Project planning, configuration, parameterization,
function test, detailed information

443080

Drive Based (DB) application Manual Project planning, configuration, parameterization,
function test, detailed information

442706

Drive Based Synchronous (DBS)
application

Manual Project planning, configuration, parameterization,
function test, detailed information

443046

Drive Based Center Winder (DBCW)
application

Manual Project configuration, configuration,
parameterization, function test, detailed information

443346

SY6 safety technology – STO and
SS1 via FSoE

Manual Technical data, installation, commissioning,
diagnostics, detailed information

442744

SR6 safety technology – STO via
terminals

Manual Technical data, installation, commissioning,
diagnostics, detailed information

442741

Connection method Manual Selection of encoder, power and hybrid cables,
accessories, technical data, connection

443102

Additional information and sources that form the basis of this documentation or are referenced by the documentation:

EtherCAT Technology Group (ETG), 2012. ETG.1300: EtherCAT Indicator and Labeling. ETG.1300 S (R) V1.1.0. Specification.
2012-01-27.

http://www.stoeber.de/en/downloads/
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23.11 Symbols in formulas

Symbol Unit Explanation

C1max F Maximum input capacitance

CN,PU F Nominal charging capacity of the power unit

CmaxPU F Maximum charging capacity of the power unit

CPU F Self-capacitance of the power unit

DIA % Reduction in the nominal current depending on the installation altitude

DT % Reduction in the nominal current depending on the surrounding temperature

E2max J Maximum switch-off energy at the output

ηN % Nominal efficiency

f1max Hz Maximum input frequency

f2max Hz Maximum output frequency

f2PU Hz Output frequency of the power unit

fN Hz Rotating magnetic field frequency at nominal speed

fPWM,PU Hz Frequency of the pulse width modulation of the power unit

I0 A Stall current

I1max A Maximum input current

I1maxCU A Maximum input current of the control unit

I1maxPU A Maximum input current of the power unit

I1N,PU A Nominal input current of the power unit

I2max A Maximum output current

I2maxPU % Maximum output current of the power unit (in relation to the nominal output current)

I2PU(A) A Output current of the power unit for axis A

I2PU(B) A Output current of the power unit for axis B

I2N,PU A Nominal output current of the power unit

Id,ref A Magnetization-generating reference current in the d/q coordinate system

IN A Nominal current

IN,MF A Nominal current of the choke or motor filter

Iq,ref A Torque/force-generating reference current in the d/q coordinate system

KI — Integral coefficient

KP — Proportional coefficient

M/Fset Nm/N Set torque or set force

M0 Nm Stall torque

M1Bstat Nm Static braking torque of the brake in the motor adapter (tolerance +40%, −20%)

M2N Nm Nominal torque on the gear unit output (relative to n1N)

M2NOT Nm Gear unit emergency off torque on the gear unit output for max. 1000 load changes

MB Nm Braking torque

MBstat Nm Static braking torque of the motor brake at 100 °C

Mk Nm Permitted tilting torque on the output

MN Nm Nominal torque

MN,B Nm Nominal braking torque

n1N rpm Nominal speed at the gear unit input
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Symbol Unit Explanation

n2N min-1 Nominal speed at the gear unit output

nN rpm Nominal speed: The speed for which the nominal torque MN is specified

p – Number of pole pairs

PeffRB W Effective power at the external braking resistor

PmaxRB W Maximum power at the external braking resistor

P2N,PU W Nominal output power of the power unit

PN,RB W Nominal power of the external braking resistor

PV W Power loss

PV,CU W Power loss of the control unit

R2minRB Ω Minimum resistance of the external braking resistor

ϑamb °C Surrounding temperature

ϑamb,max °C Maximum surrounding temperature

ϑNAT °C Nominal response temperature

t1B ms Engaging time (also: linking time) of the brake; time span from when the current is
switched off until the nominal holding torque is reached

t2B ms Release time (also: disengagement time) of the brake; time span from when the current
is switched off until the brake is completely released

TM Year, a Mission time

Ti ms Reset time

tmin ms Minimum cycle time of the application

τth °C Thermal time constant

U1 V Input voltage

U1CU V Input voltage of the control unit

U1max V Maximum input voltage

U1PU V Input voltage of the power unit

U2 V Output voltage

U2max V Maximum output voltage

U2PU V Output voltage of the power unit

U2PU,ZK V Output voltage of the power unit for the DC link connection (typical values: 400 VAC

corresponds to 560 VDC, 480 VAC corresponds to 680 VDC)

Umax V Maximum voltage

UoffCH V Switch-off threshold of the brake chopper

UonCH V On limit of the brake chopper

vact m/min Actual velocity

vset m/min Set velocity

xact m Actual position

xset m Set position
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23.12 Abbreviations

Abbreviation Meaning

AC Alternating Current

AEH Aderendhülse (end sleeve)

AWG American Wire Gauge

BAT Battery

BG Baugröße (size)

CiA CAN in Automation

CNC Computerized Numerical Control

CSA Canadian Standards Association

csp Cyclic synchronous position mode

cst Cyclic synchronous torque mode

csv Cyclic synchronous velocity mode

DC Direct Current

DHCP Dynamic Host Configuration Protocol

DI Digital Input

DMZ Demilitarized zone

EMC Electromagnetic Compatibility

ETG EtherCAT Technology Group

EtherCAT Ethernet for Control Automation Technology

FAT File Allocation Table

FSoE Fail Safe over EtherCAT

HTL High Threshold Logic

IE International Efficiency

IE class Energy efficiency class

IIoT Industrial Internet of Things

ip Interpolated position mode

IP International Protection

IP Internet Protocol

MWS Montagewinkelsatz (mounting bracket set)

NAT Nennansprechtemperatur (nominal response temperature)

NTP Network Time Protocol

P controller Proportional controller

PE Protective Earth (grounding conductor)

PELV Protective Extra Low Voltage

PI controller Proportional-Integral controller

PID controller Proportional-Integral-Differential controller

PL Performance Level

PLC Programmable Logic Controller

pp Profile position mode

PRM Predictive Maintenance

pt Profile torque mode



STOBER 23 | Appendix
02

/2
02

4 
| 

ID
 4

42
72

8.
12

433

Abbreviation Meaning

PTC Positive Temperature Coefficient

pv Profile velocity mode

RCD Residual Current protective Device

RCM Residual Current Monitoring device

RFC Request For Comments

RoHS Restriction of Hazardous Substances

SCCR Short-circuit current rating

SD Secure Digital (memory card)

SDHC Secure Digital High Capacity (memory card)

S/FTP Screened/Foiled Twisted Pair

SF/FTP Screened Foiled/Foiled Twisted Pair

SF/UTP Screened Foiled/Unshielded Twisted Pair

SIL Safety Integrity Level

SNTP Simple Network Time Protocol

SS1 Safe Stop 1

SSI Serial Synchronous Interface

STO Safe Torque Off

TCP Transmission Control Protocol

TTL Transistor-Transistor Logic

UL Underwriters Laboratories

W&S Wake and Shake
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24 Contact

24.1 Consultation, service and address
We would be happy to help you!

We offer a wealth of information and services to go with our products on our website:
http://www.stoeber.de/en/service

For additional or personalized information, contact our consultation and support service:
http://www.stoeber.de/en/support

If you need our system support:
Phone +49 7231 582-3060
systemsupport@stoeber.de

If you need a replacement device:
Phone +49 7231 582-1128
replace@stoeber.de

Call our 24-hour service hotline:
Phone +49 7231 582-3000

Our address:
STÖBER Antriebstechnik GmbH + Co. KG
Kieselbronner Strasse 12
75177 Pforzheim, Germany

24.2 Your opinion is important to us
We created this documentation to the best of our knowledge with the goal of helping you build and expand your expertise
productively and efficiently with our products.

Your suggestions, opinions, wishes and constructive criticism help us to ensure and further develop the quality of our
documentation.
If you want to contact us for a specific reason, we would be happy to receive an e-mail from you at:
documentation@stoeber.de

Thank you for your interest.
Your STOBER editorial team

http://www.stoeber.de/en/service
http://www.stoeber.de/en/support
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24.3 Close to customers around the world
We offer you committed, expert advise and support in over 40 countries worldwide:

STOBER AUSTRIA
www.stoeber.at
+43 7613 7600-0
sales@stoeber.at

STOBER CHINA 
www.stoeber.cn 
+86 512 5320 8850
sales@stoeber.cn

STOBER FRANCE 
www.stober.fr 
+33 478 98 91 80 
sales@stober.fr

STOBER Germany 
www.stoeber.de 
+49 4 7231 582-0
sales@stoeber.de

STOBER HUNGARY 
www.stoeber.de 
+36 53 5011140
info@emtc.hu

STOBER ITALY 
www.stober.it 
+39 02 93909570 
sales@stober.it

STOBER JAPAN 
www.stober.co.jp 
+81-3-5875-7583
sales@stober.co.jp

STOBER SWITZERLAND 
www.stoeber.ch 
+41 56 496 96 50 
sales@stoeber.ch

STOBER TAIWAN 
www.stober.tw 
+886 4 2358 6089 
sales@stober.tw

STOBER TURKEY 
www.stober.com 
+90 216 510 2290 
sales-turkey@stober.com

STOBER UK 
www.stober.co.uk 
+44 1543 458 858 
sales@stober.co.uk

STOBER USA 
www.stober.com 
+1 606 759 5090 
sales@stober.com
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Glossary

100Base-TX

Ethernet network standard based on symmetrical copper cables in which the nodes are connected to a switch via
copper cables twisted in pairs (shielded twisted pair, CAT 5e quality level). 100Base-TX is the subsequent progression
from 10Base-T and includes those properties with the option of a transfer speed of 100 Mbps (Fast Ethernet).

Band

In the context of a scope, a section in the display of a scope image. The recorded channels can be individually assigned,
each to one such section.

Braking resistor

Electrical resistor that is switched on by a brake chopper in order to avoid a hazard to electrical components in the
event of significant brake energy by limiting the DC link voltage. Braking energy, which is usually only present for brief
periods, is converted into heat in the resistor.

Broadcast domain

Logical grouping of network devices within a local network that reaches all nodes via broadcast.

Channel (scope, multi-axis scope)

The reserved disk space for recording a signal in DriveControlSuite. As part of a scope image, up to 12 channels can be
recorded simultaneously.

Channel assignment

Source of the data that is recorded with/by/in a channel. For example, this may involve parameters that are
transmitted in a cyclical fieldbus communication channel or a parameter that is recorded in a measurement channel.

Circuit breakers

Current-limiting switches for motor or starter protection. They guarantee safe shut-off in the event of a short-circuit
and protect loads and systems from overload.

Control cascade

Complete model of the control structure with the position controller, velocity controller and current controller
components.

Current controller

Controller that is part of the control cascade and makes sure the deviation between the set and actual torque/force is
small. In addition, it uses the deviation to calculate a value for the set current and transfers this to the power unit. The
controller has a part that controls torque/force and a part that controls the magnetic flux.

DC link discharge time

Time until the DC link capacitors are discharged enough that the device can be worked on safely.
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Defense in depth

In accordance with DIN EN IEC 62443-4-1, an approach to defend the system against any kind of attack using multiple
independent methods.

Demilitarized zone (DMZ)

Specially controlled network located between the external network (Internet) and internal network. It represents a
kind of buffer zone that separates the networks from each other through strict communication rules and firewalls.

Differential (HTL/TTL)

In the context of signal transmission, a process for being able to transmit signals with the highest possible fault
tolerance even with longer transmission paths. In this approach, transmission takes place using a pair of signal
conductors instead of just one signal conductor. The actual signal is transmitted on one line and the inverse signal on
the other.

Discrete Fourier transform (DFT)

Maps a time-discrete signal onto a periodic, discrete frequency spectrum. A Fourier transform can be carried out on a
scope image in DriveControlSuite. The spectrum display of the scope image shows all occurring frequencies. The
amplitude of a frequency stands for its frequency of occurrence.

Electronic nameplate

The synchronous servo motors are generally equipped with absolute encoders that provide special memory. This
memory includes the electronic nameplate, i.e. all type-relevant master data as well as special mechanical and
electronic values of a motor. When you operate a drive controller with a synchronous servo motor and an absolute
encoder, the electronic nameplate is read and all motor data transferred if the drive controller is connected online. The
drive controller automatically determines the associated limit values and control parameters from this data.

Fail Safe over EtherCAT (FSoE)

Protocol for transferring safety-related data via EtherCAT using a FSoE master and an indefinite number of FSoE slaves
(i.e. devices that have a Safety over EtherCAT interface). The protocol enables the realization of functional safety via
EtherCAT. FSoE and its implementation are TÜV-certified and comply with the SIL 3 requirements in accordance with
IEC 61508.

Fast discharge

Active running process that causes the capacitors to discharge. This process is completed significantly faster than the
self-discharge process. For example, the supply module has a fast discharge function but it is only active when a
braking resistor is connected and the 24 V power supply is switched on. No fast discharge is possible for overloaded
braking resistors.

Firewall

Network security device that monitors incoming and outgoing network traffic and decides whether to allow or block
specific traffic based on a set of defined security rules. It is based either on hardware, software or a combination of
both.
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Frequency analysis

Method for investigating how frequently certain events occur in a certain time span, or how strongly which frequency
components are represented in a signal.

Industrial Internet of Things (IIoT)

Subgroup of the Internet of Things (IoT) that focuses specifically on the application of IoT technologies in industrial
environments, including manufacturing, logistics and other sectors. The focus is on improving industrial processes,
efficiency, automation and real-time data acquisition. The aim is to optimize operating processes, reduce downtimes
and maximize productivity.

IPv4 limited broadcast

Type of broadcast in a network with IPv4 (Internet Protocol version 4). The IP address 255.255.255.255 is entered as
the destination. The content of the broadcast is not forwarded by a router, which limits it to the local network.

I-share

Integral share of the controller that acts on the manipulated variable through the temporal integration of the control
deviation with the weighting caused by the reset time: the longer the control difference is present, the stronger the
response is.

Life performance indicator

Value for the calculated life performance of the geared motor.

Load matrix

Recording of the frequency distribution of speeds and torques that occurred at the output of the geared motor.

Miniature circuit breakers

Special switch that protects electrical systems from overload and short-circuits.  It is specifically used for the fuse
protection of individual cores or cables. The switch has different triggering characteristics (A, B, C, D) and, thus, serves
all application areas in industrial, functional and residential construction.

Multi-axis scope

Analysis tool of DriveControlSuite with graphical output. It can be used to create synchronized scope images of
multiple drive controllers or axes in order to measure and depict the progress of parameter values, signal names or
physical addresses over time.

MV number

The number of the material variant ordered and delivered as stored in the enterprise resource planning system, i.e. the
device-specific combination of all hardware and software components.

Network Time Protocol (NTP)

Standard for synchronizing clocks in computer systems via packet-based communication networks. The protocol uses
the connectionless transport protocol UDP or the connection-based TCP. It is specifically designed to provide reliable
timing over networks with variable packet runtime.
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Output choke

Choke type that delays the current increase at the input of the drive controller or supply module in order to reduce the
harmonics in the supply grid and reduces the load of the power feed-in of the devices.

P controller

Controller type in which the manipulated variable is always proportional to the recorded control difference. As a result
of this, the controller responds to the control deviation without a delay and only creates a manipulated variable if a
deviation is present. It is a fast and stable controller with a permanent control deviation that can be used for non-
critical controls where permanent control deviation can be accepted when faults occur, e.g. pressure, flow, fill level
and temperature control.

Performance Level (PL)

In accordance with DIN EN ISO 13849-1: Measure for the reliability of a safety function or a component. The
Performance Level is measured on a scale of a – e (lowest – highest PL). The higher the PL, the safer and more reliable
the function in question is. The PL can be assigned to a specific SIL. A reversed inference from a SIL to a PL is not
possible.

PI controller

Controller type that results from a parallel connection of a P and an I-controller. With the right layout, it combines the
advantages of both types (stable and fast, no permanent control deviation) and compensates for the disadvantages
simultaneously.

PID controller

Universal controller type with a P-, I- and D-share. These three adjustment parameters make the controller flexible and
ensure exact and highly dynamic control. However, by implication, it also necessitates a wide variety of variants. It is
that much more important to ensure careful construction that is well-coordinated to the system. The application areas
for this controller type are control circuits with systems of the second order and higher, which must be stabilized
quickly and do not allow for any permanent control deviation.

Plug connectors

Component for disconnecting and connecting cables. The connecting parts are appropriately aligned by the positive
locking of the plug pieces, feature detachable, positive attachment by spring force (pin) and are often also secured
against unintended disconnection by a screw connection.

Position controller

Controller that is part of the control cascade and makes sure the deviation between the set and actual position is small.
To do so, it calculates a set velocity from the deviation and passes it to the velocity controller.

Power choke

Choke type that delays the increase in current at the input of the drive controller or supply module in order to reduce
harmonics in the supply grid.



Glossary STOBER

440

02
/2

02
4 

| 
ID

 4
42

72
8.

12

Predictive Maintenance (PRM)

Proactive maintenance process based on permanent monitoring and evaluation of machine and process data. The aim
here is to predict future maintenance requirements, thereby avoiding faults and making maintenance processes more
efficient.

Pre-trigger

Percentage portion of the recording time that takes place before the trigger and that defines the starting time of the
scope image.

Pre-trigger time

Portion of the recording time that takes place before the trigger and that defines the starting time of the scope image.

PROFIdrive

Standardized drive interface for PROFIBUS and PROFINET open standard buses. It defines the device behavior and
procedure for accessing internal device data for electrical drives on PROFINET and PROFIBUS. The interface is specified
by PROFIBUS and PROFINET International (PI) user organizations, and is specified as the future-proof standard by
standard IEC 61800-7-303.

PROFINET

Open Ethernet standard of PROFIBUS Nutzerorganisation e. V. (PNO) for automation.

PROFINET IRT

Transmission method for high-precision as well as synchronized processes in a PROFINET IO system.

PROFINET RT

Transmission method for time-critical process data in a PROFINET IO system.

PROFIsafe

Communication standard for safety standard IEC 61508 that includes both standard as well as fail-safe communication.
The standard enables reliable communication for PROFIBUS and PROFINET open standard buses based on standard
network components, and is defined as the international standard in standard IEC 61784-3-3.

P-share

Proportional share of the controller gain: the greater this share is, the stronger the influence on the manipulated
variable.

PTC thermistor

Thermistor whose resistance significantly changes with the temperature. When a PTC reaches its defined nominal
response temperature, the resistance increases dramatically, by two or more times the original resistance, to several
kOhms. Since PTC triplets are used, each thermistor monitors one phase of the motor winding. For 3 thermistors, this
means all 3 phases are monitored, achieving effective motor protection.
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Quantization

Conversion of analog signals into numbers and measurable variables. For this purpose, the analog signals are scanned
in regular intervals at the sampling rate and their voltage rating is converted at each of these scanning points to a
digital value. The analog signal can only be expressed in a finite number of digital values.

Recording time

Recording of an image, occurrence, acoustic event or other event on a corresponding medium. In the context of a
scope, the display of the calculated duration of scope image recording. The memory size, sampling time and channels
used form the basis of the calculation.

Reforming

Protective measure for drive controllers. In case of a longer storage time, the oxide layer of the capacitors reacts with
the electrolytes. This influences the electrical strength and capacitance. The process to be performed before
commissioning re-establishes the dielectric in the capacitors.

Reverse documentation

Refers to a read-only file read out by a drive controller that includes the fault memory in addition to the configuration
of a drive controller. This file is a snapshot of the time that the connection between the PC and drive controller was
interrupted. The information it contains is used for diagnostics as well as for processing service requests.

RFC

Proposed and published Internet standards, reviewed by the Internet Engineering Task Force (IETF), as consensus-
building body that facilitates discussion, and eventually a new standard is established.

Safe Stop 1 (SS1)

In accordance with DIN EN 61800-5-2: Procedure for stopping a PDS(SR). With the SS1 safety function, the PDS(SR)
performs one of the following functions: a) Triggering and controlling the motor delay variable within defined limits
and triggering the STO function if the motor speed falls below a specified limit value (SS1-d), or b) triggering and
monitoring the motor delay variable within defined limits and triggering the STO function if the motor speed falls
below a specified limit value (SS1-r), or c) triggering the motor delay and triggering the STO function after an
application-specific delay (SS1-t). In this case, SS1(-t) corresponds to the time-controlled stop in accordance with 
IEC 60204-1, stop category 1(-t).

Safe Torque Off (STO)

In accordance with DIN EN 61800-5-2: Procedure for stopping a PDS(SR). The STO safety function prevents the motor
from being supplied with any energy that could cause rotation (or motion in a linear motor). The PDS(SR) does not
supply the motor with any energy that could generate torque (or force in a linear motor). STO is the most fundamental
drive-integrated safety function. It corresponds to an uncontrolled stop in accordance with DIN EN 60204-1, stop
category 0.

Safety Integrity Level (SIL)

In accordance with DIN EN 61800-5-2: Probability of a safety function failure. SIL is divided into levels 1 – 4 (lowest –
highest level). SIL precisely assesses systems or subsystems based on the reliability of their safety functions. The higher
the SIL, the safer and more reliable the function in question is.
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Sampling time

In signal processing, the time after which an analog signal (also called a continuous-time signal) is scanned again, i.e.
measured and converted into a discrete-time signal.

Scope

Analysis tool of DriveControlSuite with graphical output. It can be used to create scope images of a drive controller in
order to measure and depict the progress of parameter values, signal names or physical addresses over time. The term
stems from traditional scope-type measuring instruments.

Scope memory

Disk space in the drive controller that records the data of a scope image.

Security

Term for the protection and safety of components and systems with regard to confidentiality, integrity and availability.

Self-discharge

Passive running process that causes the capacitors to discharge even when no electrical load is connected.

Serial number

Consecutive number stored for a product in the enterprise resource planning system and used for individual
identification of the product and for determining the associated customer information.

Short circuit current rating (SCCR)

Characteristic of electrotechnical components or modules. It is defined as the maximum short circuit current that a
component or system must safely withstand.

Simple Network Time Protocol (SNTP)

Simplified version of the Network Time Protocol (NTP). The structure of the protocol is identical to that of NTP. SNTP
clients can thus also obtain the time from NTP servers. The main difference lies in the algorithms used for time
synchronization. While NTP usually uses multiple time servers for time synchronization, SNTP uses only one time
server.

Single-ended (HTL/TTL)

In the context of signal transmission, electrical signal transmission takes place using a voltage that changes in relation
to a constant reference potential.

Synchronous operation

Synchronous movement of the individual axes in multi-axis systems.

System parameter

Parameter that is defined by the firmware. Examples include parameters for motor control, for encoders or
parameters of the control cascade.
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Template

In the context of the DriveControlSuite commissioning software, a template for graphical programming. This template
can be selected in the configuration dialog for device control, communication (fieldbus) or application in a certain
version.

Trigger

Switch or software function that generates a pulse or a switching operation during a triggering event.

Trigger condition

Triggering event that generates a pulse or switching operation.

Velocity controller

Controller that is part of the control cascade and makes sure the deviation between the set and actual velocity is small.
In addition, it uses the deviation to calculate a value for the set torque/force and transfers this to the current
controller.

Window function

Auxiliary function for minimizing the leakage effect for the Fourier transform.
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